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 you need the equipment listed below. To 
re you are using or how much RAM you 
 Apple (

 

K

 

) menu. To find out how much 
 in the upper right corner of any window 

 PowerPC processor

solution with 256 colors 

 install (55 MB after installation)

 print checks

net access, if you plan to use any of the 
System requirements

To use Quicken Deluxe 2000 for Macintosh,
find out which version of the system softwa
have, choose About This Computer from the
free space you have on your hard disk, look
in the Finder (in Icon or Small Icon view).

• the Quicken Deluxe 2000 CD-ROM

• Macintosh or Mac OS compatible with a

• double-speed CD-ROM drive or faster

• Color monitor with at least 640 by 480 re

• Mac OS software version 8.1 or higher

• 32 MB of installed RAM 

• 60 MB of free hard disk space before you

• Intuit checks and a printer, if you plan to

• a 14,400-baud or faster modem and Inter
online features in Quicken
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uicken Deluxe 2000 CD-ROM. Be sure to 
 If your installed copy is ever damaged, 
tall it.

 data files. However, it’s a good idea to 
fore installing if you’ve used a previous 
rchiving your data files” on page 486 if 

 prevent installation from working 
 Quicken, try restarting your Macintosh 

 Shift key while restarting). 

  

pplications, since you will need to restart 

urn it on before you start your Macintosh. 

  

ur CD-ROM drive.

  

e Installer.

    

reement.
Installing Quicken

To install Quicken, you need your original Q
keep your original CD-ROM in a safe place.
you can use your original CD-ROM to reins

Installation does not affect existing Quicken
back up your existing Quicken data files be
version of Quicken. (See “Backing up and a
you’re not sure how to back up your files.)

Caution Some virus-protection utilities may
properly. If you run into problems installing
without any extensions (just hold down the

1 Start your Macintosh as you usually do.

Make sure you aren’t running any other a
your Macintosh after installation.

If you have an external CD-ROM drive, t

2 Insert the Quicken Deluxe 2000 CD in yo

3 Double-click the Installer icon to start th

4 Click Continue in the Welcome screen.

5 Click Accept to the Software License Ag

The Installer icon looks 
like this:
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if you want the Installer to install all the 
ur computer.

  

ation shown on the screen.

ent location, first choose the location, and 

  

e screen.

your data files from a previous version of 
er, click Move to move your data (recom-

where it is.

  

tart your computer, click Restart.
6 Make sure that Easy Install is displayed 
files you need to run Quicken 2000 on yo

7 Click Install to install Quicken in the loc

If you want to install Quicken in a differ
then click Install.

8 Follow the installation instructions on th

If the Installer asks if you want to move 
Quicken to the Quicken Deluxe 2000 Fold
mended) or click Don’t Move to leave it 

9 If Quicken tells you that you need to res

Choose Custom Install from the 
pop-up menu to choose how 
Quicken is installed. You can 
choose which features to install:
•QuickEntry
•Financial Fitness
•Quicken Home Inventory

To install Quicken in a different 
location, choose a different disk 
from the pop-up menu or choose 
Select Folder to select a different 
folder.
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he onscreen user’s guide, you need to 
e-click the Install Acrobat Reader 4.0 icon 
nd follow the onscreen instructions.

etting started if you’re new to Quicken” 

 of Quicken for Macintosh, skip now to 
cken” on page 22.
10 (Optional) If you want to be able to use t
install Adobe Acrobat Reader. Just doubl
on the Quicken Deluxe 2000 CD-ROM a

If you’re new to Quicken, continue on to “G
next.

If you’re upgrading from a previous version
“Upgrading from a previous version of Qui



 

Chapter 1, Installation and setup    18

 

 to Quicken

 

uicken will create a new data file for you 
 first bank account and entering your first 
tions. The whole process takes only a few 

  

icken 2000 and double-click the Quicken 

  

our copy of Quicken, type your name and 

  

oftware now.

l the information as requested. Quicken 
 you through the online registration 
 Register to send the registration.
gister later when you’re reminded, or by 
 the Online menu.

  

een and click New User to set up a file for 

  

y lists you want to include.

e categories, business categories, or both. 
dual categories later, but choosing one of 
ou get started quickly. See “Quicken’s 
Getting started if you’re new

If this is the first time you’ve used Quicken, Q
and then guide you through setting up your
transaction. Just follow the onscreen instruc
minutes.

1 Go to the folder where you installed Qu
2000 application icon to start Quicken.

2 When Quicken asks you to personalize y
click OK.

3 Choose whether or not to register your s

If Quicken can’t connect to the 
Internet, it tells you how to set it 
up manually later and then 
register your software.

• If you click Register Online: Fill in al
goes onto the Internet and then takes
process. When you are finished, click

• If you click Remind Later: You can re
choosing Software Registration from

4 Read the information in the welcome scr
your Quicken data.

5 Select which of Quicken’s preset categor

You can include Quicken’s standard hom
You will be able to add and delete indivi
Quicken’s standard lists now can help y

The Quicken application icon 
looks like this:

Quicken Deluxe 2000
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e 75 to look at Quicken’s standard home 

  

 the Set Up Account window. Before you 
recent bank statement. You’ll need it to set 

  

nk selected for Account Type and enter a 
r the account.

  

 displays the Register window for that 
ce.

  

k statement in the Date field of the 

  

bank statement in the Deposit field of the 
preset Category & Transfer lists” on pag
and business categories.

6 Click OK.

Quicken creates your data file and opens
set up your first account, find your most 
up the account correctly.

7 In the Set Up Account window, leave Ba
name (and, if you want, a description) fo

8 Click Create.

Quicken creates a new bank account and
account so you can enter a starting balan

9 Enter the closing date from your last ban
Opening Balance transaction.

10 Enter the ending balance from your last 
Opening Balance transaction.
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e transaction.

eady to add a transaction to the register.

  

 your first transaction.

er the closing date of your last bank state-

count. Now you can bring the account up 

at have occurred in this account between 
ement and today. These transactions may 
rded in your paper check register, 

account, or ATM deposits to or 

atement’s ending date that have not yet 
11 Click Record to save the Opening Balanc

Your first account is set up and you are r

12 Follow the onscreen instructions to enter

Start with a transaction that occurred aft
ment.

Congratulations! You’ve set up your first ac
to date:

See Chapter 6, Keeping your 
accounts up to date, on page 87 
for information about entering 
transactions in a register.

• Continue entering all the transactions th
the ending balance on your last bank stat
be checks that you have written and reco
electronic funds transfers to or from the 
withdrawals from the account.

• Enter all transactions dated before the st
appeared on any bank statement.*

Enter the opening balance 
for this account in the 
Deposit column. The date 
and amount for this 
Opening Balance transaction 
should be the same as the 
closing date and ending 
balance from your most 
recent bank statement.
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icken on a regular basis as they occur, or 
en your next bank statement arrives, you 
 recorded in your Quicken account. See 
n page 157 for information about recon-

 

s when you get your next bank statement 
count with the bank statement. See 
You can continue to enter transactions in Qu
whenever it’s convenient for you. Then, wh
can reconcile it with the transactions you’ve
Chapter 8, Reconciling Quicken accounts, o
ciling bank accounts.

*Or you can wait and enter these transaction
and are ready to reconcile your Quicken ac
“Before you start” on page 158.
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ersion of Quicken

 

n of Quicken, be sure to move your 
icken Folder. Then, if you still have your 
uicken, you can delete your old Quicken 

r have your original disks, back up the 
mmend that you delete your old copy of 

or 1.5, a document with instructions for 
l Support. Choose To the Web

 

 . 

 

Online 

  

or information on using a Web browser 
cial information on the Web” on page 34.

  

d your Quicken data files to your new 
uicken application from your hard disk, 

 of these three ways:
con.
 icon.
e Quicken application icon and drop it by 
 application icon is highlighted.

  

our copy of Quicken, type your name and 

  

oftware now.
Upgrading from a previous v

If you are upgrading from a previous versio
existing Quicken data files into your new Qu
Install Disks from your previous version of Q
folder from your hard disk. If you no longe
folder before you delete it. We strongly reco
Quicken.

Note: If you are upgrading from Quicken 1 
upgrading is available from Intuit Technica
Technical Support from the Online menu. F
with Quicken, see “Up–to–the–minute finan

1 After you have installed Quicken, move
Quicken Folder, and removed your old Q
you can open your Quicken data file one
• Double-click your Quicken data file i
• Double-click the Quicken application
• Drag your Quicken data file icon to th

releasing the mouse button when the

2 When Quicken asks you to personalize y
click OK.

3 Choose whether or not to register your s
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goes onto the Internet and then takes you 
ss. Fill in all the information as requested. 
 to send the registration.
gister later when you’re reminded, or by 
 the Online menu.

  

een and click Upgrading User to continue.

hat’s new in Quicken. Click Continue 

  

 dialog box, select your data file and click 

 or dragged the data file icon to the 
 this step.

matically creates a copy of the data file in 
ly using and puts it in a folder called Old 
r (Q8) to the end of the file name so you 

ion of Quicken. For example, if your 
ed “Murphy’s Finances,” the Quicken 98 

8)” and you will be able to find it in the 

dates your original data file for Quicken 
to update another Quicken data file, 
lect that file.
If Quicken can’t connect to the 
Internet, it tells you how to set it 
up manually later and then 
register your software.

• If you click Register Online: Quicken 
through the online registration proce
When you are finished, click Register

• If you click Remind Later: You can re
choosing Software Registration from

4 Read the information in the welcome scr

You’ll see a series of screens telling you w
after you read each screen.

5 If Quicken displays a standard Open File
Open.

If you double-clicked your data file icon
Quicken application icon, Quicken skips

Before Quicken opens your data file, it auto
the format of the version you were previous
Quicken Data. It adds a suffix such as (Q7) o
know it is formatted for your previous vers
current data file is a Quicken 98 data file nam
copy will be named “Murphy’s Finances (Q
Old Quicken Data folder.

Converting your data file may 
take a little while, especially if the 
file is large.

After the backup file is created, Quicken up
2000 and you’re ready to work. If you need 
choose Open File from the File menu and se
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 2000 format, you CANNOT go back and 
uicken. If you ever need to use your old 

, you can open the copy of the file that 
r.
Note After you update your file to Quicken
use the same file with an earlier version of Q
data with your previous version of Quicken
Quicken put in the Old Quicken Data Folde



  

  25

 

icken can do 

 

2

 

.....................................................................26

.....................................................................28

.....................................................................29

.....................................................................30

.....................................................................31

.....................................................................32

 the Web .....................................................34

.....................................................................35
2 Here’s what Qu
for you
Managing your bank accounts.......................

Online banking .................................................

Tracking your investments .............................

Tracking your assets and debts ......................

Planning ahead.................................................

Reports and graphs..........................................

Up–to–the–minute financial information on

What’s new in Quicken 2000 ..........................



 

 Here’s what Quicken can do for you    26

 

s

 

ike a paper checkbook register. You enter 
balance in the register, including checks 
s, ATM (automated teller machine) trans-

g tasks quickly and easily, including:

sactions without spending a lot of time 
ch transaction you enter, so you only have 

Quicken computes 
the account balance 
automatically each 
time you record a 
transaction.
Chapter 2,

Managing your bank account

A Quicken bank account register looks a lot l
all the transactions that affect your account 
you’ve written, deposits, electronic transfer
actions, and so on.

Quicken helps you accomplish many bankin

• Keeping detailed records of all your tran
entering data. QuickFill™ remembers ea
to type recurring transactions once.

Quicken has no problem if 
you use more than one series 
of check numbers at a time. 
You can write your checks by 
hand, print Intuit checks 
directly from Quicken, or use 
a combination of both. 

Quicken displays the name of 
the account (Joint Checking) 
in the window title.
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ake sure they agree with the statements 

counts. Quicken records the transfer in 
s automatically. 

 a car payment that you pay at the same 
 pay only once, to a paycheck direct 
ay finally rolls around, Quicken either 

for you automatically—whichever you 

  

. Just double-click the QuickEntry icon in 
transactions without opening Quicken. 

es from and where it goes with categories. 
ral different stores, you can tell Quicken 
h time you record a payment to any of 
n, at the end of the month, you can create 
you spent on groceries that month.

m 
Chapter 2,

• Reconciling your Quicken accounts to m
from your bank.

• Transferring money between Quicken ac
both accounts and updates your balance

• Scheduling any kind of transaction—from
time every month, to a class fee that you
deposit. When a bill is due or when payd
reminds you about it or simply enters it 
prefer.

• QuickEntry makes data entry even faster
your Quicken folder to enter your latest 

• Keeping track of where your money com
For example, if you buy groceries at seve
to use the same “Groceries” category eac
those stores in any Quicken register. The
a report or graph that shows how much 

Entering categories is easy. 
As soon as you type the 
letters “Gr,” QuickFill 
completes the category 
name “Groceries.” You can also choose a category name fro

the pop-up menu in the Category field.
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u convenient, day or night access to your 
d security features. With online banking 

isters with transactions downloaded 
aving data entry time and effort

matic transaction matching

eck or licking a stamp

ame financial institution

 charge card information, so you have up-
ecision making

 future date you specify. 
Chapter 2,

Online banking 

The Quicken online banking feature gives yo
accounts using state-of-the-art encryption an
you can:

• Automatically update your Quicken reg
directly from your financial institution, s

• Easily reconcile your accounts with auto

• Pay your bills without ever writing a ch

• Transfer funds between accounts at the s

• Retrieve account balances and credit and
to-date information for better financial d

• Schedule a payment now to be paid at a
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o track what you own in stocks, bonds, 
ts that fluctuate in price. With investment 

tments

sactions

l gains

nvestment accounts in a single window. 
mary information for all your securities.
Chapter 2,

Tracking your investments

You can use Quicken investment accounts t
mutual funds, and other types of investmen
accounts, you can:

• Compare the performance of your inves

• Keep detailed records of investment tran

• Update current market values

• Report on investment income and capita

The Portfolio window lets you see all your i
You can update security prices and view sum
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ts

 

an balances, the value of your car or other 
n your credit cards. If you set up accounts 
clude them in net worth reports and 
 total financial picture.

 it keeps track of both the amount of 
ing principal balance—it even calculates 
 each payment. 

ack of your possessions and their values. 
insurance coverage and track insurance 
Chapter 2,

Tracking your assets and deb

Quicken can help you track such things as lo
personal possessions, and the balances due o
for all your assets and debts, Quicken can in
graphs to give you an accurate view of your

When Quicken tracks loans and mortgages,
interest you’ve paid and the loan’s outstand
the proportions of interest and principal for

Quicken Home Inventory helps you keep tr
You can also make sure you have adequate 
claims. 
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ey’s been going. It can also help you look 
variety of long- and short-term planning 
to mortgage tracking tools. Use reports, 
financial health, and then try out “what-
culators. The Quicken tax planner helps 
and the loan tracking tools help you shop 
rest and principal you would pay in 

ls and services to help gain better control 

  

 time and money at tax time. Quicken 
 answers to help you determine whether 

  

edit rating with a free copy of your credit 
you eliminate possible headaches in the 

t of your financial situation and provides 
age applications.

debt level and helps you create an action 

  

our most important personal information 
 and for your family’s and friends’ peace 
Chapter 2,

Planning ahead 

Quicken doesn’t just track where your mon
into your financial future. Quicken offers a 
tools, from budgets to planning calculators 
graphs, and budgets to assess your current 
if” scenarios with the financial planning cal
you estimate what your next tax bill will be, 
for loans by figuring exactly how much inte
different loan scenarios.

As well, Quicken includes the following too
of your finances:

• Tax Deduction Finder can help you save
walks you through simple questions and
or not you might qualify for deductions.

• Free Credit Report lets you check your cr
report. Finding mistakes now may help 
future.

• Net Worth Analysis gives you a snapsho
valuable information for loan and mortg

• Debt Reduction Planner evaluates your 
plan to reduce your debt.

• Emergency Records Organizer saves all y
in one place—for your own convenience
of mind in case of an emergency. 
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eports and graphs to give you insight into 
rting tools, you can include information 
ou can create a QuickReport™ or an 
ate, or you can customize standard 

e layout and choosing just the accounts 

for the last three months of last year. You 
ory summary report or an expense 
Chapter 2,

Reports and graphs 

Quicken can create many different kinds of r
your finances. With Quicken’s flexible repo
from any or all of your Quicken accounts. Y
EasyAnswer report or graph for a quick upd
Quicken reports and graphs by changing th
and categories you want to see.

Suppose you want to look at your expenses 
can see the information you want in a categ
comparison graph.
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If you want to see more detail 
about a value in a graph (for 
example, a specific pie slice), 
double-click the value to get a 
QuickZoom graph.

An expense comparison 
graph shows how much you 
are spending on individual 
categories in relation to your 
total spending and to other 
categories. You can use graphs 
to analyze spending patterns, 
show your top ten expenses, 
alert yourself to overspending, 
and compare historical data.
Chapter 2,

Subcategories help you 
analyze your spending or 
income patterns; you can look 
at a detailed breakdown of 
how much you’ve spent or 
earned for each subcategory as 
well as see a total for the 
category.

In a category summary report, 
Quicken totals your income 
and expenses and displays the 
totals on the screen. You can 
also print the report if you like.

If you want to view the trans-
actions that make up a value in 
a report, double-click the value 
to get a QuickZoom report (a 
list of transactions). To change 
one of the transactions in that 
list, double-click it to go to the 
register with that transaction 
selected.
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nformation on the Web

 

ect to the World Wide Web right from 
nline menu and then choose your Web 
b is updated continuously to give you the 
anking, and Quicken technical support.

st already have an Internet Service 
, and you must identify them in Quicken 
ervice Provider” on page 183 and 
 more information.
Chapter 2,

Up–to–the–minute financial i

If you have a Web browser, it’s easy to conn
Quicken. Just choose To the Web from the O
destination. Quicken’s home page on the We
very latest in financial information, online b

To set up Web access from Quicken, you mu
Provider (ISP) and a Web browser installed
Preferences. See “Specifying your Internet S
“Choosing a Web browser” on page 185 for
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o organize your finances, with enhance-
se interface. Quicken 2000 is designed to 
nformation than ever, in a format that is 

  

aphs, and helpful suggestions based on 
ig picture. If you have Internet access 

rces to help you to make more informed 

  

olio’s value and monitor historical trends. 
 can download up to five years of stock 

 

uicken in Quicken Help Topics and select

 

Quicken Help Topics and select
Chapter 2,

What’s new in Quicken 2000

Quicken 2000 makes it even easier for you t
ments that improve on its already easy-to-u
make your work faster and give you more i
useful, efficient, and smart.

Get the big picture

Quicken Insights brings together reports, gr
your own financial data so you can see the b
Insights also delivers up-to-date Web resou
financial decisions. 

Download more quotes

Now you can keep better track of your portf
Using the new historical quotes feature, you
and mutual fund quotes from the Web.

For step-by-step help, go to Customizing Q

How do I set up Quicken Insights?

For step-by-step help, go to Investments in 

How do I download historical quotes?
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 and research on the stocks you follow by 
rch from Quicken.com

 

.

  

arket but need guidance on how to make 
 you gather, all in one place, the informa-
o invest your money.

  

ing you in comparing mortgage interest 
ard and bank interest rates.

 

Quicken Help Topics and select

 

Quicken Help Topics and select

 

Quicken Help Topics and select
Chapter 2,

Access more investment data

You can stay informed of late-breaking news
taking advantage of current news and resea

Research investment opportunities

Want to take advantage of the power of the m
smarter investment choices? Quicken helps
tion you need to evaluate and decide how t

Reduce your mortgage

Quicken can help you save money by assist
rates online. You can also search for credit c

For step-by-step help, go to Investments in 

How do I get up-to-date financial news?

For step-by-step help, go to Investments in 

How do I research stock performance?

For step-by-step help, go to Investments in 

How do I compare interest rates online?
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s to try out different scenarios for your 
estments or retirement, banking and 
ents. 

  

ur finances faster and easier than ever. 
used commands, making it easier for you 
customize Quicken to fit your needs.

  

y to pay your bills and manage your 
ing capabilities in Quicken, you can more 
ed from your participating financial 

 

icken Help Topics and select

 

uicken in Quicken Help Topics and select

 

 in Quicken Help Topics and select
Chapter 2,

Find answers fast

Go online and use QuickAnswers calculator
personal financial situation, whether it's inv
credit, saving and spending, taxes or life ev

Save more time

A redesigned interface makes managing yo
This new design brings together commonly 
to find your favorite features. And you can 

Pay bills and bank online

Online banking is the quick, convenient, wa
accounts. With improved transaction match
accurately categorize transactions download
institution.

For step-by-step help, go to Planning in Qu

How do I plan for life events?

For step-by-step help, go to Customizing Q

How do I change the toolbar?

For step-by-step help, go to Online banking

How do I get started with online banking?
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t to more financial institutions, including 
 unions, and Canadian banks.

e your tax return. Quicken Deluxe 2000 
bate) of one Federal return using Intuit’s 

 in Quicken Help Topics and select

 Quicken Help Topics and select
Chapter 2,

Access more financial institutions

With Quicken Deluxe 2000, you can connec
hundreds of small community banks, credit

File taxes online

Filing online is a faster and easier way to fil
includes free electronic filing (via mail-in re
WebTurboTax electronic filing Web site.

For step-by-step help, go to Online banking

How do I get started with online banking?

For step-by-step help, go to Income taxes in

How do I file taxes online?
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ented by six tabs at the top of your screen. 
work and prevent your workspace from 
ndows. You’ll work on different kinds of 

ding checking, savings, and money 

nds, and other investments.

d mortgages, and assets such as your 

ts might affect your finances, plan for tax 
e and pay less interest on your debts.

t tell you where your money comes from 

rently open Quicken data file. This area 
ss financial information resources on the 

in one activity area when you switch to a 
ll see the same windows that were open 
h gives you one-click access to common 
so that it includes only the buttons you 
t up the activity areas and toolbars so they 
en workspace” on page 43.
Working with Quicken

Quicken has six activity areas that are repres
These activity area tabs help organize your 
becoming cluttered with too many open wi
financial tasks in each activity area.

• Banking: Work with bank accounts, inclu
market accounts.

• Investing: Track stocks, bonds, mutual fu

• Assets/Debt: Track credit cards, loans an
home.

• Planning: Budget, forecast how new even
time, and develop strategies to save mor

• Reporting: Create reports and graphs tha
and where it goes.

• The last area takes its name from the cur
contains task buttons that help you acce
Web.

Quicken hides the windows you have open 
new area. When you return to an area, you’
when you left it. The Quicken toolbar, whic
tasks, changes as you change activity areas 
need for the area you’ve selected. You can se
work for you; see “Customizing your Quick
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n this section to choose Quicken 

ing a button in the toolbar. The toolbar 
 it includes the buttons for the most 
rea you’ve selected.

ttons, see “Customizing your Quicken 

 just as you choose commands from any 
acintosh user, see the documentation that 
tion.

s you press at the same time to choose a 
 commands have keyboard shortcuts by 
nation, if any, is listed in the column on 
Choosing Quicken commands

You can use any of the methods described i
commands.

Choosing commands from the toolbar

You can choose Quicken commands by click
changes as you change activity areas so that
commonly used commands in the activity a

To add, delete, and rearrange command bu
workspace” on page 43.

Choosing commands from the menus

Choose commands from menus in Quicken
other Macintosh menus. If you are a new M
came with your computer for more informa

Choosing commands with the keyboard

A keyboard shortcut is a combination of key
command. You can find out which Quicken
looking at the menus to see what key combi

The toolbar in the Banking 
area includes buttons for 
common banking tasks.

Keyboard shortcut for the 
Accounts command.
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own the x (Command) key while you 
, for example, hold down the x key and 
yboard shortcuts on the back cover of this 
our own keyboard shortcuts in Quicken. 
rtcuts” on page 45.
the right. To use a keyboard shortcut, hold d
press another key. To open the Account list
press A. You can see a list of many preset ke
Quick Reference Card. You can also create y
See “Creating your own Command-key sho
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orkspace

uicken workspace by hiding the 
nging, or removing tabs and command 

and then click the General icon in the 

ows” checkbox to hide the backdrop.

of command buttons that changes as you 
 You can use the toolbar just as it is, or you 
Customizing your Quicken w

You can customize the appearance of your Q
backdrop or the toolbar, and adding, rearra
buttons. 

Hiding the backdrop

1 Choose Preferences from the Edit menu 
scrolling panel on the left.

2 Clear the “Show backdrop behind wind

Customizing the toolbar 

The toolbar initially contains a standard set 
switch from one activity area tab to another.
can change it so it suits your working style.

The toolbar in the Banking 
area includes buttons for 
common banking tasks.
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ds to the toolbar in any activity area tab. 
utton to the toolbar in the Banking tab if 
dow while you work in the Banking area.

 menu.

nt to add the command button.

o add to the activity area tab from the 

ton list onto the toolbar.

s quickly, you can drag the Windows 
 (Edit menu . Configure Toolbar) to the 
utton to the toolbar, you can choose any 

ns

n, open the Configure Toolbar window 
 the button you want to move to a new 
Adding a button to the toolbar

You can add many Quicken menu comman
You could, for example, add the Portfolio b
you want to easily access your Portfolio win

1 Choose Configure Toolbar from the Edit

2 Click the activity area tab where you wa

3 Choose the command button you want t
scrolling list of commands.

4 Drag the button from the Command But

Switching between open windows

If you want to switch between open window
button from the Configure Toolbar window
toolbar. Once you’ve added the Windows b
open window from its pop-up menu.

Rearranging and removing command butto

To change the position of a command butto
(Edit . Configure Toolbar). Select and drag
location in the toolbar.
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the Configure Toolbar window (Edit . 
ant to remove and drag it off the toolbar. 
 Tabs, Show Command Buttons and 

ortcuts

l find that you use some commands more 
ur favorite commands by creating short-
e command with a simple key sequence: 
n assign a Command-key shortcut to any 
e in the Registers menu.

enu bar. Don’t release the mouse button.

mmand to which you want to assign a 

mouse button.

the menu name, command name, and 
.

the x key and click OK.

e same Command-key shortcut assigned 
ange. If you confirm the change, Quicken 
u command and assigns it to the 
To remove a single command button, open 
Configure Toolbar). Select the button you w
To remove the whole toolbar, clear the Show
Show Account Buttons checkboxes.

Creating your own Command-key sh

As you become familiar with Quicken, you’l
than others. You can make it faster to use yo
cuts for them. A shortcut lets you execute th
pressing the x key plus one other key. You ca
menu command, including any account nam

1 Hold down the x key and click in the m

2 Release the x key and select the menu co
shortcut.

3 With the command selected, release the 

Quicken displays a window that shows 
existing Command-key shortcut (if any)

For example, if you want the 
shortcut for an account named 
Checking to be x-1, type 1 and 
click OK.

4 Type the key you want to combine with 

If another menu command already has th
to it, Quicken asks you to confirm the ch
removes the shortcut from the other men
command you selected.



Chapter 3, Working with Quicken    46

enu bar. Don’t release the mouse button.

mmand.

se the mouse button.

Key field in the Edit Command Key 
Removing a Command-key shortcut

1 Hold down the x key and click in the m

2 Release the x key and select the menu co

3 With the menu command selected, relea

4 Delete the shortcut from the Command 
window.

5 Click OK.



Chapter 3, Working with Quicken    47

ce from Quicken Help

ething in Quicken, you can go to Quicken 
elp coaches you through every step and 
s along the way. When you use Quicken 
 windows you have open. If you need to 

uide that are available in Quicken Help 

e a number of different ways to open 

nu.

tended keyboard.

e folder named Quicken Help is in the 
, and that the Apple Guide extension is in 
.

en Help Topics and select
Getting step-by-step assistan

If you have a question about how to do som
Help for step-by-step assistance. Quicken H
prevents you from skipping important step
Help, its window stays in front of any other
move it, just drag its title bar.

The step-by-step procedures in this User’s G
are listed in tables like this one.

When you are working in Quicken, there ar
Quicken Help:

• Press x-?

• Choose Quicken Help from the Help me

• Press the Help key if you are using an ex

If Quicken Help doesn’t open, make sure th
same folder as your Quicken application file
the Extensions folder in your System Folder

For step-by-step help, go to Registers in Quick

How do I enter a transaction?
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g a session with Quicken, you see the 
window.

•Click the Look For button 
to search for a specific 
word.
The first time you open Quicken Help durin
“getting started” view of the Quicken Help 

The Quicken Help window 
gives you three ways to 
find the information you 
need:
•Click the Topics button to 

choose from a list of 
general areas in 
Quicken—like the table 
of contents in a book.

•Click the Index button to 
choose from an alphabet-
ical list of keywords—
like the index in a book.
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 scrolling list of topics on the left. When 
splays a list of questions on the right that 

ow do I... questions show you how to 
 explain why you can’t do something you 
ns explain terms you need to understand 

wered and click OK, Quicken Help takes 
Quicken Help Topics

When you click the Topics button, you see a
you click one of the topics, Quicken Help di
it can answer about the topic you selected. H
complete a task in Quicken. Why... questions
think you should be able to do. And Definitio
to work with Quicken.

When you select the question you want ans
you to the first instruction panel.

When you select a topic in 
the list on the left, Quicken 
Help shows you a list of 
questions it can answer 
about that topic.
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t arrow in the lower right corner to go to 
nd following the instructions. When you 
lower right corner to go to the next step.

 Topics button to return to the Topics 
ken Help. 

Click the right arrow to go to the 
next step.

Click Expert for a summary of the 
steps required to complete this task.

Click the left arrow if you want to 
go back a step.
After you read the first panel, click the righ
the first step. Continue reading the panels a
finish each step, click the right arrow in the 

When you’ve finished all the steps, click the
window, or click the close box to leave Quic

When the More Info button is 
available, you can click it to see 
more detailed information.

Click the Topics button if you 
want to return to the Quicken 
Help Topics window.

Click the close box when you 
are ready to leave Quicken 
Help.
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o scrolling lists. The list on the left is an 
of the list, and then scroll through the list 
re about. When you select an index entry, 
ions that Quicken Help can answer.

wered and click OK, Quicken Help takes 
anel and follow the instructions.
Quicken Help Index

When you click the Index button you see tw
alphabetical index. Select a letter at the top 
until you find the term you want to know mo
the list on the right shows you related quest

When you select the question you want ans
you to the first instruction panel. Read the p

Click any letter to see the 
entries for that letter in the 
index.

Click any index entry to see 
a list of related questions.
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n Help asks you to enter a word you want 
 text and click Search, the list on the right 
p can answer.

wered and click OK, Quicken Help takes 
anel and follow the instructions.
Quicken Help Look For

When you click the Look For button, Quicke
to know more about. When you type in your
displays related questions that Quicken Hel

When you select the question you want ans
you to the first instruction panel. Read the p

Click this button to activate 
the text box; then type a 
word and click Search.



Chapter 3, Working with Quicken    53

elp you get more out of using Quicken. 
cken in the Tip area of the toolbar.

you work in Quicken by choosing Tips & 
n to see a series of tips and shortcuts for 

 right arrow to go 
one tip in this 
a; click the left 
 go back one tip.
Learning useful tips and shortcuts

Tips & Shortcuts are helpful hints that can h
You’ll see a new tip each time you start Qui

You can also look at Tips & Shortcuts while 
Shortcuts from the Help menu. Click a butto
that topic area.

Click the Topics button to go 
back to the “Topics” panel 
that lists all the topic areas.

Click a button to see the 
first tip for that topic area.

Click the
forward 
topic are
arrow to
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n Help

 and don’t know what it is, you can use 
 Help, choose Show Balloons from the 

reen to see its help balloon. To turn off 
e Help menu.
Finding out ‘What’s that?’ with Balloo

If you see an item in a window or in a menu
Balloon Help to find out. To turn on Balloon
Help menu. Then point to an item on the sc
Balloon Help, choose Hide Balloons from th
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e. You can open this Adobe Acrobat* 
e Help menu.

Guide window to change the way the 
ngle page at a time, with two pages side 
u can also reduce or enlarge the text and 
centage.

he Right Arrow key or the Down Arrow 
 from the View menu. If you’ve chosen to 
 use the scroll bar to scroll from page to 

 Reader, double-click the Install Acrobat 
D-ROM and follow the installation 

tion from this 
u to change how 
t is displayed.
Using this manual

Quicken includes this onscreen User’s Guid
document by choosing User’s Guide from th

Use the controls at the bottom of the User’s 
document is displayed. You can view it a si
by side, or as continuous scrolling pages. Yo
graphics by choosing a larger or smaller per

To move from page to page, you can press t
key on your keyboard, or choose Next Page
see continuous scrolling pages, you can also
page.

*If you haven’t yet installed Adobe Acrobat
Reader 4.0 icon on your Quicken Deluxe C
instructions.

Choose a size from this pop-up 
menu to change the scale of the 
document (how big it looks 
onscreen).

Choose an op
pop-up men
the documen

To display the Table of Contents, 
drag this button to the right. 

This is the current page 
number. Click it to go to 
a different page.
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x

se Bookmarks and Page from the View 
the text to expand or collapse levels—so 
d the headings and subheadings in each 
 the manual.

le of Contents. Click the triangle to the left 
or that letter. Click an entry to go to that 

n manual using the Find command.

bout the word or words you want to find.

Enter the text you want to find.

Select Match Case to find only 
text that is capitalized the way 
you entered it.
Using the Table of Contents and Inde

To use the manual’s Table of Contents, choo
menu (x-7). Click the triangles to the left of 
you can see the chapter titles in the book an
chapter. Click an entry to go to that page in

To use the Index, choose Index from the Tab
of a letter to expand or collapse the entries f
page in the manual.

Searching the manual

You can search for something in the onscree

1 Choose Find from the Tools menu (x-F).

2 In the Find window, fill in information a

Select Find Backwards to find the 
previous occurrence of the text.

Select Match Whole Word Only 
to find only text that matches 
exactly.
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 the word, choose Find Again from the 

ile menu, enter page setup information 

nge and click OK.

eader

he onscreen user’s manual at the click of 
in Acrobat Reader you must have a 
ader know which browser you are using.

nd then choose Weblink.

r containing the browser you want to use 
3 Click Find.

4 (Optional) To find the next occurrence of
Tools menu (x-G).

Printing sections and chapters

1 (Optional) Choose Page Setup from the F
for your printer, and click OK.

2 Choose Print from the File menu (x-P).

3 In the printer dialog box, select a page ra

Choosing a web browser for Adobe R

You can go directly to Web destinations in t
a link. To reach Web destinations from with
browser already installed and let Acrobat Re

1 Choose Preferences from the File menu a

2 Click Select.

3 In the Open File dialog box, find the folde
with Acrobat Reader and open it.
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dow to save your settings.

er

Adobe Acrobat Reader, choose Reader 
 are viewing a PDF file such as this user’s 
4 Select the browser you want to use.

5 Click Open.

6 Click OK in the Weblink Preferences win

More information about Acrobat Read

For more information about how to use the 
Online Guide from the Help menu while you
guide.
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ancial data. Your personal Quicken data 
a checking account, a savings account, 
t. If you use your Quicken data file for 
ng account, an A/R account, an A/P 

re the same lists of categories, classes, and 
nds from one account to another within 
 report or graph, you can choose to see 

 file. For example, if you want a status 
ou can create a net worth report that 
redit card, and savings accounts. If you 
erall financial picture, you can include 

 file, including investment accounts, 
Chapter 4, Ac

About Quicken data files

Your Quicken data file contains all your fin
file might contain several accounts, such as 
credit card accounts, and a portfolio accoun
business, it might contain a business checki
account, and a capital equipment account.

All the accounts in one Quicken data file sha
other information—and you can transfer fu
the same file. Plus, when you run a Quicken
data from any or all of the accounts in your
report on the accounts you use every day, y
includes the balances from your checking, c
want your net worth report to show your ov
information from all of the accounts in your

A Quicken data file is like a drawer in 
a filing cabinet, and the accounts in it 
are like the folders in that file drawer. 
You might, for example, have folders 
in your financial file drawer labeled 
Checking, Savings, Car loan, 
Mortgage, and so on.
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ity accounts you use to track the value of 
 mortgage.

ly, you probably need just one data file. 
clude information from accounts that are 

cide you need more than one data file if, 
al and business finances completely 
n data file” on page 481.
Chapter 4, Ac

retirement accounts, and the asset and liabil
your home and the remaining balance on its

If you use Quicken for personal finances on
Quicken reports, graphs, and budgets only in
in the same data file. However, you may de
for example, you want to keep your person
separate. See “Using more than one Quicke
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ething you own (an asset) or something 
money—or value—that is added to or 

s few or as many accounts as you’d like, 
 financial records to be. Some people track 
 want to know where every penny goes. 
or a while and then add other accounts as 
ts before they begin entering any data.

 what you own:

ts to track checking accounts, savings 
ebit cards. Bank accounts are the only 
rint checks or make electronic payments. 
 121, and Chapter 9, Banking online from 

nt to track your cash. See Chapter 10, 

nt to track the value of an asset such as a 
ounts to track your capital equipment or 
king assets and liabilities, on page 234.
Chapter 4, Ac

About Quicken accounts

Each Quicken account represents either som
you owe (a liability), and lets you track the 
subtracted from that account.

Quicken is flexible enough to let you track a
depending on how complete you want your
only their primary checking account; others
Some people use just one checking account f
they go along; others set up all their accoun

Tracking what you own

Quicken has five account types for tracking

• Bank account. Use Quicken bank accoun
accounts, money market accounts, and d
Quicken accounts from which you can p
See Chapter 7, Paying your bills, on page
Quicken, on page 180.

• Cash account. Use a Quicken cash accou
Tracking your cash, on page 214.

• Asset account. Use a Quicken asset accou
home or car. For a business, use asset acc
accounts receivable. See Chapter 12, Trac
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 accounts to track brokerage accounts and 
 as stocks and bonds. See Chapter 14, 

tual fund account to track a single mutual 
nts, on page 270.

 what you owe:

 card accounts to track your credit cards, 
ines. See Chapter 11, Tracking your credit 

 account to track something you owe, 
iness, use liability accounts to track 
ee Chapter 12, Tracking assets and liabili-
Chapter 4, Ac

• Portfolio account. Use Quicken portfolio
other assets that fluctuate in value, such
Tracking investments, on page 270.

• Mutual fund account. Use a Quicken mu
fund. See Chapter 14, Tracking investme

Tracking what you owe

Quicken has two account types for tracking

• Credit card account. Use Quicken credit
charge cards, lines of credit, and equity l
cards, on page 222.

• Liability account. Use a Quicken liability
such as a mortgage or car loan. For a bus
accrued liabilities or accounts payable. S
ties, on page 234.
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ally the same for all Quicken accounts. 
 if you decide to change it (see page 68).

ccount or track a loan, see “Creating a 
 mutual fund account” on page 304, or 
 set up the account.

hen click New in the Accounts list.

ormation about the account.

Click Notes to open a 
window where you can 
enter account information 
such as an account number, 
branch address, or phone 
number.

To hide an account so it 
doesn’t show up in lists, 
click this checkbox to select 
it. 

 click 
anking 
t setting 

To add an account to the 
current toolbar activity 
area, click this checkbox to 
select it. 
Chapter 4, Ac

Setting up a Quicken account

The steps for setting up an account are basic
You can edit most account information later

Note: If you want to set up an investment a
portfolio account” on page 291, “Creating a
“Setting up a loan” on page 249, before you

1 Choose Accounts from the Lists menu, t

2 In the Set Up Account window, enter inf

Enter an account name. 
You can use your bank’s 
name or a descriptive name 
such as Savings. It can be 
up to 30 characters long.

Enter a description if you 
want to see more informa-
tion about this account in 
the Category & Transfer 
list. It can be up to 54 
characters long.

Click an account type to 
select it.

To set up an account for online banking,
Enable Online Banking. See Chapter 9, B
online, on page 179 for information abou
up an online account.
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me to both the Account list and the 
gister.

t column for a bank account) and change 

nd date to enter in the Opening Balance 

Quicken places the 
insertion point in the 
column where you’ll 
enter the opening 
balance. The name 
of this column varies 
depending on the 
type of account you 
created.

ter and change 
e if you need to.

Date

our last 

“current” 

Date of your last statement
Chapter 4, Ac

3 Click Create.

Quicken creates the account, adds its na
Category & Transfer list, and opens its re

4 Enter an opening balance (in the Deposi
the date if necessary.

Use this table to determine the amount a
transaction.

You can come back to this transaction la
the opening balance amount and the dat

Account Type Opening Balance

Bank Ending balance from y
bank
statement (also called 
or “new” balance)
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omatically saves your work, so you don’t 
it.

ave on Today’s date

r last 
also 

Date of your last statement

sset Today’s date

 on the Today’s date

ning balance for a security” on page 296.

ning share balance” on page 305.

Date
Chapter 4, Ac

5 Click Record.

Each time you click Record, Quicken aut
need to save your data file before you ex

Cash Amount of cash you h
hand

Credit card Balance due from you
credit card statement (
called “new” balance)

Asset Current value of the a

Liability Current amount owed
liability

Portfolio See “Setting up an ope

Mutual fund See “Setting up an ope

Account Type Opening Balance
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t a time by opening multiple Register 
t you have open because the account 

egister in the current data file (or bring it 

ccount bar at the bottom of the toolbar. 
 Quicken displays as many as possible of 
tivity area as buttons in the account bar.

op-up menu in the toolbar.

d then choose the account name.

unt List from the Registers pop-up menu 
m the Lists menu. Then open the account 

 the account name or selecting it and 
Chapter 4, Ac

Opening an account register 

You can work with more than one account a
windows. You can always tell which accoun
name is part of the Register window title.

There are several different ways to open a r
to the front if it’s already open):

• Click the button for that account in the a
Depending on the width of your screen,
the last accounts you’ve opened in an ac

• Choose the account from the Registers p

• Choose Registers from the Lists menu an

• Open the Account list by choosing Acco
in the toolbar or by choosing Accounts fro
from the Account list by double-clicking
clicking Open.
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accounts

t name in the Account list and click Edit. 
 Edit Account window. You can rename 

 and read or edit any notes you added. 
 account or change an investment 

e account type in most cases.*

n hide it so that it doesn’t show up in the 
 Its transactions are still there so you can 
t show up in any lists. To hide an account, 
en click Hide in Lists in the Edit Account 
idden account again, select the Show 

list.

the Account list and clicking Delete.

in changing account information. If you 
tions in it. When you edit the account 
nsactions.

tfolio or mutual fund account, and you 
, or liability account into a portfolio or 
Chapter 4, Ac

Editing, hiding and deleting 

To edit a Quicken account, select the accoun
Then, change the account information in the
an account, change the account description,
You can edit the credit limit for a credit card
account’s tax status. You can also change th

If you don’t use an account anymore, you ca
Account list or the Category & Transfer list.
use them in reports and graphs, but it doesn’
select it in the Account list and click Edit. Th
window. If you decide you want to see the h
Hidden Accounts checkbox in the Account 

You can delete an account by selecting it in 

Caution: Do not delete an account as a step 
delete an account, you lose all of the transac
information, the account retains all of its tra

*You can’t change the account type of a por
can’t change a bank, cash, asset, credit card
mutual fund account.
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 the transactions in that account, and any 
our other Quicken accounts lose the 

en Help Topics and select
Chapter 4, Ac

When you delete an account, you lose all of
transfers between the deleted account and y
transfer information.

For step-by-step help, go to Registers in Quick

How do I edit account information?

How do I hide an account?

How do I delete an account?
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Chapter 4, Ac
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ons to help you track where your money 
tegorize” your transactions, Quicken can 

 reports, graphs, and budgets. If you are 
nt reports and graphs to tell you:

ings like groceries, utilities, mortgage 
, entertainment, charity, and so on. These 
es.

lary, bonuses, dividends, interest income, 
on. These items are tracked using income 

ou enter in Quicken, you can:

orts and graphs that show where your 
it. See Chapter 15, Creating reports, on 
hs, on page 406.

f your categories and create reports or 
r actual expenses and income. See 

rns by generating a list of tax-related 
ormation to tax-preparation software. See 
n page 456.
Chapter 5, Categories an

About categories

Categories are labels you assign to transacti
comes from and where it goes. When you “ca
give you insight into your finances through
tracking your home finances, you might wa

• How much you spend each month on th
interest, auto maintenance, medical fees
items are tracked using expense categori

• How much you receive each month in sa
rent from investment properties, and so 
categories.

If you assign categories to the transactions y

• Generate income- and expense-based rep
money comes from and how you spend 
page 366, and Chapter 16, Creating grap

• Set up budget amounts for some or all o
graphs that compare your budget to you
“Budgeting” on page 426. 

• Save time when preparing your tax retu
income and expenses, or by exporting inf
Chapter 18, Getting ready for tax time, o
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 in any non-investment account in your 
e a check for groceries, you would assign 

hen you enter it in your Quicken 
 groceries by credit card, you would also 
action when you enter the transaction in 

he organization of your reports, graphs, 
egory list, your reports and budgets may 
 

tegories consistently. For example, if you 
nsactions for gasoline, but other times 

uto:Fuel,” Quicken displays two separate 
ons, and another for “Auto:Fuel” transac-
ou want to find all occurrences of “Auto” 
categorize some of them as “Auto:Fuel” 
e 117).

, and budgets if you categorize credit and 
tegorize checking account transactions, 
AmEx” or “Credit card.” See Chapter 11, 

ries to many kinds of investment transac-
 for more information.
Chapter 5, Categories an

“What do I put in the Category 
field?” on page 97, explains how 
to assign categories to transac-
tions.

You can assign a category to any transaction
Quicken data file.* For example, if you writ
the category “Groceries” to the transaction w
checking account register. If you pay for the
assign the category “Groceries” to the trans
your Quicken credit card account register.

The organization of your categories affects t
and budgets. If you have a long, detailed cat
also be long, but they will be more detailed.

It is important to assign categories and subca
sometimes assign the category “Auto” to tra
you assign the category and subcategory “A
amounts in reports: one for “Auto” transacti
tions. You can use the Replace command if y
in a register and decide whether or not to re
(see “Finding a specific transaction” on pag

Tip: You’ll get more accurate reports, graphs
charge card purchases the same way you ca
instead of assigning a general category like “
Tracking your credit cards, on page 222.

*Quicken assigns special investment catego
tions. See the table that begins on page 316
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categories

, you had the opportunity to include a 
list, or both in your Quicken data file. You 

odify them to suit your needs. 

e preset category lists when you set up 
st choose Categories & Transfers from the 
e menu, select either the Business Catego-
en Essentials folder, and click Open.

y trial and error, start by using one of the 
ories as you work with Quicken. Or, if 
ant to use Quicken to organize your 

page 74 and the modified lists on page 77 

 Categories & Transfers from the Lists 

ts provided by Quicken;
Chapter 5, Categories an

Setting up categories and sub

When you started Quicken for the first time
preset home category list, business category 
can use the preset categories as they are or m

Tip: Even if you didn’t choose to include th
your data file, you can import them now. Fir
Lists menu. Then choose Import from the Fil
ries or Home Categories file from the Quick

If you like to get started quickly and learn b
preset category lists and then add new categ
you prefer to think about exactly how you w
finances, review the preset category lists on 
and then create your own list.

To see your Category & Transfer list, choose
menu.

The next page shows the preset category lis
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You can mark catego-
ries as tax-related and 
assign tax form infor-
mation to them. See 
Chapter 18, Getting 
ready for tax time, on 
page 456.

ck a column title to change the order in 
ich categories appear in the list. This list 
orted by category name, but you could 
o choose to sort it by type if, for example, 
 want to group your all of your income 

egories together. You can also sort by tax 
status or description.
Chapter 5, Categories an

You can delete any categories 
you’re not going to use by 
selecting them in the list and 
clicking Delete. For example, if 
you live in the U.S., you may 
want to delete all the Canadian 
categories. And if you live in 
Canada, you may want to 
delete the U.S. tax categories.

Cli
wh
is s
als
you
cat

Subcategories are indented 
under the main category. Click 
the triangle to the left of the 
category name to hide or show 
its subcategories.

Quicken’s preset Category & 
Transfer lists

The list on the left is the preset 
list of home categories that 
Quicken provides, and the one 
on the right is the preset list of 
business categories.
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ting new categories or new subcategories 
s and subcategories. You can also change 
ry into a category, and you can move 

. See “Creating new categories” on 
9, and “Editing, deleting, and moving 
Chapter 5, Categories an

Modifying the preset category lists

You can modify a preset category list by crea
and by editing or deleting existing categorie
a category into a subcategory or a subcatego
subcategories from one category to another
page 78, “Creating subcategories” on page 7
categories and subcategories” on page 80.
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category descriptions are visible in the 
er category list on the left, but the 
ow has been narrowed to hide them in 

horter list above. You can resize most 
ken windows if you want to save room 
ur desktop by dragging the size box in 

ower right corner of the window.
Chapter 5, Categories an

Here are two sample category 
lists:
•The list on the left is a partial 

view of a category list used by 
a couple who want to track 
their income and expenses in 
more detail than provided by 
the preset home category list.

•The list on the right is shorter 
than the preset list of home 
categories, and it contains 
main categories only—no 
subcategories. 

The 
long
wind
the s
Quic
on yo
the lAccount names in square brackets ( [ ] ) are included in this list so 

you can transfer funds between accounts. Double-click an account 
name to create a transfer. See “Transferring money between 
accounts” on page 103.

The first time you set up a 
portfolio or mutual fund 
account, Quicken adds these 
investment categories (preceded 
by •) to your Category & 
Transfer list.
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ter any transactions, or you can set them 
actions. Quicken will ask if you want to 
 category name it doesn’t recognize.

 Lists menu (x-L).

lick New (x-N).

formation about the category.

ategory & Transfer list.

(Optional) Select the Tax-related 
checkbox if you want to use this 
category to track tax-related income or 
expenses. Quicken displays the Assign 
Tax Links window, where you can 
assign categories to specific line items 
on IRS forms. See “Marking categories 
as tax related” on page 458. 
Chapter 5, Categories an

Creating new categories

You can set up your categories before you en
up “on the fly” while you are entering trans
set up a new category whenever you enter a

1 Choose Categories & Transfers from the

2 In the Categories & Transfers window, c

3 In the Set Up Category window, enter in

4 Click Create to add the category to the C

Click Income if this is an income 
category such as salary, interest 
income, or rent from an investment 
property. Click Expense if this is an 
expense category such as groceries, 
utilities, mortgage interest, or charity.

The category name can be up to 32 
characters long. Be careful not to 
enter more than one name for the 
same category. For example, if you 
type “Clothes,” Quicken will see it 
as a new category even if you 
already have a category called 
“Clothing.”
The category description can be 
up to 54 characters long. You can 
show the description instead of 
the category name in reports and 
graphs if you want to see a more 
detailed description.
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ity than using categories alone. For 
 could have subcategories such as “Cable 
ou can show information for each subcat-
orts, graphs, and budgets.

 Lists menu (x-L).

elect the category for which you want to 
ategory.

formation about the subcategory just as 

e list.

elow the main category in the Category & 
ries for the category, they are listed in 

Quicken doesn’t display a type (income 
or expense) for subcategories because 
they are always the same type as the 
parent category.
Chapter 5, Categories an

Creating subcategories

Using subcategories gives you more flexibil
example, under the category “Utilities” you
TV,” “Gas & Electric,” and “Water.” Then y
egory under the main categories in your rep

1 Choose Categories & Transfers from the

2 In the Categories & Transfers window, s
create a subcategory and click Add Subc

3 In the Set Up Category window, enter in
you would for a new category.

See the illustration in step 3 on page 78.

4 Click Create to add the subcategory to th

Quicken displays the new subcategory b
Transfer list. If there are other subcatego
alphabetical order.

To add the subcategory “Loan Int” 
under the category “Auto,” select 
“Auto” and click Add Subcategory. 
Then type “Loan Int” in the 
Category field and click Create.

In this example, Quicken would 
display the subcategory “Loan Int” 
between “Fuel” and “Service.”
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 categories and 

ation by selecting a category in the 
f you rename a category or subcategory, 
e with the new name in all transactions 

 selecting it in the Category & Transfer list 
egory or subcategory, Quicken removes 
and from the Category field of any trans-

ory as a step in changing its name. Delete 
expect to use it again or if you want to 
egory to several different categories.

tegory, or move a subcategory from one 
ing them in the Category & Transfer 
ubclass, you cannot promote the subclass 

vestment categories (those preceded 
fer categories from the Category & 
 the associated account (see “Editing, 
.

Chapter 5, Categories an

Editing, deleting, and moving
subcategories

You can edit category or subcategory inform
Category & Transfer list and clicking Edit. I
Quicken automatically replaces the old nam
categorized with the old name. 

You can delete a category or subcategory by
and clicking Delete.* When you delete a cat
the name from the Category & Transfer list 
actions to which it is assigned.

Caution: Don’t delete a category or subcateg
a category or subcategory only if you don’t 
reassign the transactions for the deleted cat

You can also change a category into a subca
category to another by dragging and dropp
list.(Note that when you change a class to a s
back to a class.)

*You cannot edit or delete the predefined in
by •), and you can only edit or delete trans
Transfer list by editing, hiding, or deleting
hiding and deleting accounts” on page 68)
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ses in Quicken Help Topics and select

es?

s?
Chapter 5, Categories an

For step-by-step help, go to Categories & Clas

How do I edit categories and subcategories?

How do I delete categories and subcategori

How do I move categories and subcategorie
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orts and graphs by letting you specify 
ly. Classes do not replace categories; they 
 have categories. Unlike subcategories, 
tegory, classes can be used with any 
e reports and graphs based on categories, 

ers in your household, you can create a 
w much each person earns and spends 

category. For example, spouses could 
nd Dining/Jim, and clothing expenses as 

t for business and personal expenses, you 
e class Business to distinguish them from 
For example, you could classify business 

ent/Business and Subscriptions/

ify transactions by property name or 
ld be categorized as utility expenses and 
erties by entering Utilities:Water/ElmSt, 

n identify transactions by client name. 
come and expenses related to each client. 
Chapter 5, Categories an

About classes

Classes add an additional dimension to rep
where, to what, or to whom transactions app
add information to transactions that already
which can only be used with their parent ca
category. Quicken has the flexibility to creat
classes, or both.

You can use classes in situations like these:

• If you share a Quicken data file with oth
class for each person so you can track ho
without creating subcategories for each 
classify dining expenses as Dining/Sue a
Clothing/Sue and Clothing/Jim.

• If you use your personal checking accoun
can identify business transactions with th
personal expenses in the same category. 
expenses as Dining/Business, Entertainm
Business.

• If you manage properties, you can ident
address. For example, six water bills cou
classified as applying to six different prop
Utilities:Water/OakSt, and so on.

• If you work with multiple clients, you ca
Then you can report separately on the in



d classes track income and expenses    83

earned as Income/Smith, Income/Jones, 

s and the kind of information they can 

Examples of class names

SellCo, Mena, Bartel, Lew & Co.
Bob, Karen, Glenn, Kate, Eric
Chris, Terry

Midwest, West, East, North, South
Harlow St, Ward Way, Rusko Ave

Crandall, Miller, Barturen-Ramirez
Truck, phone, fax, copier
Business
Chapter 5, Categories an

For example, you might classify income 
and Income/Lee.

The following table gives examples of classe
help you track:

Use classes to specify Reason for using classes

Whom the transaction is for:

•Your clients
•Your salespeople
•You or your spouse

Track income and expense by client
Track commissions
Track income and expense by individual

Where the transaction 
applies:

•Sales regions
•Property names

Track performance by division
Track income and expense by property

What the transaction is for:

•Job or project names 
•Equipment or vehicle
•Business use

Perform job costing
Track expense by item
Separate business income and expense 
from personal income and expense
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sses

rent ways, Quicken does not provide a 
e Classes from the Lists menu and click 
r any transactions, or you can set them up 
ons. Quicken will offer to let you set up a 
 doesn’t recognize. For information about 
ning a class to a transaction” on page 100.

ses in Quicken Help Topics and select
Chapter 5, Categories an

Setting up classes and subcla

Because people use classes in so many diffe
preset list of classes. To create a class, choos
New. You can set up classes before you ente
“on the fly” while you are entering transacti
new class whenever you enter a class name it
assigning classes to transactions, see “Assig

For step-by-step help, go to Categories & Clas

How do I set up classes and subclasses?
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 classes and subclasses

y selecting a class in the Class list and 
s, Quicken automatically replaces the old 
 classified with the old name.

g it in the Class list and clicking Delete. 
n removes the name from the Class list 
igned. 

 step in changing its name. Delete a class 
 again or if you want to reassign the trans-
ent classes.

change a subclass into a class, or move a 
 and drop them in the Class list. (Note that 
cannot promote the subclass back to a 

r vice versa.

ses in Quicken Help Topics and select
Chapter 5, Categories an

Editing, deleting, and moving

You can edit class or subclass information b
clicking Edit. If you rename a class or subclas
name with the new name in all transactions

You can delete a class or subclass by selectin
When you delete a class or subclass, Quicke
and from any transactions to which it is ass

Caution: Don’t delete a class or subclass as a
or subclass only if you don’t expect to use it
actions for the deleted class to several differ

You can also change a class into a subclass, 
subclass from one class to another. Just drag
when you change a class to a subclass, you 
class.)

You cannot change a class into a category, o

For step-by-step help, go to Categories & Clas

How do I edit classes and subclasses?

How do I delete classes and subclasses?

How do I move classes and subclasses?
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Chapter 5, Categories an
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xpenses

 you can enter transactions for that 
ts the balance in your account. Common 

 Quicken)

tions

or withdrawals

ens the Register window for that account. 
unt in the register—although you may 
u plan to print with Quicken in the Write 
uicken” on page 128) or the Enter Online 
g online payments” on page 202).

gh the types of transactions vary from 
s are the same whether you are using the 
r liability account.*

ve registers, but investment transactions 
ing investment transactions in the 
Chapter

Recording your day-to-day e

Every Quicken account has a register where
account. A transaction is any item that affec
transactions in a bank account include:

• checks (written by hand or printed with

• ATM (automated teller machine) transac

• deposits

• EFT (electronic funds transfer) deposits 

• bank service charges and interest

When you set up a new account, Quicken op
You can record all transactions for that acco
want to enter online payments and checks yo
Checks window (see “Writing checks with Q
Payment window (see “Creating and sendin

All Quicken accounts have registers. Althou
register to register, the basic entry technique
register for a bank, cash, credit card, asset, o

*Portfolio and mutual fund accounts also ha
require additional information. See “Enter
register” on page 311.
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Balance Today is the 
balance of all transac-
tions through today. 
If you postdate trans-
actions, Quicken also 
displays an ending 
balance that is the 
balance of all transac-
tions in the register.

omatically 

t the transaction 
ed it.

kmark in the Clr column indicates the 
 status of each transaction. See page 169.
Chapter

Enter the amount of a check or 
other payment in the Payment 
column; enter the amount of a 
deposit in the Deposit column.

The active, selected transac-
tion has a bold border around 
it.

Click Record to save the transaction and aut
update the account balance.

Click Restore if you make a mistake and wan
to revert to the way it was before you chang

Quicken shows the name of the 
account in the window title.

A chec
cleared

Click Number at the top of the 
register to sort the register by 
check number instead of by 
date. When you sort by 
number, the Balance column is 
blank, but Quicken still 
displays the balances in the 
lower right corner.
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d choose the account name.

lbar by choosing the account name from 
e in the Banking, Investing, or Assets/

ransaction, choose New Transaction from 

tion in each field.

In the Payment or Deposit 
column, enter the amount 
of the payment or deposit. 

escription 
ee name or 
 for the 

You cannot enter a value in 
the Balance column. 
Quicken calculates a new 
balance for you when you 
record the transaction.

 Memo 
dditional 

ut this 
Chapter

Entering a transaction in the register

1 Choose Registers from the Lists menu an

You can also open a register from the too
the Registers pop-up menu when you ar
Debt areas.

2 If the selected transaction is not a blank t
the Edit menu (x-N).

3 Enter information about the new transac

In the Number column, 
you can enter a number for 
a handwritten check or use 
the pop-up menu to select 
the type of transaction. 
Press + to enter the next 
check number quickly. In the Category field, enter 

a category to help you track 
income and expenses. See 
“What do I put in the 
Category field?” on 
page 97.

In the Payee or D
field, enter a pay
other description
transaction.

(Optional) In the
field, enter any a
information abo
transaction.

Type a date, or use the pop-
up calendar to select a date.
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he next field. If you prefer to press Return 
, see “Customizing the register” on 

saction, click Record. Quicken saves each 
record it.

 sorts it in the register and recalculates all 
ctions by date or by check number.

r

en Financial Calendar™ for today or for 
te transactions or move transactions from 
e, or delete transactions in the Calendar 

transaction for today or for a day in the 
lected day in the Calendar and automat-
s well.

utton in the toolbar.
Chapter

Press Tab to move the insertion point to t
instead of Tab to move from field to field
page 118. 

4 When you have finished entering the tran
new transaction in your data file as you 

When you record a transaction, Quicken
subsequent balances. You can sort transa

Entering a transaction in the Calenda

You can also schedule transac-
tions—including recurring trans-
actions such as bill payments and 
your paycheck deposit—in the 
Calendar or the register for dates 
in the future (see “Scheduling bill 
payments” on page 122. 

You can enter new transactions in the Quick
any date in the past. You can also edit or dele
one day to another. You can enter, edit, mov
for any non-investment account.

When you use the Calendar to enter a new 
past, Quicken adds that transaction to the se
ically records it in the appropriate register a

1 In the Banking area, click the Calendar b
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ns to move forward 
th at a time.

Click Add Note to 
add a note for the 
selected day. After 
you’ve added a 
note, double-click 
the note square to 
read or edit the 
note.

unts you want to 
ow transactions 

ounts.

Choose any year 
listed in the year 
pop-up menu (or 
choose Other and 
enter any year 
between 1928 and 
2027) to go to that 
year.
Chapter

Choose a month from the 
month pop-up menu to go 
to that month in the 
currently 
selected 
year.

Past transactions are shown 
on the day they were 
recorded. Scheduled future 
transactions are shown in blue 
text on the day they are sched-
uled to happen.

Click the arrow butto
or backward one mon

If there are more transactions for 
a day than will fit, the date is 
followed by an ellipsis (...). Double-
click the day to see all its transactions 
in a separate Transactions window.

The selected day has a bold 
box around it.

Click Selected Accounts to select the acco
see. The Calendar is initially set up to sh
from all accounts except investment acc

You can use the arrow keys 
to move from day to day, 
and the PgUp and PgDn 
keys to move from month 
to month.

Today’s date has a dark 
box around it. On a 
color monitor, it is also 
shaded light blue.
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 you want to record the transaction. 

t corner of the Calendar window.

nformation about the transaction in each 

nter in each field, see “Entering a transac-

 the Calendar and in the register.

corded for today) transaction in the 

m the QuickFill Transactions list (see 
113).

Quicken shows you the Balance 
Today (and an ending balance if 
there are any postdated transac-
tions in the register) for the 
selected account.

Click the Check button to enter 
a check to print with Quicken 
or an electronic payment.
Chapter

2 Select the day (past or present) on which

3 Click New Transaction in the lower righ

4 In the Enter Transaction window, enter i
field, just as you would in a register.

If you need information about what to e
tion in the register” on page 90.

5 Click Record to record the transaction in

You can also enter a new past or present (re
Calendar by:

• Dragging and dropping a transaction fro
“Entering data with QuickFill” on page 

Make sure the correct account is 
shown in the Account field. 
When you record the transac-
tion, it is entered both in the 
Calendar and in the register for 
the selected account.

For information about the sched-
uling section of the window, see 
“Scheduling a future transaction 
in the Calendar” on page 122.
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ansactions window. Hold down the 
transaction to today or to a day in the past 
ay).

inder note to a day in the Calendar. 

en Help Topics and select

ar?
Chapter

• Copying a transaction from any open Tr
Option key while you drag and drop the 
(or to the Transactions window for that d

You can also print the Calendar or add a rem

For step-by-step help, go to Calendar in Quick

How do I print the Calendar?

How do I add a reminder note to the Calend
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nd edit any field by selecting the incorrect 
ngle mistake you make while entering or 
from the Edit menu (x-Z). To restore a 
de any changes to it, click the Restore 
 cannot edit is the balance in the Balance 
ring reconciliation, see “Letting Quicken 

ne with a bold checkmark in the √ (Clr) 
oncile your Quicken records with your 
re about to change a reconciled transac-

r, even if you originally entered it in the 
ng account, you can easily move it to the 
 to change the account.

account using the Shortcuts button in the 
ove, click the Shortcuts button and 

en Help Topics and select
Chapter

Correcting mistakes

To make a change to a transaction, select it a
information and typing over it. To undo a si
editing information in a field, choose Undo 
transaction to the way it was before you ma
button. The only item in the transaction you
column. If you need to change the balance du
adjust for differences” on page 175.

Note: Changing a reconciled transaction—o
column—can cause problems when you rec
bank statement. Quicken warns you if you a
tion.

You can edit any transaction in the Calenda
register. If you enter a transaction in the wro
correct account by editing it in the Calendar

You can also move a transaction to another 
register. Select the transaction you want to m

For step-by-step help, go to Calendar in Quick

How do I edit a transaction?

How do I move a transaction?



 6, Keeping your accounts up to date    96

-up menu. Then enter the “to” account 

nd choosing Delete Transaction from the 
r to void a transaction instead of deleting 
ck as void, you can keep an accurate 
nsaction, select it and choose Void Trans-

en Help Topics and select

en Help Topics and select
Chapter

choose Move this Transaction from the pop
name in the Move Transaction window.

You can delete a transaction by selecting it a
Edit menu (x-D). Sometimes you may prefe
it. By marking a printed or handwritten che
record of each numbered check. To void a tra
action from the Edit menu.

For step-by-step help, go to Registers in Quick

How do I edit a transaction?

How do I move a transaction?

For step-by-step help, go to Registers in Quick

How do I delete or void a transaction?
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 field?

gory field of a transaction:

el your transactions so you can track 
re it goes. See “Assigning a category to a 

sactions even more specifically than with 
nefit from using classes; others find that 
finances. See “Assigning a class to a trans-

 Quicken account to another. See “Trans-
ge 103.

tegory, class, or transfer to a single trans-
age 107.

ach transaction because Quicken uses the 
ports, graphs, and budgets based on your 
ategory to a transaction, Quicken uses the 
unts in reports and graphs. You can set a 
u forget to enter a category; see “Custom-
Chapter

What do I put in the Category

You can enter any of these items in the Cate

• Categories and subcategories let you lab
where your money comes from and whe
transaction” next.

• Classes and subclasses let you define tran
categories alone. Some Quicken users be
categories are all they need to track their 
action” on page 100.

• Transfers let you move money from one
ferring money between accounts” on pa

Tip: If you want to assign more than one ca
action, you can “split” the transaction. See p

Assigning a category to a transaction

See “About categories” on page 72 
for more information about 
creating and using categories.

You should assign at least one category to e
category information you assign to create re
income and expenses. If you don’t assign a c
label “Other” to refer to uncategorized amo
preference telling Quicken to warn you if yo
izing the register” on page 118.
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y:

y field

nu in the Category field

ansfer list 

tion you want to categorize.

nning of more than one category name, 
gins with the letters you typed. Keep 

category name.

u want, either press Tab to accept that 
bcategory.

he text that’s currently in the Category 
ed when you type it.

me.

e correct subcategory.

 pop-up 
Chapter

You can assign a category to a transaction b

• typing the category name in the Categor

• choosing a category from the pop-up me

• selecting a category in the Category & Tr

Typing a category name in the register

1 Click in the Category field of the transac

2 Start typing the category name.

If the first few characters match the begi
QuickFill enters the first category that be
typing until QuickFill enters the correct 

3 When Quicken displays the category yo
category, or type a colon ( : ) to enter a su

The colon always appears at the end of t
field, no matter where the cursor is locat

4 (Optional) Start typing a subcategory na

Continue typing until QuickFill fills in th

You can also choose a category from the
menu in the Category field.
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e that isn’t already in the Category & 
t up a new category or select an existing 

ransfer list

ant to categorize.

 Lists menu (x-L).

to paste it in the Category field.

u want and click Use or press Return. Or 
e Category & Transfer list and drop it in 

on as you see the 
he letter “w” after 
 “Water.”

lick Set Up to create a new category.

lick Select to select an existing category 
rom the list.
Chapter

If you enter a category (or subcategory) nam
Transfer list, Quicken asks if you want to se
category.

Choosing a category from the Category & T

1 Click anywhere in the transaction you w

2 Choose Categories & Transfers from the

3 Double-click a category name in the list 

You can also select the category name yo
you can drag the category name from th
the selected transaction in the register.

Type the letter “u” to enter the 
category name “Utilities.”

To enter a subcategory, type a colon as so
category you want. In this case, typing t
the colon displays the subcategory name

Click Cancel if you made a 
typing error and want to return 
to the register to enter the 
correct category.

C

C
f
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y add more information to transactions 
sses” on page 82 to determine whether 

ld

tion you want to classify.

y name, or after an account name if you 

m the category (or account). It always 
tly in the Category field, no matter where 

ning of more than one class name, Quick-
 the letters you typed. Keep typing until 
Chapter 6

Assigning a class to a transaction

Classes do not replace categories; rather, the
that already have categories. See “About cla
classes are appropriate for your situation.

You can assign a class to a transaction by:

• typing the class name in the Category fie

• selecting a class in the Class list

Typing a class name in the register

1 Click in the Category field of the transac

You can add a class name after a categor
want to classify a transfer transaction.

2 Type a forward slash ( / ).

The forward slash separates the class fro
appears at the end of the text that’s curren
the cursor is located when you type it.

3 Begin typing the class name.

If the first few characters match the begin
Fill enters the first class that begins with
QuickFill enters the correct class name.
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nt, either press Tab to accept that class or 

he text that’s currently in the Category 
ed when you type it.

 correct subclass. You might, for example 
 in step 3 to specify which unit needed 

n’t already in the Class list, Quicken asks 
 existing class.

t Up to create a new class.

lect to select an existing class from the list.
Chapter 6

4 When Quicken displays the class you wa
type a colon ( : ) to enter a subclass.

The colon always appears at the end of t
field, no matter where the cursor is locat

5 (Optional) Start typing a subclass name.

Continue typing until Quicken fills in the
want to add a subclass to the transaction
repairs: Repairs/Oak St:Unit1.

If you enter a class (or subclass) name that is
if you want to set up a new class or select an

As soon as you type a forward 
slash, Quicken recognizes that 
you are entering a class. In this 
example, the category is 
Repairs and the class is Oak St.

Click Cancel if you made a 
typing error and want to 
return to the register to enter 
the correct class.

Click Se

Click Se
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ant to classify.

).

he Category field.

ant and click Use or press Return. Or you 
ist and drop it in the selected transaction 
Chapter 6

Choosing a class from the Class list

1 Click anywhere in the transaction you w

2 Choose Classes from the Lists menu (x-K

3 Double-click a class name to paste it in t

You can also select the class name you w
can drag the class name from the Class l
in the register.
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 accounts

on transactions:

ount to a savings account

t to a checking account

to a liability account that tracks the 

 source account, Quicken automatically 
ion account. If the source transaction is a 
ction is a deposit or increase.

savings account to your checking account 
e a bracket ( [ ), and then enter the name 

d of the transfer transaction in your 
ords a corresponding deposit transaction 
ecking account. You don’t include an 
 field for a transfer transaction because 
ount to another.
Chapter 6

Transferring money between

Transfers can record these and other comm

• movement of funds from a checking acc

• cash advances from a credit card accoun

• loan payments from a checking account 
balance of the loan 

When you record a transfer transaction in a
creates a parallel transaction in the destinat
payment or decrease, the destination transa

For example, if you transfer $500 from your 
to cover household expenses, you would typ
of the checking account in the Category fiel
savings account. Quicken automatically rec
of $500.00 in the Deposit column of your ch
income or expense category in the Category
you have simply moved funds from one acc
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dy open, you can transfer money by 
 the Category field of the transfer transac-

er the name of the destination account in 
 typing the name of the account.

m the pop-up menu in the Category field 
list).

 want, press Tab.

action.
Chapter 6

If the register for the source account is alrea
entering the transfer information directly in
tion.

1 In the register for the source account, ent
the Category field by typing  [ , and then

OR

Choose the destination account name fro
(account names are at the bottom of the 

2 When Quicken displays the account you

3 Click Record to record the transfer trans

This is the transaction Quicken 
automatically records in “Joint 
Checking” (the destination 
account) as a result of the transfer.

This is the transfer transaction in 
“Terry Savings” (the source 
account). The square brackets 
show that it is a transfer.

If you begin typing the account 
name, QuickFill completes it. In 
this example, we typed “[jo” and 
QuickFill added “int Checking].”
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gister and creates a parallel transaction in 
ame amount.

t of the total amount of a transaction. For 
your paycheck into a retirement account. 
your mortgage payment that goes toward 
t tracks the loan balance and assign an 

he payment. See “Entering transactions 
or information about transferring part of 

fer transaction. If, for example, you pay 
t and you want to record the purchase in 
d assign the class “Antiques” to the trans-
Antiques” in the Category field.

ween accounts by choosing Transfer 

en Help Topics and select
Chapter 6

Quicken records the transaction in this re
the destination account register for the s

In some cases, you may want to transfer par
example, you may want to transfer some of 
Or you might want to transfer the portion of 
the loan principal into a liability account tha
expense category to the interest portion of t
with more than one category” on page 107 f
a transaction.

You can include class information in a trans
for an antique table from a checking accoun
an asset account called “Personal Assets” an
action, you would enter “[Personal Assets]/

You can also enter a transfer transaction bet
Money from the Activities menu.

For step-by-step help, go to Registers in Quick

How do I transfer funds between accounts?
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a transfer

 a transfer to or from another account, the 
 change.

saction, the information changes in both 
e information changes only in the account 

letes it from both accounts.

tes every occurrence of the name in all 

Entering transactions with more than one 
amount only in the original transaction in 
 the destination account (the one that 
Chapter 6

Changing a transaction that includes 

When you change a transaction that includes
transaction created by the transfer may also

• If you edit the date or amount of the tran
accounts. But if you edit anything else, th
where you make the change.

• If you delete the transaction, Quicken de

• If you rename an account, Quicken upda
transactions.

If a transfer is part of a split transaction (see “
category” next), you can change the date or 
the source account. You cannot change it in
received the transfer).
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ore than one category

r transfers to a single transaction by split-
t want to create a split transaction if you 
as clothing, office supplies, and home 

ter category names and amounts to 
 this information when you first record a 
ter.

n the Date, Number, and Payee fields, and 
 in either the Payment or Deposit column.

plit (x-E).

Quicken copies any 
information you have 
already entered in the 
Category, Payment, or 
Deposit fields of the 
transaction to the first 
split line.
Chapter 6

Entering transactions with m

You can assign multiple categories, classes, o
ting the transaction. For example, you migh
write a single check to purchase items such 
furnishings from a department store.

When you create a split transaction, you en
identify each part of the split. You can enter
transaction, or you can go back and add it la

Entering a split transaction

1 Enter information about the transaction i
enter the total amount of the transaction

2 Click the Open Split button to open the s

Click the Open Split button to 
open the split.
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ry field in the split, or choose a category 

o field and press Tab.

the first category in the first Amount field.

already selected; just type the amount for 
. 

eld.

 amounts until you have added one split 

Quicken subtracts the 
amount you typed in the 
Amount field of the first 
split line ($32.47) from the
total amount you entered 
for the transaction 
($124.57) and displays the
remainder ($92.10) in the 
next Amount field.
Chapter 6

3 Type a category name in the first Catego
from the pop-up menu and press Tab.

4 (Optional) Type a memo in the first Mem

5 Type the amount you want to allocate to 

The amount for the entire transaction is 
the first category right over that amount

6 Press Tab to move to the next Category fi

7 Continue to add categories, memos, and
line for each part of the transaction.
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ction contains one or more uncategorized 
red a category for at least one of the 
to go back to the transaction and enter the 
 the entire transaction; or click Save to 
ed.

k Clear 
t lines.

If you have an uncatego-
rized remainder on the last 
line of a split and you want 
to recalculate the transaction 
total, click Adjust Total. 
Quicken deletes the 
remainder and recalculates 
the total transaction amount 
based on the sum of all the 
split amounts you entered.
Chapter 6

8 Click Record to record the transaction.

If you see the message “This split transa
items. Save changes?” you have not ente
amounts in the transaction. Click Cancel 
missing category; click Discard to delete
leave part of the transaction uncategoriz

If you decide not to split this transaction, clic
Split to delete all the information in the spli

You can add as many lines as 
you want to a split transaction.



, Keeping your accounts up to date    110

r paycheck

tegories for salary, federal income tax, 
 the deposit correctly, Quicken can 
ver and over again without having to 

ount register (x-N).

Payee fields, and then enter the net 
it column. The net amount is your salary 

plit.

gory you use to track your salary in the 
our paycheck in the Amount field.

ur gross salary (such as amounts for a 
health care), you may want to split your 
k the pretax amount and the taxable 
e in this example.
Chapter 6

Sample split transaction: entering you

See “Scheduling bill payments” 
on page 122 for information about 
entering your paycheck automati-
cally every month. 

You can split your paycheck deposit into ca
state income tax, and so on. Once you set up
memorize the transaction so you can use it o
enter it all again.

1 Start a new transaction in your bank acc

Fill in the Date, Number (optional), and 
amount you are depositing in the Depos
minus taxes and deductions.

2 Click the Open Split button to open the s

3 In the first line of the split, enter the cate
Category field and the gross amount of y

If pretax amounts are deducted from yo
retirement plan or flexible spending for 
salary category into subcategories to trac
amount separately. That’s what was don
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ck as a negative amount.

 as federal taxes, state taxes, medical 
. You can use Quicken’s standard catego-
 create additional expense categories for 

re any deductions) in the Amount 
cking both pretax and taxable salary 
e of the amounts in the first split line 

t line. Note that since the gross salary 
nder is a negative number.
Chapter 6

4 Enter every deduction from your payche

You may have deductions for items such
insurance, disability insurance, and so on
ries for some of these items, and you can
other deductions as needed.

Enter your net pay as the total amount 
for the transaction. Your net pay is the 
amount left to deposit after all the 
deductions.

Enter the category you use to track 
gross salary. In this example, Terry has 
$196.78 in pretax deductions taken out 
of a total gross pay of $1,290.37, so the 
gross amount is divided between two 
Salary subcategories: Taxable and Pre-
Tax. If you don’t care about that level 
of detail, use the Salary category for 
the full amount.

Enter your gross pay (the amount befo
field of the first split line. If you are tra
(as in this example), you should enter on
and the other amount in the second spli
is larger than the net deposit, the remai
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 in split transactions. You may, for 
tion. This money is not an expense (since 
ferred to another Quicken account. In this 
oth a flexible spending account for 

a retirement account ( [Terry’s 401k] ). 
cause they are deductions from Terry’s 
e destination accounts.

Deductions are entered as 
negative amounts because 
they are subtracted from 
your gross salary. Quicken 
adds more split lines 
automatically.
Chapter 6

See “Transferring money between 
accounts” on page 103 for infor-
mation about entering a transfer 
transaction.

You can also assign transfers to amounts
example, want to enter a 401(k) contribu
it’s still your money); it is just being trans
example, Terry has entered transfers to b
medical expenses ( [Medical FSA] ) and 
These transfers are negative amounts be
paycheck; they show up as deposits in th

5 Click Record to record the transaction.

You can add “Self” and “Spouse” 
to the Tax categories to distin-
guish between people in a two-
income household.

To enter a transfer of money from 
this account (the account where 
you are depositing the paycheck) 
to another account (like a Quicken 
account that tracks your 401(k), 
enter the account name in square 
brackets and enter the amount as 
a negative amount.
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 quickly:

 in transaction fields for you. 

ions without opening Quicken.

lations right in your register.

 information directly from your financial 
e from Quicken, on page 180.

ions as you enter them and stores them in 
e them again and again without having to 
ose QuickFill Transactions from the Lists 

dell Grocery every week. The first time 
uicken memorizes everything except the 

 Grocery” to the QuickFill Transactions 
ll Grocery” in a Payee field, Quicken finds 
s it in the register for you. You can change 
e amount—and then record the new 

n updates the “Blaisdell Grocery” transac-
Chapter 6

Speeding up data entry

Quicken makes it easy to enter transactions

• QuickFill™ automatically finishes filling

• QuickEntry lets you enter daily transact

• QuickMath™ lets you make simple calcu

• Online account access lets you download
institution. See Chapter 9, Banking onlin

Entering data with QuickFill 

You can stop Quicken from 
automatically memorizing trans-
actions by choosing Preferences 
from the Edit menu, clicking the 
Registers icon, and clearing the 
“Add new transactions to the 
QuickFill list” checkbox.

You can also stop QuickFill from 
filling in transactions by clearing 
the “Use QuickFill to fill in trans-
actions” checkbox.

QuickFill automatically memorizes transact
the QuickFill Transactions list so you can us
type them each time. To look at the list, cho
menu (x-T). 

For example, you may write a check to Blais
you record that check in a Quicken register, Q
date and check number and adds “Blaisdell
list. The next time you begin typing “Blaisde
the transaction in the QuickFill list and enter
any information Quicken enters—such as th
transaction. If you change anything, Quicke
tion in QuickFill list.
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tion to keep it from changing. When you 
anges to it before you enter it in the 
s list retains the original locked transac-
e, if you usually withdraw $40 when you 
saction in the list so that Quickfill always 
 amount of your last ATM withdrawal.

rned off, you can still recall a transaction 
ns list and dropping it in the register or 

u want to change or delete a QuickFill 
l Transactions list and click Edit or Delete.

 QuickEntry

 to enter your daily transactions by using 
ry icon in your Quicken Deluxe folder to 
pens quickly and gives you access to all 
and nothing else—so you can enter trans-

en Help Topics and select
Chapter 6

Quicken marks each locked trans-
action in the list with a bold dot 
(•).

You can lock an individual QuickFill transac
recall a locked transaction, you can make ch
register; however, the QuickFill Transaction
tion unless you edit it manually. For exampl
go to the ATM, you can memorize that tran
enters $40 for you—even if you changed the

Even if you choose to work with QuickFill tu
by dragging it from the QuickFill Transactio
the Write Checks window. If you decide yo
transaction, you can select it in the QuickFil

Reducing transaction entry time with

You can significantly reduce the time it takes
QuickEntry. Just double-click the QuickEnt
open this “mini-application.” QuickEntry o
your bank, cash, and credit card registers—
actions quickly and easily.

For step-by-step help, go to Registers in Quick

How do I recall a QuickFill transaction?

How do I memorize a transaction?

How do I change a memorized transaction?

How do I delete a memorized transaction?
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gisters in Quicken. You enter transactions 
 of QuickFill, QuickMath, and the pop-up 
 stored in your Quicken data file, and is 
e you open Quicken.

QuickEntry displays the 
Ending Balance for the 
account. It includes all 
transactions you have 
entered in Quicken or 
QuickEntry, including any 
postdated transactions. 
Chapter 6

The registers in QuickEntry work like the re
the way you always have, taking advantage
lists from Quicken. Your QuickEntry data is
added to your Quicken registers the next tim

Choose any bank, cash, or 
credit card account in your 
Quicken data file from the 
Account pop-up menu.



, Keeping your accounts up to date    116

 QuickMath

lculations to determine the correct dollar 
le, you may want to total the amount due 
m your savings account to your checking 
e calculations for you right in the amount 
r =) to pop up a “paper tape” where you 

f you were using an adding machine.

 in Preferences to add, subtract, multiply, 
troke. For example, the percent key ( % ) 
so you can easily calculate percentages. 

en Help Topics and select
Chapter 6

Calculating transaction amounts with

Sometimes you may want to make simple ca
amount to enter in a transaction. For examp
on several bills before you transfer money fro
account to pay them. QuickMath can do thes
field. Just press any operator key (+, –, *, /, o
can see numbers as you enter them, just as i

You can also assign special QuickMath keys
or divide dollar amounts with a single keys
is preassigned to multiply amounts by 0.01 

The tape shows your calcu-
lations as you type them.

For step-by-step help, go to Registers in Quick

How do I calculate transaction amounts?

How do I assign QuickMath keys?
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ions in the register or the Write Checks 
nd a specific check number or a specific 
e Edit menu to open the Find window.

 changes to text in your transactions. For 
ou could search for all occurrences of the 
 correct name. Choose Find/Replace. 
lace window.

en Help Topics and select
Chapter 6

Finding a specific transaction

The Find command locates specific transact
window. For example, you might want to fi
payee. Choose Find/Replace . Find from th

You can use the Replace command to make
example, if you misspelled a payee name, y
misspelled name and replace them with the
Replace from the Edit menu to open the Rep

For step-by-step help, go to Registers in Quick

How do I find a transaction in a register?



, Keeping your accounts up to date    118

’s registers by choosing Preferences from 
nd selecting or clearing the checkboxes. 
t decimal points, use the Return key 
s, or ask Quicken to warn you when you 

s you make to the preferences are in effect 
reas in Quicken.

en Help Topics and select
Chapter 6

Customizing the register

You can change settings that affect Quicken
the Edit menu, clicking the Registers icon, a
For example, you can enter amounts withou
instead of the Tab key to move between field
enter a duplicate check number. Any change
for all your registers and other data-entry a

For step-by-step help, go to Registers in Quick

How do I customize the register?
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ek, a month, a year, or longer, and then 
eriod of time.

en Help Topics and select
Chapter 6

Printing the register

You can specify a time period of a day, a we
print a record of your transactions for that p

For step-by-step help, go to Registers in Quick

How do I print the register?
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Chapter 6
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n can save you time and help you 
e. Many bills, such as rent and insurance 
 always for the same amount. Other bills 
om month to month. Even regular bills 
can schedule all your bills in Quicken’s 
es. You can also schedule income and 
osits or monthly transfers from checking 

ither reminds you about it or records it in 
hen you can make the payment electron-

a check by hand.

including bill payments—in the 
 overview of your financial past, present, 
ur income is expected to come from in the 
 can also use the Calendar instead of the 
l if you’re working with more than one 
n in the Calendar” on page 91.

 Calendar

utton in the toolbar.

r, see page 92.
Scheduling bill payments 

Scheduling your bill payments with Quicke
remember to pay your bills when they’re du
payments, occur at regular intervals and are
occur less regularly, or the amount varies fr
don’t come all at once—they trickle in. You 
Financial Calendar, even if the amount vari
transfer transactions, such as paycheck dep
to savings.

After you schedule a transaction, Quicken e
your register automatically when it is due. T
ically, print a check with Quicken, or write 

When you schedule financial transactions—
Calendar, you get a visual month-by-month
and future.You can see at a glance where yo
future and how you expect to spend it. You
register to enter transactions, which is usefu
account at a time. See “Entering a transactio

Scheduling a future transaction in the

1 In the Banking area, click the Calendar b

For more information about the Calenda
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you want to schedule a transaction.

 lower right corner of the window (x-N).

ction window that looks very much like a 
nters the date you selected in the Date 

in the Schedule Future Transaction 

ster view or Write Checks view.

er...pmts” is selected for Duration and 7 
d for the number of payments, because 
 7 payments left on this loan.

Use these buttons to switch 
between the Register view 
and the Write Checks view.
2 Select the day in the Calendar on which 

3 Click the New Transaction button in the

Quicken opens a Schedule Future Transa
blank transaction in a register. Quicken e
field and highlights the Account field.

4 Enter information about the transaction 
window.

You can enter information either in Regi

Choose the name of the Quicken 
account from which you will 
make this payment.

“Stop aft
is entere
there are

Choose how 
frequently you make 
the payment.

If you want Quicken to remind 
you about a scheduled transaction 
so you can write a check to make 
the payment, choose “Remind me 
about” and enter the number of 
days in advance you want your 
reminder. Choose “Automatically 
enter” if you don’t need to 
confirm the transaction, and 
Quicken will automatically enter 
it in the register when it is due. 
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ns, such as a paycheck deposit (see 
aycheck).

 the transaction to the Calendar for every 

the register

rom the register using the Shortcuts pop-
hoose Schedule this Transaction from the 
edule Future Transaction window as 

action?

heduled transactions that are due or past 
e become due since the last time you used 

If your paycheck varies by a 
few cents from one time to the 
next, you might want to tell 
Quicken that you want to see 
and confirm the transaction 
each time before it is recorded 
in the register.

 your paycheck 
nitely).
You can also schedule income transactio
page 110 for instructions for entering a p

5 When you’re finished, click Record to add
day on which it is scheduled to happen.

Scheduling a future transaction from 

You can also enter a scheduled transaction f
up menu. Select an existing transaction and c
Shortcuts pop-up menu. Then fill in the Sch
shown in step 4 above.

What happens after I schedule a trans

Each time you start Quicken, it checks for sc
due (that is, scheduled transactions that hav

Choose the name of the Quicken 
account where the deposit will 
be recorded.

Choose how frequently you get 
a paycheck.

Enter the date of your next 
paycheck.

Tell Quicken how many times you want
transaction recorded (in this case, indefi
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 that is due or past due, one of two things 

 you set up the scheduled transaction: 
ransaction window containing the trans-

, and click Record to record it in the 
 recorded (or postdated) in the Calendar. 
n’t want enter this transaction right now, 

time you start Quicken. Or you can click 
is specific occurrence of the scheduled 
cording it, but want to leave it scheduled 

n you set up the scheduled transaction: 
gister and changes it from scheduled to 

without asking you for confirmation.

 the register, you can make the payment 

t electronically. See “Making online 

ee “Writing checks with Quicken” on 
 page 133.
Quicken). If it finds a scheduled transaction
will happen:

• If you selected Remind Me About when
Quicken displays a Confirm Scheduled T
action.

You can edit the transaction, if necessary
register and change it from scheduled to
You can also click Remind Later if you do
but want to be reminded again the next 
Skip Transaction if you want to delete th
transaction from the Calendar without re
as is for future entry dates.

• If you selected Automatically Enter whe
Quicken records the transaction in the re
recorded (or postdated) in the Calendar—

After your transaction has been recorded in
in any of the following ways:

• Send an instruction to make the paymen
payments” on page 201.

• Write and print a check with Quicken. S
page 128 and “Printing Intuit checks” on

• Write a check by hand.
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early, double-click the day on which it 
, and click Pay Now. 

ctions

in the Calendar. Double-click a day in the 
 for that day. Then:

 Delete (x-D). 

dit (x-E). 

ange its date, or drag it from the Transac-
y in the Calendar.

r postdated transaction in the Calendar, 
er.

en Help Topics and select

en Help Topics and select
If you want to pay a scheduled transaction 
appears, select it in the Transactions window

Editing and deleting scheduled transa

You can edit, delete, and move transactions 
Calendar to open the Transactions window

• To delete a transaction, select it and click

• To edit a transaction, select it and click E

• To move a transaction, either edit it to ch
tion window and drop it into another da

When you edit or delete a a past, present, o
your changes are also recorded in the regist

For step-by-step help, go to Calendar in Quick

How do I pay a future transaction early?

For step-by-step help, go to Calendar in Quick

How do I edit a transaction?

How do I delete a transaction?

How do I move a transaction?
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nd the same time

ransactions that you record in an account 
ay have a rent payment, a phone bill, and 
onth. Instead of setting up each payment 
n group them into a single entity, a trans-

ually or set up for automatic entry.

ills

to print, electronic payments to transmit, 
hen you turn on your computer or when 

bout scheduled transactions that are due, 
n reminders for scheduled transactions.

en Help Topics and select

ly?

en Help Topics and select
Grouping transactions that occur arou

We recommend that you use 
scheduled transactions instead of 
transaction groups for scheduling 
individual future transactions, 
because the Calendar handles 
scheduled transactions more 
effectively.

Transaction groups are groups of recurring t
register at the same time. For example, you m
a utility bill all due at the beginning of each m
separately as a scheduled transaction, you ca
action group, that you can either enter man

Billminder reminds you to pay your b

Billminder™ can remind you about checks 
or transaction groups that are due—either w
you start Quicken. It does not remind you a
however, since the Calendar provides its ow

For step-by-step help, go to Calendar in Quick

How do I set up a transaction group?

How do I enter a transaction group manual

How do I edit a transaction group?

How do I delete a transaction group?

For step-by-step help, go to Calendar in Quick

How do I set up Billminder?
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ecks, you save time and avoid clerical 
k of hand-writing checks and then 

dards of the American Banking Associa-
ings and loan institutions, credit unions, 
a. When you order personalized Intuit 
count number, bank name, check 
y financial institutions on your checks. 

uarantee that:

nk.

osh-compatible printer.

 as you submitted it.

se call right away. We will quickly replace 
er you prefer.
Writing checks with Quicken

By using Quicken to write and print your ch
errors because you avoid the duplicate wor
recording them in Quicken. 

Intuit checks

Intuit checks are printed to the exacting stan
tion and are pre-approved by all banks, sav
and brokers in the United States and Canad
checks, Intuit prints your name, address, ac
numbers, and all the information required b

All Intuit checks are triple guaranteed. We g

• Your checks will be accepted by your ba

• Your checks will work with your Macint

• Your check order will be printed exactly

If we fail to meet these three conditions, plea
your order or refund your money, whichev
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tion of the available check styles and 
indow envelopes. Both your address and 

, eliminating the need to address 

 Quicken package for your convenience. 
menu in order to have Quicken print the 
call Quicken Checks Customer Service at 
y and Intuit checks will be in your hands 

the paper checks you already have or fill 
u use Quicken, enter the transactions in 

 a starting number considerably higher 
r example, if your personal check 

ntuit checks at 3001. That way, you avoid 
rs.

k numbers in one account. The bank has 
on your checks. Check numbers are for 
Ordering checks

Canadian users:
Canadian cheques and other 
supplies are also available from 
Intuit. Call Quicken Checks 
Customer Service at the phone 
number on page 509.

The Intuit Check Catalog provides a descrip
colors. All Intuit checks fit in Intuit double-w
the payee’s address appear in the windows
envelopes. 

We’ve enclosed ordering information in the
Choose Order Supplies from the Apple (K) 
ordering information for you. You can also 
the phone number on page 509. Order toda
in less than three weeks. 

How do I write checks away from home?

For checks you write away from home, use 
in an Intuit check by hand. The next time yo
your check register.

When you order your Intuit checks, indicate
than your existing paper check numbers. Fo
numbers are in the 1000 range, begin your I
confusion or possible duplication of numbe

Quicken can easily manage two sets of chec
no concerns about which numbers you use 
your own records.
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 that can be printed free on Intuit checks. 
u want a custom logo, enclose black-and-
er. There is a one-time $35 setup fee for 
arrangement is required, additional 

k account. 

om which you want to write checks.

-J).

ds on the check.
How can I get a logo printed on my checks?

You can also add a logo or other 
art to your checks when you send 
them through your printer. See 
“Adding art to checks” on 
page 155.

Intuit has a large selection of standard logos
Just order by number from the catalog. If yo
white, camera-ready artwork with your ord
custom logos. If touch up, typesetting, or re
charges may be incurred. 

Filling out a check

You can write checks from any Quicken ban

1 In the Banking area, open the account fr

2 Click the Checks button in the toolbar (x

3 Enter information in the appropriate fiel
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s you would in a register. If you use Intuit 
 nine lines of split information on the 

k, click Record to save it in both the Write 

Balance Today is the balance 
of the transactions in the 
account through today; the 
ending balance is the balance 
for all transactions, including 
postdated transactions.

tion 
ck 
ter 

The date appears on the check 
when you print it. To change 
it, just type a new one.

n you enter the dollar 
unt in the $ field, Quicken 
matically spells out the 
unt on the next line.
4 Enter a category in the Category field.

Enter categories, splits, or transfers just a
voucher checks, Quicken can print up to
perforated voucher attachment.

5 When you have finished writing the chec
Checks window and the register.

Enter the payee name. When 
you view this check in the 
register, the payee information 
appears in the Payee field.

If you plan to mail the check in 
an Intuit window envelope, 
enter the payee name and 
mailing address. You can use up 
to five lines; press Return to start 
a new line. Press the quote key 
( ’ ) to copy the payee name to 
the first line.

Enter category, class, or transfer informa
in the Category field. You can split a che
just as you split a transaction in the regis
(see page 107).

Whe
amo
auto
amo

You can enter a memo that prints 
on the check and appears in the 
Memo field in the register. If you 
don’t want your memo to be 
visible when you mail the check in 
a window envelope, you can 
change Quicken’s Register prefer-
ences to add a Note field where 
you can enter it instead.
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cks, you can review them before printing 
ow or by reviewing them in the register.

check numbers. Intuit checks are prenum-
ered checks for stop payment purposes. 
the register when it prints the check. Until 
 the Number column of each printable 
After you’ve written and recorded your che
by scrolling through the Write Checks wind

The Write Checks window does not display 
bered because most banks require prenumb
Quicken inserts the correct check number in 
the checks print, Quicken displays PRINT in
transaction in the register.
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 page-oriented printers (including laser 
rs and StyleWriters) and continuous-feed 

u, select the printer you plan to use, and 

nd then click the Print Checks icon in the 

ettings in the Preferences window.
Printing Intuit checks 

You can print checks with Quicken on both
and inkjet printers such as Apple LaserWrite
printers. 

Setting up your printer

1 Choose Chooser from the Apple (K) men
then close the window.

2 Choose Preferences from the Edit menu a
scrolling panel on the left.

3 Make your changes to the Print Checks s
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lected bank account.

 

 

Choose your check style from this 
pop-up menu. For information about 
Intuit checks, see “Intuit checks” on 
page 128.

You can add a company logo or other 
art to your checks. See “Adding art to 
checks” on page 155.

Click Positioning to adjust the position 
of text on your check. See “Positioning 
checks in page-oriented printers” next, 
or “Positioning checks in continuous-
feed printers” on page 136.
4 Click OK to save these settings for the se

Choose a font name and size from the 
Font and Size pop-up menus for the text
that prints on your checks. The Sample 
box shows an example of the currently 
selected font and size.

If you are printing checks with a 
page-oriented printer, make 
sure the Sheet Feeder checkbox 
is selected. If you are using a 
continuous-feed printer, make 
sure the checkbox is cleared.

Choose one of these icons if you 
want to print a partial page of 
checks on a page-oriented printer.

Select this checkbox if you want Quicken
to change the dates on the checks to the 
date when you print the checks.

Print Checks settings are specific 
to a single Quicken bank account. 
Choose the account you want to 
set up from this pop-up menu.

Select this checkbox if you want 
to print category information 
from split transactions on the 
perforated attachment to 
voucher checks.

These are the default preferences 
for page-oriented printers.
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rinters

wing table describes how to position a full 
 printers, full pages of checks should be 
ointing toward the printer. If your printer 
ould insert checks in the paper tray or 
sert standard letterhead paper.

Check position

Load checks face up

640, or Load checks face down*

Load checks face up

Load checks face down*

riter 1200, Load checks face up

ser Printer II Load checks face up

Load checks face up*

Load checks face down*

Load checks face up
Load checks face down*
Positioning checks in page-oriented p

If you are planning to start 
printing with less than a full page 
of three standard or wallet checks, 
see “Printing a partial first page of 
checks with page-oriented 
printers” on page 141.

If you have a page-oriented printer, the follo
page of checks in your printer. For all listed
inserted with the top of the page of checks p
isn’t listed here, you can assume that you sh
envelope feeder the same way you would in

Printer type

Apple Color LaserWriter 12/600

Apple LaserWriter 16/600, LaserWriter 12/
LaserWriter Select 360

Apple Personal LaserWriter 320 

Apple Personal LaserWriter 4/600

Apple StyleWriter, StyleWriter II, or StyleW
Color StyleWriter 1500, 2400, or 2500

GCC Personal Laser Printer or Personal La

Epson 740i

HP DeskWriter series 5 or series 6

HP LaserJet II or III
HP LaserJet IV or V
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 printers

 the checks as you would any continuous-
ontally in the position you normally use 

obably won’t need to change the position 
tically according to your printer type.

e the order of the sheets so the first sheet 
 printed check numbers match the 

n the checks

r position number five on the check with 
pe head. Snap the roller into place against 
ld them firmly in place. Then, if the 
t too high:
ences from the Edit menu and then click 

cks icon in the scrolling panel on the left.
ing and enter –30 in the Fine Tuning field.

f the first check with the top of the plastic 
f the print head.

f the first check with the top of the print 
Positioning checks in continuous-feed

If you have a continuous-feed printer, insert
feed printer paper. Position the checks horiz
for printing on 8.5-by-11-inch paper. You pr
of the paper clamps. Position the checks ver

* When you load checks face down, revers
of checks is on top. This ensures that the
numbers in the register.

Printer type How to positio

ImageWriter I Align the line fo
the top of the ty
the checks to ho
checks still prin
• Choose Prefer

the Print Che
• Click Position

ImageWriter II Align the top o
guard in front o

ImageWriter LQ Align the top o
head.
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your printer, do it now.

 online.

want to print checks.

 (x-P).*

indow.

y checks to print, you need to enter your 
age 130). If you have already entered the 

umber column to show Quicken which 
Printing checks from your account

1 If you haven’t already put the checks in 

2 Make sure your printer is turned on and

3 Open the bank account from which you 

4 Choose Print Checks from the File menu

5 Check the settings in the Print Checks w

*If you see a message that you don’t have an
checks in the Write Checks window (see p
checks in the register, enter PRINT in the N
checks you want to print.
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 check you want to print and then click 

t a full 
tarting 
, see 
th page-
6 If you chose Selected Checks, mark each
OK.

This number should be the 
same as the number on the first 
check in the printer. If it is not, 
change it.

Click Checks Dated Through 
to print all checks dated on or 
before the date shown. Change 
the date to print checks in a 
different date range.

Click Selected Checks to print 
only selected checks.

Select the icon for three checks if you pu
page of checks in the printer. If you are s
with a partial page of one or two checks
“Printing a partial first page of checks wi
oriented printers” on page 141.

Click a transaction in the list to 
mark it as a check you want to 
print. Quicken puts a check-
mark in the Print column for 
each check you select. If you 
accidentally mark a check you 
don’t want to print, click it 
again to remove the check-
mark.
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to open the printer dialog box for your 

art printing your checks.

re printing, stop the printing process by 
key together. If your printer continues to 

icken needs to know if they all printed 

ly, click No.

es.

the register still have PRINT in the 
icken enters the check numbers.
7 Click Print in the Print Checks window 
printer.

8 Click Print in the printer dialog box to st

Stopping a print job

If you notice a problem while your checks a
pressing the Command key (x) and period 
print, turn its power switch off.

Examining printed checks

After the checks have finished printing, Qu
correctly.

• If any of the checks did not print correct

• If all the checks printed correctly, click Y

Until you click Yes, unprinted checks in 
Number column. After you click Yes, Qu
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efore the printer finishes printing your 
ine the checks before you click Yes or No.

ber column of the printed checks in the 

ly, click No.
r of the first unprinted or incorrectly 
e first check that printed incorrectly (or 

cks jammed or the printer ran out of 

 correctly, try adjusting the check printing 
ent for page-oriented printers” on 
ent for continuous-feed printers” on 

e problem.

 “Printing checks from your account” on 
Sometimes Quicken displays this message b
checks. Wait a few moments so you can exam

1 Examine the printed checks.

2 If the checks printed correctly, click Yes.

Quicken puts check numbers in the Num
register. You are finished printing.

3 If any of the checks did not print correct
• Quicken asks you to type the numbe

printed check. Type the number of th
did not print) and click OK.

• Examine your printer to see if the che
checks.

• If the text on the checks is not aligned
settings. See “Adjusting check alignm
page 144, or “Adjusting check alignm
page 150.

4 Start printing again after you’ve fixed th

Go back and follow steps 4 through 8 in
page 137 to print the remaining checks.
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with page-oriented printers

 page-oriented printer, you’ll sometimes 
checks remains after you’ve finished 
ial page the next time you begin to print 

on’t load your checks yet.

and click the Print Checks icon in the 

re printing checks is selected in the 
f the alignment icons to show Quicken 
ter.

 and insert your partial page of checks in 

ter has
 or face down

he top of the check into the printer first
Printing a partial first page of checks 

If you use standard or wallet checks in your
find that a partial page of one or two blank 
printing. You can start printing on that part
checks.

Before you start, turn on your printer, but d

1 Choose Preferences from the Edit menu 
scrolling panel on the left.

2 Make sure the account from which you a
Account pop-up menu; then select one o
how you insert envelopes into your prin

If your printer won’t print checks 
properly from the envelope feeder 
(or doesn’t have an envelope 
feeder), try positioning the checks 
in the paper tray with the top of 
the check touching the rollers. You 
might need to order forms leaders 
from Quicken Checks Customer 
Service at the phone number on 
page 509.

Before you choose your page orientation
the printer you need to know:
• the type of envelope feeder your prin
• if you should insert the check face up
• if you should insert the left edge or t
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w.

 (x-P).

 Number field is the same as the number 
 checks.

 print on this partial page.

Centered in the envelope feeder or 
paper tray, with the top edge of the 
check feeding into the printer.

or on the wrong side, 
 the envelope feeder.

ned against the right 
 the envelope feeder.
3 Click OK to close the Preferences windo

4 Choose Print Checks from the File menu

5 Be sure the number in the Starting Check
of the first check on your partial page of

6 Select the one or two checks you want to

7 Select a Checks on First Page icon.

Centered in the 
envelope feeder.

The direction of the 
arrows is toward the 
printer.

You feed partial pages of checks 
into your printer the same way 
you feed envelopes. See your 
printer manual to find out what 
the printer manufacturer recom-
mends for loading envelopes in 
the envelope feeder or cassette.

Note: If your checks print upside down 
reverse the way you load the checks into

Positioned against 
the left side of the 
envelope feeder.

Positio
side of
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elope feeder or cassette as pictured in the 

erhead face down (as the Apple Personal 
 way. Look in your printer manual if you 

ou can continue printing on a full page of 
rinting checks from your account” on 
8 Load the one or two checks into your env
partial-sheet icon you selected.

If your printer requires that you load lett
LaserWriter does), load your checks that
aren’t sure.

9 Click Print to start printing the checks.

After the partial page of checks is printed, y
checks by following steps 4 through 8 in “P
page 137.

Choose the icon for the number 
of checks you’re printing.

Note: Depending on the printer 
you use, the orientation of the 
check icons on the buttons may 
be horizontal instead of vertical.
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riented printers

g special to print checks with the text 
page-oriented printer, however, you may 
o adjust the alignment of text on your 
nstructions for printing checks in this 
ctly on the printed checks.

e location of text on your check if certain 
ce you get your checks to print correctly, 
ou won’t have to change them again to 
 future.

in individual fields on Intuit checks, but 
 to match those on non-Intuit checks.

hich field and line positions need 

nd then click the Print Checks icon in the 

re printing checks is selected in the 
ositioning.

 new settings for the items you want to 
e or negative numbers. See the tables that 
itioning problems.
Adjusting check alignment for page-o

In most cases, you won’t need to do anythin
aligned correctly. If you have a non-Apple, 
need to use the information in this section t
checks—but only if you have followed the i
chapter and the text is still not aligned corre

You can make fine-tuning adjustments to th
fields don’t print in quite the right place. On
Quicken saves your alignment settings, so y
print checks with the same alignment in the

Note You can adjust the positioning of text 
you cannot rearrange the order of the fields

1 Review your printed checks to decide w
adjusting.

2 Choose Preferences from the Edit menu a
scrolling panel on the left.

3 Make sure the account from which you a
Account pop-up menu, and then click P

4 In the Adjust Positioning window, enter
change and click OK. You can use positiv
follow step 5 for solutions to specific pos
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en place the paper on top of a check page 
 if the text printed correctly.

t 

Change the Horizontal settings to 
adjust the side-to-side position of 
text in individual fields and text 
that seems too short or too long for 
a particular field.

Vertical settings are in hundredths 
of an inch.

Horizontal settings are shown as 
the number of characters per field.

Solution

Increase the number of lines in the 
vertical Lines Per Check setting.

Decrease the number of lines in the 
vertical Lines Per Check setting.
5 Print a test check on blank paper, and th
and hold them both up to the light to see

Change the Fine Tuning setting to 
adjust the top-to-bottom position 
of all the text on a check, or 
change the Memo Position setting 
to adjust the top-to-bottom 
position of the text in the Memo 
field only. Entering a lower 
number moves the text up and a 
higher number moves it down.

Change the Partial Page settings to adjus
the top-to-bottom position of text on a 
check printed as a partial page.

Quicken determines the number 
of Lines Per Check based on the 
type of Intuit check you selected.

Vertical positioning problem

The text on the first check prints 
correctly, but the text on the next check 
prints too high.

The text on the first check prints 
correctly, but the text on the next check 
prints too low.
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Increase the number in the Fine Tuning 
setting to move the text on the check 
down.

Decrease the number in the Fine Tuning 
setting to move the text on the check up.

Increase the number in the Memo 
Position setting to increase the distance 
between the Memo field and the top of 
the check.

Decrease the number in the Memo 
Position setting to decrease the distance 
between the Memo field and the top of 
the check.

Solution

Increase the number of characters in the 
horizontal Date, Payee, Amount, Text 
Amount, Address, or Memo setting to 
increase the distance between the text in 
that field and the left edge of the check.

Solution
The text on the first check starts printing 
too high.

The text on the first check starts printing 
too low.

The memo text on a check prints too 
high.

The memo text on a check prints too low.

Horizontal positioning problem

One or more check fields print too far to 
the left.

Vertical positioning problem
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Decrease the number of characters in the 
horizontal Date, Payee, Amount, Text 
Amount, Address, or Memo setting to 
decrease the distance between the text in 
that field and the left edge of the check.

Decrease the number of characters in the 
Amount Width setting to force Quicken to 
fit the amount into a shorter space. Ten 
characters is the minimum.

Increase the number of characters in the 
Text Amount Width setting to make the 
spelled-out amount longer.

Solution

Increase the number in the Single Check or 
Two Checks setting to move the text on the 
check down.

Decrease the number in the Single Check 
or Two Checks setting to move the text on 
the check up.

Solution
One or more check fields print too far to 
the right.

Check amount starts printing in the 
right place, but is cut off on the right.

Spelled-out check amount starts 
printing in the right place, but doesn’t 
fill the line.

Partial-page positioning problem

The text on a partial page of checks 
starts printing too high.

The text on a partial page of checks 
starts printing too low.

Horizontal positioning problem
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ous-feed printers

ke sure the checks are properly aligned in 
hecks. 

rinter.

ed printers” on page 136.

 online.

 to print checks.

nd make sure that the selected Paper 

 (x-P).*

ny checks to print, you need to enter a 
 want—in the Write Checks window (see 
Printing a sample check with continu

Quicken lets you print a sample check to ma
the printer before you print the rest of the c

1 Insert a sample check or checks in your p

See “Positioning checks in continuous-fe

2 Make sure your printer is turned on and

3 Open the account from which you want

4 Choose Page Setup from the File menu a
option is US Letter.

5 Choose Print Checks from the File menu

*If you see a message that you don’t have a
check—one that you can delete later if you
page 130).
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ck Print to open the printer dialog box for 

r, look at the printed check.

e text appear too far to the left or right? 
k is aligned correctly, the type rests just 

k Cancel in the Check Alignment window 
count” on page 137 to print your checks.

ly, see “Adjusting check alignment for 
6 Select Check Alignment Test and then cli
your printer.

7 Click Print. 

Quicken prints a sample check.

8 Without moving the checks in the printe

Check the horizontal alignment. Does th
Check the vertical alignment. If the chec
above the lines on the check.

9 If the sample check printed correctly, clic
and go to “Printing checks from your ac

OR

If the sample check did not print correct
continuous-feed printers” next.

When you test the check align-
ment, Quicken prints a sample 
check with a special pointer line 
printed on it. You can use the 
pointer line on the sample check to 
find and note the physical spot on 
your printer that you will use to 
line up checks in the future.
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uous-feed printers

 that printed in the middle of the sample 

e position number that the pointer line 

4

6

8

10

12

14

16

18

20

22

24

26

28

30

32

34

36

38

40

42

2

1470

DOLLARS

XX

.XX

E ====>
Adjusting check alignment for contin

1 Look at the line labeled POINTER LINE
check.

2 In the Check Alignment window, click th
arrows point to on the printed check.

Quicken prints a pointer line on 
the sample check. The arrow at 
each end of the pointer line 
points to a position number 
printed along the edge of the 
check.

In this example, the pointer line 
points to position number 26.

2

4

6

8

10

12

14

16

18

20

22

24

26

28

30

32

34

36

38

40

42

YOUR  NAME

YOUR ADDRESS

CITY, STATE  ZIP

YOUR  BANK
BRANCH OFFICE 
CITY, STATE  ZIP
00-67789/0000

PAY TO THE
ORDER OF $

MEMO

SAMPLE-VOID

�001470� �123456789� 98765432�       

XX/XX/

PAYEE XX,XXX

<==== POINTER LINE ======== POINTER LINE ======== POINTER LIN

This is a void check

Indicate the number the pointer 
line is pointing to on the check 
you just printed. The number 26 
here is just an example.
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ments by hand, moving the paper clamps 

e printer and advances the checks.

t another sample check.

r, look at the second check.

eck should be almost perfect. If it’s off by 
ove until a sample check prints correctly.

r future positioning.

 as the sprocket cover or print head, with 
of the check. Make a note of this spot on 
o align your checks so you won’t have to 
3 Make any side-to-side positioning adjust
on the printer as necessary.

4 Click Align.

Quicken aligns the check vertically in th

5 If you want to verify the alignment, prin

If a half-line adjustment is needed, 
you can use the line feed button 
on top of your printer or the knob 
on the side to move the check up 
or down half a line.

6 Without moving the checks in the printe

The vertical positioning of the second ch
a noticeable amount, repeat the steps ab

7 Note the correct position of the check fo

Visually line up part of your printer, such
one of the position numbers at the edge 
the printer. From now on, use this spot t
print more sample checks.
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, for any reason. Follow these steps to 
ve entered in the register instead of in the 

he check you want to reprint.

 number with the word PRINT.

ttention to entering the correct number in 
Reprinting checks

You can easily reprint any check at any time
reprint checks, or to print checks that you ha
Write Checks window.

1 In the register, select the transaction for t

2 In the number column, replace the check

3 Click Record.

4 Print the check as usual, paying special a
the Starting Check Number field.

Entering PRINT in the Number 
column turns checks that have 
already been printed into 
checks you can print again.
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) you may need to use a special option for 
 your checks. To clear or select the Use 

and click the Print Checks icon in the 

re printing checks is selected in the 
ption-T.

kbox just to the right of the Sheet Feeder 

box as described in the table that follows 

ngs.*

Use this trailer strip 
option

rd or wallet 
 is shorter 
the trailer 
e of checks.

Clear the checkbox.

gle pages so 
r.

Clear the checkbox.
Using the trailer strip option

In some situations (see the table on page 153
handling existing or missing trailer strips on
Trailer Strip checkbox:

1 Choose Preferences from the Edit menu 
scrolling panel on the left.

2 Make sure the account from which you a
Account pop-up menu, and then press O

Quicken displays a Use Trailer Strip chec
checkbox.

3 Select or clear the Use Trailer Strip check
step 4.

4 Click OK to save the check printing setti

In this check printing situation

If you are printing a partial page of standa
checks, Quicken may tell you that the page
than the size selected in Page Setup. See if 
strip is missing from the bottom of the pag

You have turned continuous checks into sin
you can use them in a page-oriented printe
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 checks

rder more checks. Choose Preferences 
 Checks icon in the scrolling panel on the 

ip checkbox when you close the window, 
n later by pressing Option-T.

artial page Select the checkbox.

artial page Clear the checkbox.

Use this trailer strip 
option
Letting Quicken remind you to order

Quicken can remind you when it’s time to o
from the Edit menu and then click the Order
left.

*Although Quicken hides the Use Trailer Str
it saves the setting. You can display it agai

You are using a LaserWriter SC to print a p
with one check on it.

You are using a LaserWriter SC to print a p
with two checks on it.

In this check printing situation
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 your checks. The image can be up to 1" 
checks, and up to 0.5" high and 2.5" wide 
T (Paint or Draw) format from a program 
ehand, MacPaint, or MacDraw. Quicken 
t) files. To save an EPS file as a PICT file, 
ste it into a PICT file.

Choose the account for which you want 
to order checks.

Enter the last check number in your 
current supply of checks.

Enter the check number when you want 
to reorder. Quicken reminds you to order 
more checks when you print a check with 
this number.

Click Set Reminder to save your settings 
for the selected account.

Click OK to close the Preferences 
window.

en Help Topics and select
Adding art to checks

You can print a logo, text, or other image on
high and 5" wide on standard and voucher 
on wallet checks. The image must be in PIC
such as Adobe Photoshop, Macromedia Fre
does not accept EPS (Encapsulated PostScrip
select the image, press Option-Copy, and pa

For step-by-step help, go to Banking in Quick

How do I add art to checks?
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...................................................................168

...................................................................171

 compare your Quicken records to your 
erences between the two—just like when 
 can account for every cent if you want to, 
e to the penny. 

r show Quicken bank accounts. For infor-
counts, see page 229; for portfolio or 
8 Reconciling Qu
accounts
Before you start.................................................

Starting reconciliation......................................

Marking cleared transactions .........................

Completing reconciliation...............................

Solving reconciliation problems.....................

When you reconcile a Quicken account, you
current bank statement and resolve any diff
you balance your checkbook manually. You
but Quicken doesn’t require that you balanc

The examples and illustrations in this chapte
mation specific to reconciling credit card ac
mutual fund accounts, see page 362.
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st time, make sure you:

 between the date of your last statement 

awals, including checks you’ve written by 
sactions, and electronic transfers.

nding balance of your last statement that 
.

our register even if they are dated before 
Quicken account.

 Quicken register matches the beginning 
concile.

r previous statement as the Opening 
you set it up, then the Opening Balance in 
ning balance on the first statement you 
atch, change the amount in the Deposit 

ion in your Quicken register.
Chap

Before you start

When you reconcile your account for the fir

• Enter all transactions that have occurred
and the date of your current statement.

You should enter all deposits and withdr
hand or printed with Quicken, ATM tran

• Enter any transactions dated before the e
have not yet appeared on any statement

You should enter these transactions in y
the opening balance transaction in your 

• Check that the Opening Balance in your
balance on the statement you want to re

If you used the closing balance from you
Balance for your Quicken account when 
Quicken should be the same as the begin
want to reconcile. If the amounts don’t m
column of the Opening Balance transact
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nths and have just decided that you want 
ccount and have not done it for several 
our Quicken account with the bank state-
efore you start to reconcile the statement 

nce 
ster 
nt in 

When your next statement 
arrives, enter the ending balance 
from it in the Reconcile Startup 
window as the Ending Balance.

Statement
1/31/00

$200.52

$524.18
Chap

Reconciling for more than one month

If you have used Quicken for a number of mo
to reconcile, or if you used to reconcile an a
months, you need to go back and reconcile y
ments for each of the months you skipped b
for the current month.

Quicken uses the Opening Bala
amount you entered in the regi
as the Beginning Balance amou
the Reconcile Startup window.

When you set up your Quicken account, enter 
the ending balance from your most recent state-
ment in the Opening Balance Deposit column.

Where the balances go  . . .

Statement
12/31/99

$340.73

$200.52



ter 8, Reconciling Quicken accounts    160

 your Quicken bank account so you can 
, and budgets. For example, if you start 
u could add all of your transactions from 

plete. To keep your account information 
nt bank statement. Then add the earlier 
tely starting with your earliest statement.

en Help Topics and select

?

Chap

Adding earlier transactions

You may want to add earlier transactions to
create more comprehensive reports, graphs
using Quicken in the middle of the year, yo
January 1 so your records for the year are com
accurate, wait until you reconcile your curre
transactions and balance each month separa

For step-by-step help, go to Banking in Quick

How do I catch up balancing my checkbook
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nk statement is different from the Balance 
e that something’s wrong. You’ve 

ter the bank prepared your statement, so 
r register. You may also have checks or 
have not yet cleared the bank.

r the account you want to reconcile.

.

If you have reconciled this account 
before, the total of all reconciled 
transactions in the register 
appears in the Beginning Balance 
field. Reconciled transactions are 
marked with a bold checkmark 
( � ) in the Clr column.
Chap

Starting reconciliation

If the balance shown on your most recent ba
Today in your Quicken register, don’t assum
probably entered transactions in Quicken af
the bank balance is not as up-to-date as you
other transactions from earlier months that 

If this is an online account, go to 
“Starting to reconcile an online 
account” on page 165.

1 In the Banking area, open the register fo

2 Click the Reconcile button in the toolbar

The Beginning Balance amount 
should be the same as the opening 
balance on the bank statement.

If this is the first time you are 
reconciling the account, Quicken 
uses the amount you entered for 
the Opening Balance transaction 
in your Quicken register.

The Beginning Balance “As of” 
date is the closing date of the last 
statement you reconciled. The 
Ending Balance “As of” date is the 
closing date of this statement. 
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 your statement matches the amount in 
cile Startup window.

 balance the “previous” or “opening” 
date is the closing date of the last state-

following reasons:

lve the difference in the Beginning 

s the amount of the Opening Balance 
in your register as the amount in the 
alance field in the Reconcile Startup 
e the illustration on page 159). When you 
uicken account, you may have entered the 

nt in the Deposit column of the Opening 
saction. Change the amount now in the 

reconcile one month at a time, starting 
liest statement. You need to reconcile your 
ount with the bank statements for each of 
you skipped before you start to reconcile 
t for the current month.
Chap

3 Make sure that the beginning balance on
the Beginning Balance field in the Recon

Your statement might call the beginning
balance. The Beginning Balance “As of” 
ment you reconciled.

The amounts might differ for one of the 

Your situation How to reso
Balance field

You are reconciling 
your Quicken account 
for the first time.

Quicken use
transaction 
Beginning B
window (se
set up the Q
wrong amou
Balance tran
register.

You started reconciling 
with your most recent 
statement, but you have 
not reconciled the 
previous months’ state-
ments.

You should 
with the ear
Quicken acc
the months 
the statemen
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tement and enter it in the Ending Balance 

lance amount the “current” or “new” 
e is the closing date of the statement you 

, you may have started using Quicken in 
bsequently reconciled your account for 
ne. Then you went back and recorded 
 from January. To ensure that the balance 
er is correct, you need to change the date 
 of the Opening Balance transaction in 
n register to match the opening balance 
t bank statement you want to reconcile. 

g earlier transactions” on page 160.

ank statements may be wrong. Contact 
o resolve the problem. The bank will 
rror with an adjustment on your next 
or now, change the Beginning Balance 
 let Quicken make the adjustment for you 
 in “Resolving a previous difference” on 
is adjustment will appear as a reconciled 
egister, so your account will be off by the 
t next month when you reconcile. Then 

 make another adjustment when you 
e next statement.

lve the difference in the Beginning 
Chap

4 Find the ending balance on your bank sta
field in the Reconcile Startup window.

Your statement might call the ending ba
balance. The Ending Balance “As of” dat
are reconciling.

You were using 
Quicken and 
reconciling your 
account. Then you 
started recording 
earlier transactions in 
Quicken.

For example
May and su
May and Ju
transactions
in the regist
and amount
your Quicke
from the firs
See “Addin

The ending balance on 
last month’s statement 
is different from the 
starting balance on this 
month’s statement.

One of the b
your bank t
correct the e
statement. F
amount and
as described
page 176. Th
item in the r
same amoun
let Quicken
reconcile th

Your situation How to reso
Balance field
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bank statement and you haven’t already 
nter the amount of the service charge in 
 charge in the Date field, and an expense 

on your account and you haven’t already 
 the amount of interest in the Amount 
rded in the Date field, and an income 

terest Earned transactions to the register 

ervice Charge and Interest Earned trans-
nd you’ll need to enter those amounts 
s account.
Chap

5 If any service charges are listed on your 
entered them in your Quicken register, e
the Amount field, the date of the service
category in the Category field.

6 If your statement shows interest earned 
entered it in your Quicken register, enter
field, the date when the interest was reco
category in the Category field.

7 Click Start.

Quicken adds the Service Charge and In
and displays the Reconcile window.

If you click Cancel instead of Start, the S
actions are not recorded in the register a
again when you return to reconciling thi
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t

 register throughout the month and then 
month. 

r the account you want to reconcile.

.

ance, and Statement Date (from your 
p window.

 filled in for you.

wnload Transactions window to update 
 your register was before the closing date 
ost up-to-date online data from your 

g, see “Updating your register” on 
 cleared transactions” on page 166.
Chap

Starting to reconcile an online accoun

Using online banking, you can update your
reconcile with your paper statement once a 

1 In the Banking area, open the register fo

2 Click the Reconcile button in the toolbar

3 Enter the Beginning Balance, Ending Bal
paper statement) in the Reconcile Startu

Some of this information may already be

4 Click Start.

You can choose whether or not 
downloaded transactions 
automatically appear in the 
register with checkmarks to 
indicate that they have cleared the 
bank. (Some people prefer to 
mark each transaction 
themselves.) 

5 Quicken asks if you want to go to the Do
your register. If the last time you updated
on your statement, you should get the m
financial institution now.

To update your register before reconcilin
page 195. Then continue with “Marking
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ions. A cleared transaction is one that has 
 your bank statement. The Reconcile 
ns in your Quicken register through the 

ncile window that matches a transaction 
 it as cleared.

on in the Reconcile window matches the 

sort the items in 
umber or by Date. 

Click the Show 
Instructions 
checkbox to clear 
it if you don’t 
need instructions. 
Quicken hides the 
instructions and 
displays more 
transactions.
Chap

Marking cleared transactions

Your next step is to mark all cleared transact
been processed by the bank and is listed on
window displays all unreconciled transactio
Ending Balance date you entered.

1 When you find a transaction in the Reco
on your bank statement, click it to mark

Verify that the amount for each transacti
amount listed on the bank statement.

Quicken keeps a running total of 
the number of items and the total 
amounts cleared in each list.

If a transaction appears on your 
bank statement, click it to mark it 
as cleared. A checkmark appears 
in the Clr column. If you make a 
mistake, click the transaction 
again to remove the checkmark.

Click New Transaction to enter a 
missing transaction in the register. 

Quicken can 
the lists by N

Click Uncheck All to 
remove all checkmarks 
and start over. 
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atement that’s not shown in the list of 
nsaction. 

cts a blank transaction. Enter the missing 
the Reconcile button at the bottom of the 
ow. Quicken updates the Reconcile 
ou entered in the register.

 error, double-click the transaction in the 
ister.

f the transactions on your statement as 
Chap

2 If you find a transaction on your bank st
unreconciled transactions, click New Tra

Quicken takes you to the register and sele
transaction and click Record. Then click 
register to go back to the Reconcile wind
window to show any new transactions y

3 If you find a transaction that contains an
Reconcile window to correct it in the reg

4 In the Reconcile window, mark the rest o
cleared.

If you want to see more informa-
tion about a transaction or correct 
a mistake, you can double-click 
the transaction in the Reconcile 
window to go to the register with 
that transaction selected. 
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ctions, look at the difference amount or 
oncile window.

is zero and Quicken does not display a 
 reconciled the current bank statement 
onciliation.

 Previous Difference amount is not zero: 
lems” on page 171 to find out how to 

oncile the account.

e finished reconciling, you’ll see that the 
ow reconciled (�).
Chap

Completing reconciliation

When you finish marking the cleared transa
amounts in the lower right corner of the Rec

• If the Difference this Statement amount 
field named Previous Difference: You’ve
successfully. Click Finish to complete rec

• If either the Difference this Statement or
Skip now to “Solving reconciliation prob
correct the problem and successfully rec

If you look at your check register after you’v
transactions you marked as cleared (√) are n

If there were a previous 
difference amount, it would 
appear above the Difference 
this Statement amount.
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e Clr column?

ill reconciling, you’ll see thin checkmarks 
marked as cleared in the Reconcile 

action as cleared.

ared in the Reconcile window and click 
nto bold checkmarks to signify that the 
”

e transaction.

ank, leave the Clr column blank until you 
 to reconcile.

e” some transactions that you cleared or 

e the �  from transactions marked as 

. It takes only seconds and protects you 
p and archiving your data files” on 
Chap

What’s the difference between √ and � in th

If you return to the register while you are st
in the Clr column of all transactions you’ve 
window.

• √  means that you have marked the trans

After you finish marking transactions as cle
Finish, Quicken turns the thin checkmarks i
“cleared” transactions are now “reconciled.

• �  means that Quicken has reconciled th

If a transaction has not been cleared at the b
receive your next bank statement and begin

You can manually “unclear” or “unreconcil
reconciled incorrectly:

• Option-click in the Clr column to remov
reconciled.

Tip: Back up your data file after reconciling
against accidental data loss. See “Backing u
page 486.
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 create a reconciliation report to see a 
all items that remain unreconciled. Click 
 click the Standard tab. Then select Recon-

 select Full Report, the 
t shows a summary plus 
 information for every 
ction.

e the date if you want the 
 to show your reconciled 
e as of a date other than 
Chap

Creating a reconciliation report

After you’ve reconciled an account, you can
summary of this reconciliation and a list of 
the Reports button in the Reporting area and
ciliation and click Customize.

If you select Summary and 
Unreconciled Transactions, the 
report shows a summary plus 
detail information for every 
unreconciled transaction.

If you
repor
detail
transa

Chang
report
balanc
today.

Change the report title if you wish.
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s

ot zero, your account doesn’t balance for 
e is usually either an incorrect number of 
red, or incorrect dollar amounts for some 

ero, but there is a Previous Difference 
 current statement successfully, but you 
s amount is the difference between the 
n the register for this account and the 
ce field in the Reconcile Startup window 

 is a running total comparing the items 
ked cleared in Quicken and the items on 
tatement. In this example, there’s $18.50 
rence between the Quicken register and 
ank statement.

ve not balanced your account.

 Finish and let Quicken modify your 
unt balance to agree with the bank’s by 
rding an adjustment transaction. See 
olving a difference from your current 
ment” on page 176.
Chap

Solving reconciliation problem

If the Difference this Statement amount is n
the current bank statement period. The caus
payment or deposit items checked off as clea
items.

If the Difference this Statement amount is z
amount displayed, you have reconciled the
need to resolve the Previous Difference. Thi
total of all the previously reconciled items i
amount you entered in the Beginning Balan

This
mar
the s
diffe
the b

Problem

Solutions
If the amount in this field is not zero, you ha

Click
acco
reco
“Res
state

Find the difference between 
your register and the state-
ment and correct it. See 
“Finding and correcting 
differences” next.

OR
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ent). The cause of the difference could be 
n page 162, or you could have changed or 
ed (marked with a �) or deleted a balance 

you changed the Beginning Balance 
ount in the Reconcile Startup window, or 
de a change in the register that affects the 

ginning Balance, the difference shows up 
 the Previous Difference.

u need to resolve the difference.

ick Finish to finish reconciling the 
rrent statement. Then see “Resolving 
revious difference” on page 176.
Chap

(the opening balance from the current statem
one of the situations described in the table o
deleted an item that was previously reconcil
adjustment transaction.

If 
am
ma
Be
as

If there is a Previous Difference amount, yoProblem

Solutions Cl
cu
a p

Find the cause of the 
problem and correct it. 
See the table on page 162.

OR
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uicken register and the bank statement in 

s

r bank statement and compare that 
and Checks” items you’ve marked in the 

r bank statement and compare that 
its” items you’ve marked in the Reconcile 
Chap

Finding and correcting differences

You can find the differences between your Q
a systematic way.

Finding a problem with the number of item

1 Count the number of debit items on you
number with the number of “Payments 
Reconcile window.

2 Count the number of credit items on you
number with the total number of “Depos
window.

Check the total number and 
dollar amount of items you’ve 
marked.

“Payments and Checks” include 
checks, ATM withdrawals, trans-
fers out of the account, service 
charges and fees, and automatic 
payments.

“Deposits” include ATM 
deposits, direct deposits, trans-
fers into the account, and interest 
earned.
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ter

d

ayment as a deposit
l through the list to see if you can find the 
 transaction)

 correct the problem.

f items

ms marked as cleared, there may be a 
ore items.

correctly in the register and make 
ct the problem.
“Payments and Checks” in the Reconcile 
bits on your statement. If the totals do not 
ollar amount of debits and you need to 

“Deposits” in the Reconcile window with 
statement. If the totals do not agree, you 
nt of credits and you need to check only 
Chap

Note: The bank may summarize 
transactions that you’ve listed 
separately in your register.

For example, if you made several 
deposits on a single day, the bank 
might show the sum rather than 
listing each one separately. Or you 
may summarize transactions in 
your register (such as bank 
charges) that the bank itemizes.

Some statements count the total 
number of credits for you; others 
list interest earned and ATM 
deposits separately. Some state-
ments count the total number 
of debits for you; others list 
service charges and ATM 
withdrawals separately.

3 Check to see if you:
• missed recording an item in the regis
• missed marking an item as cleared
• mistakenly marked an item as cleare
• entered any transactions twice
• entered a deposit as a payment or a p
• forgot to enter a check number (scrol

check amount listed as a withdrawal

4 Make whatever changes are necessary to

Finding a problem with the dollar amount o

If there’s no problem with the number of ite
problem with the dollar amount of one or m

1 Check to see if you entered an amount in
whatever changes are necessary to corre
• Compare the total dollar amount for 

window with the dollar amount of de
agree, you have a problem with the d
check only payment transactions.

• Compare the total dollar amount for 
the dollar amount of credits on your 
have a problem with the dollar amou
deposit transactions.
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ared transactions with the amounts 
 you didn’t transpose the digits in a trans-
for example, you entered 7.56 instead of 
, return to the register (by double-clicking 
ow) and correct the amount.

correctly in the Reconcile Startup window.

ing and ending balances from your state-
inning balance the “previous” or 
 ending balance “current” or “new.”

y processing a transaction for an incorrect 

tion (or let Quicken make the adjustment 
adjust for differences” next). Then contact 
justment on your next statement. Because 
ed item in the register, your account will 
he next reconciliation. Let Quicken make 

onciling the next statement.

etween your Quicken register and the 
cceptable if the amount is small and you 
n. If you decide to ignore the difference, 
stment for the amount of the difference. 
Chap

• Compare all amounts in the list of cle
shown on your statement. Make sure
action amount when you entered it (
7.65). If you find an incorrect amount
the transaction in the Reconcile wind

2 Check to see if you entered an amount in

Make sure you entered the correct beginn
ment. Your statement might call the beg
“opening” balance, and it might call the

3 Check to see if the bank made a mistake b
amount.

Adjust the balance by entering a transac
for you as described in “Letting Quicken 
your bank. The bank should make an ad
this adjustment will appear as a reconcil
be off by the same amount at the end of t
another adjustment when you finish rec

Letting Quicken adjust for differences

You might decide to ignore the difference b
bank statement. Ignoring the difference is a
feel it is not worth your time to track it dow
you’ll still want to let Quicken enter an adju
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tals the next time you reconcile your 

tement

t the Difference this Statement amount is 
e discrepancy and asks if you want to 

 register that was reconciled with a 
 in the reconciled balance. This could 
nt of a previously reconciled transaction 
ark from the Clr column of a previously 

 the next time you reconcile.

Click Return to Reconcile to return 
to the Reconcile window and track 
down the difference yourself.
Chap

That way you’ll be starting with accurate to
account.

Resolving a difference from your current sta

If there is no Previous Difference amount, bu
not zero, Quicken tells you the amount of th
resolve the difference.

Resolving a previous difference

If you make a change to a transaction in the
previous statement, it creates a discrepancy
happen if you deleted or changed the amou
or if you manually removed the bold checkm
reconciled transaction.

Quicken asks you to resolve the discrepancy

Click Adjust Register if you 
want Quicken to record an 
adjustment transaction in the 
register equal to the difference 
between your cleared items 
and the statement. You can 
delete the adjustment transac-
tion later if you find the error 
that caused the difference.
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cile Startup window. Make sure that the 
e correct; then click Start. In the Reconcile 
vious Difference amount. Quicken keeps 
but ignores it this time and lets you recon-

r Statements window. It shows all the 
for this account (since you started using 

Click Resolve if you want 
Quicken to help you resolve 
the discrepancy.

Click Adjust Register if you 
want Quicken to resolve the 
discrepancy by entering an 
adjustment transaction in your 
Quicken register. 
Chap

If you click Ignore, Quicken opens the Recon
beginning and ending balances and dates ar
window, the discrepancy appears as the Pre
track of the discrepancy until you resolve it, 
cile this statement. 

If you click Resolve, Quicken opens the Prio
statements you have previously reconciled 
Quicken).

Click Ignore to go to the 
Reconcile Startup window 
and reconcile the current 
statement without resolving 
the previous discrepancy.

Statements are identified by the 
Ending Date in the Reconcile 
Startup window. Note that in 
this example the December 
statement has a discrepancy of 
$62.55. 

Select a statement and click Reconcile 
Again if you want to re-reconcile that 
statement to fix the discrepancy yourself. 

Click Done when you are 
finished to go to the 
Reconcile window. 
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nd click Reconcile Again, Quicken opens 
ent. Make sure that the beginning and 
click Start. In the Reconcile window, 
you have already reconciled with that 
ppears as the Difference this Statement in 
 want to start over, you can remove all the 
 can resolve the discrepancy as described 
e 171. 
Chap

If you select a statement with a discrepancy a
a Reconcile Startup window for that statem
ending balances and dates are correct; then 
Quicken puts checkmarks next to the items 
statement. The amount of the discrepancy a
the lower right corner of the window. If you
checkmarks by clicking Uncheck All. Or you
in “Solving reconciliation problems” on pag
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9 Banking online
Banking online from Quicken ........................

Connecting to the Internet ..............................

Setting up a Quicken account for online ban

Going online to access your accounts ...........

Making online payments ................................

Communicating with your financial institut

Sending several instructions in one connect

Using Web Connect..........................................
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h Quicken saves you time and hassle. You 
t and charge card transactions, or ATM 
actions directly from your financial insti-
 automatically to your Quicken register. 
 envelopes or licking stamps. Now you 
ay or night, to send all your banking and 

tution. 

ess and online payment services.

your financial institution (usually from 
cluding cleared transactions and account 

 transactions to those in your Quicken 
ransactions to those you’ve already 
ou can add them to your register. 

unts at the same financial institution to 

tion via electronic mail.
Banking online from Quicken

The online banking service available throug
don’t need to manually record checks, credi
withdrawals; instead, download your trans
tution, check them over, and then add them
And paying bills is a snap. No more stuffing
can securely use your Internet connection, d
payment instructions to your financial insti

Online banking includes online account acc

Use online account access to:

• Download up-to-date information from 
the close of the previous banking day), in
balances.

• Automatically compare the downloaded
register. Quicken matches downloaded t
entered and notes new transactions so y

• Transfer money between two online acco
maximize the interest you earn.

• Communicate with your financial institu
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e Internet to securely send all your 

 if the need arises.

riety of financial institutions, including 
. Online payment is available for accounts 
nk or other financial institution.

s, go to Online Banking in Quicken Help 
icipating FIs?” If your financial institution 
ment through the Intuit Online Payment 

nline account access and online payment. 
led instructions.

 your computer and that it is appropri-
n’t done so yet, register Quicken online.

Intuit Online Payment service about 
Use online payment to:

• Schedule payments to anyone and use th
instructions in one connection.

• Inquire about payments and cancel them

Working with online banking

Online account access is available from a va
banks and credit and charge card companies
with check-writing privileges at any U.S. ba

For a list of participating financial institution
Topics and double-click “How do I find part
isn’t listed, you can still apply for online pay
service. 

This is an overview of setting up and using o
The rest of this chapter provides more detai

1 Make sure you have Internet access from
ately set up within Quicken. If you have

2 Contact your financial institution or the 
services and fees.
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nline banking, either over the Internet (if 
this) or by phone. You also can apply in 

tion and assigned PIN, enable your 
.

r latest transactions and online balances. 

 to those you've already entered in your 
loaded transactions to update your 

to send to your financial institution. 

 instruction and send it immediately, or 
en to send in one efficient connection.

ection to the Internet when you are 
n and do not have any other applications 
u should close the connection manually. 
3 Apply from your home or office to use o
your financial institution is set up to do 
person at your financial institution.

4 When you receive your account informa
Quicken accounts to use online banking

5 Connect to the Internet to download you

6 Compare your downloaded transactions
Quicken register, and then use the down
register. 

7 Create payment or transfer instructions 

You can create a single banking or payment
you can store several instructions for Quick

Important! Quicken does not close the conn
finished. If you are using a dial-up connectio
open that require an Internet connection, yo
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make sure you’ve registered your copy of 
ering Quicken, see step 3 on page 22.

ty

about working with your personal or 
d your financial institution have devel-
ncial data, including:

d authentication to protect your data.

 issued by your financial institution that 
 the Internet. You can change your PIN to 
ly you know it. It is not stored on your 

ider

st have Internet access. For most people, 
 to connect to an Internet Service Provider 
ernet connection, including Internet 
 able to use Web browsers like Microsoft 
u should be able to use online banking 
Connecting to the Internet

Before you get started with online banking, 
Quicken. For more information about regist

Questions you may have about securi

Like most people, you may have questions 
business finances over the Internet. Intuit an
oped several features to safeguard your fina

• Highlevel, state-of-the-art encryption an

• A Personal Identification Number (PIN)
you must enter each time you connect to
one of your choice at any time so that on
computer.

Specifying your Internet Service Prov

A note about modem speeds: 
While Quicken works with 
modems as slow as 14400 baud, 
for better performance use a faster 
modem.

To use online banking with Quicken you mu
this means using a modem and a phone line
(ISP). Quicken works with your existing Int
connections like America Online. If you are
Internet Explorer or Netscape Navigator, yo
with Quicken.
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ion:

and then select the Internet icon in the 

 are using. Depending on the ISP you 
reement. After reviewing the agreement, 

l area network using a proxy server, click 
d proxy port number, and click OK.

ave your settings.

If you are connected to a local area 
network, or LAN, check with your 
network administer to see if you 
have access to the Internet. If you 
do, your network administrator 
can provide the information you 
need to set your proxy.

To specify the browser you’d 
like to use with Quicken, click 
Select Browser.
To tell Quicken about your Internet connect

1 Choose Preferences from the Edit menu 
scrolling panel on the left.

2 Choose the Internet service provider you
choose, Quicken may display a service ag
click OK.

3 (Optional) If you are connected to a loca
Select Proxy, enter your HTTPS proxy an

4 Click OK in the Preferences window to s

Click the radio button next to the 
Internet service provider you 
are using.
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 Internet Explorer or Netscape Navigator, 
r lets you view the most current list of 

nking through Quicken. On the World 
 about how to apply for online banking 
 also offers a collection of helpful services 
 these Web destinations from within 
nstalled and let Quicken know which 

and then select the Internet icon in the 

r containing the browser you want to use 

 

ave your settings. 
Choosing a Web browser

Although a Web browser, such as Microsoft
is not required for online banking, a browse
financial institutions that provide online ba
Wide Web you can get detailed information
from a specific financial institution. Quicken
and information through the Web. To reach
Quicken you must have a browser already i
browser you are using.

1 Choose Preferences from the Edit menu 
scrolling panel on the left.

2 Click Select Browser. 

3 In the Open File dialog box, find the folde
with Quicken and open it. 

4 Select the browser that you want to use.

5 Click Open.

6 Click OK in the Preferences window to s
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 checking, savings, line of credit, money 
nts. Each financial institution determines 

ervices. Apply individually to each finan-
r more online services. If your financial 
th Quicken, you can apply for online 
t service.

s

account access or online payment with 
ual financial institutions offer various 
al institution to discuss fees and services 
 financial institutions and their contact 

n Help Topics and double-click “How do 
stitution does not offer online banking 
it Online Payment service for this service 
 checking account. 
Applying to your financial institution

You can apply for online account access for
market, and credit card or charge card accou
which account types to support for online s
cial institution where you want to use one o
institution does not offer online banking wi
payment through the Intuit Online Paymen

Finding out about available services and fee

More financial institutions will 
begin offering services through 
Quicken throughout the year. 
Check with your financial institu-
tion. 

Intuit does not charge you for using online 
your financial institution. However, individ
levels of services for a fee. Call your financi
directly with them. For a list of participating
information go to Online Banking in Quicke
I find participating FIs?” If your financial in
with Quicken, you can still apply to the Intu
(for which there is a fee) using your existing
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 for online banking

online payment, your financial institution 
 to set up your Quicken accounts to use 

 list of the accounts you can set up for 
ay receive your initial PIN in a separate 
ial institution directly if you have any 

t for online use

 Online menu.

 select the account you want to set up for 

Quicken bank or credit card accounts that 
it, money market, and credit card 
t for Quicken bank accounts that track 
nts only.
Setting up a Quicken account

After you apply for online account access or 
provides you with the information you need
online services. This information includes a
online services and your initial PIN. (You m
mailing or over the phone.) Call your financ
questions about this information.

Enabling an existing Quicken accoun

1 Choose Enable Online Banking from the

2 In the Select Account to Enable window,
an online service.

You can enable online account access for 
track your checking, savings, line of cred
accounts. You can enable online paymen
your checking and money market accou

3 Click OK.
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lect the Enable Account Access checkbox, 
 both. Or, if your bank offers online 

e Enable Web Connect Account Access 

ancial Institution Information area of the 

rmation to you in your welcome letter. 

unt name in the Account list to indicate 

ou want to enable. 

Enter your customer ID number.

Many financial institutions use 
your social security or tax identifi-
cation number as your customer 
ID. Refer to the account informa-
tion you received from your finan-
cial institution for the exact 
number to enter.
4 In the Enable Online Banking window, se
the Enable Online Payment checkbox, or
banking through Web Connect, select th
checkbox.

5 Enter your account information in the Fin
window. 

Your financial institution sends this info

6 Click Save.

A lightning bolt appears next to the acco
that it is enabled for online service.

7 Repeat this procedure for each account y

In these fields, enter the account 
information from the welcome 
letter from your financial institu-
tion.

Make sure you choose a Financial 
Institution Name and an Account 
Type. The Account Type list 
includes only types appropriate 
for your choices of Quicken 
account and services. 
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 account 

hen click New to create a new account. 

 Account Type.

 Quicken bank and credit card accounts. 
ken bank accounts only. Check with your 
s it supports.

escription.

ve when Quicken asks you if you want to 

 select the account you just created, and 

lect the Enable Account Access checkbox, 
 both. Or, if your bank offers online 

e Enable Web Connect Account Access 

ancial Institution Information area of the 

rmation to you in your welcome letter.
Creating and enabling a new Quicken

1 Choose Accounts from the Lists menu, t

If you are enabling a line of credit 
account for online account access, 
you have two choices in Quicken. 
You can set the account up as a 
credit card account or a bank 
account, depending on whether 
you use the account to write 
checks. Then, in the Enable Online 
Banking window, choose Line of 
Credit from the Account Type 
pop-up menu.

2 In the Set Up Account window, select an

You can enable online account access for
You can enable online payment for Quic
financial institution to see which service

3 Enter an account name and an optional d

4 Click Enable Online Banking and click Sa
save the account setup information.

5 In the Select Account to Enable window,
then click OK.

6 In the Enable Online Banking window, se
the Enable Online Payment checkbox, or
banking through Web Connect, select th
checkbox.

If you are enabling the Quicken 
Credit Card, type Quicken Credit 
Card in the Financial Institution 
Name field. The window changes 
to ask for the appropriate infor-
mation.

7 Enter your account information in the Fin
window.

Your financial institution sends this info

8 Click Save. 



Chapter 9, Banking online    190

unt, enter an opening balance amount in 

ur opening balance.

ou want to set up.

ken account or accounts for online 
nsactions (such as cleared checks, ATM 
t access or payment instructions to your 
9 In the Register window for the new acco
the Deposit column.

See the table on page 65 to determine yo

10 Repeat this procedure for each account y

When you’ve finished setting up your Quic
banking, you can go online to download tra
withdrawals, or deposits) or to send accoun
financial institution.
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ccounts

e

, it’s a good idea to limit your activities to 
 session lets you update your register 
s of online account access. The first time 
titution, you may be prompted to change 
 data from previous months.

ncial institution and then connect via the 
or all accounts you enabled for online 
ution. You can review the transactions in 
count at a time and then update your 

 button in the toolbar.

tion from the pop-up menu under the 

ultiple financial institutions, choose the 

nt pop-up menu on the left side of the 
Going online to access your a

Downloading transactions the first tim

The first time you use online account access
downloading transactions. This limited first
before you begin using the other capabilitie
you download or send information to an ins
your PIN and you may be able to download

To download transactions, you select a fina
Internet. Quicken downloads transactions f
account access at the selected financial instit
the Download Transactions window one ac
Quicken registers automatically.

1 In the Banking area, click the Download

2 If necessary, choose your financial institu
logo on the left side of the window.

If you have online-enabled accounts at m
one you want to access first.

3 Choose an account name from the accou
window.



Chapter 9, Banking online    192

at a single financial institution in one 
 simply indicates which account’s data 

u by your financial institution).

mpt you to change your PIN the first time 
ne given to you by your financial institu-

ters, and then enter it again and click OK.

 and change more than one PIN, click OK 
 PIN requested.

data (as of the previous banking day or 
ts at the selected financial institution. 

en downloads all data since the last time 

ary window that lists information about 
ions that were downloaded.

ry window and click OK.

plays transactions for the selected 
Quicken will get data from all accounts 
connection, so choosing an account now
you want to view first.

4 Click Get Online Data.

If you want to change your PIN 
any time after this first time, just 
click Change PIN when you go 
online. 

5 Enter your PIN (the number given to yo

For security purposes, Quicken may pro
you go online. Your existing PIN is the o
tion. 

6 Enter a new PIN with at least four charac

Note: If this account requires you to enter
and then follow the instructions for each

Quicken gets the most recent statement 
more recently) for all your online accoun
(When you get data in the future, Quick
you went online.)

You’ll see the Online Transmission Summ
the accounts and the number of transact

7 Review the Online Transmission Summa

The Download Transactions window dis
account.
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at the same financial institution, choose a 
p-up menu.

ection to the Internet when you are 
n and do not have any other applications 
u should close the connection manually. 

action that is downloaded from your 
u’ve already entered in your Quicken 

When you select a transac-
tion, that transaction is 
shown in the register in the 
bottom half of the window.

If a transaction is marked 
Matched, but is in fact new, 
click Unmatch to change 
the transaction status to 
New.
To see the transactions for another account 
different account name from the account po

Important! Quicken does not close the conn
finished. If you are using a dial-up connectio
open that require an Internet connection, yo

How Quicken matches transactions

Quicken automatically compares each trans
financial institution with the transactions yo
register. 

This is the balance at your 
financial institution for the 
selected account. It may be 
different from the balance in 
your Quicken register.

Your downloaded transac-
tions for the selected account 
are displayed in the top half 
of the window.

Click a column title to change 
the order in which your 
downloaded transactions 
appear in the window. 
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 to one already in your register, it appears 
ched. A check transaction matches if the 
er are the same in your register and in the 
ansaction (such as an ATM withdrawal) 
e dates are within 30 days of each other.

nloaded transaction, it appears in the 
er you haven’t entered that transaction in 
mber or amount differs from the transac-

rs a transaction new if the check number 
with a different amount.

rches the QuickFill Transactions list and 
tching payee that was entered within the 

pies the category information from the 
ayee.

ee is found, Quicken copies the category 
t.

leaves the Category field blank.

ccess service charges may be labeled EFT 

gory either before or after updating your 
• If a downloaded transaction corresponds
in the upper transaction list marked Mat
amount of the check and the check numb
downloaded transaction. A non-check tr
matches if it has the same amount and th

• If Quicken didn’t find a match for a dow
upper transaction list marked New. Eith
your Quicken register yet, or its check nu
tion you did enter. Quicken also conside
duplicates one for a register transaction 

How Quicken assigns categories 

Before displaying a transaction, Quicken sea
then the register for a transaction with a ma
last year.

• If a matching payee is found, Quicken co
most recent transaction with the same p

• If a split transaction with a matching pay
information from the first line of the spli

• If no matching payee is found, Quicken 

Tip: ATM transactions and online account a
for Electronic Funds Transfer. 

You can edit transactions to change the cate
register.
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ransactions from your financial institu-
r each transaction. The online banking 
 Quicken category. Quicken may or may 
ee. First, matching payees and split trans-
If no matching payee is found, Quicken 
sed on the merchant code. For more infor-
 with online banking, see “Using online 
account” on page 196. 

 in the top half of the Download Transac-
ons you see are usually those completed 
ok over each transaction before you click 
o use all the checkmarked transactions to 

hoose an account name from the account 
ow.

n to add missing payee or category infor-
tion, select the transaction in the transac-
 in the Download Transactions register at 
anges in the register and click Record.

transaction that you want to add to your 
When you download credit or charge card t
tion, the data includes a “merchant code” fo
service reads each code and translates it to a
not use that category, depending on the pay
actions are categorized as described above. 
assigns a category to the new transaction ba
mation about using credit and charge cards
account access with a credit or charge card 

Updating your register

Quicken displays downloaded transactions
tions window. Remember that the transacti
by the end of the previous business day. Lo
to “accept” it and then click Accept √ Items t
update your Quicken register. 

1 In the Download Transactions window, c
pop-up menu on the left side of the wind

Important! When editing a 
downloaded transaction to add 
payee or category information, do 
not change the amount of the 
transaction. If you think a transac-
tion amount is incorrect, contact 
your financial institution.

2 (Optional) If you want to edit a transactio
mation or if you want to delete a transac
tion list. Quicken displays the transaction
the bottom of the window. Make your ch

3 Click to place a checkmark next to each 
register.
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d drag down the list to select more than 
nd want to uncheck a transaction, click it 

ister, marked √ (cleared), and removed 
d Transactions window.

ters the transactions you accepted in your 
 and accepted items in the register as √ 

d at the financial institution. 

ing to reconcile an online account” on 

edit or charge card account

card register, the online account access 
or the credit or charge card. At the end of 
lculates the minimum payment due and 

r register after this information becomes 
ill.

 to be called IntelliCharge®) can be 
 you had IntelliCharge before, Quicken 
 installation to use online account access 
You can hold down the mouse button an
one transaction. If you make a mistake a
again.

4 Click Accept √ Items.

The checked items are added to your reg
from the transaction list in the Downloa

When you update your register, Quicken en
Quicken register and marks all downloaded
(cleared) to indicate that they’ve been poste

To reconcile your online account, see “Start
page 165. 

Using online account access with a cr

Whenever you update your Quicken credit 
service shows you the current balance due f
each billing cycle, the financial institution ca
the due date. The first time you update you
available, Quicken reminds you to pay the b

Note: The Quicken Credit Card (which used
enabled for online account access service. If
automatically updates your account during
via the Internet. 
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 Transactions button in the toolbar.

tion from the pop-up menu under the 

formation from your financial institution 
day, click Get Online Data.

count pop-up menu.

s window, click Payment Info to get more 
card bill.

available at this time. You may have been 
r your financial institution may not 
stitution may not have your statement for 
 institution.
Checking your credit or charge card balance

1 In the Banking area, click the Download

2 If necessary, choose your financial institu
logo on the left side of the window.

3 If you haven’t downloaded transaction in
or your credit or charge card company to

4 Choose a credit card account from the ac

5 (Optional) In the Download Transaction
information about your credit or charge 

If Payment Info is grayed out, no data is 
using the service for less than a month o
support this service. Or your financial in
this month ready yet. Call your financial

This window is updated once a 
month, when your new state-
ment data becomes available. 
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it or charge card balance” on page 197 to 
.

arge Card window.

ne Payment window appears with the 
ices you made in the Pay Credit/Charge 

dow, and then click either Send Now or 

 the amount to pay, and then click Pay.
imum is the minimum payment due 
etermined by your credit or charge 
 company.
 is the total outstanding balance for 
ccount.

er allows you to enter the amount you 
t to pay.
Paying your credit or charge card bill

1 Follow the steps in “Checking your cred
check your credit or charge card balance

2 In the Payment Info window, click Pay.

3 Fill in information in the Pay Credit/Ch
 

4 Click Pay.

If you selected Electronic, the Enter Onli
account and amount set to match the cho
Card window. 

5 Complete the Enter Online Payment win
Put in Out Box. 

Select the account from which 
you would like to make the 
credit or charge card payment.

Select whether the check will be 
Handwritten, Printed, or 
Electronic. (Electronic appears 
only when the account is 
enabled for online payment.)

Select
•Min

as d
card

•Full
the a

•Oth
wan
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ccounts

oney transfers, you can transfer money 
vings account and a checking account) at 
h accounts must be enabled for online 

nt access, you can transmit the instruction 
truction in the Out Box and transmit it to 
nline session. In either case, the money is 
ter you send the instruction.

it card account, it is considered a cash 
edit card account, it is considered a 

 Online menu.

ion from the pop-up menu in the upper 

ose the “from” and “to” account names 

.

r instruction in the Out Box the next time 
ctions in one connection” on page 210 for 
, go on to the next step.
Transferring money between online a

Important: Although Quicken 
adds the transfer to your Quicken 
register after sending the instruc-
tion, transfers typically do not 
take place until the next business 
day. If your account doesn’t 
contain enough money to cover 
the transfer at that time, your 
financial institution will notify 
you that it did not make the 
transfer. You must then delete the 
transfer transaction in your 
Quicken register so your accounts 
show the correct balance. 

If your financial institution allows online m
between two accounts (such as between a sa
the same financial institution. However, bot
account access.

When you transfer money with online accou
immediately or put your transfer money ins
your financial institution during your next o
usually transferred the next business day af

Note: When you transfer money from a cred
advance; when you transfer money into a cr
payment.

1 Choose Transfer Money Online from the

2 If necessary, choose the financial institut
left corner of the window.

3 Enter the amount of the transfer and cho
from the From and To pop-up menus.

4 Click either Send Now or Put in Out Box

If you click Put in Out Box, you’ll see you
you go there. See “Sending several instru
more information. If you click Send Now
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s to the payment processor, along with all 
x. 

t posted balance and the transfer limit for 
ot to allow the transfer.

ne Transmission Summary window and 

dow lists any problems, new or changed 
e “Communicating with your financial 
5 Enter your PIN and click OK.

Quicken sends your payment instruction
other checked instructions in the Out Bo

The online banking service uses your las
your account to determine whether or n

6 Review (and print, if you want) the Onli
click OK.

The Online Transmission Summary win
payments, and status inquiry results (se
institution” on page 207).
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e easiest, most convenient way to pay 
nt instructions (easier than writing a 
 online payment center.

nts from you once you set them up in the 
 the list, create the payment instruction, 

 the Online menu.

yee’s name, address, and phone number. 

s to identify you.

umber, enter your name.
Making online payments

Making online payments with Quicken is th
your bills. You set up payees, create payme
check), and then send the instructions to the

Setting up a payee

Anyone in the U.S. can receive online payme
Payee list. Then you just choose a payee from
and send it to the payment center. 

1 Choose Payments . Online Payees from

2 In the Payees window, click New.

Over time, information you set up 
for payees may change. It’s a good 
idea to check the invoice address 
and account number against your 
Payee list periodically.

3 In the Set Up Payee window, enter the pa

4 Enter the account number the payee use

If you don’t have an account or policy n

5 Click Create.
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ts

, then choose Enter Payment.

, entering a payee that you’ve already set 

ent information, click either Send Now or 

 you for your PIN and sends your 
cessor immediately. Skip to step 7.

s this payment to the list of instructions to 
nding several instructions in one connec-

ore than one payment to send, put each 

t instructions, click the Out Box button in 

 to send at this time, click it to remove the 

s to the payment processor, along with all 
x. 

 for the payment to show up as cleared. 
ocess payments, and your financial insti-
Creating and sending online paymen

1 Choose Payments from the Online menu

Depending on the payment 
processing method used by your 
financial institution, you may 
enter either the Processing Date or 
the Delivery Date. The processing 
date is the date on which payment 
processing begins; the delivery 
date is the date for which delivery 
is scheduled. Quicken tells you if 
the date you enter does not allow 
enough time for processing or 
delivery.

2 Fill in the Enter Online Payment window
up for online payment.

3 When you’ve finished entering the paym
Put in Out Box.

If you click Send Now, Quicken prompts
payment instruction to the payment pro

If you click Put In Out Box, Quicken add
send to your financial institution (see “Se
tion” on page 210). If you are creating m
one in the Out Box.

4 When you have finished all your paymen
the Banking area toolbar.

5 If you see a payment that you don’t want
checkmark.

6 Click Send Now.

Quicken sends your payment instruction
other checked instructions in the Out Bo

Allow a few days after the delivery date
Usually the payee takes a few days to pr
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yments and make the information avail-

ne Transmission Summary window and 

dow lists any problems, new or changed 
e “Communicating with your financial 

ment?

ion, Quicken automatically calculates the 
lead time required for the type of online 
lead time is the number of business days 
instruction to when the payee receives the 
own in the Payee list (choose Payments . 
ken may download new (and possibly 
u send a payment instruction or message 

nic funds transfer (EFT), the processor 
ccount to your payee. This type of 
r two business days.

cessor prints a check that includes the 
y you. The processor then sends the check 
ayment usually has a lead time of four 
ime, depending on the speed of the U.S. 
a.
tution needs a day or two to clear the pa
able.

7 Review (and print, if you want) the Onli
click OK.

The Online Transmission Summary win
payments, and status inquiry results (se
institution” on page 207).

When will the payee receive your pay

When you create an online payment instruct
earliest possible delivery date based on the 
payment the payee is set up to receive. The 
it takes from processing the online payment 
payment. The lead time for each payee is sh
Online Payees from the Online menu). Quic
improved) lead times for this list any time yo
to the payment center.

• If the payee is set up to receive an electro
transfers the money directly from your a
payment usually has a lead time of one o

• If the payee cannot receive EFTs, the pro
account number the payee uses to identif
to the payee via U.S. mail. This type of p
business days. It may take more or less t
Postal Service in the payee's delivery are
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ent, schedule the payment to occur at 
 due date. Examine the next statement 
rocessed the payment and decide how to 
e.

omatically enters a delivery date based on 
e to receive the payment. You can change 
in the next 12 months; however, the payee 
wo earlier than the delivery date because 

receives a payment, they may need 
 credit your account. 

ment instructions on October 
ays before the delivery date, 

 is the lead time for this payee. 

 payment from the payment 
fore the delivery date, 
ng this payee one business 
 date to credit your account. 
Tip: The first time you make an online paym
least four business days before the payment
from the payee to see how promptly they p
schedule your future payments to that paye

Avoid late payment charges! 
Enter a delivery date that is three 
or four days before the due date 
printed on your bill. This allows 
the payee time to process your 
payment by the due date.

When you schedule a payment, Quicken aut
the length of time it should take for the paye
the Delivery Date field to any later date with
may actually receive the payment a day or t
of U.S. Postal Service or courier variations.

Important: Keep in mind that after a payee 
additional time to process the payment and

7

24

17 18 1711 14 15 16

21

October

28

13

22 2320 26

27

3 4 5

6 8 9 10 11 12

25

19

1 2 You send your pay
10, four business d
because four days

The payee receives
processor on or be
October 17, allowi
day before the due

In this example, the due date for 
the payment is October 21.

29

If a payment is due on or soon 
after a holiday such as Columbus 
Day (like the payment in this 
example), make sure you allow at 
least four business days between 
the day you send the instructions 
and the delivery date.

30 31
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your account?

ocessor to receive your online payment 
s transfer (EFT) or mail the paper check. 
y to cover your online payment could be 

 following times:

ssed for delivery

ivery

ur account.

ermine when funds are withdrawn from 
When is the money withdrawn from 

Your financial institution uses a payment pr
instructions and process the electronic fund
Depending on the processor used, the mone
withdrawn from your account at any of the

• several days before the payment is proce

• the day the payment is processed for del

• the day the payment is delivered

• the day the paper check or EFT clears yo

Check with your financial institution to det
your account.
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 delivery date minus the lead time shown 

tion that has been transmitted to your 

m the Online menu.
cel the payment, you must call your finan-
ccording to their stop payment proce-

an instruction to cancel the payment. 
ister, but Quicken marks them 

.

Canceling a payment

You can cancel any online payment until the
in the Payee list. 

1 In your register, select a payment instruc
financial institution.

2 Choose Payments . Cancel Payment fro
• If Quicken tells you it’s too late to can

cial institution to stop the payment a
dures.

• If it is not too late, Quicken prepares 
Canceled payments remain in the reg
CANCELED.

3 Click either Send Now or Put in Out Box
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ancial institution

r the online account access or online 
ail to your financial institution, if they 

incoming e-mail on a regular basis, since 
sor may send you important information 

es or updates to Quicken. When you 
tution, make sure you scroll to the bottom 
ow: if you have new incoming e-mail 
e Online menu to open your mailbox.

t, use the Payment Query command 

tion

ancial institution. Each financial institu-
esponding to electronic mail. To send e-

 pop-up menu.

age.

your e-mail message.

.

Communicating with your fin

If you have a question about your account o
payment services, you can send electronic m
accept e-mail. You’ll also want to check for 
your financial institution or payment proces
via e-mail, such as changes to service charg
receive information from your financial insti
of the Online Transmission Summary wind
you’ll see a message. Choose E-mail from th

If you are inquiring about a specific paymen
instead of the E-mail command.

Sending mail to your financial institu

The e-mail feature lets you 
communicate only with your 
financial institution; it’s not a 
general purpose e-mail service.

If your concern is urgent, telephone your fin
tion has its own policy and time frame for r
mail to your financial institution:

1 Choose E-mail from the Online menu.

2 Choose the financial institution from the

3 Type a subject and the text of your mess

You can include up to 36 lines of text in 

4 Click either Send Now or Put in Out Box
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stitution

on:

 date and the payee has not received your 
he payee, your financial institution, and 

ayment. 

rify the address and your account infor-
orrectly in Quicken. Note the name of the 

find out if the payee has deposited or 

or a copy of the cleared check and send it 
perly credited.
Receiving mail from your financial in

To receive mail from your financial instituti

1 Choose E-mail from the Online menu.

2 Click the Incoming Mail button.

3 Select a message to read it.

Tracing a payment

If two weeks have passed since the delivery
payment, you should check its status with t
possibly with the payment processor. 

1 Call the payee and ask the status of the p

If the payment has not been received, ve
mation to make sure the payee is set up c
person you talk to. 

2 Check with your financial institution to 
cashed the payment. 

If the payment has been deposited, ask f
to the payee so your account will be pro
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 and your financial institution has no 
nt in your register and choose View 
 learn the status of the payment at the 

s been transmitted to your financial insti-

 the Online menu.

r phone calls. 

.

ne services

rror, contact your financial institution 
nt instructions for handling disputed 
ments.

yment, you must call your financial insti-
e Online menu for a list of financial insti-
line payment service is only through the 

ncel your service in writing through 
ee your customer agreement for more 
3 If the payee hasn’t received the payment
record of the payment, select the payme
Payment Status from the Online menu to
payment processor. 

Requesting a payment investigation

Payment Query initiates a 
payment investigation with your 
financial institution. View 
Payment Status sends an inquiry 
to the payment processor.

1 In your register, select a payment that ha
tution.

2 Choose Payments . Payment Query from

3 Add any relevant information from you

4 Click either Send Now or Put in Out Box

Handling disputes and canceling onli

Remember that the payment 
processor simply processes your 
transactions. Your financial insti-
tution is responsible for the 
accuracy of your statement. 

If you think your account data contains an e
directly. Typically, financial institutions pri
transactions on the back of their paper state

To cancel online account access or online pa
tution. Choose Financial Institutions from th
tutions and their phone numbers. If your on
Intuit Online Payment service, you must ca
Checkfree Corporation Customer Service. S
information.
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in one connection

unt access and online payment actions for 
 put the actions in an “out box” for 
 payment, message, or transfer, just click 
 send the instructions, click the Out Box 

can connect to multiple financial institu-
rnet session for each institution. 

Quicken always lists “Request 
new account statement data” 
in the Out Box.

ll checked instructions to the selected 
tement data you have requested. 
Sending several instructions 

You can perform any number of online acco
a single financial institution in Quicken and
Quicken to send all at once. When entering a
Put in Out Box. Then, when you’re ready to
button in the Banking area toolbar.

Once you’re connected to the Internet, you 
tions without having to establish a new Inte

Edit an item by double-
clicking it and making changes 
in the edit window. 

Delete an item by selecting it 
and clicking Delete. 

You can choose not to send 
specific instructions at this 
time. Just click the items you 
don’t want to send to remove 
the checkmark. The items 
remain in the Out Box so you 
can send them later.

When you click Send Now, Quicken sends a
institution. It also gets new mail and any sta
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 Connect, allowing you to download your 
om your financial institution’s web site. If 
l information you’ll need. Depending on 
a user ID and a password or PIN, as well 
m which you can download information.

tion using Web Connect

nnect, follow these steps.

financial institution’s Web site and log in.

ent information. 

nished downloading, your browser will 
. If Quicken does not open automatically, 
wser in Quicken and that your browser is 
“Setting up your browser for Web 
ion about setting up your browser.

ort this information into an existing 
e the appropriate option.

 made in the previous step, Quicken may 
Using Web Connect

Your financial institution may support Web
recent account history directly to Quicken fr
so, they can provide you with the additiona
your financial institution, this may include 
as the URL, or location, of the web page fro

Importing account statement informa

To import your account data using Web Co

1 Using your Internet browser, go to your 

2 Begin downloading your current statem

When your statement information has fi
launch Quicken (if it’s not already open)
check that you have chosen a default bro
set up to import Web Connect data. See 
Connect” on page 212 for more informat

3 Quicken will ask you if you'd like to imp
account, or set up a new account. Choos

4 (Optional) Depending on the choice you
ask you to set up a new account.
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count, Quicken displays your statement 
ns window. From there you can then 
cally.

nect

apping database when downloading data 
nloading Web Connect data into Quicken 
e following values:

.qfx”

browser, it will store the file “Web 
his file, choose Import Web Connect from 

enu, and then choose Internet.

o Advanced: choose User Mode from the 
After you have created or selected an ac
information in the Download Transactio
update your Quicken registers automati

Setting up your browser for Web Con

Before you begin: Quicken 
includes a copy of Microsoft 
Internet Explorer 4.5 on your CD-
ROM. Internet Explorer 4.5 is 
compatible with Web Connect and 
requires no additional configura-
tion steps. 

Some browsers do not use the Mac OS file m
files from the Internet. Before you begin dow
you must set your browser preferences to th

• the file extension is “.qfx”

• the MIME type is “application/vnd.intu

• the file is “Binary data”

• the Mac OS “File Type” is “WBCN”

• the Mac OS “File Creator” is “INTU”

• the file is “Post Processed” with Quicken

Note: If you have not configured your web 
Connect” on the your hard disk. To import t
the File menu.

If you are using Mac OS 8.5,  8.6, or 9

1 Choose Control Panels from the Apple m

2 Check to see that your user mode is set t
Edit menu.
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hange your user mode.

 File Mapping.

x”

en Deluxe 2000.

e WBCN.

scription field

MIME Type field

oing checkboxes.

 the Handle By pop-up menu.

ken Deluxe 2000 as the helper application
If necessary, click Advanced and OK to c

3 Click the Advanced tab.

4 From the scrolling list on the left, choose

5 Click Add.

6 In the Add Mapping window, enter “.qf

7 From the applications list, choose Quick

8 From the File Type pop-up menu, choos

9 Click Show Advanced Options.

10 Enter “Quicken Web Connect” in the De

11 Enter “application/vnd.intu.qfx” in the 

12 Select the Map Incoming and Map Outg

13 Select the Binary Data default format.

14 Choose Processing with Application from

15 If necessary, click Select and choose Quic

16 Click Add.
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counts

ent ways in Quicken. You can enter your 
 account register, or you can set up a 
ur cash transactions there. Both methods 
y are included in reports, graphs, and 
ou account for every penny.

Account to use

nses for Bank account

 or all of Cash account

 credit Cash account

l Cash account
When to use Quicken cash ac

You can record cash transactions two differ
cash transactions in your Quicken checking
separate Quicken cash account and enter yo
let you categorize your cash expenses so the
budgets, and neither method requires that y

Record-keeping preferences 

You want to categorize the income or expe
only a few cash transactions.

You want to keep detailed records of most
your cash transactions.

You prefer to use cash instead of checks or
cards.

You need to track petty cash for your smal
business.
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 Quicken bank accounts

h transactions and treat the rest as miscel-
 to set up a separate cash account. Instead, 
r Quicken bank account as usual.

ellaneous expenses in a Quicken bank 
ash Exp to the transaction. In reports, 

transactions together in the Cash Exp 

ion that you’d like to track more specifi-
ory more specific than Cash Exp to that 
ight include tax-related transactions, 

ing large amounts, or any other cash 
uicken categories.

00 from your checking account and you 
cash ($100 you donated to a charity and 
ng a category like Cash Exp to the entire 
ction to track both the important expenses 
 miscellaneous expenses you don’t want 

gister.

 $200 in this example).
Entering cash transactions in

If you want to track only a few important cas
laneous expenses or income, you don’t need
enter cash deposits and withdrawals in you

When you enter a cash withdrawal for misc
account, assign a catchall category such as C
graphs, and budgets, Quicken lumps these 
category. 

When you enter an important cash transact
cally, split the transaction and assign a categ
transaction. “Important” cash transactions m
transactions that involve receiving or spend
transactions you want to track using your Q

In the example below, you’ve withdrawn $2
want to record how you spent some of that 
$45 you spent for dinner). Instead of assigni
amount, you can split the withdrawal transa
you want to categorize individually and the
to categorize individually.

1 Open your Quicken checking account re

2 Enter a cash withdrawal transaction (for

3 Click the Open Split button (x-E).
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 the first line of the split, replace the $200 
ution ($100), and press Tab to move to the 

en calculates the remainder ($100.00) and 

 the second line of the split, replace the 
ing expense ($45), and press Tab to move 

ken calculates the remainder ($55) and 

 miscellaneous cash expenses to the third 
If you need more information 
about assigning categories to 
transactions, see page 97.

4 Assign the expense category “Charity” to
amount with the amount of your contrib
next line.

When you leave the Amount field, Quick
puts it in the next Amount field.

5 Assign the expense category “Dining” to
$100 amount with the amount of your din
to the next line.

When you leave the Amount field, Quic
puts it in the next Amount field.

6 Assign the expense category you use for
line of the split.

7 Click Record to record the transaction.

When you leave the Amount 
field in the second line of the 
split, Quicken calculates the 
final remainder and puts it in the 
third line of the split. If you 
don’t want to track this amount, 
enter the category you use for 
miscellaneous cash expenses.

Click the Open Split button to 
open the split.
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 cash accounts 

uicken bank accounts. If you’ve used a 
ost of what you need to know to use a 
se a Quicken cash account, see the table 

unt

r cash transactions and enter each one as 
ers several items that you want to catego-
 you enter it in the cash account register. 

go to the Banking area and choose your 
nu in the toolbar.

elp Topics and select

es?
Setting up and using Quicken

Quicken cash accounts are very similar to Q
Quicken bank account, you already know m
cash account. If you aren’t sure whether to u
on page 215. 

Entering cash expenses in a cash acco

Save your receipts and other records of you
a separate transaction. If one cash receipt cov
rize individually, split the transaction when

To open the register for your cash account, 
cash account from the Registers pop-up me

For step-by-step help, go to Cash in Quicken H

How do I set up a cash account?
How do I track my cash & ATM expenditur
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rize, the more accurate your income and 
 are cash transactions you don’t want to 
n can enter an adjustment transaction to 
s cash expenses when you update your 

nce” on page 221.

cash withdrawal 
nsfer to the cash 
 account” on 
 account is in the 

ive columns instead 
icken bank account 
chases and the 
 of cash on hand. 
The more transactions you enter and catego
expense reports and graphs will be. If there
track, you don’t need to enter them. Quicke
cover the total amount of your miscellaneou
cash balance. See “Updating your cash bala

The cash account received this $120 when a 
was recorded in the savings account as a tra
account. (See “Transferring cash into a cash
page 220.) Note that the name of the savings
Category field.

The Payee or Description field 
shows where you made the 
cash purchase.

A cash account register has Spend and Rece
of Payment and Deposit columns like a Qu
register. Use the Spend column for cash pur
Receive column for increases in the amount

Categorize your cash transac-
tions if you want them catego-
rized in reports and graphs.
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unt, deposit money and get cash back, or 
ccount, you should enter a transfer trans-
oney into your cash account (see “Trans-
03).
Transferring cash into a cash account

When you withdraw cash from a bank acco
get a cash advance from any other Quicken a
action in the source account to transfer the m
ferring money between accounts” on page 1

When you withdraw cash from 
a Quicken bank account, record 
a transfer from the bank 
account to the cash account.
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e way you reconcile a Quicken bank 
n purpose of updating the balance in a 
accurate without having to enter every 
se cash transactions you specifically want 
balance, Quicken enters an adjustment 
r miscellaneous cash expenses.

count from the Registers pop-up menu in 

es menu.

window.

nt transaction in the register.

ated on or before the date of the balance 

 click OK, Quicken enters 
adjustment transaction 
es the balance in the 
 match the amount of 
ave on hand.
Updating your cash balance 

You don’t need to balance a cash account th
account with your bank statement. The mai
cash account is to keep the account balance 
cash transaction. You need to enter only tho
to track. Then, when you update your cash 
transaction to cover the total amount of you

1 In the Banking area, choose your cash ac
the toolbar.

2 Choose Adjust Balance from the Activiti

3 Enter information in the Adjust Balance 

4 Click OK to record the balance adjustme

Quicken marks all transactions that are d
adjustment as reconciled.

Enter the amount of cash you 
have on hand today. Quicken 
compares this amount with the 
current balance in the account.

When you
a balance 
that chang
account to
cash you h

(Optional) Enter a category for 
the adjustment transaction.
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ard accounts

arge cards, lines of credit, or equity lines. 
ays, depending on your record-keeping 

rmine the best way to use Quicken.

Actions to take

Record the check that pays the bill in 
your Quicken bank account. Split the 
transaction if you want to categorize 
specific charges. (This method doesn’t 
let you track an outstanding balance, 
however.) See “Entering credit card 
transactions in Quicken bank accounts” 
on page 225.

Enter and categorize each transaction 
from your charge slips as you make 
purchases.The credit card register 
shows your balance and the available 
credit remaining on the card. See 
“Setting up and using credit card 
accounts” on page 227.
Ch

When to use Quicken credit c

You can use Quicken to track credit cards, ch
You can record transactions three different w
preferences. Use the following table to dete

Record-keeping 
preferences Account to use

You want to keep 
records of only a 
few individual 
transactions and 
you always pay 
your bill in full.

Bank account

You sometimes 
carry a balance 
rather than paying 
your bill in full 
every month and 
you want to know 
your outstanding 
balance at all times.

Credit card 
account
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f a major credit card company, they are 
e with a debit card, the money is 
 written a check. Use a bank account for 
ount.

Enter and categorize the transactions 
you want to track (either from charge 
slips or from your monthly statement), 
and then create one transaction to cover 
all the charges you don’t want to take 
the time to enter. See “Setting up and 
using credit card accounts” on page 227.

Use online account access to update 
your credit card or charge card account 
automatically every month. See “Using 
online account access with a credit or 
charge card account” on page 196.

Actions to take
Ch

Although debit cards often carry the name o
not credit cards. When you make a purchas
withdrawn from your account as if you had
debit card transactions, not a credit card acc

You want to keep 
records of some or 
all of your 
transactions.

Credit card 
account

You want to keep 
track of your 
transactions, but 
you don’t have time 
to enter them 
manually.

Credit card 
account with 
online account 
access

Record-keeping 
preferences Account to use



apter 11, Tracking your credit cards    225

ons in Quicken bank 

ave only a few credit or charge card 
ecord these expenses in the Quicken bank 
 track some or all of your credit or charge 

ies in a split transaction when you write a 

tatement lists transactions for a gift and 
 which you don’t want to keep a record. 

edit or charge card bill in either the Write 

 the first line of the split.

 first line of the split, replace the transac-
ith the amount of the gift you bought 
xt line.

en calculates the remainder ($373.74) and 
Ch

Entering credit card transacti
accounts

If you always pay your bill in full and you h
expenses you want to track, it’s easy to just r
account from which you pay the bill. You can
card purchases by entering multiple categor
check to pay your bill.

In this example, your credit or charge card s
clothing, plus some miscellaneous items for
The total bill is $427.86.

1 Enter a payment transaction to pay the cr
Checks or Register window.

2 Click the Open Split button (x-E).

The total amount of the check appears in

For more information about 
assigning categories to transac-
tions, see page 97.

3 Assign the expense category Gifts to the
tion amount ($427.86 in this example) w
($54.12), and press Tab to move to the ne

When you leave the Amount field, Quick
puts it in the next Amount field.
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 to the second line of the split, replace the 
lothing you bought ($237.07), and press 

en calculates the remainder ($136.67) and 

 miscellaneous expenses to the third line 

 uncategorized, Quicken lumps them as 
Ch

Tip: You can use QuickMath to 
calculate split amounts quickly; 
see “Calculating transaction 
amounts with QuickMath” on 
page 116.

4 Assign the expense category “Clothing”
$373.74 amount with the amount of the c
Tab to move to the next line.

When you leave the Amount field, Quick
puts it in the next Amount field.

5 Assign the expense category you use for
of the split.

If you leave the miscellaneous purchases
“Other” in reports graphs.

6 Click Record to record the transaction.

Quicken includes these expenses 
for gifts and clothing when you 
create any report or graph based 
on categories.

When you leave the Amount 
field in the second line of the 
split, Quicken calculates the 
remainder and puts it here. This 
is the amount you spent for 
miscellaneous items.
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rd accounts

ar to Quicken bank accounts. If you’ve 
now most of what you need to know to 

whether to use a Quicken credit card 

tions

r you can:

 items and enter the transactions as they 
d provides you with your current credit 

o lets you double-check your charges 

ement and enter the transactions from the 
n’t need to keep track of your balance 

arge card transaction without having to 
updating your credit or charge card infor-

uicken Help Topics and select
Ch

Setting up and using credit ca

Quicken credit card accounts are very simil
used a Quicken bank account, you already k
use a credit card account. If you aren’t sure 
account, see the table on page 223. 

Entering credit or charge card transac

To enter transactions in a credit card registe

• Save your charge slips when you charge
occur throughout the month. This metho
or charge card balance at all times. It als
against those listed on your statement.

OR

• Wait until you receive your monthly stat
statement. This method is easy if you do
throughout the month.

Note: To keep a record of every credit or ch
enter all the transactions yourself, consider 

For step-by-step help, go to Credit Cards in Q

How do I set up a credit card account?
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ss feature. For more information, see 
r charge card account” on page 196.

t, go to either the Banking or Assets/Debt 
 Registers pop-up menu in the toolbar.

 Credit 
t less the Balance 

harge, finance 
lumn for bill 
Ch

mation using Quicken’s online account acce
“Using online account access with a credit o

To open the register for a credit card accoun
area and choose the account name from the

Categorize your charges if 
you want them categorized 
in reports and graphs.

This transfer is recorded 
automatically when you 
pay the bill from a Quicken 
bank account; see “Paying 
your credit or charge card 
bill” on page 232.

The Clr column would 
show a bold checkmark ( � ) 
if you had already recon-
ciled this transaction with 
your statement.

Balance Today is your outstanding balance.
Remaining is your credit limit for the accoun
Today amount.

Use the Charge column for purchases you c
charges, and other fees. Use the Payment co
payments or credits to your account.
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ontains accurate information, you should 
harge card statement. Reconciling a credit 
eral Quicken features:

e you make, Quicken can record a single 
e charges you don’t want to record 

nce charge transaction.

redit or charge card payment in your 

 with your credit or charge card statement 
ccount with your bank statement. Mark 
as cleared and enter any missing transac-

rd account name from the Registers pop-

.

arge card statement in the Reconcile 
Ch

Reconciling a credit card account

To make sure that your credit card account c
reconcile it each month with your credit or c
card account lets you take advantage of sev

• If you don’t want to enter every purchas
adjustment transaction that covers all th
individually.

• Quicken can automatically record a fina

• Quicken can automatically record your c
Quicken bank account.

You reconcile a Quicken credit card account
much as you reconcile your Quicken bank a
transactions that appear on your statement 
tions for which you want to keep records.

1 In the Banking area, choose the credit ca
up menu in the toolbar.

2 Click the Reconcile button in the toolbar

3 Enter information from your credit or ch
Startup window.
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ion (if you entered a Finance Charge 
 Reconcile window.

, the Finance Charge transaction is not 
o enter it again when you return to recon-

ncile window that matches a transaction 
 click it to mark it as cleared.
Ch

4 Click Start.

Quicken adds a Finance Charge transact
amount) to the register and displays the

Note: If you click Cancel instead of Start
recorded in the register and you’ll need t
ciling the account.

5 When you find a transaction in the Reco
on your credit or charge card statement,

Enter any finance charge from 
the statement, the statement 
date, and an expense category 
for the finance charge amount. If 
you enter a finance charge, 
Quicken automatically records a 
transaction for that amount in 
the register.

Enter the ending balance (or 
“balance due”) and statement 
date from your credit or charge 
card statement.
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nt that are missing from the list of unrec-
ion and enter them now in the register.

hese missing charges into a single adjust-
iling your statement. See “Letting 
175.

 error, double-click the transaction in the 
e register.

s cleared, look at the Difference this State-

ally the same as reconciling a bank 
econciliation” on page 168.
Ch

6 If you find transactions on your stateme
onciled transactions, click New Transact

Or, if you prefer, Quicken can combine t
ment transaction when you finish reconc
Quicken adjust for differences” on page 

7 If you find a transaction that contains an
Reconcile window to correct it now in th

8 When you have finished marking items a
ment amount.

Reconciling a credit card account is basic
account at this point. See “Completing r

Click a transaction to mark it as 
cleared. You can correct a mistake in 
the register by double-clicking the 
transaction in the Reconcile window 
to go to the register with that trans-
action selected.

As you click cleared transactions to 
check them off, Quicken displays 
the difference between the total of 
the cleared transactions and the 
Ending Balance you entered.

When the Difference this Statement 
amount is zero, you’ve successfully 
reconciled the account.
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uicken asks if you want to pay your 
 want Quicken to create a transaction to 

ill window. See “Paying your credit or 

 charge card statement, Quicken can write 
 in your check register, or record a trans-
yment.

ount from which you plan to pay the bill 
ck manually, print a check with Quicken, 
sing online payment.*

ith online payment, see “Paying your 
Ch

9 When you’ve completed reconciliation, Q
credit or charge card bill. Click Yes if you
pay the bill.

Quicken displays the Pay Credit Card B
charge card bill” next.

Paying your credit or charge card bill

As the final step in reconciling your credit or
a check to print, record a handwritten check
action you can transmit electronically for pa

1 Select the name of the Quicken bank acc
and specify whether you will write a che
or transmit the payment electronically u

*If you want to pay your bill electronically w
credit or charge card bill” on page 198.
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ister or the Write Checks window.

lects the payment transaction in the Write 

 printable check), and change the amount 
y your bill in full. Then click Record.

ation and uses it the next time you make 

If the bank account you 
selected is enabled for online 
payment, see “Paying your 
credit or charge card bill” on 
page 198.
Ch

2 Click Pay to enter the payment in the reg

After Quicken records the payment, it se
Checks window or the register.

3 Enter a payee, memo, and address (for a
of the transaction if you don’t want to pa

Quicken remembers the payment inform
a payment on this credit or charge card.

Select Handwritten if you will 
write the check by hand or 
Printed if you will print the 
check with Quicken (see 
“Printing Intuit checks” on 
page 133). If the bank account 
you selected is enabled for 
online payment, you also have 
the choice to pay electronically.

Select the account from which 
you want to make the payment. 
Quicken records the payment in 
this account as a transfer to the 
credit card account.
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12 Tracking assets
liabilities
When to use Quicken asset and liability acc

Setting up and using asset and liability acco
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d liability accounts

t you owe, and the difference between 

ou can track such things as loan balances, 
essions, and the cost basis of your home. 
nts can track capital equipment, accounts 

 up accounts for all your assets and liabil-
 reports and graphs to give you an 

.

t your net worth—even if you don’t track 
o open Net Worth Analysis, go to the 
n in the toolbar.

s represent only part of your total assets. 
 you can use to track your other assets: 
al fund accounts. Use Quicken’s portfolio 
ch as stocks, bonds, mutual funds, and 
e Chapter 14, Tracking investments, on 
ck the following kinds of assets:
Chapt

When to use Quicken asset an

Assets are what you own, liabilities are wha
them is your net worth.

With Quicken asset and liability accounts, y
the value of your car or other personal poss
For a small business, asset and liability accou
receivable, and accounts payable. If you set
ities, Quicken can include them in net worth
accurate view of your total financial picture

You can use Net Worth Analysis to figure ou
everything you own and owe in Quicken. T
Planning area and click the Net Worth butto

When to use Quicken asset accounts

The balances in your bank and cash account
Quicken has three additional account types
asset accounts, portfolio accounts, and mutu
and mutual fund accounts to track assets su
other investments that fluctuate in value (se
page 270). Use Quicken asset accounts to tra
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t account. Then, when you receive a 
s you normally would, but create a 
ount of the principal payment so the asset 
you.
is process by helping you set up an asset 
nd then calculating the principal and 
 loans and mortgages, on page 246.

 improvements over the years. Use the 
 balance for the account, and then record 
ake it (generally as a transfer from the 
nt). Many types of improvements add to 
ses for asset accounts” on page 240).

entory and use it to track furnishings, 
ent, jewelry, and other property you keep 
hase date and price as a transaction in the 
 or stolen, your records can help to settle 
ack the contents of your home in more 

r dependent care expenses, you can use 
racking the amounts withheld from your 
tering your paycheck” on page 110 for 

r paycheck to another account.

s acquired and track depreciation as it 
Chapt

Type of asset Sample uses for asset accounts

Loan notes you hold You can track money you’ve lent in an asse
payment, deposit it in your bank account a
transfer to the loan asset account for the am
account tracks the amount that is owed to 
Tip: Quicken’s loan feature can simplify th
account and a loan payment transaction, a
interest amounts. See Chapter 13, Tracking

Home cost basis Set up an asset account to track your home
purchase price of the home as the opening
each improvement in the register as you m
account where the money was actually spe
the cost basis of your home (see “Sample u

Contents of your home Create an asset account for your home inv
major appliances, audio and video equipm
in your home. Enter each item with its purc
asset account. If your property is damaged
your claim with the insurer. You can also tr
detail with Quicken Home Inventory.

Prepaid medical or dependent 
care expenses

If you set aside pretax dollars for medical o
an asset account as a holding account for t
paycheck. See “Sample split transaction: en
information about transferring part of you

Capital equipment Track the value of capital equipment as it i
occurs.
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s.
Chapt

Accounts receivable Keep up-to-date accounts receivable record

Type of asset Sample uses for asset accounts
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ts

ent part of your liabilities. Use Quicken’s 
ies:

 of money you’ve borrowed, such as car 
 Then, when you write a check to make a 
liability account for the amount of the 
s balance always shows the amount you 

is process by helping you set up an asset 
nd then calculating the principal and 
 loans and mortgages, on page 246.

xes and income taxes payable. When you 
sfer the payroll taxes portion of each 

of the split transaction. This technique 
mount that’s due for payroll taxes.

for your small business.

ke liability accounts, credit card accounts 
 accounts” on page 227.
Chapt

When to use Quicken liability accoun

The balances due on your credit cards repres
liability accounts to track these other liabilit

Type of liability Sample uses for liability accounts

Loan balances You can use liability accounts to keep track
loans, home equity loans,* and mortgages.
loan payment, create a transfer to the loan 
principal payment so the liability account’
owe on the loan.
Tip: Quicken’s loan feature can simplify th
account and a loan payment transaction, a
interest amounts. See Chapter 13, Tracking

Accrued liabilities Track accrued liabilities, such as payroll ta
do the payroll for your small business, tran
check to a payroll liability account as part 
makes it easy for you to keep track of the a

Accounts payable Keep up-to-date accounts payable records 

*If you have a home equity line of credit, use a credit card account to track it. Unli
track the amount of credit available to you. See “Setting up and using credit card
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d liability accounts

y similar to Quicken bank accounts. If 
lready know most of what you need to 
ou aren’t sure whether to use a Quicken 
uicken asset accounts” on page 235 or 
 page 238. 

bility account

ility account in two ways:

 you can enter the appreciation (increase 
n (decrease in value) of capital equipment 
ter.

r accounts. When you enter a transaction 
n asset or liability, Quicken can record the 
ility account automatically. For example, 
ter and you track your computer equip-
rize the transaction in your checking 
puter equipment asset account. Quicken 

 account as an increase in the value of the 

 Quicken Help Topics and select

t?
Chapt

Setting up and using asset an

Quicken asset and liability accounts are ver
you’ve used a Quicken bank account, you a
know to use an asset or liability account. If y
asset or liability account, see “When to use Q
“When to use Quicken liability accounts” on

Entering transactions in an asset or lia

You can enter transactions in an asset or liab

• Enter transactions directly. For example,
in value) of an antique or the depreciatio
as a transaction in an asset account regis

For more information about trans-
fers, see “Transferring money 
between accounts” on page 103.

• Enter transactions as transfers from othe
in another Quicken account that affects a
payment as a transfer to the asset or liab
if you write a check to purchase a compu
ment in an asset account, you can catego
account register as a transfer to your com
records a parallel transaction in the asset
account.

For step-by-step help, go to Assets & Debt in

How do I set up an asset or liability accoun
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 home, it is important to keep track of all 
cord can save you money when you sell 
art of the home’s cost basis and thus 
re taxed.

or $100,000 in 1993. To track the value of 
nt called “House” with the $100,000 
r the next few years you made improve-
detector for $17.29, remodeled your 
throom for $5,350.00. In 1997 you sell the 

eem that your taxable gain is $25,000 (the 
g prices). But your cost basis is actually 
se price and your improvements), so the 
.96.

ecrease the 
or amounts that 
Chapt

Sample uses for asset accounts

Tracking home improvements. If you own a
the improvements you make to it. Such a re
the home, because improvements become p
reduce the amount of profit on which you a

To simplify this example, we’ve 
ignored the costs of buying and 
selling the house, but you should 
include them in your cost basis.

For example, suppose you bought a home f
the home, you set up a Quicken asset accou
purchase price as the opening balance. Ove
ments to your home: you installed a smoke 
kitchen for $6,387.75 and remodeled your ba
home for $125,000. At first glance it might s
difference between your purchase and sellin
$111,755.04 (the sum of your original purcha
gain on which you owe taxes is only $13,244

These purchase transactions 
were entered as transfers when 
the checks were written from a 
Quicken bank account named 
“Joint Checking.”

Use the Decrease column for amounts that d
value of the asset; use the Increase column f
increase the value of the asset.

This purchase transaction was 
entered as a transfer when it 
was recorded in a Quicken 
credit card account named 
“Line of Credit.”
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 up an asset account with an opening 
ction for the current value of each piece of 
y and sell equipment, create transfer 

uicken account where you record the 
 checking or credit card account).

ile you own it, create an expense category 
cord the depreciation amount.

ed directly in the 
e Decrease 

the account.
Chapt

More information about using 
Quicken for small business 
finances is in the onscreen 
Business User’s Guide in 
Quicken Deluxe. 

Tracking the value of capital equipment. Set
balance of zero, and create a separate transa
equipment (asset) you own. Then, as you bu
transactions to the asset account from the Q
purchase or sale transaction (for example, a

If you want to depreciate an asset’s value wh
for depreciation and enter transactions to re

The purchase and sale of equip-
ment were recorded in a 
Quicken bank account as trans-
fers to this asset account. The 
amount of the purchase is in the 
Increase column because it 
increases the value of the 
account. The amount of the sale 
is in the Decrease column 
because it decreases the value of 
the account.

These depreciation transactions were record
asset account register. The amounts are in th
column because they decrease the value of 

These transactions are for 
existing equipment. The current 
value is in the Increase column 
because it increases the value of 
the account.



er 12, Tracking assets and liabilities    242

uicken simplifies the process of tracking a 
 and mortgages, on page 246, for informa-
mortized loans.

ability account to track accrued liabilities 
liability account’s current balance always 

recorded in the 
 account. The 

t decreases the 

 payroll taxes 
Chapt

Sample uses for liability accounts

Tracking amortized loans and mortgages. Q
loan balance. See Chapter 13, Tracking loans
tion about using liability accounts to track a

Tracking accrued liabilities. You can use a li
such as taxes withheld but not yet paid. The 
shows the amount of tax owed as of today.

This transaction is a quarterly tax payment 
checking account as a transfer to the liability
amount is in the Decrease column because i
total amount owed.

The Opening Balance shows the 
amount of Social Security tax 
owed at the time you set up the 
account.

Each month the employer 
records a transaction for the 
employee’s paycheck in a 
checking account. This transac-
tion is a transfer from that 
paycheck transaction. The 
amount is the sum of the Social 
Security tax withheld from the 
paycheck plus the employer’s 
contribution. The amount is in 
the Increase column because it 
increases the total amount 
owed.

This is a liability account for Social Security
collected for a household employee.
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ility account

ty account the same way you reconcile a 
ment. Instead, you may want to mark 
own an asset or when you no longer owe 
values of assets and liabilities that are still 

ive as assets or liabilities; in other words, 
. If you sell an asset listed in an asset 
 is no longer part of your net worth and 
orts that show the total value of your 
 want to delete the item from the account 
e it in a report in the event of an audit.

u can restrict reports to show uncleared 
s to appear. To mark an individual asset 
oth the transaction for the purchase of the 
tem as cleared (as well as any other trans-
tion). To mark a transaction as cleared, 
 use the Find command (x-F) to locate 
Chapt

Updating the value of an asset or liab

You don’t need to balance an asset or liabili
Quicken bank account with your bank state
transactions as cleared when you no longer 
a liability. You may also want to update the 
open.

Closing assets or liabilities

Closed items are those that are no longer act
they no longer contribute to your net worth
account (an antique, for example), that item
you probably don’t want to include it in rep
assets and liabilities. However, you may not
altogether, because you may want to includ

If you mark your closed items as cleared, yo
items only when you don’t want those item
as closed, open the asset account and mark b
item and the transaction for the sale of the i
actions that affect its value, such as deprecia
select it and click in the Clr column. You can
related transactions.
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 account

r liability account, make an adjustment to 
t account for real estate you own, you can 
 the value of the account to reflect the 

es menu.

window.

nt transaction in the register.

ated on or before the date of the balance 

 click OK, Quicken adds 
adjustment transaction 
es the balance in the 
 match the value you 
r the asset.

) Enter a category for the 
t transaction.
Chapt

Updating the balance in an asset or liability

If you want to update the value of an asset o
the balance. For example, if you have an asse
tell Quicken to enter a transaction to update
current value of the property.

1 Open the asset account register.

2 Choose Adjust Balance from the Activiti

3 Enter information in the Adjust Balance 

4 Click OK to record the balance adjustme

Quicken marks all transactions that are d
adjustment as reconciled.

Enter the current value of the asset 
(in this example, a piece of 
property in an account named 
“Vacation Lot”). Quicken 
compares this amount with the 
current balance in the account.

When you
a balance 
that chang
account to
entered fo

(Optional
adjustmen
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Chapt
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r paid off, with each payment you make. 
interest you’ve paid and the loan’s 

ly, you know how tedious it can be. 
oportion of interest and principal, you 
or every payment—even if you pay the 
 can automate those calculations for you.

o items that work together to track your 
l account to track the loan balance. If 
 borrower, then the principal account is a 

e. If you are the lender, the principal 
oney that is owed to you.

loan, enter the loan payment transaction 
ou’re making the payment (a checking 
tomatically calculates the correct propor-

 this case, a liability account) to 
he loan (the Balance Today).
Chapte

How Quicken tracks a loan

Quicken can track how a loan is amortized, o
Quicken keeps track of both the amount of 
outstanding principal balance. 

If you’ve tracked loan amortization manual
Because each payment covers a different pr
have to calculate the interest and principal f
same total amount every time. But Quicken

If you have a Web browser, the 
Quicken Financial Network can 
help you find the cheapest loan. 
Choose To the Web . Mortgage 
Center from the Online menu. 

When you set up a loan, Quicken creates tw
loan: a special loan payment and a principa
you’re tracking a loan for which you are the
liability account that tracks what you still ow
account is an asset account that tracks the m

When it’s time to make a payment on your 
in the register for the account from which y
account in the example below). Quicken au

Quicken creates a loan payment 
and adds it to the Loan list.

Quicken also creates a principal account (in
keep track of the outstanding principal on t
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he principal amount to pay down the 

ut “what-if” scenarios for loan planning 
 how much your loan payments will be or 
sing the financial planning calculators” 

n in the checking account 
erest and principal amounts.
Chapte

tion of interest and principal and transfers t
balance in the liability account for the loan.

Tip: Quicken’s loan calculator lets you try o
before you set up the loan. You can estimate
how much you can afford to borrow. See “U
on page 443.

To make a loan payment, select it 
in the Loan list and click Use.

Quicken enters the loan payment transactio
register and automatically calculates the int

Quicken transfers the principal 
portion of the payment to the loan 
principal account—which 
decreases the balance on the loan.

The Balance Today in the 
principal account register shows 
how much you currently owe (or 
are owed) on the loan.



r 13, Tracking loans and mortgages    249

ion about the loan and the lender (or the 
en creates both a loan payment and a 

rmation. 

 loan features such as variable interest 
ization. Refer to the section that begins on 
r loan.

s button in the toolbar.

ton (x-N).

ach of the questions as it applies to your 

p the loan on the basis of your answers to 
Chapte

Setting up a loan

When you set up a loan, you enter informat
borrower, if you are the lender). Then Quick
principal account for you based on this info

Tip: Quicken can handle a variety of special
rates, balloon payments, and negative amort
page 258 if any special features apply to you

1 In the Assets & Debt area, click the Loan

2 In the Loans window, click the New but

3 In the Loan Interview window, answer e
loan.

Quicken determines the best way to set u
the questions.
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window.

u’ve already made payments, Quicken 
up from the day the loan started or from 
llowing information to help you decide.
you need to know your payment amount, 
the total number of payments, the annual 
t of the loan.
 next scheduled payment, you need to 
e of your next payment, the annual 

 requires a final balloon payment 
cified number of regular 
 click Yes (and see “Handling 
pes of loans” on page 258).

has an interest rate that is constant 
of the loan, click Fixed. If it has a 
n change, click Variable.

n users:
n originated in the United States, 
 it originated in Canada and is 
ed semi-annually, click Canadian.

you’ve made any prepayments, you must 
t, so Quicken will not give you any other 
Chapte

4 Click Continue to open the Set Up Loan 

If you are setting up a loan for which yo
may ask you whether you want to set it 
the next scheduled payment.* Use the fo
• To set up the loan from its beginning, 

the date you made the first payment, 
interest rate, and the original amoun

• To set up the loan starting with your
know your payment amount, the dat

If you’ve already made 
payments on this loan, click Yes. 
If this is a brand new loan and 
you haven’t made any 
payments, click No.

If you’ve made any prepayments 
(extra amounts that went toward 
reducing your principal 
balance), click Yes. If you haven’t 
made any payments on this loan, 
this question is dimmed.

If this loan
after a spe
payments,
different ty

If this loan 
for the life 
rate that ca

 Canadia
If your loa
click US. If
compound

*If your loan has a variable interest rate or if 
set it up as if it begins with the next paymen
option.
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an balance or how many payments you 

ower, if you are the lender).

 the name for the loan in the Loan list and 
saction (or deposit transaction, if this is a 

tion in the Set Up Loan window.*

ths for Quicken to correctly calculate the 
n.

For this loan, the interest paid 
is going to be tracked with 
the “Mort Int” category, and 
the principal balance is going 
to be tracked in the Mortgage 
liability account.
Chapte

interest rate, and either the current lo
have left to make.

Entering loan information

1 Enter the name of the lender (or the borr

Quicken uses the name you enter here as
as the payee for your loan payment tran
lending loan).

2 Fill in the remainder of the Loan Info sec

*The loan term must be longer than 12 mon
principal, interest, and payment informatio

If you enter an amount for “PMI, 
property taxes, etc.,” Quicken 
opens the Preview Payment 
window when you click Create 
so you can categorize the non-
loan portion of the payment. See 
“Previewing the loan payment 
transaction” on page 253.
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re how to fill in a field. See “Handling 
ou have a variable-rate or zero-interest 
n or a balloon payment.

.

e “PMI, property tax, etc.” field, Quicken 
ow so you can categorize that expense.

unts, Quicken takes you to the Calendar 
dule your loan payment, or simply adds 

Select this checkbox if you 
want Quicken to set up your 
loan payment as a scheduled 
transaction in the Calendar. very-

re you 
Chapte

Use the table on page 253 if you aren’t su
different types of loans” on page 258 if y
loan or a loan with negative amortizatio

3 Select the appropriate Payment Options

4 Click Create to create the loan.

If you’ve entered a non-loan amount in th
takes you to the Preview Payment wind

If you haven’t entered any non-loan amo
if you’ve indicated that you want to sche
your loan to the Loan list.

Click Preview Payment to confirm that e
thing looks the way you expect it to befo
finish creating the loan.

Select this checkbox if any of the 
following apply: 
•You want to review or change 

payment information each time you 
recall the loan payment.

•The loan has a variable interest rate 
or negative amortization.

•You plan to make prepayments of 
principal either occasionally or in 
varying amounts.
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tion

n Existing loan 
(starting with 
first payment)

Existing loan 
(starting with 
next payment)

 total payment that goes toward principal 
o not include any other amounts such as 
xes that may be included in the total 

in your regular payment that do not go 
al or interest. These may include insurance, 
, and so on.

ill 
t 

The date you 
made your first 
payment.

The date you will 
make your next 
payment.

 make scheduled payments on this loan.

er 
ou 
is 

The total number 
of payments for 
this loan, 
including the 
ones you’ve 
already made.
Chapte

Previewing the loan payment transac

Field in Set Up Loan 
window Brand new loa

Principal + interest The part of the
and interest. D
insurance or ta
payment.

PMI, property tax, etc. Any amounts 
toward princip
property taxes

Date of first payment The date you w
make your firs
payment.

Date of next payment

Frequency How often you

Total # of payments The total numb
of payments y
will make on th
loan.
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The number of 
payments you 
have already 
made.

The number of 
payments 
remaining to pay 
off the loan.*

nual interest rate you are paying.

e expense category you want to use to track 
id on this loan (or, if you are the lender, the 
ry you want to use to track the interest 

e account you want to use to track the loan 
oan principal account must have a different 

rincipal account for the loan before you set 
ter the name of the existing principal 

n Existing loan 
(starting with 
first payment)

Existing loan 
(starting with 
next payment)
Chapte

# paid

Payments remaining

Annual or Current 
interest rate

The current an

Interest category The name of th
the interest pa
income catego
earned).

Principal account The name of th
balance. Each l
name.
If you set up a p
up the loan, en
account.

Field in Set Up Loan 
window Brand new loa
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tion to confirm that everything looks the 
 the loan, click the Preview Payment 

ntered non-loan amounts in the “PMI, 
to the Preview Payment window when 
 extra amounts. You’ll also need to 

t The original 
amount of the 
loan

The balance 
remaining to be 
paid on the loan.*

change the amount Quicken calculates for 
fields if it is not the exact amount you owe 
d to you).

fter which your balloon payment is due. 
 different types of loans” on page 258 for 
ion on what to enter if you see this field.

icken calculates the number of payments 
 entered as the payment amount and the 

n Existing loan 
(starting with 
first payment)

Existing loan 
(starting with 
next payment)
Chapte

If you want to preview the payment transac
way you expected before you finish creating
button in the Set Up Loan window. If you e
property tax, etc.” field, Quicken takes you 
you click Create so you can categorize those

Loan amount The full amoun
of the loan.

Current balance

Note: You can 
either of these 
(or that is owe

Balloon on payment #
(only appears if you’ve 
said there is a balloon 
payment)

The payment a
See “Handling
more informat

* If you know the current loan balance, Qu
you’ve already made based on what you
interest rate.

Field in Set Up Loan 
window Brand new loa
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the payment electronically or by printing 

interest only, you probably won’t need to 
ayment window. 

ur loan payments, 
nd Quicken puts this 
lit transaction.

Click Handwritten if you will write 
the checks by hand.

If you are set up to make online 
payments with Quicken, you will 
also see an option for transmitting 
the payments electronically (see 
“Making online payments” on 
page 201).

d for 
o 
t, use 
e 
ld.
Chapte

preview your payment if you want to make 
a check with Quicken. 

If your loan payments are for principal and 
edit any of the information in the Preview P

If any non-loan amounts are included in yo
your total payment shows up in the $ field, a
additional amount in the third line of the sp

Quicken automatically puts the 
category you entered for Interest 
Category and the account you 
entered for Principal Account in 
the first two lines of the split.

The interest and principal 
amounts are for the next sched-
uled payment only. Quicken 
calculates the correct amounts 
for interest and principal each 
time you make a payment.

Quicken enters the name of 
the lender here for a loan 
where you are the borrower.

If you want to print checks 
with Quicken to make your 
payments, click Printed and 
enter the lender’s address.

Enter a category for the amount you entere
“PMI, property tax, etc.” here. If you want t
assign more than one category to the amoun
a different line for each category and put th
amount for each category in the Amount fie
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a smaller Preview Payment window like 
Chapte

If you are the lender for the loan, you’ll see 
this one.

Quicken enters the name of the 
borrower here.

If you are the lender for the 
loan, the principal account is 
an asset account instead of a 
liability account, and Quicken 
creates a deposit transaction 
instead of a payment when 
you record the regular 
payment transaction.
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ans

f loans. The table below shows what 
Set Up Loan window for several different 
e than one special feature (for example, a 
n), follow all the guidelines that apply.

 a final balloon payment, do not use the 
 entire amount as interest when you make 

is information

your next payment that goes toward 
terest

e that will apply to your next payment

kbox; then, whenever the interest rate 
n enter the new interest rate and payment 
ou recall the loan payment transaction

payments you would make if you were 
rincipal for the full amortization period

payments you have already made

payments that would remain if you were 
rincipal for the full amortization period
Chapte

Handling different types of lo

Quicken can handle many different kinds o
special information you need to enter in the 
types of loans. If your loan incorporates mor
variable-rate loan with negative amortizatio

Note: If you have an interest-only loan with
loan tracking feature. Instead, categorize the
your payment.

Type of loan For this item Give Quicken th

Variable-rate loan Principal + interest The amount of 
principal and in

Annual interest rate The interest rat

Confirm payment 
before recording

Select this chec
changes, you ca
amount when y

Balloon payment Total # of payments* The number of 
borrowing the p

# paid* The number of 

Payments remaining* The number of 
borrowing the p
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the final payment (calculated by 
 number of years remaining until the 
t is due by the number of payments per 

erest rate (if both the interest rate and 
nt vary), or the interest rate on which the 
on was initially based (if your loan 
nt is fixed but the interest rate varies)

elines in the table on page 253 for 
ation in these fields; use the full loan 
ch the loan amortization was initially 
ine what you enter

ment amount or interest rate varies, 
checkbox is selected; then you can enter 
nt amount or the new interest rate when 
an payment transaction

 blank

 from the answers you select in the Loan 

is information
Chapte

Balloon on payment # The number of 
multiplying the
balloon paymen
year)

Negative amortization Annual interest rate The current int
payment amou
loan amortizati
payment amou

Loan amount or
Current balance*

Follow the guid
entering inform
amount on whi
based to determ

Confirm payment 
before recording

If either the pay
make sure this 
the new payme
you recall the lo

Zero-interest loan Annual interest rate Zero (0)

Interest category Leave this field

* Quicken determines which of these fields to include in the Set Up Loan window
Interview window. You won’t see them at the same time.

Type of loan For this item Give Quicken th
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 you recall the loan payment transaction 
r of the account from which you are 
es the interest and principal amounts and 

indow for the bank account from which 

yment in a bank account, not in the 
 track the loan principal.

enu (x-N).

rt typing the lender’s name in the Payee 
Tab to recall the loan payment. Then skip 

ter a payment and click Use.

 confirmation, review or change any infor-
 click Record to enter the transaction in 

s affect future payments. See “How 
ayments and schedules” on page 262 for 
Chapte

Making a loan payment

When it’s time to make your loan payment,
from the Loan list and enter it in the registe
making the payment. Then Quicken calculat
updates the loan balance.

1 Open the register or the Write Checks w
you will make the loan payment.

Important: Make sure you enter your pa
liability or asset account you are using to

2 Choose New Transaction from the Edit m

3 Choose Loans from the Lists menu.

If QuickFill is turned on, you can just sta
field. When you see the full name, press 
to step 5.

4 Select the loan for which you want to en

5 If you have set up your loan for payment
mation necessary for this payment. Then
the register.

Changes you make to the first three field
changes to a loan payment affect future p
details.
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Checks window to record the loan 

e loan, Quicken reminds you that this is 
 payment, you won’t be able to recall the 

n by mistake, click Cancel in the Payment 
eady in the register, delete it by selecting 
an balance and the number of payments.

as negative amortization with fixed 
ut a variable-interest rate, enter the 
t rate (if it has changed as of this 
hen re-enter the payment amount.

 to make a prepayment of 
ith this payment only, enter 
t here.
Chapte

6 Click Record in the register or the Write 
payment transaction.

When you recall the final payment for th
the last payment. After you’ve made the
loan payment transaction again.

Note: If you recall a loan payment transactio
Confirmation window. If the payment is alr
it and pressing x-D. Quicken restores the lo

If the loan h
payments b
new interes
payment); t

If you want
principal w
that amoun

If you have a variable-rate 
loan and the interest rate has 
changed as of this payment, 
enter the new rate and 
regular payment amount.

If the Current Balance 
amount doesn’t match the 
actual balance on the loan, 
enter the correct amount.

This is the amount you entered for 
“PMI, property taxes, etc.” in the Set 
Up Loan window (or any other 
amounts you entered in the split lines 
in the Preview Payment window).
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t future payments and schedules

 change the data in the Payment Confir-

s

justs the balance for the loan in the 
edule and adds a balance adjustment 

to the principal account to correct the 
ay amount.

justs the regular payment amount and 
 for this payment and all future payments.

s the amount you enter as the new 
ment amount for this payment and all 
ents.
se the regular payment, Quicken 

e principal amount for each payment, and 
er the final payment or the number of 
maining.
ase the regular payment, Quicken 
e principal amount for each payment, but 
rease the number of payments remaining. 
eates a balloon payment as the final 
Chapte

How changes to a loan payment affec

This table explains what happens when you
mation window.

If you change this This happen

Current balance Quicken ad
payment sch
transaction 
Balance Tod

Annual interest rate Quicken ad
interest rate

Regular payment Quicken use
regular pay
future paym
If you increa
increases th
reduces eith
payments re
If you decre
decreases th
does not inc
Instead, it cr
payment.
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est, principal, and other charges for future 
ent schedule by selecting the loan in the 
en the payment schedule is open, you can 
 from the File menu. The payment 
t past payments.

en you make your regular loan payment 
nally add a prepayment of principal to 

irm payment before recording” checkbox 
icken asks you to confirm your regular 
Additional Prepayment field in the 

reases the principal amount for this 
ly and reduces either the final payment or 
 of payments remaining.

uicken Help Topics and select

s

Chapte

Viewing a loan’s payment schedule

You may want to see the breakdown of inter
loan payments. You can view a loan’s paym
Loan list and clicking Payment Schedule; wh
print it by choosing Print Payment Schedule
schedule does not include information abou

Making prepayments of principal

You can make prepayments of principal wh
or between regular payments. If you occasio
your regular loan payment, select the “Conf
in the Set up Loan window. Then, when Qu
payment, enter the payment amount in the 
Payment Confirmation window.

Additional 
prepayment

Quicken inc
payment on
the number

For step-by-step help, go to Assets & Debt in Q

How do I view a loan’s payment schedule?

If you change this This happen
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ments, the entire payment is a prepay-
 to change the loan setup or edit the loan. 
ll your regular loan payment transaction. 
account from which you are making the 
al account as the transfer account in the 
utomatically updates the balance of the 
Chapte

If you make a payment between regular pay
ment of principal; therefore, you don’t need
When you make a prepayment, do not reca
Instead, create a separate transaction in the 
payment, and enter the name of the princip
Category field of the transaction. Quicken a
loan principal.
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ation except the principal account name 
cking Edit. (See “Editing, hiding and 
o rename the principal account.) You can 
nd clicking Delete.

ion, you can also edit some loan informa-
saction, including the payment amount, 
e step 5 on page 260).

uicken Help Topics and select
Chapte

Changing and deleting loans

You can change any of the loan setup inform
by selecting the loan in the Loan list and cli
deleting accounts” on page 68 if you want t
delete a loan by selecting it in the Loan list a

If your loan is set up for payment confirmat
tion when you recall the loan payment tran
the interest rate, and the current balance (se

For step-by-step help, go to Assets & Debt in Q

How do I edit loan information?

How do I delete a loan?
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king in Quicken, follow this procedure to 
an. 

help you determine whether or not you 
lanning calculators” on page 443.

in “Setting up a loan” on page 249.

the register for the new principal account 
an and categorizes or transfers any 

When you enter the infor-
mation about the new loan, 
make sure you enter a 
principal account name 
that is different from the 
one you were using for 
your old mortgage.
Chapte

Refinancing a loan

If you refinance a loan that you’ve been trac
set up the new loan and “pay off” the old lo

Tip: You can use the refinance calculator to 
should refinance. See “Using the financial p

1 Set up the new loan following the steps 

2 Edit the Opening Balance transaction in 
to create a split that “pays off” the old lo
remaining amounts.
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n balance plus 
om the lender for 
 was deposited in 
ansfer to the Joint 
Chapte

3 Delete the old loan from the Loan list.

This is the principal account 
register for the new loan.

This split line pays off the old loan. 
(The next illustration shows the 
transfer transaction in the register 
for the old principal account.)

Since the new loan covers the 
closing costs, you should categorize 
this expense in the split.

If the new loan is bigger than the old loa
closing costs, you may receive a check fr
the difference. In this example, the check
a checking account, so it is entered as a tr
Checking account.

You might want to change 
Opening Balance to the name 
of the new lender to make the 
transaction more meaningful.

This is the principal account 
register for the old loan.

This is the transfer transaction 
from the new loan’s principal 
account that pays off the balance 
of the old loan.
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interest

ou’ve paid on a loan since the beginning 

eating a report that shows your interest 

uicken Help Topics and select
Chapte

Estimating year-to-date loan 

You may want to know how much interest y
of the year for tax purposes. 

You can see your year-to-date interest by cr
payments. 

For step-by-step help, go to Assets & Debt in Q

How do I estimate year-to-date interest?
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Chapte
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o track what you own in stocks, bonds, 
ts that fluctuate in price. Investment 
ns, see the performance of your invest-

x reports that show investment income 

 use to track investments:

an investment that has a constant share 
te of deposit or money market fund that 
rice that fluctuates. You can write checks 

ck rate of return.

 just about anything you own: real estate, 
. You can track simple investment trans-
ot track rate of return.

cks one or more securities. Like a real-
nsactions (buys, sells, dividends, and so 
alance, and give you a total market value 
rent performance measures for the 
nt and for the account as a whole.

ount tracks a single mutual fund. It is 
 and cannot have a cash balance. It has the 
f some actions, such as automatically 
About investment accounts

You can use Quicken investment accounts t
mutual funds, and other types of investmen
accounts let you track investment transactio
ments, update security prices, and create ta
and capital gains.

When to use an investment account

Quicken has four types of accounts you can

• Bank account. A bank account can track 
price or no share price, such as a certifica
earns interest but does not have a share p
from a bank account, but you cannot tra

• Asset account. An asset account can track
personal property, collectibles, and so on
actions in an asset account, but you cann

• Portfolio account. A portfolio account tra
world brokerage account, it can track tra
on) for multiple securities, show a cash b
for the account. You can view many diffe
individual securities in a portfolio accou

• Mutual fund account. A mutual fund acc
restricted to transactions for one security
advantage of streamlining the tracking o
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ecurity at the most recent price whenever 
cken account. You can see many different 
urity in a mutual fund account.

ccounts track the same kinds of informa-
me, capital gains, and performance), you 

 which of these two investment account 

hich type of Quicken account to use to 

Use this type of account

Portfolio

Mutual fund

Portfolio

Portfolio
recording the purchase of shares of the s
you transfer money in from another Qui
performance measures for the single sec

Tip: Since both portfolio and mutual fund a
tion about your investments (things like inco
should use the other factors listed to decide
types to use for a specific investment.

Use the following table to help you decide w
track your investments.

If you invest in

One or more securities (stocks, bonds, 
or mutual funds) for which you want to 
track a cash balance in addition to the 
securities themselves (for example, a 
collection of investments through a 
brokerage firm)

A single mutual fund that has no cash 
balance

Real estate investment trusts (REITs) or 
partnerships

Unit trusts
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ch as annuities and 401(k) plans, using 
an investment in a portfolio account, you 
nt for each purchase or sale transaction. If 
t account instead of an investment 

Portfolio

Bank for the checking part of the account 
and portfolio for everything else (use 
transfers for purchases and deposits)

Bank (if you write checks) or mutual fund 
(if you want to track rate of return)

Bank

Portfolio or asset

Portfolio or asset

Portfolio or asset

Portfolio or asset

Asset

Use this type of account
You can track some types of investments, su
either a portfolio or asset account. To track 
must know the share price and dollar amou
you don’t have this information, use an asse
account.

IRA accounts, Keogh accounts, or 
variable annuities

Cash management accounts (CMAs)

Money market funds

CDs 

Treasury bills

Fixed annuities

Employer retirement plans: 401(k), 
403(b), pension

Collectibles or precious metals

Real estate

If you invest in
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on’t get a detailed statement that shows 
rmation to use a portfolio or mutual fund 
just the balance when you get your state-

ent funds that make up your 401(k) 
arate asset account for each fund.
Tip: After you set up a Quicken 
account for a 401(k), you can 
record a transfer from your 
paycheck deposit to the 401(k) 
account for the amount of your 
regular contribution. See “Sample 
split transaction: entering your 
paycheck” on page 110 for an 
example.

For example, if you have a 401(k) but you d
every purchase, you don’t have enough info
account. Instead, use an asset account and ad
ment. If you want to keep track of the differ
without using a portfolio account, use a sep
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t account

ur investments in a Quicken portfolio or 
es recommendations for grouping securi-

ations

te Quicken portfolio account for each 
rage account or other managed account 

a cash management account (CMA), set 
ing part of your brokerage account as a 
k account (so you can print checks and 

sily) and set up a Quicken portfolio 
the rest of the investments. Then transfer 
een the two Quicken accounts when you 

l securities or receive investment income.

don’t have securities with fluctuating 
ur retirement account, you may want to 
 Quicken portfolio account, since you 
 the investments later.
e Quicken portfolio accounts for your 
ccount and for a spouse’s retirement 
Organizing securities in an investmen

If you’ve decided to track one or more of yo
mutual fund account, the following table giv
ties in investment accounts.

Security type Recommend

Brokerage accounts Use a separa
actual broke
you have.
If you have 
up the check
Quicken ban
reconcile ea
account for 
money betw
buy and sel

IRAs, 401(k) accounts, or 
other retirement accounts 

Even if you 
prices in yo
set it up as a
may change
Use separat
retirement a
account. 
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a few individual securities that you hold 
 may want to set up each one as a 
icken portfolio account; then you can 
cile each account with its statement. Or 
nt to lump all the securities in a single 

rtfolio account, especially if you have 
lio accounts; then you can subtotal these 
 account in reports and track them as a 

ations
Securities you hold directly If you have 
directly, you
separate Qu
easily recon
you may wa
Quicken po
other portfo
securities by
group.

Security type Recommend
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s

tment account, you have three options 
es). We recommend the first option.
Deciding how to set up your securitie

When you set up a new security in an inves
(described in the table on the following pag
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Disadvantages

1)You have to locate data for 
transactions that occurred in the 
past.

2)You must spend time entering all 
past transactions.
Setup option Advantages

Option 1: Enter all historical data. 
Enter the initial purchase for each 
security and all subsequent 
transactions. Enter:
• Name and type of security
• Date, amount invested, and number 

of shares (or price per share) for the 
initial purchase

• All subsequent transactions 
(including buys, sells, reinvest-
ments, gifts, stock splits, and 
returns of capital)

• All dividends, interest, and capital 
gains distributions for the current 
year

• (Optional) All nonreinvested 
dividends, interest, and capital 
gains distributions for prior years 
(to give you a more complete value 
for past performance; does not 
affect cost basis)

• Price per share at the end of last 
year, for prior years (if available), 
and for today

• Anything else that may affect its 
price or performance history 

1)All Quicken reports are complete 
and accurate.

2)If you sell a security, the capital 
gains report displays the purchase 
dates, amounts invested, and the 
realized gain, so you can use this 
report to prepare Schedule D tax 
information.

3)When you sell a security, you can 
specify which lot or lots to sell to 
minimize or maximize your taxable 
capital gains—both long-term and 
short-term.

4)All your investment records are in 
one convenient place, making it 
easier for you to analyze your invest-
ments and produce data for tax and 
other purposes.
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1)Because your data is incomplete, 
Quicken cannot give you an accurate 
value for total unrealized gain (since 
unrealized gain depends on the cost 
basis for the security).

2)If you sell the security, the capital 
gains report does not show an 
accurate purchase date. And, 
because the cost basis dates back 
only to the beginning of the year, the 
realized gain is not accurate.

Disadvantages
Option 2: Set up for this year. Enter 
your investment holdings as of the 
end of last year and all transactions 
for each security since the beginning 
of this year. Enter:
• Name and type of security
• Number of shares owned at the end 

of last year
• Price per share at the end of last 

year and today
• All transactions (purchases, sales, 

dividends, reinvestments, and so 
on) for the current year

1)The information you need to gather 
goes back only to the end of last year 
and is probably easy for you to find.

2)Data for the year is complete, so you 
can use the investment income 
report to prepare Schedule B tax 
information.

3)Quicken produces accurate reports 
on performance, income, and 
changes in unrealized gain for time 
periods starting with the beginning 
of this year.

4)When you sell a security, you can 
specify which lot or lots to sell to 
minimize or maximize your short-
term capital gains.

Setup option Advantages
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1)Data for this year is incomplete, so 
you can’t use the investment income 
report to prepare Schedule B tax 
information.

2)You may have to wait a few months 
before your investment data is in the 
range where Quicken can display a 
valid investment performance 
report.

3)Because your data is incomplete, 
Quicken cannot give you an accurate 
value for total unrealized gain (since 
unrealized gain depends on the cost 
basis for the security).

4)If you sell the security, the capital 
gains report does not show an 
accurate purchase date. And, 
because you are starting from today, 
the realized gain is not accurate.

Disadvantages
Option 3: Set up fast. Enter your 
current investment holdings. Enter:
• Name and type of security
• Number of shares you currently 

own
• Current price per share

1)You can get started with a minimum 
amount of information to gather.

2)You can start using the account right 
away to see whether you think it’s 
worthwhile to gather and enter more 
information.

3)Quicken produces accurate reports 
on performance, income, and 
changes in unrealized gain for time 
periods starting now.

Setup option Advantages
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ta in Quicken

ent account, take a look at the different 
g, and viewing your investment data.

n register that functions much like the 
. Use the Register window to view all the 
count.
Tracking your investment da

Before you set up your first Quicken investm
windows you will use for setting up, enterin

The Register window

Each Quicken investment account has its ow
registers for other types of Quicken accounts
transactions that have been entered in an ac

The first register shown here is for 
a portfolio account (see “Setting 
up a Quicken portfolio account” 
on page 291), and the second is for 
a mutual fund account (see 
“Setting up a Quicken mutual 
fund account” on page 304).

You can click the Actions button 
and use Quicken’s investment 
forms to enter investment trans-
actions (see “Using investment 
forms to enter transactions” on 
page 308), or you can enter trans-
actions directly in the register 
once you are familiar with the 
different actions (see “Entering 
investment transactions in the 
register” on page 311).
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pdating security prices” on page 339)

ities in which you hold an open position

 in the Portfolio window in several ways. 
d and how and where they are displayed, 
ities are listed and how they are grouped.

To print the information 
in the Portfolio window, 
choose Print Portfolio 
from the File menu.

t in the 
aining infor-
by dragging 

Change this date to view 
or enter prices “as of” 
the selected date.
The Portfolio window

In the Investing area, click the 
Portfolio button in the toolbar to 
see the Portfolio window.

Use the Portfolio window to:

• view and update security prices (see “U

• view summary information for all secur

You can customize the information you see
You can change which columns are displaye
and you can change the order in which secur

All your investment accounts share 
a single Portfolio window. 

Use the Group By pop-up menu to 
choose how you want to group your 
securities in this window.

Click the triangles to show or hide 
the securities in each “group.”

If there are more columns or rows than fi
window, use the scroll bars to see the rem
mation. You can also resize the window 
the size box.

Use the WatchList to track securities 
or indexes you don’t own but want 
to watch.
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the Portfolio window:

 right corner of the window.

ant to see in the Portfolio window; clear 
ant to see.

lio window, drag the area just to the right 

When you click OK, the selected 
columns are displayed in the Portfolio 
window. If there are more columns 
selected than will fit in the window, you 
can use the horizontal scroll bar to scroll 
columns into view.

Click Defaults to select only the 
columns that were selected when you 
installed Quicken.
Customizing the column display

To change which columns are displayed in 

1 Click the Customize button in the upper

2 Select the checkboxes for columns you w
the checkboxes for columns you don’t w

3 Click OK.

To change the size of a column in the Portfo
of the column title to the left or right.

Select this checkbox to show the 
individual lots you’ve acquired 
for each security.

Tip: Turn on Balloon Help (by 
choosing Show Balloons from 
the Help menu) to see descrip-
tions of each item in this 
window.

A vertical line appears when you 
click in the resize area to the 
right of a column title. Drag to 
the left or right to resize the 
column.
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ar, simply drag and drop any column 
cation to a new one.
To change the order in which columns appe
(except Name and Price) from its current lo

The mouse pointer changes to a 
hand when you move it over a 
column title. You can use the 
hand to drag that column to a 
new location.
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curity, type, or goal. Choose the grouping 
 in the upper left corner of the window. 
mn to sort the securities. Just click a 
ical or numerical order.

urity (each individual acquisition of the 
 under that security by selecting the 

h security” checkbox in the Portfolio 

roup titles (the items in bold in the first 
the securities or lots below them.
Customizing the row display

You can group your securities by account, se
you want from the Group By pop-up menu
Within the groupings, you can use any colu
column title to sort that column in alphabet

You can also display each open lot for a sec
security that you still own) as a separate row
“Show individual acquisitions (lots) for eac
Customization window (see page 283). 

You can click the triangles to the left of the g
column) or security names to hide or show 
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curities and edit or delete existing securi-
share one Securities list that contains all 

 the Set Up Security window as described 
k Edit and make your changes in the Edit 
Changing, deleting, and moving securi-

n change the order in which securities 
r in the Securities list by clicking a column 
 sort that column in alphabetical order. 
st is sorted by security name, but you can 
rt it by symbol, type, or goal.

ant to put 
curities.

 or remove a security from your Watch 
lick in the Watch List column. Quicken 
es your portfolio to show your changes. 
The Securities window

Choose Securities from the Lists 
menu to see the Securities 
window.

Use the Securities window to set up new se
ties. All your Quicken investment accounts 
your securities.

To set up a new security, click New and fill in
in step 3 on page 292. To edit a security, clic
Security window. To delete a security, see “
ties” on page 357.

The Securities window lists all 
your securities. 

You can drag and drop securities 
from this list into any account (or 
the WatchList) in the Portfolio 
window.

You ca
appea
title to
This li
also so

If you have hidden any securities and you w
them back in the list, click Show Hidden Se

To print the Securities list, choose 
Print Securities from the File 
menu.

To add
List, c
updat
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 of information about individual securi-

n you entered when you set up the 

ph for the security.

ou have entered for the security. Quicken 
er day, plus high price, low price, and 

ction you’ve entered for this security in 

 
Click Customize to select what 
information you see in the graph 
and how it is displayed.
The Security Detail window

Double-click a security in the 
Portfolio window to see informa-
tion about that security in the 
Security Detail window.

The Security Detail window shows a variety
ties you’ve set up in Quicken:

• The Setup Info tab shows the informatio
security.

• The Graph tab shows a price history gra

• The Prices tab shows every share price y
stores one “closing” price per security p
volume information, when available.

• The Transactions tab shows every transa
any account.

Click one of the other tabs to see 
additional information about the 
selected security.

Click Prev Security or Next Security to 
view information about the previous or
next security in your Securities list.

Click any data point to see the 
exact date and price for that point.

Click Overlay Securities to select 
additional securities to view in 
the same graph.
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ct investment forms for entering invest-
me, Dividends, and so on). The table in 
16 lists all of these actions alphabetically 
mation about using specific forms to 
nt transactions in Quicken.
The Investment Actions window

In the Investing area, click the 
Actions button in the toolbar to 
see the Investment Actions 
window.

Use the Investment Actions window to sele
ment transactions (Buys, Sells, Interest Inco
“Choosing an investment action” on page 3
and tells you where to find additional infor
record many of the most common investme

The Investment Actions window 
lists all the investment forms 
you can use to enter transactions 
in investment accounts. Just 
double-click an action to open an 
investment form.
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ounts

unts varies by field.

he effects of rounding and truncating to 
u can adjust the cash balance or the share 
sting the cash or share balance” on 

s amounts

 of formats to display share price 
 track of them internally to the nearest ten 
 displays exact integers without decimals. 
four decimal places, you must leave out 
l places when you enter the share price.

umber of shares to four decimal places. It 
 without decimals. It does not display 

l point unless they are followed by non-
 more than four decimal places, Quicken 
 places. For example, Quicken truncates 
.21678 to 8.2167.

ar amounts to two decimal places. When 
t from the price and number of shares, it 
.01. For example, if you enter 40.3 shares 
ds the dollar amount upward to $332.88.
How Quicken displays investment am

The way Quicken displays investment amo

At some point, you may want to adjust for t
make the register match your statements. Yo
balances for individual securities. See “Adju
page 364.

Field How Quicken display

Share Price Quicken uses a variety
information but keeps
thousandth (0.0001). It
If there are more than 
the additional decima

Shares In/Out Quicken displays the n
displays exact integers
zeros after the decima
zero digits. If there are
cuts off the additional
the number of shares 8

Cash In/Out Quicken displays doll
it calculates the amoun
rounds to the nearest 0
at $8.26, Quicken roun
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) in a field, the number is too large to 
etween -$9,999,999.99 and $9,999,999.99. 
the amount but doesn’t display it. If you 
o smaller transactions with amounts that 
If Quicken displays a row of asterisks (*****
display. Quicken displays dollar amounts b
Outside that range, Quicken keeps track of 
want, you can split a large transaction into tw
Quicken can display.



Chapter 14, Tracking investments    291

o account

re than one security, but it can be used to 
rusts, and so on. See “About investment 
 about when to use portfolio accounts.

ormation about the account.

If this is a nontaxable account 
(an IRA or 401(k) account, for 
example), click this checkbox to 
clear it.

If you ever want to hide this 
account so it doesn’t show up in 
lists (the Account list or the 
Portfolio window, for example), 
click this checkbox to select it.
Setting up a Quicken portfoli

A portfolio account is designed to track mo
track other investments such as IRAs, unit t
accounts” on page 271 for more information

Creating a portfolio account

1 Choose Accounts from the Lists menu.

2 Click New.

3 In the Set Up Account window, enter inf

4 Click Create.

Click Portfolio to select it as the 
account type. 

Enter a name for the account, up 
to 30 characters long. You can 
use the broker’s name or another 
descriptive name.

(Optional) Enter a description 
for the account that’s up to 54 
characters long.
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e Account list, the Category & Transfer 
s its register.

nt

hich you will be entering transactions in 
 all the securities before you start entering 
le you are entering transactions. Quicken 
ver you enter a name it doesn’t recognize. 
nsactions, follow these steps.

button in the toolbar.

as a market value of zero in the Portfolio 
y transactions in it.

tom of the Portfolio window.

me for the security you want to set up and 

ready in the Securities list), click Set Up 
up.

ecurities list. Just choose Securities from 
e Set Up Security window.
Quicken creates the account, adds it to th
list, and the Portfolio window, and open

Adding a security to a portfolio accou

You need to set up each of the securities for w
your portfolio account. You can either set up
transactions, or set them up “on the fly” whi
offers to let you set up a new security whene
To set up a security before you enter any tra

1 In the Investing area, click the Portfolio 

If you just set up a portfolio account, it h
window because you haven’t entered an

2 Click the Add Security button at the bot

3 In the Security Name window, enter a na
click OK.

If this is a new security (one that’s not al
when Quicken asks if you want to set it 

4 Fill in the Set Up Security window.*

*You can also get to this window from the S
the Lists menu and click New to display th
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curities list.

r Add Shares to Account or Add Security 

 your current holdings to your portfolio 
d continue to step 7.

ant to track it in the WatchList, select Add 
 new security to the WatchList in the 
etting it up.

hares In action or a Buy action to add 

al) Choose a security type and an invest-
oal. See “Assigning security types and 
ent goals to your securities” on page 295.

n can warn you when you enter a price 
tches or exceeds the limits you enter in 

elds. See “Retrieving security prices using
n Quotes” on page 348 for more informa-

 this security so it doesn’t show up in lists 
urities list and the Portfolio window, for 
e), click this checkbox to select it.
5 Click Create to add the security to the Se

6 In the Add Security window, select eithe
to WatchList, and then click OK.

If you own this security and want to add
account, select Add Shares to Account an

If you don’t own this security and just w
Security to WatchList; Quicken adds the
Portfolio window and you are finished s

7 Select whether you want to use a Move S
shares to your portfolio account.

Quicken displays the name you 
entered. If you want to change it, 
just type a new name, up to 30 
characters long.

Enter the security’s symbol if 
you plan to export or import 
price data, including from the 
Internet.

(Option
ment g
investm

Quicke
that ma
these fi
Quicke
tion.

To hide
(the Sec
exampl

If this is a nontaxable security 
(a tax-free bond, for example), 
click this checkbox to clear it.
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e you started using Quicken and want to 
olio account, select Move Shares In. 

estment form. To fill in the form, see 
urity” on this page and begin with step 3.

you started using Quicken, select Buy. 
rm. To fill in the form, see “Buying and 
If you already owned this security befor
add your current holdings to your portf
Quicken displays the Move Shares In inv
“Setting up an opening balance for a sec

If you first purchased this security after 
Quicken displays the Buy investment fo
selling securities” on page 324.
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als to your securities

rities in the Portfolio window and to sort 
.

 Mutual Fund, and Stock. To add a new 
ck New in the Types window, enter a new 
 might add Money Fund, T-Bill, Tax-Free 
also use types (or goals) to identify securi-

 Fund, Growth, High Risk, Income, and 
t from the Goal menu, click New in the 
ck Create. For example, you might add 
, Growth & Income, or Medium Risk. You 
 industry groups (such as technology, 
Assigning security types and investment go

Quicken can use types or goals to group secu
and subtotal investment reports and graphs

• The preset security types are: Bond, CD,
one, choose Edit from the Type menu, cli
type, and click Create. For example, you
Bond, Option, REIT, Unit Trust. You can 
ties in your children’s names.

• The preset investment goals are: College
Low Risk. To add a new one, choose Edi
Goals window, enter a new goal, and cli
Retirement, Down Payment, Remodeling
can also use goals (or types) to designate
energy, consumer products, and so on).
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curity

in other words, to enter an initial transac-
d a Move Shares In transaction if you 
ing Quicken.* The Move Shares In action 
nvestment account without transferring 
Quicken account.

 account’s Register window, or choose 

le-click Move Shares In.

 as shown for the setup option you want 

re included in this step. See the table that 
rmation before deciding which option to 

ete transaction history for each security, 
uisition (Option 1). If you don’t enter a 
curity is inaccurate and Quicken cannot 
ins.

tarted using Quicken, you should 
he Buy action instead of the Move Shares 
s” on page 324).
Setting up an opening balance for a se

To set up an opening balance for a security (
tion for it in the account), you need to recor
acquired that security before you started us
lets you add shares you already own to an i
the money for their purchase from another 

1 Click the Actions button in the portfolio
Actions from the Activities menu (x-J).

2 In the Investment Actions window, doub

3 Fill in the Move Shares In investment form
to use.

Instructions for all three setup options a
begins on page 278 if you need more info
use.

We recommend that you record a compl
starting with your initial purchase or acq
complete history, the cost basis for the se
report accurate unrealized or realized ga

*If you first purchased a security after you s
probably record its initial purchase using t
In action (see “Buying and selling securitie
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 the following information:

 changes to the information described for 

of shares you owned on 12/31 of last year.
e this security all at one time, leave the 

s to the information described for Option 

 of shares you own today.
e this security all at one time, leave the 

the date of your initial purchase or 
ition of the security.

 the name of the security (either type it 
ose it from the pop-up menu).

 your cost per share (including 
ission, fees, and load). See “Deter-
g what to enter in the ‘At’ (Share 
 field” on page 300.
Option 1: Enter all historical data. Fill in

Option 2: Set up for this year. Make these
Option 1:
• Date: Enter 12/31 of last year.
• Number of shares: Enter the number 
• Price per share: If you did not acquir

“At” field blank.

Option 3: Set up fast. Make these change
1:
• Date: Enter today’s date.
• Number of shares: Enter the number
• Price per share: If you did not acquir

“At” field blank.

4 Click Record to record the transaction.

Enter 
acquis

Enter the number of shares you 
acquired on this date. See “Deter-
mining what to enter in the 
Shares field” on page 299.

Make sure the correct portfolio 
account name is displayed. If not, 
choose it from the pop-up menu.

Enter
or cho

Enter
comm
minin
Price)
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 in the Investment Actions window to 

les, dividends, reinvestments, and so on 
red in step 3 and today for each security. 
 on page 308 for information about 

ransactions.

d add to this portfolio account, go back to 
n page 292 and continue through “Setting 
ge 296 for each security you want to add.

the account, continue to “Setting up the 
 301.
See Option 1 and Option 2 in the 
table on page 278 for a list of the 
transactions you need to enter for 
the security to bring it up to date.

5 For Option 1 or Option 2, use the actions
bring each security up to date.

You will need to record all purchases, sa
that occurred between the date you ente
See “Recording investment transactions”
entering the most common investment t

If you have additional securities to set up an
“Adding a security to a portfolio account” o
up an opening balance for a security” on pa

When you are finished adding securities to 
cash balance in a portfolio account” on page
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d

es you acquired (or owned) on the date 
 to help you decide what to enter for 

shares to enter

umber of shares

e actual number of bonds—to match the 
rices are quoted

llar value

 1

 of ounces
Determining what to enter in the Shares fiel

In the Shares field, enter the number of shar
you entered in the Date field. Use this table
different types of investments.

Security type Number of 

Stock or mutual fund The actual n

Bond Ten times th
way bond p

Money market fund or CD The total do

Collectible The number

Precious metal The number
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 Price) field

 price you paid per share as a decimal or 
hat to enter for different types of invest-

e share price field. For information about 
r, see “How Quicken displays investment 

us a fraction, leave a space after the dollar 
een the numerator and denominator (for 
an exact multiple of 1/32, Quicken 

r

rice per share

f the actual market value of each bond—
 way prices are quoted

llar value

r ounce
Determining what to enter in the ‘At’ (Share

In the At (share price) field, enter the initial
fraction.* Use this table to help you decide w
ments.

You can enter up to four decimal places in th
how Quicken displays the amounts you ente
amounts” on page 289.

*To enter a share price as a whole number pl
amount, and use a forward slash ( / ) betw
example, 36  3/8). If a security price is not 
displays it as a decimal.

Security type Price to ente

Stock or mutual fund The actual p

Bond One-tenth o
to match the

Money market fund or CD One dollar

Collectible The total do

Precious metal The price pe
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lio account

folio account if, for example, you trans-
rities, or received a cash dividend or 

ur portfolio account and have entered all 
e Cash Balance in the lower right corner 

rect, your account is set up. Go to 
up to date” on page 303.

t correct:

es menu.

 current date and the correct cash balance 

There is cash in this 
account that was added 
when interest was paid 
but not reinvested or 
transferred out of the 
account, so Quicken 
shows a cash balance of 
$490.00.
Setting up the cash balance in a portfo

You might have a cash balance in your port
ferred funds from a bank account, sold secu
interest payment.

After you have set up all the securities in yo
the transactions for those securities, check th
of the Register window.

If the amount shown for Cash Balance is cor
“Bringing the market value for the account 

If the amount shown for Cash Balance is no

1 Choose Adjust Balance from the Activiti

2 In the Adjust Balance window, enter the
for this account.

When you record a transaction 
that adds cash to or removes 
cash from the account, Quicken 
calculates the correct cash 
balance. If there is no cash in the 
account, this column displays 
zeros.
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egorize the adjustment transaction.

saction in the portfolio account register 
ks that transaction and all previous trans-

sh balance in a brokerage account may be 
d (MMF) that pays interest. If this is true 
et up the MMF as another security in the 
how much cash you have invested in the 
ou would for any other security.
Enter a category name if you want to cat

3 Click OK.

Quicken adds a balance adjustment tran
that corrects your cash balance, and mar
actions as reconciled.

Optional Money Market Fund setup: The ca
periodically swept into a money market fun
for your account, we recommend that you s
account. Then the Portfolio window shows 
MMF, and you can enter dividends just as y
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ount up to date

u are ready to bring its value up to date. 
 for information about entering security 

ccount in the lower right corner of the 
test price you’ve provided. Quicken also 
olumn for the account in the Portfolio 
ost recent prices you’ve provided for all 

 date in the Set Prices As Of field (at the 
Bringing the market value for the acc

Your portfolio account is now set up and yo
See “Updating security prices” on page 339
prices.

Quicken displays the market value for the a
register. This market value is based on the la
displays market value in the Market Value c
window. This market value is based on the m
displayed securities in the account as of the
top of the Portfolio window).
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 fund account

 single mutual fund with no cash balance. 
p a mutual fund account or a portfolio 
n page 271.

nt from the Registers pop-up menu in the 

ormation about the account.

. To set up a mutual fund account, select 
 the name of the fund as the name for the 

me to the Account list, the Category & 
dds the mutual fund to the Securities list, 
Setting up a Quicken mutual

A mutual fund account is designed to track a
If you’re not sure whether you want to set u
account, see “About investment accounts” o

Creating a mutual fund account

1 In the Investing area, choose New Accou
toolbar.

2 In the Set Up Account window, enter inf

See the illustration in step 3 on page 291
Mutual Fund as the account type and use
account.

3 Click Create.

Quicken creates the account, adds its na
Transfer list, and the Portfolio window, a
and opens the register.
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started using Quicken, you need to record 
urchase or acquisition.* The Move Shares 
n to an investment account without trans-
nother Quicken account.

nd account’s Register window, or choose 

le-click Move Shares In.

 as shown for the setup option you want 

re included in this step. See the table that 
rmation before deciding which option to 

ete transaction history for the mutual 
 or acquisition (Option 1). If you don’t 
r the security is inaccurate and Quicken 

lized gains.

tarted using Quicken, you should set up 
o record the initial purchase of the shares 
Buying and selling securities” on 
Setting up an opening share balance

If you acquired this mutual fund before you 
a Move Shares In transaction for the initial p
In action lets you add shares you already ow
ferring the money for their purchase from a

1 Click the Actions button in the mutual fu
Actions from the Activities menu (x-J).

2 In the Investment Actions window, doub

3 Fill in the Move Shares In investment form
to use.

Instructions for all three setup options a
begins on page 278 if you need more info
use.

We recommend that you record a compl
fund, starting with your initial purchase
enter a complete history, the cost basis fo
cannot report accurate unrealized or rea

*If you first purchased this fund after you s
the opening balance using the Buy action t
instead of the Move Shares In action (see “
page 324).



Chapter 14, Tracking investments    306

 the following information:

 changes to the information described for 

of shares you owned on 12/31 of last year.
e shares of this fund all at one time, leave 

s to the information described for Option 

 of shares you own today.
e shares of this fund all at one time, leave 

ltiplies the share price by the number of 
in the Market Value column for the 

 the date of your initial purchase 
quisition of these shares.

 your cost per share (including 
ission, fees, and load).
Option 1: Enter all historical data. Fill in

Option 2: Set up for this year. Make these
Option 1:
• Date: Enter 12/31 of last year.
• Number of shares: Enter the number 
• Price per share: If you did not acquir

the “At” field blank.

Option 3: Set up fast. Make these change
1:
• Date: Enter today’s date.
• Number of shares: Enter the number
• Price per share: If you did not acquir

the “At” field blank.

4 Click Record to record the transaction.

Quicken records the price per share, mu
shares you own, and displays the result 
account in the Portfolio window.

Enter
or ac

Enter the number of shares you 
acquired on this date.

Make sure the correct mutual fund 
account name is displayed. If not, 
choose it from the pop-up menu.

Enter
comm
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 in the Investment Actions window to 

es, reinvestments, and so on that occurred 
nd today. See “Recording investment 
n about entering the most common invest-

ount up to date

d you are ready to bring its value up to 
e 339 for information about entering 

ccount in the lower right corner of the 
test price you’ve provided. Quicken also 

ue column for the account in the Portfolio 
ost recent price you’ve provided for the 

 field (at the top of the Portfolio window).
See Option 1 and Option 2 in the 
table on page 278 for a list of the 
transactions you need to enter for 
the security to bring it up to date.

5 For Option 1 or Option 2, use the actions
bring the account up to date.

You will need to record all purchases, sal
between the date you entered in step 3 a
transactions” on this page for informatio
ment transactions.

Bringing the market value for the acc

Your mutual fund account is now set up an
date. See “Updating security prices” on pag
security prices.

Quicken displays the market value for the a
register. This market value is based on the la
displays the market value in the Market Val
window. This market value is based on the m
security as of the date in the Set Prices As Of
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tions

actions in a portfolio or mutual fund 
tment Actions list (see “Using investment 
n enter transactions directly in an invest-
sactions in the register” on page 311).

t transactions, you must set up an invest-
uicken portfolio account” on page 291 or 
” on page 304.

actions

utton in the toolbar (x-J).

le-click an investment action.

page 316 to help you decide which invest-

u fill in the fields in the investment form.

ister for the selected account.
Recording investment transac

You can use investment forms to enter trans
account by selecting an action from the Inves
forms to enter transactions” next), or you ca
ment register (see “Entering investment tran

Note: Before you begin recording investmen
ment account as described in “Setting up a Q
“Setting up a Quicken mutual fund account

Using investment forms to enter trans

You can use investment forms to 
enter transactions without 
opening the register for the 
account.

1 In the Investing area, click the Actions b

2 In the Investment Actions window, doub

See “Choosing an investment action” on 
ment action to use.

3 Use the table on the next page to help yo

4 Click Record.

Quicken saves the transaction in the reg
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formation

f the investment account in which you 
rd this transaction. Type the name or 
m the pop-up menu.

r share; see “Determining what to enter in 
re Price) field” on page 300 for more 
 about what to enter for various types of 
ou don’t need to enter a share price if you 
he number of shares and the total cost or 
s; Quicken calculates it.a

or expense category (and a class, if you 
egorize a Misc. Income or Misc. Expense 

mmission, load, or fees.

the transaction.

n for the Transfer Money transaction.

f the Quicken account to which or from 
re transferring funds. If the funds are 
 or going to the cash balance in the 

ve this field blank.
In this field in the action 
form Enter this in

Account The name o
want to reco
choose it fro

At (Share Price) The price pe
the ‘At’ (Sha
information
securities. Y
enter both t
net proceed

Category/Class An income 
want) to cat
transaction.

Commission The total co

Date The date of 

Description A descriptio

Destination of Funds or
Source of Funds

The name o
which you a
coming from
account, lea
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 of the miscellaneous income or expense.

ccount and destination account for the 
ney transaction.

 memo for the transaction.

eeds from the transaction. You don’t need 
 amount if you enter both the number of 
hare price; Quicken calculates it.

ter the split in a Stock Split action.

f the security associated with the action.

 of shares involved in this transaction. 
eed to enter the number of shares if you 
hare price and the total cost or net 
uicken calculates it.*

io in a Stock Split action; see “Entering 
and stock dividends” on page 331 for 
ation about what to enter.

st of the transaction. You don’t need to 
ount if you enter both the number of 

hare price; Quicken calculates it.*

formation
Expense Amount or
Income Amount

The amount

From, To The source a
Transfer Mo

Memo An optional

Net Proceeds The net proc
to enter this
shares and s

New Price The price af

Security The name o

Shares Of The number
You don’t n
enter both s
proceeds; Q

Split Ratio The split rat
stock splits 
more inform

Total Cost The total co
enter this am
shares and s

In this field in the action 
form Enter this in
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e register

nt transactions, use the investment forms 
 enter transactions” on page 308. Later, 
vestment transactions, you may find it 
vestment account register.

or mutual fund account name from the 

ransaction, choose New Transaction from 

fields in the register.

d total cost and let Quicken calculate the 
is slightly different from the actual share 
dow. Editing the price in the Portfolio 
hat was saved with the transaction.
Entering investment transactions in th

While you’re learning how to enter investme
as explained in “Using investment forms to
when you’re more familiar with entering in
faster to enter transactions directly in the in

1 In the Investing area, choose a portfolio 
Registers pop-up menu in the toolbar.

2 If the selected transaction is not a blank t
the Edit menu.

3 Use the next table to help you fill in the 

a. It is best to enter the number of shares an
share price. If the calculated share price 
price, you can edit it in the Portfolio win
window does not affect the share price t
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In a portfolio account, this 
column displays the cash 
balance in the account. When 
you record a transaction, 
Quicken calculates the correct 
cash balance. If you have no 
cash in the account, the 
column displays zeros.

In a mutual fund account, this 
column displays the number 
of shares you hold (to four 
decimal places). When you 
record a transaction, Quicken 
automatically calculates the 
correct total number of shares.
A portfolio account 
register

If a price for a security is 
not an exact multiple of 1/
32, Quicken displays it as a 
decimal. If the number of 
shares is an exact integer, 
Quicken displays the 
number without decimals.

A mutual fund 
account register
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formation

the transaction.

f the action. Either choose it from the pop-
 if QuickFill is turned on, just start typing 
d QuickFill enters the rest automatically.
oose an action, Quicken blocks out fields 

levant to that action. For example, the 
ld is relevant to a Buy action because you 
hares to the account, but the Shares Out 
vant.

 the security associated with the action. If 
turned on, just start typing a security 
uickFill enters the rest automatically. 
eld blank for a Miscellaneous action that 
olve an individual security.
n for the action. For transfer transactions, 
laces the Security field with a Description 
4 Click Record to record the transaction.

In this field in the register Enter this in

Date The date of 

Action The name o
up menu or,
the name an
After you ch
that are irre
Shares In fie
are adding s
field is irrele

Security 
(portfolio only)

Description
(portfolio only)

The name of
QuickFill is 
name and Q
Leave this fi
does not inv
A descriptio
Quicken rep
field.
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hat affect the share balance in the account, 
ed to enter two of these three amounts. 
ows that share price, number of shares, 
mount are related, and calculates the one 
ter.a

that increase the share balance:
 x Shares In) ± Commission = Cash Out 
unt)
that decrease the share balance:
 x Shares Out) ± Commission = Cash In 
unt)

mmission, load, or fees, if applicable.
nter a commission, Quicken adjusts the 
nt in the Cash In or Cash Out field. Or, if 
lues for the share price and number of 

a total dollar amount that includes the 
, Quicken enters the difference between 

ount and share price times the number 
the commission field. For example, if you 
hase of 100 shares at $15 per share and a 
 $1600, Quicken enters a commission of 

formation
Share Price
Shares In/Shares Out
Cash In/Cash Out

For actions t
you only ne
Quicken kn
and dollar a
you don’t en
For actions 
(Share Price
(dollar amo
For actions 
(Share Price
(dollar amo

Commission The total co
When you e
dollar amou
you enter va
shares, and 
commission
the dollar am
of shares in 
enter a purc
total cost of
$100.

In this field in the register Enter this in
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f the Quicken account to which or from 
re transferring funds; see “Transferring 
d from other accounts” on page 322. If the 
ming from or going to the cash balance in 
 leave this field blank (portfolio accounts 

or expense category (and a class, if you 
egorize a Miscellaneous transaction. For 
 require an investment category, Quicken 
correct category for you and you cannot 

 memo for this transaction.

io in a Stock Split action; see “Entering 
and stock dividends” on page 331.

d total cost and let Quicken calculate the 
is slightly different from the actual share 
dow. Editing the price in the Portfolio 
hat was saved with the transaction.

formation
Transfer

Category/Class

The name o
which you a
money to an
funds are co
the account,
only).
An income 
want) to cat
actions that
assigns the 
change it.

Memo An optional

Split Ratio The split rat
stock splits 

a. It is best to enter the number of shares an
share price. If the calculated share price 
price, you can edit it in the Portfolio win
window does not affect the share price t

In this field in the register Enter this in
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u can use to record transactions in an 
 what effect each action has on your 
a decrease) and matches the action to the 
he page reference below the action name 
action to enter different kinds of invest-

ffects 
R by 
c.

Affects 
market 
value

Affects 
cash 
balance

Quicken 
uses this 
category1

c or 
ec

Inc Dec ——

c —— Inc •Long 
CapGnDst 
  or
•Long 
CapGnDst 
   NT

c —— Inc •Short 
CapGnDst 
  or
•Short 
CapGnDst 
   NT
Choosing an investment action

There are 17 different investment actions yo
investment account. The table below shows
portfolio (Inc indicates an increase and Dec 
investment category Quicken assigns to it. T
directs you to information about using that 
ment transactions.

Action in 
Actions list Code Desc. of 

the action

Affects 
average 
cost

Affects 
gain/
loss %

Affects 
# of 
shares 

Affects 
cost 
basis

A
IR
se

Buy
(page 324)

BUY Buy security 
with cash2

Inc or 
Dec

Inc or 
Dec

Inc Inc In
D

Capital 
Gain Long
(page 329)

CGL Receive cash 
from long-
term capital 
gains 
distribution2

—— —— —— —— In

Capital 
Gain Short 
(page 329)

CGS Receive cash 
from short-
term capital 
gains 
distribution2

—— —— —— —— In
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c —— Inc •Div 
Income or
•Div 
Income NT

c —— Inc •Int Income 
or
•Int Income 
NT

ec —— Dec Choose 
category 
from list

c —— Inc Choose 
category 
from list

c or 
ec

Inc —— ——

c or 
ec

Dec —— ——

ffects 
R by 
c.

Affects 
market 
value

Affects 
cash 
balance

Quicken 
uses this 
category1
Dividend 
(page 327)

DIV Receive cash 
from 
dividend2

—— —— —— —— In

Interest 
Income 
(page 327)

II Receive cash 
from interest 
income2, 3

—— —— —— —— In

Misc. 
Expense

MISC Pay miscella-
neous 
expense with 
cash3

—— —— —— —— D

Misc. 
Income

MISC Receive cash 
from miscel-
laneous 
income3

—— —— —— —— In

Move 
Shares In

MS Add shares 
to account

Inc or 
Dec

Inc or 
Dec

Inc Inc In
D

Move 
Shares Out

MS Remove 
shares 
from account

Inc or 
Dec

Inc or 
Dec

Dec Dec In
D

Action in 
Actions list Code Desc. of 

the action

Affects 
average 
cost

Affects 
gain/
loss %

Affects 
# of 
shares 

Affects 
cost 
basis

A
IR
se
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c Inc —— •Div 
Income or
•Div 
Income NT

c Inc —— •Int Income 
or
•Int Income 
NT

c Inc —— •Long 
CapGnDst 
  or
•Long 
CapGnDst 
   NT

ffects 
R by 
c.

Affects 
market 
value

Affects 
cash 
balance

Quicken 
uses this 
category1
Reinvest 
Dividend 
(page 328)

RD Reinvest in 
shares 
of the 
security with 
money from 
dividend or 
income 
distribution

Inc or 
Dec

Inc or 
Dec

Inc Inc In

Reinvest 
Interest 
(page 328)

RI Reinvest in 
shares 
of the 
security with 
money from 
interest 
distribution

Inc or 
Dec

Inc or 
Dec

Inc Inc In

Reinvest 
Long 
(page 328)

RL Reinvest in 
shares 
of the 
security with 
money from 
long-term 
capital gains 
distribution

Inc or 
Dec

Inc or 
Dec

Inc Inc In

Action in 
Actions list Code Desc. of 

the action

Affects 
average 
cost

Affects 
gain/
loss %

Affects 
# of 
shares 

Affects 
cost 
basis

A
IR
se
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c Inc —— •Short 
CapGnDst 
  or
•Short 
CapGnDst 
   NT

c Update
4

Inc ——

c or 
ec

Dec Inc •Realized 
Gain or
•Realized 
Gain    NT

ffects 
R by 
c.

Affects 
market 
value

Affects 
cash 
balance

Quicken 
uses this 
category1
Reinvest 
Short 
(page 328)

RS Reinvest in 
shares 
of the 
security with 
money from 
short-term 
capital gains 
distribution

Inc or 
Dec

Inc or 
Dec

Inc Inc In

Return of 
Capital 
(page 330)

RC Receive cash 
from return 
of capital2, 3

Dec Inc —— Dec In

Sell
(page 324)

SELL Sell security 
and receive 
cash2

Inc or 
Dec

Inc or 
Dec

Dec Dec In
D

Action in 
Actions list Code Desc. of 

the action

Affects 
average 
cost

Affects 
gain/
loss %

Affects 
# of 
shares 

Affects 
cost 
basis

A
IR
se
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ith a bold dot (for example, •Div Income), 
automatically the first time you set up a 
nnot delete investment categories or edit 
matically, however, if you delete all your 
 up a new investment category, you can 
nning of the category name. Note: If a 
nt or security, Quicken assigns a non-

—

—

——

——

——

——

——

——

— —— Inc or 
Dec

Choose 
transfer 
account 
from list

ffects 
R by 
c.

Affects 
market 
value

Affects 
cash 
balance

Quicken 
uses this 
category1
1 Investment categories, which all begin w
appear in your Category & Transfer list 
portfolio or mutual fund account. You ca
their names. (Quicken deletes them auto
investment accounts.) If you want to set
press Option-8 to insert a “•” at the begi
transaction involves a non-taxable accou

Stock Split 
(page 331)

SS Change 
number of 
shares as a 
result of 
stock split:
Positive 
stock split 
(e.g., two for 
one)
Negative 
stock split 
(e.g., one for 
two)

Dec

Inc

——

——

Inc

Dec

——

——

—

—

Transfer 
Money 
(page 322)

XFR Transfer 
money 
into or out of 
this account3

—— —— —— —— —

Action in 
Actions list Code Desc. of 

the action

Affects 
average 
cost

Affects 
gain/
loss %

Affects 
# of 
shares 

Affects 
cost 
basis

A
IR
se
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) to it.
sh from the current account, or it can 
ther account. For a mutual fund account, 
another Quicken account.
 from a portfolio account. It is not avail-
 mutual fund account cannot have a cash 

e price manually because there is not 
late the market value for you.
taxable category (one that ends with NT
2 This action can add cash to or remove ca

involve a transfer of cash to or from ano
this action must involve a transfer from 

3 This action adds cash to or removes cash
able for a mutual fund account because a
balance.

4 Quicken reminds you to update the shar
enough information for Quicken to calcu
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nts

 an investment account and another 
tically when you use investment forms to 

nvestment action that involves a transfer 
tion of Funds field where you can enter a 

 checking account (Checking in the 
rtfolio account (Discount Broker), you 
ccount with a transfer from Checking as 
king account register and put the check 
Transferring money to and from other accou

For more information about 
creating transfers, see “Transfer-
ring money between accounts” on 
page 103.

Some actions can involve a transfer between
account. These transfers are handled automa
enter your transactions. The form for each i
includes either a Source of Funds or Destina
transfer account name.

For example, if you write a check from your
example below) to pay for a security in a po
would record a Buy action in the portfolio a
the Source of Funds, and then go to the chec
number in the corresponding transaction.
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tronic payments to purchase securities, 
egister (or Write Checks window) as a 
 the portfolio account register to change 
nd add the security name, price, and 

hoose the name of the source account (the
uicken account the funds are coming 
om) from this pop-up menu.

hoose the name of the destination account 
he investment account the funds are 
ing to) from this pop-up menu.

 Quicken creates a Buy transaction 
If you print checks with Quicken or use elec
enter the payment in the checking account r
transfer to the portfolio account. Then go to
the Transfer Money action to a Buy action, a
number of shares.*

Use the Buy action to record 
a security purchase in the 
portfolio account.

C
Q
fr

Quicken records the Buy 
transaction in the portfolio 
account register.

Quicken also records the 
transaction in the checking 
account register. If you want, 
you can fill in the check 
number there later.

C
(t
go

*If the transfer is to a mutual fund account,
automatically.
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 account, enter a Transfer Money transac-
he information as necessary in the desti-

er with cash from the same account 
 transfer from another account, such as 

 sell a security, you can keep the cash from 
nts only) or transfer it to another account.

he Transfer field of a Buy or Sell transac-

Enter in Transfer field

chase 
ance 

nothing; leave it blank1

chase 
 the 
].

[Checking]2

ts is [Current Account]3

ceeds nothing; leave it blank1
If you are transferring cash out of a portfolio
tion in the portfolio account, and then edit t
nation account register.

Buying and selling securities

For every buy or sell transaction, 
you must know two of these 
items:
1)the number of shares
2)the price of the shares
3)the dollar amount of the
transaction

When you buy a security, you pay for it eith
(portfolio accounts only) or with money you
your checking account. Similarly, when you
the sale in the same account (portfolio accou

This table shows what you should enter in t
tion to transfer funds appropriately:

Action Desired Result

BUY Quicken subtracts the pur
amount from the cash bal
of the current account.

Quicken subtracts the pur
amount (transfers it) from
cash balance of [Checking

Cash balance in all accoun
unchanged.

SELL Quicken adds the sale pro
to the cash balance of the 
current account.
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nd account because it cannot have a cash 

 to or from any other Quicken account.
f the current investment account.

dded to the purchase price or subtracted 
ission field.

 load) is a commission built into the 
urity. A load fund has two share prices: a 
alue (NAV) price. Enter the purchase of a 
al commission. The true market value of 

 price. If you want to correct the market 
e NAV price (see “Updating 
 between the market value and what you 

he selling price. Funds with these loads 
rice. Enter the sale of such a fund using 

ceeds 
h 

[Checking]2

ts is [Current Account]3

Enter in Transfer field
1 This choice is not available in a mutual fu
balance.

2 [Checking] represents a generic transfer
3 [Current Account] represents the name o

Commissions. If an explicit commission is a
from the sale proceeds, enter it in the Comm

Loads. A load (sometimes called a front-end
purchase price of a mutual fund or other sec
Buy or Offer price and a Sell or Net Asset V
load fund at the Buy price with no addition
your investment is based on the Sell or NAV
value, update the price of the fund using th
security prices” on page 339). The difference
paid is the load.
A back-end load is a commission built into t
have an NAV price greater than the selling p
the actual selling price.

Quicken adds the sale pro
(transfers them) to the cas
balance of [Checking].

Cash balance in all accoun
unchanged.

Action Desired Result
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er its original date of issue, you usually 
 owner. Accrued interest is interest the 
t.

se transaction without including accrued 

nter the payment of accrued interest as a 
ame in the Security field, the dollar 
pense category “•Accrued Int” in the 

ther Quicken account, enter a third trans-
 accrued interest. Use the Transfer Money 
t.

e lots for each security so you can identify 
 only part of your holdings. Unless 
 selling the ones you bought first (the first 
specify exactly which lots you are selling, 
 register (or the Choose Lots button in the 
 in the Select Specific Shares (Lots) 

e the Move Shares Out action to remove 
s a gift, for example) or when you use the 
Accrued Interest. When you buy a bond aft
have to pay accrued interest to the previous
bond has already earned but not yet paid ou

• Use a Buy action to enter the bond purcha
interest.

• Use the Misc. Expense (MISC) action to e
separate transaction. Enter the security n
amount in the Cash Out field, and the ex
Category field.

• If you paid the accrued interest out of ano
action to show a cash transfer equal to the
(XFR) action and enter the source accoun

Security lots. Quicken keeps track of separat
which shares you are selling* when you sell
Quicken is told otherwise, it assumes you’re
in, first out or FIFO method). If you want to 
click the Lots button in the transaction in the
investment form) and fill in the information
window.

*Lot selection is also available when you us
shares from an account (if you give them a
Buy action to cover a short position.



Chapter 14, Tracking investments    327

idends or interest, you need to tell 
ccount or being transferred out. Use the 
e action (II).

Shares to Sell tells you how many 
shares you entered in the Shares Out 
field in the register.

Total Selected keeps a running total of 
the amounts entered in the Selected 
column.

Remaining lets you know how many 
more shares you need to select.

Enter in Transfer field

d or 
h 
ount.

nothing; leave it blank1
Entering dividends and interest

For reinvested dividends or 
interest, see “Entering reinvest-
ments” on page 328.

When you enter the receipt of cash from div
Quicken whether the cash is staying in the a
Dividend action (DIV) or the Interest Incom

Quicken displays all the avail-
able (open) lots for the security 
and lets you enter individual 
amounts to sell in the Selected 
column.You can double-click a 
row to select all the shares in 
that row.

Click Clear All to set the selection back to 
zero for all lots.

You can also use this pop-up 
menu to choose one of several 
common methods for selecting 
lots to sell. When you choose an 
item from the menu, Quicken 
does the calculations and 
makes the selection for you.

Action Desired Result

DIV or II Quicken adds the dividen
interest income to the cas
balance of the current acc
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nd account because it cannot have a cash 

 to or from any other Quicken account.
f the current investment account.

 fund that is the cash balance of a 
 and enter the name of the money market 

mutual fund pays you as a result of 
ecurities in the fund) like a dividend in 

l shares of a security with money paid to 
income (use the Reinvest Dividend or 
tribution (use the Reinvest Long or 

d or 
 it) to 
king].

[Checking]2

ts is [Current Account]3

Enter in Transfer field
1 This choice is not available in a mutual fu
balance.

2 [Checking] represents a generic transfer
3 [Current Account] represents the name o

For dividend income from a money market
brokerage account, use the Dividend action
fund in the Security field.

Treat an income distribution (money that a 
dividends and interest it receives from the s
Quicken.

Entering reinvestments

A reinvestment is the purchase of additiona
you by that security as dividend or interest 
Reinvest Interest action) or capital gains dis
Reinvest Short action).

Quicken adds the dividen
interest income (transfers
the cash balance of [Chec

Cash balance in all accoun
unchanged.

Action Desired Result
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ons (one of the income actions plus a Buy 
r cost basis because each reinvestment 

tual funds

o you by a mutual fund as a result of 
ities within the fund. The fund usually 
hort-term or long-term capital gains. Use 
n Short (CGS) action.

nd account because it cannot have a cash 

 to or from any other Quicken account.
f the current investment account.

Enter in Transfer field

m the 
lance 

nothing; leave it blank1

m the 
to the 
].

[Checking]2

ts is [Current Account]3
Reinvestment actions combine two transacti
action) into one. Reinvestments increase you
counts as a purchase of shares.

Entering capital gains distributions from mu

For capital gains distributions 
reinvested in new shares, see 
“Entering reinvestments” on this 
page.

A capital gains distribution is money paid t
capital gains the fund earns by selling secur
informs you whether the distribution is for s
the Capital Gain Long (CGL) or Capital Gai

1 This choice is not available in a mutual fu
balance.

2 [Checking] represents a generic transfer
3 [Current Account] represents the name o

Action Desired Result

CGL or CGS Quicken adds the cash fro
distribution to the cash ba
of the current account.

Quicken adds the cash fro
distribution (transfers it) 
cash balance of [Checking

Cash balance in all accoun
unchanged.
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total or partial repayment of the money 
 a sale in that you are not the one who 

 mortgage-backed security (such as a 
assed on to you, when the underlying 
 returns capital as it sells the bonds in the 

ital gains distribution, is not a taxable 
cord it in Quicken. Quicken reduces the 
he return of capital (or, if you enter a 
u own multiple lots of the security, 
n proportion to the number of shares.

ty, Quicken treats the transaction differ-

on to record the number of shares (but no 
ur number of shares and records a sale 
ring the shares to another Quicken 
nsaction for receipt of the shares in the 

tion to add shares without subtracting 
umber of shares received and the actual 
Entering a return of capital or principal

A return of capital is money paid to you as 
you invested. A return of capital differs from
initiates the return of capital. For example, a
Ginnie Mae) returns capital, which is then p
mortgages pay off principal. A unit trust also
trust.

Important! After a Return of 
Capital action, you must also 
update the security price in the 
Portfolio window if you want to 
see the correct market value.

A return of capital or principal, unlike a cap
event. Use the Return of Capital action to re
cost basis of the security by the amount of t
negative amount, raises the cost basis). If yo
Quicken reduces the cost basis for each lot i

Giving and receiving securities

When you give or receive shares of a securi
ently than it treats a purchase or sale.

Giving shares. Use the Move Shares Out acti
price or dollar amount). Quicken reduces yo
with a capital gain of zero. If you’re transfer
account, enter a separate Move Shares In tra
second account.

Receiving shares. Use the Move Shares In ac
cash from any Quicken account. Enter the n
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, fees, and load). The way you figure the 
ares as a gift or an inheritance:

lly the value of the shares on the date the 
 date. When you receive inherited shares, 
ate.

e price the giver originally paid for the 
ord the cost per share when the giver 

r other retirement account, the fund may 
l action and enter both the share price and 

nt of the fee in the Commission field to 
 Enter the name of the investment account 

k split, you are usually given additional 
 was before the split, but the total market 
 Stock Split action to record the split in 
ions for that security.
initial cost per share (including commission
cost depends on whether you receive the sh

Important! Consult your tax 
adviser about rules that may 
apply in determining gain or loss 
on shares you inherit or receive as 
a gift.

• Inherited shares. The cost basis is genera
decedent died or an alternative valuation
record the cost per share (price) on that d

• Gift shares. The cost basis is generally th
shares. When you receive gift shares, rec
purchased the shares.

Redeeming shares for IRA custodial fees

In a mutual fund account set up as an IRA o
redeem shares as a custodial fee. Use the Sel
the total dollar amount. Also enter the amou
make the net amount of the transaction zero.
itself in the Transfer field.

Entering stock splits and stock dividends

Note: In a reverse split, you 
receive fewer shares than you 
have now.

Stock splits. When a security declares a stoc
shares. Each share is then worth less than it
value for your shares is unchanged. Use the
each Quicken account that contains transact
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new price per share. Quicken recalculates 
ber of shares and updates the market 

ly recorded transactions for the security.
e security on the same day as the split, 
 transactions. For example, if you had 100 
ll 100 shares on the day of the split, 

end in the form of additional shares 
same as a cash dividend issued by a 
cash dividend.

mpany issuing the stock dividend will 
he Stock Split action to enter a nontaxable 
to old shares, add 1 to the number of 
r example, if you receive 0.05 share per 
). Use the Reinvest Dividend action for a 

ratio. This example shows a 2-for-1 split.

le: if you receive one additional share for 
res you hold, you would have four (three 

very three you had before, so the Split 
 4-for-3, and you would enter 4 for 3 in 
fields.

price (after the split) for the security.
When you record a stock split, you enter the 
your average cost per share for the new num
price. Quicken doesn’t change any previous
If you have more than one transaction for th
Quicken puts the stock split before the other
shares before a two-for-one split, and you se
Quicken knows you still have 100 shares.

Stock dividends. A stock dividend is a divid
instead of cash. A stock dividend is not the 
company, nor is it the same as a reinvested 

Most stock dividends are nontaxable; the co
inform you whether or not it is taxable. Use t
stock dividend. For the ratio of new shares 
dividend shares given per existing share (fo
existing share, enter 1.05 to 1 for Split Ratio
taxable stock dividend.

Enter the split 

Another examp
every three sha
plus one) for e
Ratio would be
the Split Ratio 

Enter the new 
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 broker to pay for a security you are 
have a margin loan; if you buy a security 
count, Quicken displays a negative cash 

, use the Misc. Expense action and assign 
nterest transaction.

loan principal amount, use the Transfer 
row at the time you borrow it, and enter 
 form Source of Funds field (or in the 
ransfer Money transaction when you pay 

 in various face value denominations. You 
face value and interest is paid when the 
s EE bond is exempt from state and local 
d is redeemed. When you buy a Series EE 
Buying on margin

A margin loan is money you borrow from a
buying. You don’t have to tell Quicken you 
and don’t have enough cash for it in your ac
balance.

To record interest you pay on a margin loan
the category “•Int Expense” to the margin i

For information about using a 
liability account to track the loan 
principal, see Chapter 12, 
Tracking assets and liabilities, on 
page 234.

If you set up a liability account to track the 
Money action to record the amount you bor
the liability account name in the investment
register Transfer field). Then enter another T
off the loan.

Buying and redeeming U.S. savings bonds

The U.S. government issues Series EE bonds
buy a Series EE bond at a discount from its 
bond is redeemed. The interest from a Serie
taxes, and no federal tax is due until the bon
bond, use the Buy action.
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urity), enter the purchase price as the sale 
ween the purchase price and the redemp-
 Income action to record this difference as 

 most individual taxpayers do, you gener-
s when you actually receive it. If you use 
report interest on U.S. savings bonds each 
ual of interest, use the method described 
 zero-coupon bonds” on this page.

lue. When you sell it, part of the sale price 
ill or bond. Use the Interest Income action 
l, and enter the difference between the 
e dollar amount for the Sell transaction.

ame of the security is:

0 6% 1/28

ns “face value $1000, 6% interest, 
date January 2028.”
When you redeem the bond (at or before mat
price in a Sell transaction. The difference bet
tion price is taxable interest. Use the Interest
interest income.

If you use the cash method of accounting, as
ally report the interest on U.S. savings bond
the accrual method of accounting, you must 
year as it accrues. To record the annual accr
for recording taxable interest in “Recording

Redeeming T-bills

You buy a T-bill at a discount from its face va
is interest you’ve earned while holding the b
to record the interest received when you sel
interest amount and the total sale price as th

In this example, the buyer 
purchased one Series EE bond 
with a face value of $1,000.

To match the way bond prices 
are quoted, the price is divided 
by 10 and the number of shares 
is multiplied by 10.

The purchase price was $500 
because it was purchased at 
half the face value.

The full n

  US $100

This mea
maturity 
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rom its face value. While you hold it, its 
ns. Even though you don’t receive this 
very year on a Form 1099-OID as taxable 
ord the interest shown on Form 1099-OID 
rd a second transaction for the corre-
n the Return of Capital transaction, enter 
interest amount. This negative Return of 
d thus reduces the unrealized gain if you 
rice of the bond.

ant to record interest income, clear the 
 as a security. Then Quicken will assign a 
nsaction for the interest you receive.

distinctive name such as “XYZ put Aug 

tion at the purchase price. For example, if 
nsaction with a share price of $5.

osition with a Sell transaction for the 
Sell action).
Recording zero-coupon bonds

You buy a zero-coupon bond at a discount f
value increases because of the interest it ear
interest until you sell, it is reported to you e
interest. Use the Interest Income action to rec
and use the Return of Capital action to reco
sponding increase in the value of the bond. I
a dollar amount equal to the negative of the 
Capital amount increases your cost basis an
sell the bond or update the current market p

Handling tax-free bond income

If you have a tax-free bond for which you w
Taxable checkbox when you set up the bond
non-taxable category when you record a tra

Entering options (puts and calls)

Treat an option like a security and give it a 
40.”

• When you buy a call, enter a Buy transac
you buy a $40 call for $5, enter a Buy tra

• When you exercise the call, close your p
amount of the call (in this example, a $5 
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ty, include the cost of the call as a fee paid 
e, you would enter a Buy transaction for 

, Quicken treats it like a short sale. If an 
s, enter the opposite action (Sell or Buy, 
 to close your position. Quicken then 

se a call, close your position with a Sell 

 own; you actually sell shares you borrow 
y the security later at a lower price to pay 
you initially sell the shares and then use 
e out the short sale. Quicken calculates 
t time.

r gains from short sales. They do not 
lose out the short sale with a Buy at the 
ur actual purchase price, and finally enter 
s amount.
• When entering the purchase of the securi
(to correct the cost basis). In this exampl
$40 plus a $5 commission.

If you sell an option you don’t already own
option you bought or sold expires worthles
respectively) for the option at a price of zero
records a realized gain or loss. If you exerci
transaction for the call.

Selling short

A short sale is the sale of a security you don’t
from your broker and hope that you can bu
your broker back. Use the Sell action when 
the Buy action when you buy shares to clos
your gain or loss on the entire process at tha

Note: In investment performance 
reports, the average annual total 
return for a short sale (a Sell 
followed by a Buy) is a negative 
value.

Use the investment income report to see you
appear in capital gains reports unless you c
original sales amount, then enter a Buy at yo
a second Sell transaction at the original sale
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counts in a country other than the United 
rrency and keep track of changing 

ual fund account to track holdings in a 

or the account that you hold in a foreign 

t with the name “U.K. Savings” for a bank 

 record an opening balance transaction. 
 pounds) in the Shares In field and the 
field.

rt U.K. pounds to U.S. dollars is 1.5, you 
 

Managing foreign currency

If you have investments or other types of ac
States, you need a way to manage foreign cu
exchange rates. You can use a Quicken mut
foreign currency.

1 Set up a Quicken mutual fund account f
currency.

For example, you could set up an accoun
account in the U.K.

2 Use the Buy or Move Shares In action to
Enter the balance of the account (in U.K.
current exchange rate in the Share Price 

For example, if the current rate to conve
would enter 1.5 in the Share Price field.

The first transaction is the original 
short sale, followed by a Buy that 
closes out the sale with no gain or 
loss. The third transaction is the 
Buy that closes out your position, 
followed by a Sell that closes out 
the trade so it appears (and shows 
the profit) in a capital gains 
report.



Chapter 14, Tracking investments    338

en you earn interest.

ange rate by entering it in the Price field 

 bank 
uicken 
on.

Share Balance is the 
current balance in U.K. 
pounds.

Market Value is the 
current balance in U.S. 
dollars.
3 Record Reinvest Interest transactions wh

4 (Optional) Keep track of the current exch
for the security in the Portfolio window.

Record a Reinvest Interest 
transaction when you earn 
interest on the account.

When you transfer funds between a Quicken
account and the foreign currency account, Q
automatically records a Buy or Sell transacti

Enter the current exchange 
rate in the Share Price field.

For Shares Out or Shares In, 
enter amounts in U.K. 
pounds.
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 Portfolio window; you can add, edit and 
you can use Quicken Quotes™ to retrieve 
r some or all of your securities; and you 

or up to the last five years.

ties every day if you like; Quicken will 
. Whenever you update prices, Quicken 
t values for your securities and accounts.

 price information in the file Quicken 
der on your hard drive. You’ll want to 
icken data file. 

file by typing x-Option-U: Quicken also 
ctions to the Quicken Quotes file on your 
Updating security prices

You can view and enter security prices in the
delete prices in the Security Detail window; 
prices for the last five trading days online fo
can download historical price information f

You can update share prices for your securi
keep track of one price per day per security
uses the new prices to recalculate the marke

Important: Quicken saves your downloaded
Quotes, stored in the Quicken Essentials fol
back up this file just as you would your Qu

You can copy prices to the Quicken Quotes 
copies all price information from your transa
hard disk.
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rtfolio window

esting area and click the Portfolio button 

re prices and market values for all securi-
e prices and market values are shown “as 
 recorded a price.

w, follow these steps for each date on 

ate for which you want to enter share 

Market value for a security 
equals the share price times 
the number of shares.

For more information 
about the Portfolio 
window, see page 282.

The only value you can edit 
in this window is the share 
price.

ty to add a 
n account 
ist.
Viewing and entering prices in the Po

To open the Portfolio window, go to the Inv
in the toolbar (x-H).

In the Portfolio window, Quicken shows sha
ties in all your investment accounts. All shar
of” the most recent prior date for which you

To enter share prices in the Portfolio windo
which you want to enter a price.

1 Change the Set Prices As Of date to the d
prices.

The Portfolio window shows all 
securities for which you have an 
open position, unless you have 
marked the security as hidden 
(see step 4 on page 292). It also 
shows any securities or indexes 
you have added to the WatchList.

Click Detail to see detail 
information about the 
selected security.

Change the date to view share 
prices and market values “as of” 
a different date. Use the pop-up 
calendar to quickly choose 
another date. Click Add Securi

new security to a
or to the WatchL



Chapter 14, Tracking investments    341

te field are available in the Portfolio 
s:

for the displayed date.

rice field, or press + or − to change the 

ices As Of In the Price field for the 
security, press 

Option-plus

Option-minus

t-plus Option-Shift-plus

t-minus Option-Shift-minus

od) Option-Shift-period

ma) Option-Shift-comma
All the date shortcuts available in any da
window. You can also use these shortcut

For information about entering 
share prices for different kinds of 
securities, see page 300.

2 Select a security and enter a share price 

Just type the price in the selected Share P
price to the next 1/8 (0.125).

To go to this date In the Set Pr
field, press 

Next day + (plus)

Previous day − (minus)

Latest known price for a 
security

Option-Shif

Earliest known price for 
a security

Option-Shif

Next known price for a 
security

> (Shift-peri

Previous known price 
for a security

< (Shift-com
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he column to the right of the Share Price 

 record the newly entered price.

dates any other securities with the same 

 to be incorrect for any reason, press x-
 and number of shares based on the trans-
ters. At the same time, Quicken also 
ctions to the Quicken Quotes file on your 

at

 an estimate (Quicken uses the most 
 price you’ve entered for this security).

 an increase or decrease from the most 
ered share price.

 the same as the last price entered for this 

ave been entered for this security.
Quicken uses the following symbols in t
field in the Portfolio window:

3 Click Record or press Return or Enter to

If the security has a symbol, Quicken up
symbol.

Recalculating security prices

If the prices in the Portfolio window appear
Option-U. Quicken updates the share prices
actions in all your Quicken investment regis
copies all price information from your transa
hard disk.

This symbol Tells you th

♦ (diamond) This price is
recent share

↑  or  ↓ This price is
recently ent

5  (bar) This price is
security.

❍  (circle) No prices h
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hidden, they don’t appear in the Portfolio 
e register. This means that the market 
h the market value for that account in the 
ee “Hiding a security” on page 360.

s in Security Detail

eleted in the Prices panel in the Security 

folio window to go to the Security Detail 

ry list for the security.

e information.
 list, click New and fill in the New Price 
sing price, you can also enter high, low, 
ified date.
 in the list, click Edit, and then change any 
indow.
in the list, click Delete, and then click Yes 
re.
Important: If you have securities marked as 
window, but their transactions are still in th
value in the Register window may not matc
Portfolio window. To “unhide” a security, s

Adding, changing, and deleting price

Security prices can be added, changed, or d
Detail window.

1 Double-click a security name in the Port
window with that security selected.

Note: If you have downloaded a 
price history for a security from 
the Internet, those prices are 
displayed in the Security Detail 
Prices tab. Any prices you’ve 
added or changed will not be 
shown if a historical price is avail-
able for the same date.

2 Click the Prices tab to see the price histo

3 Make your changes to the displayed pric
• If you want to add a new price to the

window. In addition to entering a clo
and volume information for the spec

• If you want to change a price, select it
of the information in the Edit Price w

• If you want to delete a price, select it 
when Quicken asks you if you are su
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uotation service. You can use it to retrieve 
 well as market indexes such as the Dow 
t five trading days. With Quicken Quotes, 
hether you own it or not.

 allows you to download security prices, 
s, you can use it to retrieve stock, mutual 
et indexes, and you can update prices for 

es, you must have a stock symbol. 
Retrieving security prices online

Note: You may not be able to use 
Quicken Quotes, or the historical 
prices download feature, from 
your place of business if your 
employer has established a 
“firewall” between your 
computer and the Internet. 
Contact your company’s network 
administrator for more informa-
tion.

• Quicken Quotes is an online stock price q
stock, mutual fund, and option prices, as
Jones or Standard & Poor’s 500 for the las
you can update prices for any security, w

• The Quicken historical prices feature also
for up to five years. Like Quicken Quote
fund, and option prices, as well as mark
any security. 

Before you begin downloading security pric
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eviation that uniquely identifies a 
e name of the company or group issuing 

w Jones 30). Since Quicken uses symbols 
mbol to each security for which you want 
e as those commonly used by major stock 

der to retrieve prices for a security. You 
ch of your securities by choosing Securi-
s list. If you need to add or correct a stock 

symbols from your broker, from the 
e, or from financial publications.
Understanding stock symbols

A stock symbol (or ticker symbol) is an abbr
security. Often it is a shortened version of th
the security, like INTU (Intuit) or DJ 30 (Do
to retrieve stock prices, you must assign a sy
to get prices. These symbols must be the sam
exchanges.

You must enter the exact stock symbol in or
can see the symbols currently assigned to ea
ties from the Lists menu to open the Securitie
symbol in Quicken, you can get the correct 
company whose quotes you want to retriev
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exchanges

refixes when entering them into your 
adian securities, you must enter a prefix 
change, followed by a colon (:), and then 

E or F:AIS509.

fixes:

xchange

 Exchange 

er Stocks

Exchange

k Exchange 
Entering stock symbols for Canadian stock 

United States securities don’t require any p
investment accounts; however, to track Can
to indicate either the securities type or its ex
enter the stock or mutual fund symbol.

In the symbol field, enter for example, T: BC

The following is a list of valid Canadian pre

Prefix Exchange

A Alberta Stock E

F Mutual funds

M Montreal Stock

O Over the Count

T  Toronto Stock 

V Vancouver Stoc
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u are looking at the information you 

 20-minute delay (depending on the 
ce for the day if you retrieve the quotation 
rices are quoted at the previous day’s 

 and American stock exchanges reflect the 
0-minute delay). Prices for stocks traded 
e or quote (average of bid and ask) avail-
ge of bid and ask) are available on 

ne exchange, there may be a price differ-
te of those prices.
Understanding stock price information

Keep the following points in mind when yo
retrieve with Quicken Quotes:

• Stock prices are quoted on either a 15- or
service you choose), or on the closing pri
after the market is closed. Mutual fund p
closing price.

• Prices for stocks traded on the New York
most recent composite stock trade (on a 2
on NASDAQ reflect the most recent trad
able on a 20-minute delay. Quotes (avera
additional over-the-counter issues.

• If the same stock appears on more than o
ence. Quicken Quotes reports a composi
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otes

 menu.

ion, Quicken displays a summary 
ds either the high or low price setting you 
f the change in the market value of any 
you entered in Quicken Quotes prefer-
in this window.

rices, click View Latest Prices.

 the price history graph, click the Portfolio 
o window, click the Graph tab; then click 
trading volume” and “Show high-low 
Retrieving security prices using Quicken Qu

Note: Quicken stores only one 
price per security per day; if you 
store prices multiple times in a 
day, the new prices replace the 
existing prices.To retrieve stock 
quotations for the last five trading 
days, use Quicken Quotes.

1 Choose Quicken Quotes from the Online

After downloading the pricing informat
window. If any price that’s entered excee
entered for a security (see page 292), or i
investment account exceeds the percent 
ences (see page 350), Quicken reports it 

2 (Optional) To see all of the new closing p

To see all of the new price information in
button in the toolbar to open the Portfoli
the Customize button, select the “Show 
price range” checkboxes, and click OK.
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 five years, use Quicken’s historical prices 

 menu.

ich you would like to download price 

e historical pricing information.

n your data file. You will see the 
en the Portfolio window.

s all securities.

des all securities.
Retrieving historical security prices

To retrieve stock quotations for up to the last
feature. 

1 Choose Historical Prices from the Online

2 Select the names of the securities for wh
histories.

3 Select the date range for which you’d lik

4 Click Download.

Quicken enters the downloaded prices i
downloaded prices the next time you op

Each security (or index) in your 
Securities list appears in this 
window if it has a symbol 
assigned to it—whether or not 
you actually own it.

Select

Exclu
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n you get when you retrieve stock prices. 
ns about stock prices or trading methods.

n for items traded on exchanges

 shares traded on the current day
f contracts traded during the current day
o volume is shown)

 on the current day (for mutual funds, this 

on the current day (for mutual funds, this 

t the last price update

e current price (Current) and yesterday’s 

price update or, if the last update was not 
price update
The following table describes the informatio
Consult your stockbroker if you have questio

Field Definition

Symbol Stock symbol identificatio

Volume For stocks, the number of
For options, the number o
For mutual funds, zero (n

High The highest trading value
is the ask price)

Low The lowest trading value 
is the bid price)

Current The price of the security a

Change The difference between th
closing price

Time/Date Either the time of the last 
today, the date of the last 
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time, you may need to check the Quicken 

and then click the Quotes icon in the 

e, that you would like Quicken to report 

ices you retrieve change the market value 
 the entered percentage.
Setting Quicken Quotes preferences

Before you use Quicken Quotes for the first 
Quotes settings in the Preferences window.

1 Choose Preferences from the Edit menu 
scrolling panel on the left.

2 Enter the amount of change, in percentag
in the Download Summary window.

Quicken lets you know whenever the pr
of any investment account by more than

3 Click OK to save your settings.
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torical prices, you can still import security 
port prices from a text file if the text file 

 can understand: one symbol/price/date 
ble spaces (using only one type of delim-
 and quotation marks.

s based on symbols, you must add 
st (see step 4 on page 292). After you’ve 
e a text file containing symbols, prices, 

QIF from the File menu.

 and click Open.
e: !Type:Prices

 carriage return
s for the price data:
Importing a price file into Quicken

Even if you don’t use Quicken Quotes or his
price data into your Quicken file. You can im
contains the information in a format Quicken
per line, delimited by either commas or dou
iter per line). Quicken ignores single spaces

Since Quicken matches prices with securitie
symbols for the securities in the Securities li
assigned symbols to your securities and hav
and dates, you are ready to import the file.

1 In the Portfolio window, choose Import 

2 Select the file that contains the price data
• The first line in the import file must b
• The last line must be: ^ followed by a
• And you can use any of these format

ABC, 123.456
ABC, 123.456, 12/31/96
ABC   123.456   12/31/96
"ABC", 123.456, "12/31/96"
"ABC", "123.456", "12/31/96"
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es you don’t own

opular stock indexes, such as the Dow 
oor’s 500 stock index. Or you might want 
 you’ll need to set up the security or index 

button in the toolbar.

tom of the Portfolio window.

name of the security or index you want to 

ready in the Securities list), click Set Up 
up.

hen click Create to add the security to the 

 292.

 Security to WatchList and click OK.

alue or security price in the Price field for 

r index you want to add to the WatchList, 
st and drop it in the Portfolio window.
Tracking indexes and securiti

You may want to track one or more of the p
Jones Industrial Average or the Standard & P
to track a security you don’t own. To do that,
and then add it to the WatchList.

1 In the Investing area, click the Portfolio 

2 Click the Add Security button at the bot

3 In the Security Name window, enter the 
track and click OK.

If this is a new security (one that’s not al
when Quicken asks if you want to set it 

4 Fill in the Set Up Security window, and t
Securities list.

For more information, see step 4 on page

5 In the Add Security window, select Add

6 In the Portfolio window, enter an index v
one or more dates.

Tip: If you’ve already set up the security o
you can just drag it from the Securities li
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 for investments

out your investments, the more complete 
ill be. If you initially set up your invest-

of prices and dates for transactions, you 
 more complete information.

ou must revise the initial Move Shares In 
all transactions from your initial acquisi-

er of shares of securities owned on that 

er of shares on the day before the 
e period and on the last day of the period, 
tions during the period

res and cost basis on a date at least one 
 beginning of the period for all securities 
plus all purchases and sales (including 
vestments, and returns of capital) from 

 end of the period

res owned and price per share at the 
end of the period (to include unrealized 
transactions during the period
Entering a transaction history

The more information you give Quicken ab
and accurate your reports and summaries w
ment accounts by entering rough estimates 
may want to go back now and give Quicken

To enter a complete history for a security, y
transaction for that security and then enter 
tion until today.

To get Tell Quicken

Accurate market values 
for a specified date

Price and numb
date

Accurate average 
annual total return for a 
specified period

Price and numb
beginning of th
plus all transac

Accurate capital gains 
summary (realized 
short-term and long-
term gain or loss) for a 
specified period

Number of sha
year before the
you have sold, 
stock splits, rein
that date to the

Accurate income and 
expense summary for a 
specified period

Number of sha
beginning and 
gains), plus all 
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nsaction

ion for the security in the register.

isition.*

t per share (including commission, fees, 

 in the Shares In field.

ction.

eps the original date and price in the price 
 price, see “Adding, changing, and 
 343.
Revising an initial Move Shares In tra

1 Select the initial Move Shares In transact

2 Revise the date to the initial date of acqu

3 If necessary, enter your actual initial cos
and load) in the Share Price field.

4 If necessary, revise the number of shares

5 Click Record to record the revised transa

*When you change the date, Quicken still ke
history list. To delete the original date and
deleting prices in Security Detail” on page
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past

 for the account or in the appropriate 

ch transaction.

h into or out of the account, use a self-
e cash balance in this account or any other 

 investment form, enter the name of the 
ds or Source of Funds field. In the register, 
 the Transfer field.

to or out of a portfolio account, use the 
er and leave the Transfer field blank. This 
 the account by the amount of the transfer.

ly) is incorrect when you finish entering 
t Balance from the Activities menu; see 
 page 364.
Entering transactions for dates in the 

Enter past transactions either in the register
investment forms.

• Make sure to enter the correct date for ea

• If a transaction involves a transfer of cas
transfer transaction to avoid changing th
account.

To create a self-transfer transaction in an
current account in the Destination of Fun
enter the name of the current account in

• If you want to enter a transfer of cash in
Transfer Money action (XFR) in the regist
increases or decreases the cash balance in

• If the cash balance (portfolio accounts on
transactions, adjust it by choosing Adjus
“Adjusting the cash or share balance” on
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ing securities

ered for a security: name, symbol, type, 

e security you want to edit.

Security Info tab and then click Edit.

indow* (which looks just like the Set Up 
d click OK.

en changes the name in the Security field 
ange a security’s tax status, Quicken 
the corresponding non-taxable categories 
e investment categories assigned to them.

w from the Securities list by selecting the 
Changing, deleting, and mov

Changing security information

You can edit any of the information you ent
goal, price alerts, and tax status.

1 In the Portfolio window, double-click th

2 In the Security Detail window, click the 

3 Make your changes in the Edit Security w
Security window shown on page 292) an

If you change the name of a security, Quick
of any transactions that include it. If you ch
replaces taxable investment categories with 
in any transactions for the security that hav

*You can also open the Edit Security windo
security in the list and clicking Edit.
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s list only if you don’t have an open 
leting a security does not delete any trans-
emoves the security name from the 
e it. If you want to keep the transaction 
ecurity and just mark it as hidden (see 
e, investment reports and graphs will 
that include it.

anently

er if:

 its history to a backup file, and want to 
ur working file.

 you don’t own.

d click Delete (x-D).

ity if Quicken shows that you own any 
Deleting and hiding securities

You can delete a security from the Securitie
position for that security in any account. De
actions; it just deletes its price history and r
Security field of any transactions that includ
history for a security, you should keep the s
“Hiding a security” on page 360). Otherwis
show no security name for the transactions 

Deleting a security from your data file perm

You might want to delete a security altogeth

• You don't own it anymore, you archived
delete the archived information from yo

• You’ve lost interest in tracking a security

• You want to start over for any reason.

To delete a security:

1 Choose Securities from the Lists menu.

2 Select the security you want to delete an

The Delete button is disabled for a secur
shares of that security.
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firm that you really want to delete the 

 the Securities list and from all transac-
3 Click Yes when Quicken asks you to con
security.

Quicken removes the security name from
tions that include it.
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ars in lists (like the Securities list and the 
sactions and in reports and graphs. That 

to-day data entry, but you keep its 

 click Edit (x-E).

t it and click OK.

t to hide the security, you’ll need to select 
e Securities list so that you can edit the 

on’t own, they can be deleted from the 
ht want to delete a security from the 

n account, or if you decide you no longer 

ty you want to delete from the WatchList.

dit menu (x-D).
Hiding a security

When you hide a security, it no longer appe
Portfolio window), but it still appears in tran
means that you no longer see it during day-
complete transaction history.

1 Choose Securities from the Lists menu.

2 Select the security you want to hide and

3 Click the Hide in Lists checkbox to selec

If you change your mind and no longer wan
the “Show hidden securities” checkbox in th
hidden security to “unhide” it.

Deleting a security from the WatchList

Since items in the WatchList are items you d
WatchList in the Portfolio window. You mig
WatchList if you purchase it and add it to a
want to track it.

1 In the Portfolio window, select the securi

2 Choose Delete WatchList Item from the E
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o another

ory for a security from one portfolio 
g the security name from the old account 

volve transfers to or from another 
e cash balance in one or both of the 
Moving a security from one account t

You can move the complete transaction hist
account to another by dragging and droppin
to the new one in the Portfolio window.

Caution: If any of the moved transactions in
Quicken account, you may need to adjust th
accounts.



Chapter 14, Tracking investments    362

 Web

a variety of information about individual 
ou have direct Internet access through an 
 to research more information about your 

ne menu.

hich you want more information, or 
nu.

 takes you to Quicken.com, displaying a 
 security you selected. 

ou understand the financial picture of the 

eluxe 2000 from the Application menu, at 
.

Researching securities on the

While the Security Detail window provides 
securities that you’ve set up in Quicken, if y
Internet Service Provider, you can go online
securities.

1 Choose Research Security from the Onli

2 Enter the security name or symbol for w
choose the security from the pop-up me

3 Click Go Online.

Quicken opens your default browser and
summary page of information about the

Information may include:
• recent trading information
• links to recent stories in the news
• financial statements
• company profiles

as well as many other resources to help y
security.

4 To return to Quicken, choose Quicken D
the top right hand corner of your screen
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nts

, mutual fund, or other financial adviser, 
tement. In a portfolio account you recon-

nt you reconcile the share balance. You 
en investment account. 

nt is similar to reconciling other Quicken 
Chapter 8, Reconciling Quicken accounts, 

a portfolio account, go to the Portfolio 
m the statement that you haven’t already 

stock split transaction cannot be recon-
pdate the account to match your state-

ance” next.
Reconciling investment accou

Reconciling an investment register

When you get a statement from your broker
you can reconcile your account with the sta
cile the cash balance; in a mutual fund accou
cannot reconcile market value in any Quick

Reconciling a portfolio or mutual fund accou
accounts. If you need more information, see 
on page 157.

After you’ve reconciled the cash balance in 
window (x-H) and enter any share prices fro
entered.

Tip: A mutual fund account that includes a 
ciled. Use the Adjust Balance command to u
ments. See “Adjusting the cash or share bal
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t account, you can still adjust the cash 
alance in a mutual fund account to match 

es menu.

are balance for this account.

 want to categorize the adjustment trans-

saction in the register that makes your 
 that transaction and all previous transac-
nt, a cash balance adjustment appears in 
ansaction. For a mutual fund account, a 
ove Shares (MS) transaction.

urity in a portfolio account, you need to 
action for the amount of the adjustment.
Adjusting the cash or share balance

If you don’t want to reconcile an investmen
balance in a portfolio account* or the share b
what’s on your statement.

1 Choose Adjust Balance from the Activiti

2 Enter the date and the current cash or sh

You can also enter a category name if you
action.

3 Click OK.

Note: When you make a share 
balance adjustment in a mutual 
fund account, the cost basis for the 
security does not change.

Quicken adds a balance adjustment tran
cash or share balance correct, and marks
tions as reconciled. For a portfolio accou
the register as a Transfer Money (XFR) tr
share balance adjustment appears as a M

*To adjust the share balance for a single sec
use a Move Shares In or Move Shares Out 
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 can use to get started quickly. Then you 
 can see your Quicken data just the way 
e any custom report you create so you can 

om which you can create reports that 

port answers one of eight basic questions 
. See “Getting easy answers” on page 368.

tion detail report that has only a few 
 of good information in a hurry. See 

 detailed enough to give you exactly the 
best suits your needs. See “Creating basic 

e report layout, content, and organization, 
ver again. See “Reusing custom report 

ategory are available right in your 
 that contains a payee or category for 
 report from the Shortcuts pop-up menu. 
n all occurrences of the selected payee or 
About reports

Quicken provides report templates that you
can customize the reports you create so you
you want to. Quicken also lets you memoriz
use it again.

There are several different starting points fr
show you the information you want to see.

• EasyAnswer reports. An EasyAnswer re
you may have about your financial data

• QuickReport. A QuickReport is a transac
customization options but provides a lot
“Creating a QuickReport” on page 369.

• Basic Quicken reports. These reports are
information you want in the format that 
Quicken reports” on page 370.

• Memorized reports. When you customiz
you can save the settings and use them o
settings” on page 395. 

• Shortcut reports. Reports on a payee or c
Quicken registers. Select any transaction
which you want a report. Then choose a
Quicken displays a year-to-date report o
category in the current account. 
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estions about your Quicken data without 
use. Use EasyAnswer reports if you want 
 questions in the illustration in step 3.

utton in the toolbar.

swer tab.

on you want answered.

ers the selected question.

data that answers your question and then 
Getting easy answers

EasyAnswer reports let you answer basic qu
having to figure out which type of report to 
to get a quick and easy answer to any of the

1 In the Reporting area, click the Reports b

2 In the Reports window, click the EasyAn

3 Click a radio button to choose the questi

4 Click Create to create a report that answ

Quicken searches the current file for the 
displays the report on the screen.

Click Customize to see the 
options for customizing the 
selected report. See “Custom-
izing reports” on page 372.

For the selected question, make 
sure the pop-up menu shows the 
time period for which you want 
a report.

If you choose the first question, 
enter a category name. If you 
choose the last question, enter a 
security name.
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e transactions for a specific payee, 
A QuickReport gives you information 
u specify.

port button in the toolbar.

gister or an item selected in a list, the 
give you a transaction report that includes 
counts that contain the selected item.

ick OK.

This field contains City Garbage 
because a transaction to City Garbage 
was selected in the register. You can 
change it to any text you want to 
match.
Creating a QuickReport

A QuickReport lets you see some or all of th
category, class, memo, account, or security. 
from all your accounts for the date range yo

1 In the Reporting area, click the QuickRe

If you have a transaction selected in a re
Create QuickReport window is preset to 
all transactions from all your Quicken ac

2 Define the report you want to run and cl

Choose Payee & Description, 
Category, Class, Memo, 
Account, or Security from this 
pop-up menu. Make sure that 
what you choose from this 
menu is appropriate for what 
you enter in the Contains field. Choose All Transactions to see all 

matching transactions, or choose a 
date range to limit the transactions.



Chapter 15, Creating reports    370

ts

of the standard, business, and investment 
e your report, see “Customizing reports” 

utton in the toolbar.

tandard, Business, or Investment tab to 

ze the 
Custom-

ts, see page 395; 
rts, see page 368.
Creating basic Quicken repor

You follow the same basic steps to create all 
reports in Quicken. If you want to customiz
on page 372.

1 In the Reporting area, click the Reports b

2 In the Reports window, click either the S
display a list of reports.

If you choose a preset date range 
from the Date pop-up menu, 
Quicken enters dates for you 
automatically. If you choose 
Custom, you can use the Custom 
Dates window to name and 
define your own custom date 
range and add it to the pop-up 
menu.

You can also just type your own 
dates in the From and Through 
fields.

Click Customize if you want to customi
selected report before you create it. See “
izing reports” on page 372. 

For information about memorized repor
for information about EasyAnswer repo

Quicken shows you a small 
sample of the report you selected. 
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 transactions to be included in the report.

 date is the first day of this year and the 

standard settings.

sactions in the specified date range and 
e search may take some time, depending 
 the complexity of the report.

e you create it, select the report and then 
indow. If you decide you want to 
izing reports” on page 372.
3 Select the report you want to create.

4 (Optional) Change the date range for the

Unless you change the dates, the starting
ending date is today.

5 Click Create to create a report using the 

Quicken searches the current file for tran
then displays the report on the screen. Th
on the size of your Quicken data file and

Tip: If you want to customize a report befor
click the Customize button in the Reports w
customize it after you create it, see “Custom
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e it; you can create a report first and then 
gs before you create the report and some 

reate one that’s close to what you want, 
op-up menus right on the report itself.

eral options for customizing the way it 
ge when you print it. 
Customizing reports

You can customize a report before you creat
customize it; or you can customize some thin
after.

Customizing right on the report

The easiest way to customize a report is to c
and then customize it using the icons and p

Changing the layout

After you’ve created a report, you have sev
looks onscreen and the way it fits on the pa
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a page break above any row by selecting 
k icon.

d by selecting it and clicking the Delete 

 Header icon to hide the title lets you see 
 also hidden in printed reports when it is 

ou can choose which columns to display 
con.

fitting to one page wide is possible for a 
en this checkbox is selected.

r most reports, you can choose a different 
nu to rearrange the data in the report. For 
tal items in the table that begins on 

If you select Tax Spouse 
and click the Add Page 
Break button, Quicken will 
add a page break above Tax 
Spouse.
• Add a manual page break. You can add 
that row and clicking the Add Page Brea

You can delete a page break you’ve adde
Page Break button.

• Hide the title area. Clicking the Collapse
more rows of report data. The title area is
hidden onscreen.

• Edit report columns. For many reports, y
and print by clicking the Edit Columns i

• Tell Quicken to Print One Page Wide. If 
report, Quicken will resize the report wh

• Sort or subtotal the report differently. Fo
item from the Subtotal or Sort pop-up me
more information, see the Sort and Subto
page 378.

In this report, Quicken has 
put a page break in the 
middle of the subcatego-
ries for Tax Spouse. To keep 
the category and subcate-
gories together on the same 
printed page, you can force 
a page break above the 
category name.
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 the fonts for some or all of the sections in 
he top of the report. 

ort, choose that section from the first pop-
ze, and style from the next three pop-up 

 that apply to all reports (except 
rt preferences” on page 400.

eport title by selecting it and typing a new 

on a report column by clicking under the 
ation.

ze individual columns by dragging the 
n heading. You can resize columns for all 
• Change the report fonts. You can change
your report using the pop-up menus at t

To make changes to one section of the rep
up menu, and then choose a new font, si
menus.

If you want to make global font changes
memorized reports), see “Changing repo

• Edit the report title. You can change the r
one.

• Reposition the columns. You can repositi
column title and dragging it to a new loc

• Change the column widths. You can resi
small diamond to the right of the colum
reports except reconciliation reports.

The mouse pointer changes to a 
double-pointed arrow when it 
passes over an area that you can 
drag to resize.
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oose Page Setup from the File menu and 
orientation.

dow. If you need customization options 
r you want to make a number of changes 
he Customize Report window and make 
ntent, and organization options. For more 
stomize Report window” on page 376.

rt

ctly the information you need, you can 
ffect what information you see. Just click 

a of the report and choose the way you 

ransactions included in the report, choose 
 next to the dates below the report title. If 
he illustration in step 2 on this page.

tegories, classes, or securities are included 
 to the appropriate item name to choose 
information about the available choices, 
• Change the page orientation. You can ch
switch between Portrait and Landscape 

• Customize in the Customize Report win
that aren’t available right on the report, o
to your report all at once, you can go to t
changes to any of the available layout, co
information, see “Customizing in the Cu

Restricting the items that appear in the repo

If the report you created doesn’t contain exa
make changes right on the report itself that a
one of the pop-up buttons in the header are
want to change the data that’s displayed.

• If you want to change the date range for t
a new date range from the pop-up menu
you prefer to type in specific dates, see t

• If you want to restrict which accounts, ca
in the report, use the pop-up menu next
exactly what you want to see. For more 

You can use any of the pop-ups to 
change the data you see in the report.
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curity items in the table that begins on 

other item for which you see a pop-up 
” on page 382.

t window

’t available right on the report, or you 
report all at once, you can use the 
s to any of the available layout, content, 

he information in your report by custom-

llow steps 1 through 3 in “Creating basic 
a report template. Then click Customize.

 the Customize button at the top of the 
see the Account, Category, Class, and Se
page 384.

• If you want to restrict the report by any 
button, see “Customizing report content

Customizing in the Customize Repor

If you need customization options that aren
want to make a number of changes to your 
Customize Report window to make change
and organization options.

Customizing report layout

You can change the way Quicken presents t
izing the report layout.

1 If you haven’t yet created your report, fo
Quicken reports” on page 370 to choose 

OR

If you’ve already created the report, click
Report window.
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he Layout tab.

options.

layout options (for reconciliation report 
port” on page 170). The choices available 
ort type. Not all options are available for 

ent or organization, click either the 

ings 
2 In the Customize Report window, click t

3 Make your changes to the report layout 

The table that follows step 5 lists report 
options, see “Creating a reconciliation re
for each option are determined by the rep
all reports.

See “Customizing report content” 
on page 382 and “Customizing 
report organization” on page 392 
for more information.

4 If you want to customize the report cont
Content or Organization tab.

5 Click OK to create the report.

This date range matches the 
date range for this report in the 
Reports window. If you want to 
change it, type new dates or 
choose a different date range 
from the pop-up menu.

You can use the generic title for 
the report, or enter a more 
descriptive title of your own.

This is the Layout tab for a 
category summary report.

Click Defaults to return to the initial sett
for this report.
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esults

reates the report using data from the 
lected budget.

cludes the difference between budgeted 
d actual amounts from each period in the 
dgeted amount for the next period.

oes not carry amounts forward

lick the Choose Columns button to go to 
e Choose Columns window where you 
n select exactly the columns you want to 
e in your report.

reates a separate column for each item. If 
u choose None, Quicken creates a 
port with a single amount column. Not 
l options are available for all reports that 
t you choose column headings.
Layout option Selection R

Budget the name of a budget C
se

Carry forward differences 
from previous periods

Selected

Not selected

In
an
bu
D

Choose columns C
th
ca
se

Column headings None, a time period, Category, Class, 
Payee, Account, Security, Security 
Type, or Investment Goal

C
yo
re
al
le
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cludes only categories for which you 
ve entered amounts in the selected 
dget. (If Match Budget Layout is 

lected, the layout of the report exactly 
atches the category layout in the Budget 
tup window for the selected budget.)
cludes categories for which you have 
tered amounts in the selected budget, 

lus categories that you have already used 
 transactions.
cludes every category in the Category & 
ansfer list.

enerates additional transaction lines (in 
e investment transaction report) or 
come/inflow lines (in the investment 
come report) to represent the impact of 

rice increases and decreases for securities.
oes not include unrealized gains.

omputes short-term capital gains based 
 the number of days you enter here.

esults
Include categories that meet 
the following criteria

Budgeted categories only

Budgeted or non-zero actuals

All categories

In
ha
bu
se
m
Se
In
en
p
in
In
Tr

Include unrealized gains Selected

Not selected

G
th
in
in
p
D

Maximum short-term holding 
period

any number of days C
on

Layout option Selection R
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cludes one total for account balances 
sed on the ending date you enter at the 
p of the window.
reates a column and totals account 
lances for each week, two weeks, half 
onth, month, quarter, half year, or year.

reates a separate row for each category, 
ass, payee, or account. Not all options are 
ailable for all reports that let you choose 
w headings.

reates a separate column that shows the 
ollar amount difference between the 
lected periods.
oes not include a dollar difference 
lumn.

ists check numbers that are missing or 
uplicated in the series of check numbers 
r each account.
oes not list missing or duplicated check 
mbers.

esults
Report at intervals of None

a time period

In
ba
to
C
ba
m

Row Headings Category, Class, Payee, or Account C
cl
av
ro

Show dollar column Selected

Not selected

C
d
se
D
co

Show missing checks Selected

Not selected

L
d
fo
D
nu

Layout option Selection R
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reates a separate column that shows the 
ercentage difference between the selected 
eriods.
oes not include a percentage difference 
lumn.

cludes all detail from split lines in split 
ansactions.
oes not include detail from split lines in 
lit transactions. Note: If you restrict the 
tegories or classes in the report, Quicken 
tomatically shows split transaction 

etail.

rts transactions by the item you choose. If 
u have also chosen an item for Subtotal, 

ansactions are sorted within the 
btotaled groupings. Not all options are 
ailable for all reports that let you choose 

sort item.

roups and totals transactions by the item 
u choose. If you choose Don’t Subtotal, 

uicken doesn’t subtotal amounts in the 
port. Not all options are available for all 
ports that let you choose a subtotal item.

esults
Show percent column Selected

Not selected

C
p
p
D
co

Show split detail Selected

Not selected

In
tr
D
sp
ca
au
d

Sort Account, Amount, Category, Check #, 
Class, Date, Memo, or Payee

So
yo
tr
su
av
a 

Subtotal Don’t Subtotal, a time period, 
Category, Class, Payee, Account, 
Security, Security Type, Investment 
Goal, or Short- vs. long-term

G
yo
Q
re
re

Layout option Selection R
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 included in your report by customizing 
nclude only transactions to a specific 
e that have been reconciled or cleared in 
ort only on payments from your accounts 
eport that’s limited to tax-related catego-

llow steps 1 through 3 in “Creating basic 
a report template. Then click Customize.

 the Customize button at the top of the 

he Content tab.

lick to create links between your 
tegories and tax-line items recognized by 
x preparation software.

lick to create links between your classes 
d copies of forms recognized by tax 

reparation software.

esults
Customizing report content

You can specify what kind of information is
the report content. You can tell Quicken to i
payee or only transactions to a specific paye
your accounts. Or you can have Quicken rep
or only on deposits. You can even create a r
ries only.

1 If you haven’t yet created your report, fo
Quicken reports” on page 370 to choose 

OR

If you’ve already created the report, click
Report window.

2 In the Customize Report window, click t

Tax Links see page 459 for information C
ca
ta

Tax Copies see page 467 for information C
an
p

Layout option Selection R
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t options.

 the report content options alphabetically. 
 determined by the report type. Not all 

ut or organization, click either the Layout 

You can choose which of 
these items to include for 
some types of reports.
3 Make your changes to the report conten

The table that begins on page 384 lists all
The choices available for each option are
options are available for all reports.

See “Customizing report layout” 
on page 376 and “Customizing 
report organization” on page 392 
for more information.

4 If you want to customize the report layo
or Organization tab.

This is the Content tab for 
a category summary report.

You can restrict as 
many or as few of 
these items as you 
want. See the table on 

Click Defaults to return to the 
initial settings for this report.

You can restrict as many or as few 
of these items as you want. See 
the table on the next page for 
detailed information about 
changing any of the content 
options available for your report.



Chapter 15, Creating reports    384

esults

cludes transactions from all accounts in 
e current Quicken data file.
cludes only transactions from the current 
count (or the most recently used 
count).
cludes only transactions from the 
counts you select in the Select Accounts 
indow. 

cludes all transaction amounts.
cludes amounts equal to the amount you 
ter.
cludes amounts greater than the amount 
u enter.
cludes amounts greater than or equal to 
e amount you enter.

cludes amounts less than the amount you 
ter.
cludes amounts less than or equal to the 
ount you enter.
5 Click OK to create the report.

Content option Selection R

Account All 

Current

Selected

In
th
In
ac
ac
In
ac
w

Amount Any
Equal

Greater

Greater or equal

Less

Less or equal

In
In
en
In
yo
In
th

In
en
In
am
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cludes all transactions, with or without 
tegories.
cludes only transactions categorized with 
e categories you select in the Select 
ategories window.
cludes categories that contain the text 
u enter.
cludes categories that match the text you 
ter exactly.
cludes categories that begin with the text 
u enter.
cludes categories that end with the text 
u enter.
cludes only transactions categorized with 
x-related categories.

cludes all transactions.
xcludes transactions with numbers or 
RINT in the Number column.
cludes only checks within the range of 
mbers you specify, for example, from 101 

rough 105.

esults
Category All

Selected

Contains

Is

Starts with

Ends with

Tax-related only

In
ca
In
th
C
In
yo
In
en
In
yo
In
yo
In
ta

Check # All
None

Numbered

In
E
P
In
nu
th

Content option Selection R
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cludes all transactions, with or without 
asses.
cludes only transactions classified with 
e classes you select in the Select Classes 
indow. 
cludes classes that contain the text you 
ter.
cludes classes that match the text you 
ter exactly.
cludes classes that begin with the text 
u enter.
cludes classes that end with the text you 
ter.

cludes uncleared transactions. Uncleared 
ansactions have nothing in the Clr 
lumn.
cludes cleared transactions. Cleared 
ansactions have a thin checkmark in the 
lr column.
cludes reconciled transactions. 

econciled transactions have a bold 
eckmark in the Clr column.

esults
Class All

Selected

Contains

Is

Starts with

Ends with

In
cl
In
th
w
In
en
In
en
In
yo
In
en

Include (cleared 
status)

Uncleared
items

Cleared
items (√)

Reconciled
items (�)

In
tr
co
In
tr
C
In
R
ch

Content option Selection R
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cludes payment transactions (including 
ecks). For nonbank accounts, payments 
e decreases to cash or asset accounts and 
creases to credit card or liability accounts.
cludes deposit transactions.
cludes unprinted checks.

cludes untransmitted electronic 
ayments (available only if electronic 
ayments are enabled).

cludes all investment goals.
cludes goals that contain the text you 
ter.
cludes goals that exactly match the text 
u enter.
cludes goals that begin with the text you 
ter.
cludes goals that end with the text you 
ter.

esults
Include (transac-
tion type)

Payments

Deposits
Unprinted 
Checks
Untransmit-
tedPmts

In
ch
ar
in
In
In

In
p
p

Investment Goal All
Contains
Is
Starts with
Ends with

In
In
en
In
yo
In
en
In
en

Content option Selection R



Chapter 15, Creating reports    388

cludes all transactions, with or without 
emos.
cludes memos that contain the text you 
ter.
cludes memos that exactly match the text 
u enter.
cludes memos that begin with the text 
u enter.
cludes memos that end with the text you 
ter.

cludes transactions for all payees. 
cludes payees that contain the text you 
ter.
cludes payees that exactly match the text 
u enter.
cludes payees that begin with the text 
u enter.
cludes payees that end with the text you 
ter.

esults
Memo All
Contains
Is
Starts with
Ends with

In
m
In
en
In
yo
In
yo
In
en

Payee & Descrip-
tion

All
Contains
Is
Starts with
Ends with

In
In
en
In
yo
In
yo
In
en

Content option Selection R
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ts, categories, classes, or securities, 
elect the items you want to include in the 

cludes all securities.
cludes only the securities you select in 
e Select Securities window. 
cludes securities that contain the text you 
ter.
cludes securities that exactly match the 
xt you enter.
cludes securities that begin with the text 
u enter.
cludes securities that end with the text 
u enter.

cludes all security types.
cludes types that contain the text you 
ter.
cludes types that exactly match the text 
u enter.
cludes types that begin with the text you 
ter.
cludes types that end with the text you 
ter.

esults
If you choose the Selected option for accoun
Quicken displays a window where you can s

Security All
Selected

Contains
Is
Starts with
Ends with

In
In
th
In
en
In
te
In
yo
In
yo

Security Type All
Contains
Is
Starts with
Ends with

In
In
en
In
yo
In
en
In
en

Content option Selection R
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d option for categories, Quicken displays 

uicken returns to the Content tab in the 
he report, Quicken includes only transac-
u can follow the same procedure to 
 or securities you select.

Selects all categories.

Selects only income categories 
or only expense categories.

Excludes all categories.
report. For example, if you choose the Selecte
the Select Categories window.

When you select categories and click OK, Q
Customize Report window. When you run t
tions that contain the selected categories. Yo
restrict a report to just the accounts, classes,

Click a category or subcategory 
to select or clear it. Quicken 
includes all marked categories 
and subcategories in the report. 
You can also select account 
names at the end of the list to 
include only selected transfers.

You can select “–No category–” 
if you want the report to include 
transactions that don’t have a 
category assigned to them. You 
can use this feature to track 
down all your uncategorized 
transactions so you can catego-
rize them.
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r Ends with option for payee, memo, 
estment goal, you can use special wildcard 
.*

f how wildcards can change your report.

hat contains unspecified characters where 
he beginning, in the middle, or at the end 
type). 

ith one unspecified character.

tches for the text that follows. 

s the search options for which you might 

The report does not include

l, tax, Tax, TAX, taxable, tax 
deduction, Tax:State, surtax, new 
tax loss

, TAX taxable, tax deduction, Tax:State, 
surtax, new tax loss, rent
It doesn’t matter whether you use 
upper- or lowercase letters, and 
Quicken ignores spaces before or 
after the phrase you type.

If you choose the Contains, Is, Starts with, o
category, class, security, security type, or inv
characters in text fields to narrow the search

The table on the next page gives examples o

Wildcard Description

.. (two periods) Finds a match t
you type .. (at t
of the text you 

? (question mark) Finds a match w

~ (tilde) Excludes all ma

*The table that begins on page 384 describe
use wild cards. 

Example The report includes

~tax rent, utilities, salary, trave
subscriptions, and so on

t..x trix, tx, tkx, t–––x, tax, Tax
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to search for a transaction or transactions 

n determine how income and expense 
nized in your report and which transfer 

llow steps 1 through 3 in “Creating basic 
a report template. Then click Customize.

 the Customize button at the top of the 

trix, tx, t–––x, taxable, tax 
deduction, new tax loss, 
Tax:State, surtax, rent 

blank 

tax, rent, utilities, and so on

The report does not include
You can also use these wildcard characters 
in a register.

Customizing report organization

The choices you make for report organizatio
categories and transfer transactions are orga
transactions are included.

1 If you haven’t yet created your report, fo
Quicken reports” on page 370 to choose 

OR

If you’ve already created the report, click
Report window.

t?x tkx, tax, Tax, TAX

.. tax, rent, salary, and so on

~.. blank 

Example The report includes
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he Organization tab.

ation options.

 the table that follows step 5 for informa-
are available for your report.

ut or content, click either the Layout or 
2 In the Customize Report window, click t

3 Make your changes to the report organiz

Organization options vary by report. See
tion about the organization options that 

See “Customizing report layout” 
on page 376 and “Customizing 
report content” on page 382 for 
more information.

4 If you want to customize the report layo
Content tab.

5 Click OK to create the report.

Click Defaults to return to the 
initial settings for this report.
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esults

tals income transactions, expense 
ansactions, and transfer transactions in 
parate sections of your report.
roups and totals inflows (both income 
ansactions and transfers that bring value 
to your accounts) and outflows (both 
pense transactions and transfers that take 
lue out of your accounts). For example, if 
u have an asset account called “House” 
d you enter home improvement 

ansactions as transfers to that account, 
oosing Cash Flow treats those transfers 
 spending, giving you a more accurate 

icture of your expenditures.

cludes all transfers.
xcludes all transfers.
xcludes transfers between accounts that 
e included in the report. Essentially, these 
e transfers that cancel each other out in 
e report.
Organization 
option Selection R

Organization Income and 
Expense
Cash Flow

To
tr
se
G
tr
in
ex
va
yo
an
tr
ch
as
p

Transfers All Transfers
No Transfers
Transfers to 
accounts outside 
report

In
E
E
ar
ar
th
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gs

ows you exactly what you want, you can 
tion so you can recall the report at any 

easy answers” on page 368, “Creating a 
 basic Quicken reports” on page 370.

uctions in “Customizing reports” on 

you want it. If not, change the customiza-
nt. 

-M).
Reusing custom report settin

After you’ve customized a report so that it sh
memorize the layout, content, and organiza
time.

Memorizing a report

1 Create a report as described in “Getting 
QuickReport” on page 369, or “Creating

2 Customize the report following the instr
page 372.

Make sure the report looks just the way 
tion options until you have what you wa

3 Choose Memorize from the Edit menu (x
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rt Template window.

ed tab in the Reports window.

re reusing a report template that includes 
rized.

utton in the toolbar.

ized tab.

ed reports.

want to create.

Give your memorized report a 
distinctive name so you can 
distinguish it from other reports.

ember 
eport.
4 Enter information in the Memorize Repo

5 Click Memorize to memorize the report.

Quicken adds the report to the Memoriz

Recalling a memorized report 

When you recall a memorized report, you a
all the customization options you’ve memo

1 In the Reporting area, click the Reports b

2 In the Reports window, click the Memor

Quicken displays a list of your memoriz

3 Double-click the memorized report you 

If you select this 
option, Quicken 
memorizes the dates 
you’ve specified for 
the report. If you’ve 
selected a named date 
range like Last 

A detailed description can help you rem
exactly what changes you made to this r

If you select this option, Quicken 
memorizes the dates you’ve speci-
fied for the report. If you’ve selected 
a named date range like Last 
Quarter, Quicken remembers Last 
Quarter; if you’ve typed a custom 
date, Quicken remembers the exact 
dates. If you don’t select the 
checkbox, Quicken ignores your 
dates and uses the preset dates.
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the customization options, see “Changing 

ports

rt by customizing it as you would any 
t rememorize the report, however, the 
nition the next time you recall it. You can 
d choosing Delete Report from the Edit 

n Help Topics and select
If you want to make and save changes to 
and deleting memorized reports” next.

Changing and deleting memorized re

You can make changes to a memorized repo
other report. If you make changes and don’
memorized report reverts to its original defi
delete a memorized report by selecting it an
menu (x-D).

For step-by-step help, go to Reports in Quicke

How do I change a memorized report?

How do I delete a memorized report?
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 with QuickZoom

mbers in Quicken reports in more detail. 
nother report that gives you more detail 
kZoom in a report that lists transactions, 
ter for the selected transaction. 

le-click it.

ing a list of the transactions that make up 
Investigating items in reports

You can use QuickZoom® to examine the nu
For most reports, QuickZoom takes you to a
about the item you selected. If you use Quic
however, QuickZoom takes you to the regis

1 Select an amount in the report and doub

Quicken displays a detail report contain
the selected amount.
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e register or make any changes to it, 
 report.

 the transaction. If you make changes to 
port (see “Updating reports” on 
2 (Optional) To examine a transaction in th
double-click the transaction in the detail

Quicken displays the register and selects
any transactions, Quicken updates the re
page 401).

If you want to examine or 
change any listed transaction, 
double-click it to go to the 
register with that transaction 
selected.

If you are curious about the 
transactions represented by an 
amount in this category 
summary report, you can 
double-click the amount to see 
a list of the transactions that 
make up that amount.

You can use QuickZoom 
whenever the mouse pointer 
turns into a magnifying glass.
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d set whether to view account and 
oosing Preferences from the Edit menu. 
indow are global settings; that means you 
 change the font, size, and style separately 
, you might want report titles to display 
 rest of the text in 10-point Times Plain).

ividual reports right on the report; see 

n Help Topics and select
Changing report preferences

You can change your default report fonts an
category names, descriptions, or both by ch
The settings for Reports in the Preferences w
set them once for all of your reports. You can
for different sections of reports (for example
and print in 12-point Helvetica Bold and the

You can also change the font settings for ind
“Changing the layout” on page 372.

For step-by-step help, go to Reports in Quicke

How do I change report preferences?
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pen while you make any of several 
u can change:

lendar

ndow

en updates all open reports. If a report is 
f changes, you can have Quicken update 
 making changes. If you want to control 
 can turn off automatic recalculation.

ulation from the Activities menu to turn 

ounts, or security prices.

 Now from the Activities menu.

 it does not update any other windows.
Updating reports

After you’ve run a report, you can leave it o
different kinds of changes. For example, yo

• transaction data in a register or in the Ca

• budget amounts in the Budget Setup wi

• security prices in the Portfolio window

When you make any of these changes, Quick
very large and you need to make a number o
the report only once—when you’ve finished
when Quicken recalculates report data, you

1 Choose Reports & Graphs . Auto Recalc
it off.

2 Make changes to transactions, budget am

3 Choose Reports & Graphs . Recalculate

Quicken updates the current report, but
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ts

ort from the File menu. If you want to see 
rint it, choose Print Preview Report from 
he page breaks as described in “Changing 

er program

xport, it to a new file by choosing Export 
ile and choose one of the following file 

rt the file into a spreadsheet.

 into an application such as a word 
SCII format.

n Help Topics and select
Printing and exporting repor

Printing a report

You can print a report by choosing Print Rep
what your report will look like before you p
the File menu. If necessary, you can change t
the layout” on page 372.

Exporting a report for use with anoth

Once you create a report, you can save, or e
Report from the File menu. Then name the f
formats:

• Select Excel (SYLK) if you want to impo

• Select Text if you want to import the file
processor. Quicken saves the report in A

For step-by-step help, go to Reports in Quicke

How do I print a report?
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nd capital gains reports if you want to 
are. See Chapter 18, Getting ready for tax 

n Help Topics and select
• Select MacInTax (TXF) for tax schedule a
import the file into tax preparation softw
time, on page 456.

For step-by-step help, go to Reports in Quicke

How do I save a report to a file?
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sights

aphs, and helpful suggestions based on 
ig picture. If you have Internet access 

rces to help you to make more informed 

Click Customize to 
choose what infor-
mation is displayed 
in the Insights 
window.
Seeing the big picture with In

Quicken Insights brings together reports, gr
your own financial data so you can see the b
Insights also delivers up-to-date Web resou
financial decisions.

Click the blue underlined links to 
go to the appropriate feature in 
Quicken, help resource, or to the 
Web for further information.

To open Insights, click the 
Insights icon in the toolbar, or 
choose Insights from the Activi-
ties menu.
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ge to reflect the financial information in 
ple, if you’re using Quicken to track your 
unts to the Insights page.

The items on the right are 
currently being displayed 
on the page.

• To remove an item, select 
it from the list and click 
Remove.

e order in which items appear on your 
ect an item from the list on the right, 
p or Move Down as appropriate.

n Help Topics and select
Customizing your Insights

You can customize the Quicken Insights pa
which you have the most interest. For exam
portfolio, you can add your investment acco

The items on the left are available 
to be added to the page.

• To add an item, select the item 
you want to add and click Add. 

You can change th
Insights page: sel
and click Move U

For step-by-step help, go to Reports in Quicke

How do I use Insights?
How do I set up Insights?
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s, pie charts, and line graphs to give you 
create graphs to analyze your income and 
expenses with your budget, determine 
ce of your investments.

om which you can create graphs:

aph answers one of seven basic questions 
. See “Getting easy answers” on page 408.

 layout, content, and organization of the 
 information you want in the format that 
dard Quicken graphs” on page 409. 

e graph layout and content, you can save 
e “Reusing your custom graph settings” 

Whenever the cursor turns into a 
magnifying glass, you can see the 
exact value of the element below it 
by holding down the mouse button. 
You can also double-click to see 
more information. See “Investi-
gating items in graphs with Quick-
Zoom” on page 417.
About graphs

Quicken can display your data as bar graph
a visual summary of your finances. You can 
expenses, compare your actual income and 
your net worth, and evaluate the performan

There are several different starting points fr

• EasyAnswer graphs. An EasyAnswer gr
you may have about your financial data

• Standard graphs. You can customize the
standard graph templates to give you the
best suits your needs. See “Creating stan

• Memorized graphs. When you customiz
the settings and use them over again. Se
on page 415.

In pie charts, Quicken displays the 
ten largest items first and groups 
any additional items in a slice 
called Other. To see the additional 
items, double-click the Other slice.
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estions about your Quicken data without 
use. Use EasyAnswer graphs if you want 
 questions in the illustration in step 3.

utton in the toolbar.

swer tab.

on you want answered.

ers the selected question.

data that answers your question and then 

Click Customize to see the 
options for customizing the 
selected graph. See “Custom-
izing graphs” on page 411.
Getting easy answers

EasyAnswer graphs let you answer basic qu
having to figure out which type of graph to 
to get a quick and easy answer to any of the

1 In the Reporting area, click the Graphs b

2 In the Graphs window, click the EasyAn

3 Click a radio button to choose the questi

4 Click Create to create a graph that answ

Quicken searches the current file for the 
displays the graph on the screen.

For the selected question, make 
sure the pop-up menu shows the 
time period for which you want a 
graph.

If you choose the first question, 
enter a category name. If you 
choose the last question, choose 
the way you want to see your 
asset allocation. 
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raphs

 of the standard Quicken graphs. If you 
izing graphs” on page 411.

utton in the toolbar.

d tab to display a list of graphs.

s, see 
swer 
Creating standard Quicken g

You follow the same basic steps to create all
want to customize your graph, see “Custom

1 In the Reporting area, click the Graphs b

2 In the Graphs window, click the Standar

3 Select the graph you want to create.

If you choose a preset date range 
from the Date pop-up menu, 
Quicken enters dates for you 
automatically. If you choose 
Custom, you can use the Custom 
Dates window to name and define 
your own custom date range and 
add it to the pop-up menu.

You can also just type your own 
dates in the From and Through 
fields

Click Customize to see the options 
for customizing the selected graph. 
See “Customizing graphs” on this 
page.

For information about memorized graph
page 415; for information about EasyAn
graphs, see page 408.
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 transactions to be included in the graph.

 date is the first day of this year and the 

standard settings.

sactions in the specified date range and 
e search may take some time, depending 
 the complexity of the graph.
4 (Optional) Change the date range for the

Unless you change the dates, the starting
ending date is today.

5 Click Create to create a graph using the 

Quicken searches the current file for tran
then displays the graph on the screen. Th
on the size of your Quicken data file and
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 graph before you create it; you can create 
an customize some things before you 

he information in your graph by custom-

llow steps 1 through 3 in “Creating 
o choose a graph. Then click Customize.

 the Customize button in the lower left 

he Layout tab.

options.

 options alphabetically. The choices avail-
e graph type. Not all options are available 
Customizing graphs

You can customize the layout or content of a
a graph first and then customize it; or you c
create the graph and some after.

Customizing graph layout

You can change the way Quicken presents t
izing the graph layout.

1 If you haven’t yet created your graph, fo
standard Quicken graphs” on page 409 t

OR

If you’ve already created the graph, click
corner of the Graph window.

2 In the Customize Graph window, click t

3 Make your changes to the graph layout 

The table below lists all the graph layout
able for each option are determined by th
for all graphs.
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ent, click the Content tab.

Results

udget Creates the graph using data 
from the selected budget.

Displays a percentage in the 
graph legend.
Displays a dollar amount in 
the graph legend.
4 If you want to customize the graph cont

5 Click OK to create the graph.

This date range matches the 
date range for this graph in the 
Graphs window. If you want to 
change it, type new dates or 
choose a different date range 
from the pop-up menu.

Click Defaults to return all the 
settings in the Customize Graph 
window to the initial settings.

You can use the generic title for 
the graph, or enter a more 
descriptive title of your own.

Layout option Selection

Budget the name of a b

Display in legend Percentages

Dollar
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llow steps 1 through 3 in “Creating 
o choose a graph. Then click Customize.

 the Customize button in the lower left 

Includes one total for account 
balances based on the ending 
date you enter at the top of 
the window.
Shows account balances for 
each week, two weeks, half 
month, month, quarter, half 
year, or year.

ype, 
ccount, 

Groups amounts by the item 
you choose. 

Displays individual 
subcategories or subclasses 
instead of categories and 
classes only.

Results
Customizing graph content

1 If you haven’t yet created your graph, fo
standard Quicken graphs” on page 409 t

OR

If you’ve already created the graph, click
corner of the Graph window.

Graph at intervals of None

a time period

Group by All categories, T
Goal, Security, A
Category, Class

Show subcategory/
subclass

selected

Layout option Selection
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he Content tab.

 options.

 accounts, categories, classes, or securities, 
an select the items you want to include in 
e Selected option for categories, Quicken 

ntent tab in the Customize Graph 
ludes only transactions that contain the 
cedure to restrict a graph to selected 

ut, click the Layout tab.

Selects only income categories 
or only expense categories.

Excludes all categories.
Selects all categories.
2 In the Customize Graph window, click t

3 Make your changes to the graph content

When you choose the Selected option for
Quicken displays a window where you c
the graph. For example, if you choose th
displays the Select Categories window.

When you click OK, you return to the Co
window. When you run the graph, it inc
selected categories. Follow the same pro
accounts, classes, or securities.

4 If you want to customize the graph layo

5 Click OK to create the graph.

You can select “–No category–” 
if you want the graph to include 
transactions that don’t have a 
category assigned to them.

Click a category or subcategory to 
select or clear it. Quicken 
includes all marked categories 
and subcategories in the graph.
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an memorize the layout and content so 
.

easy answers” on page 408 or “Creating 

uctions in “Customizing graphs” on 

you want it. If it doesn’t, click the 
ization options.

-M).

h Template window.

When you memorize a graph, you 
must give it a distinctive name. If you 
try to use the same name again, 
Quicken warns that you are about to 
replace an existing memorized graph.
Reusing your custom graph settings

After you’ve customized a graph, Quicken c
you can reuse the graph settings at any time

Memorizing a graph

1 Create a graph as described in “Getting 
standard Quicken graphs” on page 409.

2 Customize the graph following the instr
page 411.

Quicken does not memorize 
amounts, font settings, or printer 
settings because they are not part 
of the graph.

Make sure the graph looks just the way 
Customize button and change the custom

3 Choose Memorize from the Edit menu (x

4 Enter information in the Memorize Grap

If you select this checkbox, Quicken 
memorizes the dates you’ve specified 
for the graph. If you’ve selected a 
named date range like Last Quarter, 
Quicken remembers Last Quarter; if 
you’ve typed a custom date, Quicken 
remembers the exact dates. If you 
don’t select the checkbox, Quicken 
ignores your dates and uses the preset 
dates.

A detailed description can help 
you remember exactly what 
changes you made to this graph.
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ed tab in the Graphs window.

utton in the toolbar.

ized tab.

ed graphs.

want to create.

h by selecting it and customizing it as you 
s and don’t re-memorize the graph, 
s original definition the next time you 
by selecting it and choosing Delete Graph 

n Help Topics and select
5 Click Memorize to memorize the graph.

Quicken adds the graph to the Memoriz

Recalling a memorized graph 

1 In the Reporting area, click the Graphs b

2 In the Graphs window, click the Memor

Quicken displays a list of your memoriz

3 Double-click the memorized graph you 

Changing and deleting memorized graphs

You can make changes to a memorized grap
would any other graph. If you make change
however, the memorized graph reverts to it
recall it. You can delete a memorized graph 
from the Edit menu 
(x-D).

For step-by-step help, go to Graphs in Quicke

How do I change a memorized graph?

How do I delete a memorized graph?
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 with QuickZoom

nformation you see in a graph in more 
to a more detailed graph, from a graph to 
at make up the item you double-clicked), 
ividual transaction in a register (where 
).

 item in the graph.

r report that shows more detail about the 

ble-click a bar, pie slice, or legend item in 
uickZoom graph to create a list of the 
actions that are included in the item.
Investigating items in graphs

You can use QuickZoom to investigate the i
detail. You can QuickZoom from one graph 
a transaction report (to see the transactions th
and then from a transaction report to an ind
you can see and edit the selected transaction

1 Double-click any pie slice, bar, or legend

Quicken displays a QuickZoom graph o
item you selected.

Dou
the Q
trans

Double-click a bar, 
pie slice, or legend item to 
create a QuickZoom graph.
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kZoom graph further, double-click that 

 all the transactions that make up the item 

e register or make changes to it, double-
.

 the transaction. If you make any changes 
ort and all open graphs (see “Updating 
2 (Optional) To examine an item in a Quic
item.

Quicken displays a detail report that lists
you selected.

3 (Optional) To examine a transaction in th
click that transaction in the detail report

Quicken displays the register and selects
to transactions, Quicken updates the rep
reports” on page 401).
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hether you want graphs to be two-dimen-
ferences from the Edit menu. The settings 
bal settings; that means you set them once 
r each individual graph. You can change 

ent sections of graphs (for example, you 
 in 12-point Helvetica Bold and the rest of 

n Help Topics and select
Changing graph preferences

You can change your graph fonts and set w
sional or three-dimensional by choosing Pre
for Graphs in the Preferences window are glo
for all of your graphs instead of separately fo
the font, size, and style separately for differ
might want graph titles to display and print
the text in 10-point Times Plain).

For step-by-step help, go to Graphs in Quicke

How do I change graph preferences?
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 the graph on the screen. A printed graph 
u see onscreen. 

 increasing the memory allocated to 
Quicken application icon in the Finder, 
ncreasing the amount of memory in the 

n Help Topics and select
Printing graphs

You can print a graph to get a paper copy of
may look a little different from the graph yo

If you have trouble printing your graph, try
Quicken by quitting Quicken, selecting the 
choosing Get Info from the File menu, and i
Preferred Size field.

For step-by-step help, go to Graphs in Quicke

How do I print a graph?
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on Finder, the Quicken tax planner, and 
e time-sensitive information that may not 
l/tax planning decisions on this data 
x preparer or the IRS to receive updates 

ax planner use time-sensitive information 
y 1999.
17 Planning your 
future
An overview of the Quicken planning tools

Budgeting ..........................................................

Financial Fitness ...............................................

Financial Fitness on the Web ..........................

Using the financial planning calculators ......

Forecasting ........................................................

Important: Please note that the Tax Deducti
the online planning tools on Quicken.com us
be current. Please do not base your financia
alone. On tax-related issues, consult your ta
on current tax laws and limitations.

The Tax Deduction Finder and the Quicken t
based on 1999 tax year information as of Jul
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planning tools

ey has already gone. It can also help you 
 want to see only what expenses are 
ead to their retirement or to putting their 

to spend an evening analyzing their 
 reminder to pay the rent. 

term planning tools, including:

ering estimates of your income and 
tual income and expenses with your 
 full year ahead, and budget graphs and 
o your plan. See “Budgeting” on page 426.

lanning calculators let you try out “what-
ancing, investment savings planning, 
g. See “Using the financial planning 
t these planning calculators use data that 
our financial decisions on this data alone.

ending patterns forward up to a year and 
. Forecasting can help you make the right 
y a new car, when to invest money, and 
 on a house. See “Forecasting” on 

xe provides tools you can use to assess 
a healthy financial future. The Emergency 
ments and contact information for use in 
Chapte

An overview of the Quicken 

Quicken doesn’t just track where your mon
look into your financial future. Some people
coming up next month. Others like to plan ah
children through college. Some people like 
budget for the next year. Others just want a

Quicken offers a variety of long- and short-

• Budgets. You can set up a budget by ent
expenses; later you can compare your ac
budget amounts. Budgets let you plan a
reports show how well you are keeping t

• Financial planning calculators. The five p
if” scenarios for loan planning and refin
college planning, and retirement plannin
calculators” on page 443. Please note tha
may not be current. Please do not base y

• Forecast graph. Quicken projects your sp
displays your account balances in a graph
short-term decisions, such as when to bu
when you can afford the down payment
page 445.

• Financial Fitness planners. Quicken Delu
you current financial fitness and plan for 
Records Organizer tracks important docu
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der can help save you time and money at 
 439. 

uicken Deluxe gives you access to online 
. Use the Retirement Planner to create a 

rement goals, and the Debt Reduction 
reate an action plan to reduce your debt, 
 credit reporting errors. See “Financial 

our taxes using data you’ve already 
w data you enter directly in the planner 
 with the Quicken tax planner” on 

n amortize your home or car loan and 
, so you can see how much interest and 
, Tracking loans and mortgages, on 

al Calendar can schedule everything from 
g a new furnace to recurring transactions 
e payment. See “Scheduling bill 

phs to help you understand your current 
 you can use the other planning tools to 
ting reports, on page 366, and Chapter 16, 
Chapte

an emergency, and the Tax Deduction Fin
tax time. See “Financial Fitness” on page

• Financial Fitness planners on the Web. Q
planning tools available on Quicken.com
plan that will help you achieve your reti
Planner to evaluate you debt level and c
The Free Credit Report can help you find
Fitness on the Web” on page 441.

• Quicken tax planner. You can estimate y
entered in your Quicken accounts, or ne
windows, or both. See “Estimating taxes
page 475. 

• Loan and mortgage tracking. Quicken ca
show you a complete payment schedule
principal you are paying. See Chapter 13
page 246.

• Quicken Financial Calendar. The Financi
once-only future transactions like buyin
like your paycheck deposit or your hous
payments” on page 122.

• Reports and graphs: Use reports and gra
situation. Then, armed with that insight,
look into the future. See Chapter 15, Crea
Creating graphs, on page 406.
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 want out of Quicken:

d in planning? A month? A year? Ten 

 of the period ahead? Or are you just inter-

anagement—to plan to make a regular 
unt, for example?

 as saving toward a down payment on a 
t, putting your children through college, 
ent?

1 year ahead 5 years ahead

Loan and 
mortgage 
tracking

Financial 
planning 
calculators

udgets

Forecast graph
Chapte

Deciding which tools to use

A good starting point is to decide what you

• Over what time period are you intereste
years?

• Do you need to make a detailed analysis
ested in your overall financial picture?

• Do you want to improve your money m
transfer to a mutual fund or savings acco

• Do you have specific goals in mind, such
house or affording a higher monthly ren
or planning your investments for retirem

Financial Calendar

Past Now 1 month ahead

Reports and graphs

Register

B

Tax planner
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nses or just some of them. Since Quicken 
, you can enter budget amounts for some 
You can also create multiple budgets to 

eate reports and graphs to compare your 
et. You can also monitor your budget 
actly how you’re doing. 

tton in the toolbar.

me for this budget.

de in this budget and specify whether or 
get amounts based on your existing data.

an change which categories are displayed 
t amounts based on your existing data.
Chapte

Budgeting

You can budget all of your income and expe
organizes budgets based on your categories
or all of your categories and subcategories. 
work with different budgeting scenarios.

After you’ve set up your budget, you can cr
actual income and expenses with your budg
status “as you go,” so you can always see ex

Creating your first budget

1 In the Planning area, click the Budget bu

2 In the Create Budget window, enter a na

3 Select which categories you want to inclu
not you want Quicken to enter initial bud

After you start using your budget, you c
or use QuickBudget later to enter budge
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ken asks you which transactions you 
r in your budget. See “Entering budget 
 more information about QuickBudget.

w to create the budget.

anized

 column as either monthly averages 
 yearly totals, or you can display a 
his page), beginning with any month. Use 
ou want to see.

l budget amounts. Each amount is stored 
 average or total amounts, as appropriate, 

Select “Enter zeros for all categories” 
to start with an empty budget. See 
“Entering budget amounts 
manually” on page 429 for informa-
tion about why this might be the 
right choice.
Chapte

If you select “Use QuickBudget…,” Quic
want it to use to get the amounts to ente
amounts automatically” on page 431 for

4 Click Create in the Create Budget windo

Changing the way your budget is org

You can display budget amounts in a single
(shown on page 430), quarterly averages, or
separate column for each month (shown on t
the View pop-up menu to choose the view y

Changing the view does not affect the actua
the way you enter it, and Quicken calculates
for the view you’ve selected.

Select “Selected categories” to go to 
the Select Categories window and 
select exactly which categories you 
want in this budget.
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 view and choose the first month of your 
enu.

g purposes, choose Preferences from the 
 choose a month from the “Fiscal year 

tegories are displayed in your budget by 
n move a category from one grouping to 
ove a category from the budget (but not 

 Delete Item From Budget from the Edit 
 dollars only or in dollars and cents.

In All Months view, 
choose a starting month 
for the budget.

 menu 
rinted. 

In All Months view, 
Quicken calculates and 
displays the total 
budgeted amounts for 
each month’s Inflows, for 
each month’s Outflows, 
and for the difference 
between them, in 
addition to showing 
totals for the entire year.
Chapte

To budget for a fiscal year, go to All Months
fiscal year from the Starting With pop-up m

To set up to use your fiscal year for reportin
Edit menu and select the General icon. Then
starts with” pop-up menu.

You can change which categories and subca
clicking the Select Categories button. You ca
another by dragging and dropping it. To rem
from your Quicken file), select it and choose
menu (x-D). You can also show amounts in

If you have more than one 
budget, choose which one to 
display from this pop-up menu.

In Yearly Total or All Months 
view, the total budgeted 
amounts for each category are 
shown in the Total column. 
When Monthly Average or 
Quarterly Average is selected 
for View, the column is labeled 
Average, and average amounts 
for the period are shown.

Choose a time period from the View pop-up
to change how the budget is displayed and p
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nter budget amounts manually, or you 
matically using data from actual transac-

anually if you don’t want to use previous 
revious Quicken data that you can use to 

tton in the toolbar.

 the budget pop-up menu and a time 

 or Yearly Total view, type an amount in 
the time period for which that amount 
Chapte

Entering amounts in your budget

In Quicken, you can start from scratch and e
can let Quicken create a budget for you auto
tions in your Quicken registers.

Entering budget amounts manually

You may choose to enter budget amounts m
actual amounts, or if you have little or no p
create a budget automatically.

1 In the Planning area, click the Budget bu

2 Choose the budget you want to use from
period from the View pop-up menu.

3 Enter budget amounts by category.

In Monthly Average, Quarterly Average,
the Entered As column and then choose 
applies from the pop-up menu.
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the corresponding time period, Quicken 
and puts it in the Average column. If you 
plays the correct amount for that view, no 
ally. For example, you can enter a weekly 
ks amount for salary, an annual amount 
icken will calculate monthly average 

nthly Average view.

ach month; press Tab to move right to the 
 move down to the next category in the 

mount for a category, you can select it and 
 fields (months) to the right in the same 

If you want to enter 
amounts for specific 
months (for example, 
property taxes in 
December and April), 
choose Specific Months 
from the pop-up menu 
and then click the check-
boxes for the appropriate 
months to select them.
Chapte

When you enter an amount and choose 
calculates the monthly average amount 
then choose a different view, Quicken dis
matter how you entered the amount initi
amount for groceries, an every-two-wee
for renter’s insurance, and so on, and Qu
amounts for all of them if you are in Mo

In All Months view, type an amount in e
next month in the row or press Return to
column. Once you’ve entered an initial a
click Fill Row to copy that amount to all
row.

Click the triangles to show or hide 
categories and subcategories 
temporarily while working in 
your budget.

In this example, Auto is collapsed 
so you don’t see its subcategories, 
but Insurance is expanded to 
show its subcategories.

Since Monthly Average is selected, 
this column is labeled Average 
and shows average monthly 
amounts for each category. 
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mounts as you enter them.

 already entered in Quicken to create your 
u have data in your Quicken file, and 

ly amounts or monthly average amounts 
so ask QuickBudget to adjust these 

ur historical data can help you plan realis-
 If you are a new Quicken user, however, 
ered may not provide enough data to 

In All Months view, 
select an amount 
and click Fill Row to 
copy that amount to 
all fields (months) 
to its right in the 
same row. 
Chapte

Note: Quicken automatically saves budget a

Entering budget amounts automatically

With QuickBudget, you can use data you’ve
budget. Choose any date range for which yo
QuickBudget calculates either actual month
and enters them in your budget. You can al
amounts for inflation. 

If you’ve been using Quicken for a while, yo
tically for your future income and expenses.
the small number of transactions you’ve ent

Since All Months is selected, this 
column is labeled Total and it shows 
total yearly amounts for each 
category and subcategory.

You can enter amounts for both 
categories and subcategories. If you 
enter an amount for a category that 
has subcategories, Quicken puts any 
difference between the amount 
entered for the category and the total 
amount entered for its subcategories 
in a special “Other” subcategory.

Click the triangles to show or hide 
categories and subcategories.
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eaningful. See “Entering budget amounts 

tton in the toolbar.

 the budget pop-up menu and a time 

er of the Budget Setup window.

indow.

Enter an inflation rate if you want 
QuickBudget to inflate your actual 
amounts when calculating new 
budget amounts. You can enter a 
negative number if you want to 
deflate amounts.

ies window and 
 in the budget.

ce 
 

Chapte

make a budget created with QuickBudget m
manually” on page 429.

1 In the Planning area, click the Budget bu

2 Choose the budget you want to use from
period from the View pop-up menu.

3 Click QuickBudget in the lower left corn

4 Enter information in the QuickBudget w

This calculates an average monthly 
amount for the date range you 
specified and enters it for each 
month in your budget.

This enters the actual amounts 
from your Quicken data in each 
month of the budget (for example, 
enter actual amounts from May of 
last year in May of this year).

Enter the date range for the data 
you want to use to calculate your 
budget amounts. Although a 
budget is limited to one year, you 
can use more than one year’s data 
to calculate amounts.

Click Selected to open the Select Categor
select the categories you want to include

Select this checkbox if you want to repla
amounts you’ve already entered in your
budget. 
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dy budgeted amounts…” checkbox, 
ounts you have already entered with new 
 they will be lost.

r Quicken data and automatically enter 

s, you can use the following keys to move 

Press this key

Return, Enter, or 
Down Arrow

Up Arrow

Tab (All Months view 
only)

Shift-Tab (All Months 
view only)

Home (extended 
keyboard only)

End (extended keyboard 
only)
Chapte

Caution: If you select the “Replace alrea
QuickBudget will replace any budget am
amounts calculated from your data, and

5 Click OK to calculate amounts from you
them in the budget.

Moving around in your budget

Regardless of how you enter budget amount
around the budget.

To move

Down one category in the same column

Up one category in the same column

Right one column in the same category

Left one column in the same category

To the top of the budget

To the bottom of the budget
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een accounts—such as your mortgage 
ecking account to your savings account—
 flow.

, click the Select Categories button and, in 
 the transfer accounts you want to include 
tems for each transfer account, a “From” 
our budget, depending on how you plan 
ouped under Inflows and should be used 
ve available to spend; “To” amounts are 
 and should represent decreases in the 

ers just as you would enter or edit budget 
ng a $200 monthly transfer from an 
ed Savings, you would put From 

 month and put To Savings under 
per month. In this example, the net effect 
ly for the transfer out of your checking 

e in your savings account in your budget 
udget only the To Savings part of the 
nt or car payment the same way, by 
(from your checking account to the 
Chapte

Setting up budget amounts for transfers

You can budget amounts for transfers betw
payment or a monthly transfer from your ch
to get a more complete picture of your cash

To include transfer accounts in your budget
the Select Categories window, make sure all
in your budget are selected. There are two i
and a “To.” You can add either or both to y
to budget transfers. “From” amounts are gr
to represent increases in the amount you ha
grouped under Outflows:Flexible Expenses
amount you have available to spend.

You enter or edit budget amounts for transf
amounts for categories. If you were budgeti
account named Checking to an account nam
Checking under Inflows and enter $200 per
Outflows:Flexible Expenses and enter $200 
to the budget is $0. If you want to budget on
account and don’t want to show the increas
(the “out of sight, out of mind” principle), b
transfer. You can budget a mortgage payme
including only the “To” side of the transfer 
liability account you’ve set up for the loan).
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s

h different budget scenarios. To create an 
 the pop-up menu in the upper left corner 
 the steps in “Creating your first budget” 

hat distinguishes it from your old budget. 

Average, Quarterly Average, or Yearly 
 choose Specific Months from the pop-up 
 right of the Entered As field; then click 
months to select them.

hs view, select the amount you want to 
ck Fill Row.

m of the Budget Setup window, click the 
ories button. Then, in the Select 
indow, select the categories you want to 
 OK.

thly Average, Quarterly Average, or 
s from the View pop-up menu.
Chapte

Editing budget information

Creating and using additional budget

You can create multiple budgets to work wit
additional budget, choose New Budget from
of the Budget Setup window, and then follow
on page 426. Give your new budget a name t

To accomplish this Do this

Enter an amount for 
selected months only

In Monthly 
Totals view,
menu to the
the specific 

Copy an amount to all 
fields to the right in the 
same category

In All Mont
copy and cli

Select categories and 
subcategories

At the botto
Select Categ
Categories w
see and click

Change the time period for 
the display

Choose Mon
Yearly Total
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e already created by choosing Rename or 

icken file to another by exporting the 
e QIF file into another Quicken data file.

dget from the File menu. When you print 
 report data font settings. See “Changing 
our report font preferences.

en Help Topics and select

ken Help Topics and select

en Help Topics and select
Chapte

You can also rename or delete budgets you’v
Delete from the pop-up menu. 

You can copy budget amounts from one Qu
amounts to a QIF file and then importing th

Printing a budget

You can print a budget by choosing Print Bu
a budget, Quicken prints the text using your
report preferences” on page 400 to change y

For step-by-step help, go to Budgets in Quick

How do I rename a budget?

How do I delete a budget?

For step-by-step help, go to Data Files in Quic

How do I copy information between files?

For step-by-step help, go to Budgets in Quick

How do I print a budget?
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udget monitoring feature to show you 
 can monitor how your actual income and 
unts for Inflows and Outflows (the preset 
 Expenses, Flexible Expenses, or any 

 the selected budget. 

utton in the toolbar.

ring window.

uicken displays your budgeted amount 
or the period, and the progress bars show 
ow much of that amount you’ve spent or 
arned to date. Green means you’re over 
udget for income or under for expenses. 
ellow means you’re between 80% and 
00% of budget. Red means you’re over 
udget for expenses or under for income.
Chapte

Monitoring budget status

After you create a budget, you can use the b
how well you’re sticking to that budget. You
expenses compare with your budgeted amo
choices), or you can choose to monitor Fixed
individual categories or subcategories from

1 In the Planning area, click the Monitor b

2 Enter information in the Budget Monito

Q
f
h
e
b
Y
1
b

Click Set Up Monitoring to choose 
which categories, subcategories, or 
category groupings you want to 
monitor.

Choose a budget and a time 
period to monitor.

Today’s date shows where 
you are in the selected period.
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 reports and graphs that compare your 
during a specific time period. You can see 

 much you were over or under the 

en Help Topics and select
Chapte

Creating budget reports and graphs

Once you’ve set up a budget, you can create
actual income and expenses to your budget 
exactly where you met your budget and how
amounts you budgeted.

For step-by-step help, go to Budgets in Quick

How do I create a budget report?

How do I create a budget graph?
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lp you assess your financial situation and 
ou through the process of designing plans 
e financial situation. Please note that the 
formation (based on 1999 tax year infor-
nt. Please do not base your financial/tax 
-related issues, consult your tax preparer 

 laws and limitations. 

You can always tell 
where you are in the 
process by looking 
here to see which 
topic is highlighted.

Use the Next and 
Back buttons to 
move to the next or 
previous screen.
Chapte

Financial Fitness

The Financial Fitness planners in Quicken he
plan for the future. Financial Fitness walks y
to meet specific goals, based on your uniqu
Tax Deduction Finder uses time-sensitive in
mation as of July 1999) that may not be curre
planning decisions on this data alone. On tax
or the IRS to receive updates on current tax

Click Replay to hear the sound 
again. Use the volume slider to 
turn the sound up or down.
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ssential information that could be impor-
hings like emergency contacts, important 
en the Emergency Records Organizer, go 

button in the toolbar.

le tax deductions you may have missed. 
ether you might qualify and, if so, what 
o learn about which tax form to use, 

and dollar limits that apply. To open Tax 
nd click the Deduction button in the 
Chapte

Organize your essential records

The Emergency Records Organizer tracks e
tant to family or friends in an emergency—t
documents, and property information. To op
to the Planning area and click the Emrgncy 

Find potential tax deductions

Tax Deduction Finder helps you find possib
Just answer a set of questions to find out wh
kinds of records you must keep. You can als
special criteria that apply to the deduction, 
Deduction Finder, go to the Planning area a
toolbar.
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lanning tools available on Quicken.com. 
 Quicken.com use time-sensitive informa-
ase your financial/tax planning decisions 
nsult your tax preparer or the IRS to 
itations.

e how much you need for retirement by 
irement strategy. After you determine 
r lets you know if your current plan will 
o open the Retirement Planner, go to the 

 the toolbar.

 debt level and helps you create an action 
 debt. To open the Debt Reduction 
k the Debt Plan button in the toolbar.

 your financial fitness is to monitor your 
r financial data continuously throughout 
Chapte

Financial Fitness on the Web

Quicken Deluxe gives you access to online p
Please note that the online planning tools on
tion that may not be current. Please do not b
on this data alone. On tax-related issues, co
receive updates on current tax laws and lim

Plan for retirement 

The Retirement Planner helps you determin
asking you questions about your current ret
how much you need, the Retirement Planne
enable you to reach your retirement goals. T
Planning area and click the Retire button in

Reduce your debt 

The Debt Reduction Planner evaluates your
plan to reduce your high-interest consumer
Planner, go to the Assets/Debt area and clic

Get a copy of your credit report

One of the best things you can do to ensure
credit rating. Credit reporting agencies ente
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d usage and loan information reported to 
 the control back in your hands by giving 
 errors. To open Free Credit Report, go to 
button in the toolbar.
Chapte

the year, including such things as credit car
them by financial institutions. Quicken puts
you the means to catch and correct reporting
the Assets/Debt area and click the Credit √ 
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calculators
y “what-if” scenarios; they give you the 
cisions. You can use these calculators to 

 $150,000 at 7.5% interest, will I be able to 

ortgage at an 8% interest rate, how much 

st $10,000 of my savings and receive an 
 be in 5 years?

rs and put $2,000 into my IRA account 
 will I have available?

ch year until my child is 18, will I have 

k the same way, although the information 
es are different. 

 from the Pln Clc pop-up menu in the 

want Quicken to calculate.

ds.
Chapte

Using the financial planning 
Please note: These planning calcu-
lators use data that may not be 
current. Please do not base your 
financial decisions on this data 
alone.

The financial planning calculators let you tr
information you need to make informed de
answer questions such as:

• Loan calculator. If I get a 30-year loan for
afford the monthly payments?

• Refinance calculator. If I refinance my m
money will I save each month?

• Investment & savings calculator. If I inve
annual yield of 10%, what will the value

• Retirement calculator. If I retire in 10 yea
every year until then, how much money

• College calculator. If I set aside $5,000 ea
enough to pay for a four-year college?

All of the financial planning calculators wor
you enter and the calculations Quicken mak

1 In the Planning area, choose a calculator
toolbar.

2 Click the arrow next to the amount you 

3 Enter information in the appropriate fiel
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tion, be sure to move the cursor out of the 
icking in another field) so Quicken can do 
on you entered.

 the File menu to print the information in 

value in each field 
ss Tab to move to 
t field. The fields 
 depend on the 
 you’re using.

en Help Topics and select

ipal?

 loan?
Chapte

When you are finished entering informa
last field you fill in (by pressing Tab or cl
its calculations using all of the informati

4 (Optional) Choose Print Calculator from
the planning calculator.

Quicken recalculates the selected 
amount whenever you move the 
cursor to another field.

The arrow that’s selected (black) 
tells you which field Quicken will 
calculate. To calculate a different 
field, click a different arrow.

Enter a 
and pre
the nex
you see
planner

For step-by-step help, go to Planning in Quick

How do I estimate loan payments and princ

How do I calculate the cost of refinancing a

How do I plan my investment savings?

How do I save for my retirement?

How do I plan for college expenses?
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alance projections looking forward one 
 With this ability to look ahead, you can:

r or a new home.

nt balances might drop below a required 

avings more clearly.

nces of your accounts on the basis of the 

gets this information from the current 

uled in your Calendar. Any recurring 
ward through the full time span of the 

hly income and expenses. This is the 
onth but is not scheduled in the 

xample.

e can be events that you know are going 
xact amount, like property taxes or an 
at you want to try out as “what-ifs,” like 

ive vacation.
Chapte

Forecasting

The forecast graph can show you account b
month, three months, six months, or a year.

• Figure out when you can afford a new ca

• Look for danger zones when your accou
minimum balance, or even below zero.

• Plan your spending and map out your s

The forecast graph projects forward the bala
following sources of information:

• Your current account balances. Quicken 
balances in your registers.

• Future transactions that you have sched
scheduled transactions are projected for
graph.

• Postdated transactions.

• Estimates you make for additional mont
money that comes in or goes out every m
Calendar—your cash expenditures, for e

• “One-time” future financial events. Thes
to happen but perhaps don’t know the e
expected bonus. Or they can be events th
buying a new car or going on an expens
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 the forecast graph can be only as accurate 
our estimates for average income and 
ons not scheduled in your Calendar. The 
lp make your forecast graph as accurate 

 rise or fall as the underlying financial 
herever you have scheduled transactions.

g graph represent regular paycheck 
ar as recurring scheduled transactions. 
 ongoing scheduled living expenses.

u.

 to see in the graph.

 graph” on page 448.

ph represents.

oday and can be set to show one month, 

ces more accurately.
Chapte

Keep in mind that financial forecasting with
as you make it. Your forecast will include y
expense amounts that cover all the transacti
information in this chapter is intended to he
as possible.

Displaying the forecast graph

Typically, a forecast graph shows a gradual
trend, punctuated by sharp rises and falls w

For example, the sharp rises in the followin
deposits that have been set up in the Calend
The gradual underlying decline is caused by

1 Choose Forecast from the Activities men

2 (Optional) Select the accounts you want

See “Selecting accounts for your forecast

3 (Optional) Change the time span the gra

The forecast graph always begins with t
three months, six months, or one year.

4 Add information to represent your finan
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anges in your account balances over the 
th today’s ending balances for all your 
future transactions you’ve scheduled in 
s or postdated transactions shown in the 

alistically if you haven’t yet told Quicken 
ses. To make the forecast graph as 

Drag and drop an 
income or expense 
event marker to the 
graph to schedule a 
one-time financial 
event. See “Adding 
financial ‘special 
events’ to your 
graph” on page 454.

 monthly income 
s in these boxes. 
ional average 
n page 452.
Chapte

The forecast graph initially shows the ch
course of the next month, by starting wi
accounts and adding or subtracting any 
the Calendar (plus any transaction group
Calendar). 

Your forecast graph may rise or fall unre
about all your regular income and expen
accurate as possible: 

The title includes the date range 
you are viewing.

Click any point on the graph to 
see projected account balances for 
that day. Double-click to go to 
that day in the Calendar.

Click an event marker to see the 
date and amount for that event. 
Double-click to go to a window 
where you can edit the event 
information.

Enter extra estimated
and expense amount
See “Including addit
monthly amounts” o

Click Selected Accounts to select 
which accounts to include in 
your forecast.

Chose a time 
span for the 
graph.
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 transactions in the Calendar. See “Sched-

s you can’t schedule. See “Estimating 
ses” on page 452.
ncial events. See “Adding financial 
ge 454.

raph

 your forecast graph, click Selected 
orecast window. 

nd click OK.

lick it again to clear it.

graph depends on how you use your 
aph to show you. 

e graph to project your income and 
accounts for spending. When you visit the 
th your credit card, with cash, or by 
e your cash account, your credit card 
orecast—to give you an overall picture of 
Chapte

• Schedule regular income and expense
uling bill payments” on page 122.

• Add estimates for regular transaction
your unscheduled income and expen

• Add event markers for one-time fina
‘special events’ to your graph” on pa

Selecting accounts for your forecast g

1 To select which accounts are included in
Accounts in the lower left corner of the F

2 Mark the accounts you want to include a

Click an account name once to select it; c

Which accounts you include in the forecast 
accounts and what you want the forecast gr

In general, you will probably want to use th
spending trends. Many people use multiple 
supermarket, for example, you may pay wi
writing a check. So it makes sense to includ
account, and your checking account in the f
your cash flow. 
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 accounts—such as savings accounts or 
icken bank accounts—in your forecast. If 

t use it for regular spending or for depos-
lance included in the graph. On the other 
lable funds, you probably do want to 

tment accounts in your forecast graph.

 what you want to get out of the forecast 

ser in this first example wants to keep a 
ake sure he doesn’t bounce any checks. 

arge balance on his credit card.

Stock

1,000 Shares

Asset and Liability 
accounts

Investment accounts
Chapte

You may or may not want to include certain
money market accounts that you track in Qu
an account is fairly stable because you don’
iting income, you probably don’t want its ba
hand, if you are trying to track all your avai
include it.

Important: You can’t include Quicken inves

The following scenarios can help you decide
graph.

• Single checking account. The Quicken u
close watch on his checking account to m
He also wants to try to slowly pay off a l

$

$ $

$
$

$ $

$

Pay

Credit card accounts

Bank accounts

Cash accounts

1025

Include only the accounts that 
affect your cash flow.

Your cash flow accounts are the 
ones in which you track your 
income and your spending. 
Because you often transfer 
money between these accounts, 
you probably want to include 
all or most of them in your 
forecast graph.
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he forecast graph, so he can see a running 
w much he can pay on his credit card bill 

 example likes to put money into mutual 
m her month-to-month spending. She 
nding accounts so that she can plan her 

 accounts, and cash account. The three-
ay she will have enough cushion to feel 

l fund.
Chapte

He selects only his checking account for t
account balance to help him figure out ho
each month.

• Cash flow. The Quicken user in the next
funds when she has enough left over fro
needs to know the total value of her spe
investing.

She selects her bank accounts, credit card
month forecast shows her that by mid-M
comfortable putting $5,000 into a mutua

Projecting a single account 
shows you a running 
balance for that account.
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 in the next example are hoping they’ll 
t on a house by the end of the year. They 

ests them is the value of all their available 

ir Quicken accounts, including their 
, they don’t include the 401(k) asset 
those funds for the down payment. Their 
n their funds over time, and indicates that 
e sometime next fall.
Chapte

• Total available funds. The Quicken users
have enough money for a down paymen
estimate they’ll need $25,000. What inter
funds.

For their forecast, they select most of the
savings account and their CD. However
account, because they don’t want to use 
forecast graph shows a gradual increase i
they’ll be able to start looking for a hous

Projecting your spending 
accounts helps you time your 
expenditures better.

If this user adds an event marker 
to show her purchase of the 
mutual fund, the graph falls by 
$5,000.

Projecting all your available funds 
helps you make big investment 
decisions, such as buying a house 
or a car, or taking a vacation.

For a long-term picture like this 
one, select a one-year time span.
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 and expenses

he transactions you’ve scheduled in your 
e Quicken an estimate of the income and 
r Calendar to provide an accurate picture 

nts

d Extra Monthly Amounts, you can enter 
xpenses that are not already scheduled in 

ight include bonuses, commissions, or 
ady scheduled your salary as a recurring 
t too. Your extra monthly expenses 
uch things as groceries, eating out, enter-
t already scheduled recurring items such 
lude those amounts as well.

orecast graph updates to reflect the 
timated amounts at any time to experi-
dding a new $300 car payment would do 

make estimates from your paper records. 
more of data in Quicken, you can create a 
es.
Chapte

Estimating your unscheduled income

The forecast graph automatically includes t
Financial Calendar, but you also need to giv
expenses that you haven’t scheduled in you
of the weeks and months ahead. 

Including additional average monthly amou

In the section of the Forecast window labele
average monthly amounts for income and e
your Calendar.

For example, your extra monthly income m
investment income and, if you have not alre
transaction, you should include this amoun
probably include the money you spend on s
tainment, clothing, and so on. If you have no
as your rent and utility bills, you should inc

When you press Tab, Return, or Enter, the f
amount you entered. You can change the es
ment with different scenarios (to see what a
to your balances, for example).

If you are new to Quicken, you will need to 
If you’ve already entered several months or 
report that can help you make your estimat
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, can show your monthly income and 
oose; then you can use those amounts to 
ng table lists settings you can use to get 

he report to those categories not covered 
ill show your monthly totals without the 

 have scheduled your paycheck, rent, 
yment, you would not include those 
, Insurance:Auto) in your report.

Suggested setting

any date range you choose
Categories
Months

Selected (select only the accounts 
you’re using in your forecast 
graph)
Selected (select only the 
categories that are not covered 
by your scheduled transactions)

Cash flow
Transfers to accounts outside 
report
Chapte

A transaction summary report, for example
expenses for any number of months you ch
estimate your monthly average. The followi
the information you need.

When you restrict the categories shown in t
by your scheduled transactions, the report w
scheduled transactions. For example, if you
phone bill, utility bills, and car insurance pa
categories (Salary, Rent, Telephone, Utilities

Tab Customization option

Layout Date
Row headings
Column headings

Content Accounts

Categories

Organization Organization
Transfers
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aph

ts or events that are so irregular that you 
r or put them into your “Extra Monthly 
t be taking a trip, receiving a bonus, or 
ken lets you add financial events for any 

Expense Event marker to the date on the 

indow and click OK.

raph by placing the marker on the appro-
g the graph to include the new amount. 

n event onto the forecast 
n displays the current location 
xactly where you are.

e a marker, you can just drag it 
e-Time Events area.

nt for this event, or a total 
e are several events that occur 
here can be only one event 
y. 
Chapte

Adding financial ‘special events’ to your gr

You may have one-time-only financial even
don’t want to schedule them in the Calenda
Amounts” averages. For example, you migh
making a down payment on a new car. Quic
date on the graph.

1 Drag either an Income Event marker or 
forecast graph where you want it.

2 Enter information in the Set Up Event w

Quicken adds the event to the forecast g
priate date in the event bar and redrawin

As you drag a
graph, Quicke
so you know e

Note: To delet
back to the On

Enter an amou
amount if ther
on this date. T
marker per da

Change the date if you want to 
move the event to another day.

Enter a descriptive name for the 
event so you’ll know what it is.
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licking the marker to display the Edit 

ves to the new date when you click OK. 
ew date.

hanges to reflect the new amount.

elete the amount in the Amount field. 
you click OK. 

h fills the printed page.

vent marker shows that an 
icipated for February 16.

raph drops to reflect this one-
mount.

en Help Topics and select
Chapte

Editing financial ‘special events’

You can edit event information by double-c
Event window for that day.

• If you edit the Date field, the marker mo
You can also drag an event marker to a n

• If you edit the Amount field, the graph c

• To delete a marker, double-click it and d
Quicken deletes the event marker when 

Printing the forecast graph

When you print the forecast graph, the grap

This expense e
expense is ant

Note that the g
time expense a

For step-by-step help, go to Planning in Quick

How do I print a forecast graph?
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on Finder, the Quicken tax planner, and 
e time-sensitive information that may not 
l/tax planning decisions on this data 
x preparer or the IRS to receive updates 

ax planner use time-sensitive information 
y 1999.
18 Getting ready f
Tracking tax-related income and expenses...

Creating tax reports .........................................

Transferring Quicken data to tax software...

Estimating taxes with the Quicken tax plann

Important: Please note that the Tax Deducti
the online planning tools on Quicken.com us
be current. Please do not base your financia
alone. On tax-related issues, consult your ta
on current tax laws and limitations.

The Tax Deduction Finder and the Quicken t
based on 1999 tax year information as of Jul
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nd expenses

r Federal Income Tax return. If you assign 
and categorize your transactions 
eate reports with the tax information you 

n different ways, depending on your tax 
ant Quicken to create. Use the following 

u need How to set up your 
Quicken categories

 reports 
total tax-
tions by 

Mark categories as tax 
related (see page 458).

nd capital 
group and 
lated 
y tax form 

Assign specific line items 
from tax forms and 
schedules to categories (see 
page 459).
Ch

Tracking tax-related income a

Quicken can simplify the preparation of you
tax information to your Quicken categories 
throughout the year, Quicken can quickly cr
need. 

You can set up your tax-related categories i
situation and the kinds of tax reports you w
table to decide what strategy to use:

Your tax situation Tax reports yo

Your taxes are fairly 
straightforward 
and
you don’t want to use tax 
preparation software.

Tax summary
group and sub
related transac
category

You want to use tax 
preparation software 
or
you want to copy 
specific, detailed 
information directly into 
your tax return.

Tax schedule a
gains reports 
subtotal tax-re
transactions b
line item
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d expenses with tax-related categories, 
btotals your tax-related income and 

 Lists menu (x-L).

ant to mark as tax related.

“Setting up categories and subcategories” 

t.

link for this category (see “Assigning tax 
ge). 

Note: If you have more than one 
Quicken data file (for example, one file 
for your personal finances and one for 
your business), you’ll need to assign tax 
information separately for the categories 
in each file.
Ch

Marking categories as tax related

Tax Deduction Finder can help 
you identify tax deductible 
expenses. Choose Financial 
Fitness . Tax Deduction Finder 
from the Activities menu. 

If you categorize your tax-related income an
you can create a tax summary report that su
expenses by category.

1 Choose Categories & Transfers from the

2 Select the category or subcategory you w

If you want to create a new category, see 
on page 74.

3 Click Edit (x-E).

4 Click the Tax-related checkbox to select i

Quicken asks if you want to set up a tax 
form line items to categories” on this pa

5 Click Change.

To include this category in tax 
summary reports, select the 
Tax-related checkbox.
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ories

schedules to categories, you can create a 
rt to help you prepare your income taxes.

ssignment. If you have a category that 
le it in one of two ways:

s or subcategories for each kind of tax 
ated tax and have tax withheld, use 
 taxes and the withheld taxes.

sactions if you receive or file multiple 
e classes to separate transactions that fall 
me line in separate copies of the same tax 
e may include data for both you and your 
s finances. You may also want to set up 
al property. See “Filing multiple copies of 

 software copies amounts from one tax 
s window (see step 4 on page 460), you 

r tax preparation software requires the 
copies salary information from Form W-2 
 item from Form W-2 to your Quicken 
Ch

Assigning tax form line items to categ

If you assign line items from tax forms and 
tax schedule report and a capital gains repo

Each category can have only one line-item a
may vary in its tax treatment, you can hand

• You can divide it into separate categorie
treatment. For example, if you pay estim
separate subcategories for the estimated

OR

If you want to know more about 
using classes, see “About classes” 
on page 82.

• You can assign classes to tax-related tran
copies of any tax forms or schedules. Us
under the same category and go on the sa
form. For example, your Quicken data fil
spouse or for both personal and busines
classes if you manage more than one rent
tax forms and schedules” on page 467.

When you use tax preparation software, the
form to another. In the Assign Tax Schedule
should choose the form and line where you
amount initially. For example, tax software 
to Form 1040. So you should assign the line
category for salary.



apter 18, Getting ready for tax time    460

ess category lists already have tax-line 
e sure that the tax-line assignments are 
 own category list from scratch or add 

an assign line items from tax forms and 
 you create.

ax line assignment for the category to 
n separately for each subcategory.

 Lists menu (x-L).

lick the Tax Links button.

line information Quicken needs to assign 
 to your categories. If Quicken finds the 
older in your Quicken 2000 Folder, it 
ediately. If the TAX.SCD file is not in the 

you to locate it.

 file on your hard disk, you can reinstall 
ew copy.

 category or subcategory in the list on the 

ategory, it is shown next to the category 

 that you want to assign to that category.*
Ch

Assigning line items to categories

The categories in the preset home and busin
information assigned to them. Check to mak
correct for your situation. If you create your
categories to the preset category lists, you c
schedules for each new tax-related category

Important: A subcategory does not use the t
which it belongs. Assign tax-line informatio

1 Choose Categories & Transfers from the

2 In the Categories & Transfers window, c

A file named TAX.SCD contains the tax-
line items from tax forms and schedules
TAX.SCD file in the Quicken Essentials f
opens the Assign Tax Links window imm
Quicken Essentials folder, Quicken asks 

Tip: If you no longer have the TAX.SCD
Quicken from your master disc to get a n

3 In the Assign Tax Links window, select a
left.

If a line item is already assigned to this c
name in the column labeled Line Item.

4 In the list on the right, select the line item
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ically in bold type; line items are listed 
m or schedule.

 on the left, next to the category or subcat-

 more than one line or on more than one 
.

Select the line item you 
want to assign to the 
selected category. Scroll up 
or down to see more forms 
and schedules.

tem 
e the 
Ch

Forms and schedules are listed alphabet
alphabetically under the appropriate for

5 Click Assign.

Quicken displays the line item in the list
egory to which it is assigned.

6 Click Done to record the information.

*In general, if an amount should appear on
tax form, specify the most detailed location

The diamond indicates that the 
Tax-related checkbox is selected 
for that category.

The Assign Tax Links window 
lists all your categories on the left, 
and all the line items for each tax 
form and schedule you may need 
to file with the IRS on the right.

Whenever you select a form name, 
a schedule name, or a specific line 
item, you’ll see a brief description 
of that item in this help area. Click Assign to assign the selected line i

to the category. Click Unassign to remov
assignment.
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ny transactions to which this category or 

es

 be marked as Taxable or not when you 
ories to your investment transactions 
ecurities or accounts marked Taxable. (If 
le, Quicken assumes that the transaction 

 for transactions that are not taxable (the 
bably should not have line items assigned 

 for tax purposes. You should assign line 
s, however, because Quicken uses them to 

u may want to assign line-item informa-
eneral, you need to assign line items only 
ans such as IRAs and Keoghs (the type of 

from your checking account, you might 
fer from your checking account to your 
e (specifically, “Form 1040:IRA contribu-

s into the IRA account will be included in 
ssign tax-line information to the account 
ever, or the payment will appear in the 
Ch

A tax schedule report will now include a
subcategory is assigned.

Assigning line items to investment categori

For information about setting the 
tax status for investment 
accounts, see “Setting up a 
Quicken portfolio account” on 
page 291; for securities, see 
“Adding a security to a portfolio 
account” on page 292.

Both securities and investment accounts can
set them up. Quicken assigns different categ
depending on whether or not they involve s
either the security or the account is not taxab
is not taxable.) The categories Quicken uses
investment categories that end with NT) pro
to them, because you don’t need to track them
items to the remaining investment categorie
categorize taxable investment transactions.

Assigning line items to transfers

If you make transfers that are tax related, yo
tion to some of your Quicken accounts. In g
to Quicken accounts that track retirement pl
account that directly affects your taxes).

For example, if you contribute to your IRA 
record the transaction in Quicken as a trans
IRA account. If you assign a tax form and lin
tion-self”) to the IRA account, any payment
a tax schedule report. Make sure you don’t a
from which you transferred the money, how
report twice.
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ay you assign them to categories. 
Ch

You assign line items to transfers the same w

If you assign a line item from the 
appropriate tax form to your 
IRA account, any transfer you 
make into the IRA account from 
another Quicken account will be 
included in tax schedule reports.

Do not assign a line item to your 
checking account, however, 
because most transfers to and 
from your checking account are 
not tax related.
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 mind

x information to the account

 to an IRA account, assign the line “Form 
ution-self” to the account. (This line is for 
bution. You will have to determine how 
le.) If you draw money from an IRA 
Form 1099R:IRA total distributions-gross” 
u can specify only one line item for each 
e, if you make a contribution in the same 
 distribution, don’t assign a line item to the 

nd your spouse each contribute to an IRA, 
 two IRAs with two separate IRA accounts 
n your spouse’s account to “Form 1040:IRA 

use.”
contributions for a tax year during the 
or example, if you contribute for 1999 in 
 tax schedule report for the tax year will not 
RA information. In this situation, it is better 
 items to IRA accounts. Instead, create a 
t subtotaled by account for the period from 
ax year to the filing date of the following 
unts, but restrict the report to selected 
en select only IRA accounts. The report 
fers to IRA accounts; you can subtract the 
 for the wrong tax year.
Ch

Entering transactions with tax time in

Type of account How to assign ta

IRA retirement 
account

If you contribute
1040:IRA contrib
your gross contri
much is deductib
account, assign “
to the account. Yo
account. Therefor
year you receive a
account.
Note that if you a
you should track
in Quicken. Assig
contribution-spo
If you make IRA 
following year (f
March of 2000), a
have the correct I
not to assign line
transaction repor
January 1 of the t
year. Use all acco
categories and th
itemizes all trans
transfers that are
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unts like IRA accounts. If you contribute to 
Form 1040:Keogh deduction” to the 
raw money from a Keogh, assign “Form 
tal distributions-gross” to the account.

 require that you report 401(k) deductions 
 However, you’ll need to specify tax-line 
our 401(k) account if you use a split 
er your paycheck and show a transfer to 
nt.

re to enter your gross salary before the 
. Assign exactly the same form and line as 
:Salary) to your 401(k) account. The 
401(k) account reduce the total for your 
ry.

 pretax deductions from your salary, such as 
ding account, you should also assign W-

categories or accounts.

neral, need to specify tax information for 
ounts. Transfers between these accounts are 
etary transactions that do not affect your 

x information to the account
Ch

Keogh retirement 
account

Treat Keogh acco
a Keogh, assign “
account. If you d
1099R:Pension to

401(k) retirement 
account

The IRS does not
from your salary.
information for y
transaction to ent
your 401(k) accou
In the split, be su
401(k) deduction
your salary (W-2
transfers to your 
gross taxable sala
If you have other
for a flexible spen
2:Salary to those 

Bank, cash, credit 
card, or investment 
accounts for non-
retirement funds

You do not, in ge
these types of acc
usually just mon
taxes.

Type of account How to assign ta
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d category, you don’t need to do anything 
keep in mind that what you enter will 
. For example, if you use a credit card to 
iness meal expenses, be sure to enter the 
, because the two expenses are assigned 

a mortgage payment from your checking 
 mortgage interest portion of the payment is 
 you assign a category such as “Mort 
terest part of the transaction, you can assign 
dule A:Home mortgage interest”) to that 
tion of the mortgage payment that reduces 
normally not tax deductible, so you do not 
-line information for the transfer.

x information to the account
Ch

When you enter a transaction for a tax-relate
extra—just enter the category as usual. But 
affect the information you see in tax reports
cover both business travel expenses and bus
amounts separately using a split transaction
to different lines on Schedule C.

Mortgage accounts When you make 
account, only the
tax deductible. If
Interest” to the in
a line item (“Sche
category. The por
your principal is 
need to enter tax

Type of account How to assign ta

The line item “Schedule C: 
Travel” should be assigned to the 
category you use for business 
travel expenses.

The line item “Schedule C: Meals 
and Entertainment” should be 
assigned to the category you use 
for business meals and entertain-
ment expenses.
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d schedules

e schedules and forms—like Form W-2 
es for each copy. For example, if you and 
ould assign classes (such as Chris and 
ries in your paycheck transactions. Then 
those classes.

sign copy 1 to the class you use for one 
r second business, and so on.

).

ies button.

Use classes such as

pouse’s tax Chris, Terry

 business BizCorp, DesignCo

any where 
panies

Apple, Intuit, K&O

operty you Oak St, Elm Ave
Ch

Filing multiple copies of tax forms an

See “About classes” on page 82 for 
more information about setting 
up and using classes.

If you file (or receive) multiple copies of som
or Schedule C—you can set up and use class
your spouse each receive a Form W-2, you c
Terry) to the salary and withholding catego
you would assign copy numbers to each of 

If you file multiple copies of Schedule C, as
business, copy 2 to the class you use for you

1 Choose Classes from the Lists menu (x-K

2 In the Classes window, click the Tax Cop

Assign copy numbers if you need to

Separate your tax information from your s
information

Separate your personal finances from your
finances

Separate tax information about each comp
you worked in the tax year from other com

Separate tax information for each rental pr
own
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ass name in the list on the left and then 
e copy number.
Ch

3 In the Assign Copies window, select a cl
click the up or down arrow to change th

4 Click OK to save the information.

Click the up arrow to increase 
the copy number for the selected 
class by one, or click the down 
arrow to decrease it by one.
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ust at the end of each year or tax period. 
66, for more information about creating 

ed income and expenses, subtotaled by 
’ve marked as tax related, you must make 
gories. See “Marking categories as tax 

utton in the toolbar and then click the 

riod.

om the report to your tax forms. Quicken 
ach category for you.
Ch

Creating tax reports

You can create tax reports at any time, not j
See Chapter 15, Creating reports, on page 3
reports.

Creating a tax summary report

A tax summary report shows your tax-relat
category. Since it shows only categories you
sure you’ve marked all the appropriate cate
related” on page 458.

1 In the Reporting area, click the Reports b
Standard tab.

2 Click Tax Summary to select it.

3 Enter a date range that covers the tax pe

4 Click Create.

Note: You cannot export tax 
summary reports to tax prepara-
tion software.

You can copy the appropriate information fr
makes it easier by calculating the total for e
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l accounts in the current Quicken data file 
 to them. Transactions from several 

ame figure in the report. For example, the 
th regular salary and bonuses.

at suitable for copying or importing into 
alifications: 

imits defined by the IRS. For example, 
for IRA contributions. The tax schedule 
t you contributed.

ant transactions in Quicken.

 Schedule B are not subtotaled by source. 
 Schedule B to the investment categories 
port is subtotaled by category, but not by 

alized capital gains, a tax schedule report 
alized gains, you must create a capital 
s report for Schedule D” on page 472).

nt Quicken shows for a tax-related 
 reported to you on a tax form such as a 
e the amount from the tax form.

utton in the toolbar and then click the 
Ch

Creating a tax schedule report

A tax schedule report gathers figures from al
for all categories that have tax lines assigned
categories or accounts can contribute to the s
line “Salary” on Form W-2 might include bo

A tax schedule report lists amounts in a form
your tax forms and schedules, with these qu

• You must check the figures against any l
check the maximum deduction allowed 
report simply gives you the total amoun

• You must have already recorded all relev

• Interest income and dividend income for
For example, if you assign line items from
“•Div Income” and “•Int Income,” the re
investment account or security.

• If you have investment accounts with re
does not show them. To get figures for re
gains report (see “Creating a capital gain

• If there is a difference between the amou
category and the corresponding amount
W-2, 1098, or 1099, you should always us

1 In the Reporting area, click the Reports b
Standard tab.
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riod.

 accounts or classes, click the Customize 

 for Account to open the Select Accounts 
t to include in the report, and click OK. 

r Class to open the Select Classes window, 
 in the report, and click OK. 

 OK (in the Customize Report window).

s, subtotaled for each tax line on each tax 

n to tax preparation software, see “Trans-
s page.
Ch

2 Click Tax Schedule to select it.

3 Enter a date range that covers the tax pe

4 (Optional) To restrict the report to certain
button, and then click the Content tab.
• To restrict accounts: Choose Selected

window, select the accounts you wan
• To restrict classes: Choose Selected fo

select the classes you want to include

5 Click Create (in the Reports window) or

The resulting report lists your transaction
form.

To export tax schedule reports from Quicke
ferring Quicken data to tax software” on thi
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edule D

ed capital gains, the tax schedule report 
his information, create a capital gains 

utton in the toolbar and then click the 

riod.

-term and short-term capital gains trans-
unts only) in a format suitable for copying 
apital gains report from Quicken to tax 
icken data to tax software” next.
Ch

Creating a capital gains report for Sch

If you have investment accounts with realiz
does not show these realized gains. To get t
report. 

1 In the Reporting area, click the Reports b
Investment tab.

2 Click Capital Gains to select it.

3 Enter a date range that covers the tax pe

4 Click Create to create the report.

The capital gains report is preset to list long
actions (for taxable securities in taxable acco
or importing into Schedule D. To export a c
preparation software, see “Transferring Qu



apter 18, Getting ready for tax time    473

 tax software

report or capital gains report as a Tax 
le with MacInTax® tax preparation 
 capital gains report to a TXF file elimi-

Tax.

 and leave it open.

u.

port To File field.

nd a capital gains report, you must create 
each one.

 in a format your tax preparation software 
mpany your tax preparation software to 
Ch

Transferring Quicken data to

Quicken can save data from a tax schedule 
Exchange Format (TXF) file that’s compatib
software. Exporting a tax schedule report or
nates the need to re-enter the data in MacIn

1 Create the tax report you want to export

2 Choose Export Report from the File men

3 Enter a file name for the report in the Ex

If you create both a tax schedule report a
a separate file with a different name for 

4 Click MacInTax (TXF).

5 Click Save.

Quicken exports your data to a file that’s
can import. See the instructions that acco
use the file.
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n required on tax forms and schedules. 
ted list of line items, tax forms, and sched-
rers of tax preparation software.

u file, you will need to get a new copy of 
Tax includes an updated TAX.SCD file 
er. If you install Quicken after you install 
t the latest version of the TAX.SCD file is 
Ch

Updating tax form information

If you have a Web browser, the 
Quicken Financial Network can 
help you keep up with changing 
tax information. Choose To the 
Web . Tax Center from the Online 
menu. 

Occasionally the IRS changes the informatio
When this happens, Intuit provides an upda
ules (in the TAX.SCD file) to the manufactu

If the IRS makes any changes to the forms yo
the TAX.SCD file. The final edition of MacIn
that you can copy to your Quicken 2000 Fold
the final version of MacInTax, make sure tha
in your Quicken 2000 Folder.
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icken tax planner

ate taxes at any time during the year. In 
 tax planner lets you:

 the correct amount of tax.

terly estimated taxes.

ns such as buying a home or filing taxes 

x accountant are responsible for staying 
mpact on your personal tax situation.

er, assemble all your tax-related “paper” 
mation is comprehensive. This includes:

 both current and year-to-date earnings 
stimating midyear. If you are estimating 
wage forms.

its, including:

eipts

mortgage
Ch

Estimating taxes with the Qu

With the Quicken tax planner, you can estim
addition to estimating your final tax bill, the

• Determine whether you are withholding

• Determine whether you should file quar

• Evaluate the tax impact of major decisio
jointly versus separately.

Important: Remember that you and your ta
current on tax codes and interpreting their i

Assembling your tax information

Before you enter information in the tax plann
information so you can be sure your tax esti

Income records. Most paycheck stubs show
and deductions, which is useful if you are e
at year-end, use your W-2, W-2G, and 1099 

Records of itemized deductions and tax cred

• medical and dental payment records

• real estate and personal property tax rec

• interest payment records for your home 
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ted

IRS, public libraries, bookstores, and your 

s may be helpful for reference. 

ns report. You may want to check these 
ta you need for tax purposes is included 
orized using categories to which you’ve 
 tax reports” on page 469.

planner’s windows from scratch, or you 
ken data and then add to it or change it 

lculators . Tax from the Activities menu.
Ch

• records of payments for child care

• dependent expenses that may be tax rela

• charitable contribution receipts

Tax publications. You can get them from the 
tax accountant. 

Previous tax returns. Previous years’ return

Quicken tax schedule report and capital gai
reports to make sure that all the financial da
in your Quicken data file and that it is categ
assigned tax-line information. See “Creating

Using the tax planner

Please note that the Quicken tax 
planner uses time-sensitive infor-
mation that may not be current. 
Please do not base your financial/
tax planning decisions on this 
data alone. On tax-related issues, 
consult your tax preparer or the 
IRS to receive updates on current 
tax laws and limitations.

You can enter all the information in the tax 
can use some or all of your tax-related Quic
any way you like.

To open the tax planner, choose Planning Ca
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tion, the tax planner calculates your total 

nt of tax you will owe.

You can create and compare 
three different tax scenarios, 
and you can click Clear 
Scenario to set the values in any 
of the scenarios back to zero.

You can change the tax rates to 
keep current with tax law 
changes.

utton to use the 
ve already entered 
cken data file.

Help Topics and select

r?
Ch

Tax planner results

After you have entered all your tax informa
tax, which shows you either:

• Remaining Tax Due: the projected amou

OR

Click this button to assign 
tax-line information to 
your categories in the 
Assign Tax Links window.

The tax planner calculates these 
numbers for you automatically.

You enter data in these fields. 
You can either type numbers 
yourself or tell Quicken to use 
information it already has in 
your Quicken file.

Clicking any of these buttons 
opens another window where 
you enter additional informa-
tion.

Click this b
data you ha
in your Qui

For step-by-step help, go to Taxes in Quicken 

How do I estimate taxes with the tax planne
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und you will receive.

 may want to consider reducing your 
eep in mind, however, that if you reduce 
ou may incur penalties and interest.)

, you may need to make quarterly 
thholding to avoid penalties and interest 
lications or a tax professional to make a 
ed tax payments.

o compare different tax alternatives. You 
narios so you can see the tax implications 

a home, selling an investment, filing taxes 
ken automatically saves all the informa-
narios.

r (ISP) and a Web browser, you can go to 
ut about tax rate changes after September 
p://www.quicken.com/taxcenter/.
Ch

• Refund Due: the projected amount of ref

If the Refund Due amount is significant, you
estimated tax payments or withholdings. (K
your payments or withholdings too much, y

If the Remaining Tax Due is more than $500
estimated tax payments or increase your wi
when you file your return. Consult IRS pub
final determination about quarterly estimat

Trying out different tax scenarios

You can create three different tax scenarios t
may, for example, want to create multiple sce
of major decisions or events, such as buying 
jointly or separately, or getting a raise. Quic
tion you enter in any of the tax planner’s sce

Tip: If you have an Internet Service Provide
the Quicken Tax Center on the Web to find o
1999. Open your Web browser and go to htt
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 data file

ly, you probably need just one Quicken 
in one data file, Quicken can:

egories for all your accounts

e report or graph to track income and 
t information

ther within the file

etween the accounts in one file and the 
, however, why you might want to have 

s purposes if your personal and business 
ifferent checking accounts

ounts (see “Creating a new file for a new 

e, you can copy all or part of the informa-
ile. You can copy selected transactions as 
s, budget amounts, and securities to your 

ken Help Topics and select
Appendix A, W

Using more than one Quicken

If you use Quicken for personal finances on
data file. When you have all your accounts 

• Keep one list of income and expense cat

• Include data from all accounts in a singl
expenses, net worth, and other importan

• Transfer money from one account to ano

With separate files, there is no connection b
accounts in another. There are some reasons
more than one file:

• To keep information separate for busines
finances are entirely separate and have d

• To keep a separate file for each year’s acc
fiscal or calendar year” on page 492)

If you decide to create an additional data fil
tion in your original data file into the new f
well as information such as categories, classe
new file.

For step-by-step help, go to Data Files in Quic

How do I set up an additional file?

How do I copy information between files?
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cken data 

ows (or DOS) data file with Quicken 2000 
tion in the Quicken for Windows data file 
o a Quicken 2000 for Macintosh data file. 
sh data with Quicken for Windows, you 

e Quicken for Macintosh data file to a QIF 
indows data file. 

h data 

en for Macintosh data file, prepare your 

ore than 30 split lines. 

^, %, $, #, @, !, ~, <, >, :, or } from account 
lasses.

me name, rename one of them. For 
and an account named “petty cash.”

s have more than 29 characters in the 

ormat.

 Show Hidden Accounts checkbox in the 

 these steps to create a QIF file.
Appendix A, W

Importing and exporting Qui

To use information from a Quicken for Wind
for Macintosh, you must export the informa
to a QIF file, and then import the QIF file int
If you want to use your Quicken for Macinto
can export all or part of the information in th
file, and then import it into a Quicken for W

Exporting Quicken 2000 for Macintos

Before you export information from a Quick
data file by completing the following:

• Break up split transactions that contain m

• Remove special characters, such as *, &, 
names, security names, categories, and c

• If a category and an account have the sa
example, you may have both a category 

• Make sure that none of your transaction
Category field.

• Set your Macintosh system date to U.S. f

• Show all hidden accounts by clicking the
Account list to select it.

After you’ve prepared your data file, follow
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m which you want to export data.

ion-B.

.

opy of your data file.

 saved in step 3.

ation in the file, or select Custom Export 
t to export.

oppy disk if you want to import it into 
Appendix A, W

1 Open the Quicken for Macintosh file fro

2 Re-index the data file by pressing x-Opt

3 Choose Save a Copy from the File menu

Click OK in the window and name the c

4 Open the copy of your data file that you

5 Choose Export from the File menu.

6 Select Full Export to export all the inform
and choose which information you wan

7 Click Export to create a QIF file.

8 Copy the QIF file onto a PC-formatted fl
Quicken for Windows.

Change the dates if you want to 
export transactions only from a 
specific date range.

Choose which other items you 
want to export.

Click Selected to choose which 
accounts you want to include in 
your export file.
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Windows

boxes in the Create Quicken File window.

F file that you saved from Quicken for 

F file, and then click OK.

ances in your new Quicken for Windows 
nces in your Quicken for Macintosh data 
te or missing transactions in your register.
Appendix A, W

Importing a QIF file into Quicken for 

1 Open Quicken for Windows.

2 Choose New from the File menu.

3 Clear both the Home and Business check

4 Insert the PC-formatted disk with the QI
Macintosh.

5 Choose Import QIF from the File menu.

6 Use the Browse button to locate your QI

Check to make sure that the account bal
data file are the same as the account bala
file. If they don’t match, look for duplica
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r Macintosh data file

en for Macintosh data file, Quicken 
 only want to import selected information 
ch for “exporting” in the Quicken for 
porting your Quicken for Windows data.

ata file into which you want to import 

acintosh data file, choose New from the 

ick Open.
Appendix A, W

Importing data into a Quicken 2000 fo

When you import a QIF file into your Quick
imports all the information in the file. If you
from a Quicken for Windows data file, sear
Windows Help index for instructions on ex

1 Open the Quicken 2000 for Macintosh d
information.

If you haven’t yet created a Quicken for M
File menu to create a new data file.

2 Choose Import QIF from the File menu.

3 Select the file you want to import and cl
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ur data files

n data to guard against accidental data 
 when you close Quicken, or you can set 
py yourself. 

 automatically every third time you close 
 in a special backup folder so you’ll have 

ake a backup copy of your data file when 

:

nd then select the File Backup icon in the 
Appendix A, W

Backing up and archiving yo

It is very important to back up your Quicke
loss. Quicken can create automatic backups
Quicken to remind you to make a backup co

Backing up your data automatically

Quicken comes preset to back up your data
your Quicken data file. This backup is stored
it if you ever need it.

You can also have Quicken remind you to m
you close it. 

To change Quicken’s preset backup options

1 Choose Preferences from the Edit menu a
scrolling panel on the left. 
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eckbox selected if you want Quicken to 

c backups, change the number in the 
 field. The higher the number, the less 

atically. 

Quicken keeps, change the number in the 
 higher the number, the more backup 
.

u want Quicken to remind you to back up 

s, change the number in the “Remind me 
ber, the less often Quicken will remind 

Select this checkbox if you also want 
Quicken to remind you to make a 
backup of your data file every time 
you close it. 
Appendix A, W

2 Leave the “Automatically back up…” ch
back up your data file automatically.

To change the frequency of the automati
“Automatically back up every … times”
often Quicken will make a backup autom

To change the number of backup copies 
“Keep the last … backup files” field. The
copies Quicken keeps on your hard disk

3 Select the “Remind me…” checkbox if yo
your data.

To change the frequency of the reminder
every … times” field. The higher the num
you to make a backup.

Quicken is preset to back up 
your data file automatically every 
third time you close it. To back 
up your data file more often, 
enter a lower number.

Quicken is preset to save the 
four most recent backups. 
Increase this number to keep 
more backup copies of your 
data file.



orking with Quicken data files          488

sks you where to put the backup file and 

 the File menu (x-Q).

ken data file.

 to the backup disk icon.

Choose a location for the backup 
copy of your data file.

If you are going to back up your 
data on a floppy disk, make sure 
there is enough room on the disk 
for the whole data file.

Click Backup to save an exact 
copy of your data file in the 
selected location.
Appendix A, W

If you turn this preference on, Quicken a
what to name it.

Backing up your data manually

Caution: If you create an alias of 
your data file, be sure that you 
back up the original file, not the 
alias.

1 If Quicken is running, choose Quit from

2 Insert your backup disk.

3 Open the folder that contains your Quic

4 Drag the icon for your Quicken data file

Quicken proposes a name for 
your backup file. You can 
replace this name by typing a 
new one. Just make sure you 
choose a name you’ll recognize 
if you ever need to find the file.
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elease the mouse button.

 backup disk. If a file with the same name 
ftware asks you to confirm that you want 

fe place.

m the backup disk:

, double-click its icon to open it.

m the backup disk into the folder on your 
 data files.

th the same name in the folder, dragging 
ur backup file has the same name as your 

Drag your Quicken data 
file to the backup disk. The 
Quicken data file in this 
example is “Murphy’s 
Finances.”
Appendix A, W

5 When the backup disk icon is selected, r

The system software copies the file to the
already exists on the disk, the system so
the file replaced.

6 Eject the backup disk and store it in a sa

Restoring your data

If you ever need to restore your data file fro

1 Insert your backup disk and, if necessary

2 Drag the backup copy of your data file fro
hard disk where you keep your Quicken

Caution: If there is already a data file wi
the backup copy there will replace it. If yo

This is the Quicken application file. 
It does not contain your data.
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 to rename one of them to make sure you 

 the year

e people want to “close out” their 
ar by archiving the previous year’s data 
 the current file and storing it in a safe 

t year. If you close out a Quicken data file 
e ability to create reports and graphs that 

at you make a simple year-end backup of 
g backups) and then just continue to use 

tions.

 the File menu (x-Q).

en data file and click the icon for your file 

-D).

licate of your file and adds “copy” to the 
 “Murphy’s Finances,” the new file is 
Appendix A, W

current Quicken data file, you may want
can easily identify which is which.

Archiving your data file at the end of

In addition to making regular backups, som
accounts at the end of a fiscal or calendar ye
(in other words, removing the old data from
place) and creating a new file for the curren
at the end of a year, however, you sacrifice th
include information from previous years.

For maximum flexibility, we recommend th
your file (in addition to your regular workin
your current data file for this year’s transac

Creating a year-end backup

1 If Quicken is running, choose Quit from

2 Open the folder that contains your Quick
to select it.

3 Choose Duplicate from the File menu (x

The system software creates an exact dup
name. For example, if your file is named
named “Murphy’s Finances copy.”
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 immediately.

r 1999 transactions, you might want to 
rphy’s Finances 1999.”

rchive file to it.

fe place.

icken data file.

ous year’s transactions in the current file, 

.

Appendix A, W

4 Rename the copy by typing a new name

If you are creating a backup copy of you
rename the copy (your archive file) “Mu

5 Insert a backup disk and then copy the a

6 Eject the backup disk and store it in a sa

7 Continue to work with your original Qu

8 (Optional) To prevent access to the previ
you can set up a transaction password.

See “Setting up passwords” on page 496
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 calendar year

e large and unwieldy, or your accountant 
ile for a new fiscal or calendar year, you 
 new file for the new year.

.

 uncleared transactions from the previous 

 that contains nothing in the Clr column. 
red transactions” on page 494 if you need 
ther or not you want to include uncleared 

your new Quicken data file.

 Save a Copy treats 
leared transactions” 

494 before selecting or 
this checkbox.
Appendix A, W

Creating a new file for a new fiscal or

If your working Quicken data file has becom
insists that you create a new Quicken data f
can use the Save a Copy command to start a

1 Open your Quicken data file.

2 Choose Save a Copy from the File menu

3 Enter the date range for the new year.

4 Decide how you want Quicken to handle
year.

An uncleared transaction is a transaction
See “How Save a Copy treats prior unclea
more information before you decide whe
transactions.

5 Click OK.

6 In the Save dialog box, enter a name for 

Enter the beginning and ending 
dates for the new year, not the 
previous year. 

For example, if you want to start 
a new file for 1998, enter 1/1/98 
and 12/31/98.

See “How
prior unc
on page 
clearing 
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d “Murphy’s Finances,” you might name 

ontains:
 year for each non-investment account 
 transactions, all transactions that have 

r
d in your investment accounts

ation
orized reports and graphs

lect the new file, and click Open to 
e new year.

iles:

s to date. This is your archive file.

r the new year. From now on, you will do 
Appendix A, W

For example, if your current file is name
the new file “Murphy’s Finances 2000.”

7 Click Save.

Quicken creates a copy of your file that c
• the ending balance from the previous

(plus, if you included prior uncleared
not yet been cleared or reconciled)

• all your transactions for the new yea
• all transactions you have ever entere
• all your lists
• your budgets
• your online account and payee inform
• your custom settings, including mem

8 Choose Open File from the File menu, se
continue your work in the new file for th

Archiving the old file

You now have two different Quicken data f

• The old file contains all your transaction

• The new file contains only transactions fo
all your work in this file.
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te that it is an archive. Then copy it to a 
fe place. If you don’t need frequent access 
 delete the archive file from your hard 

e file

ransactions from the previous period 
n the original file), open the archive file 
ctions that occurred before the end of the 
r archive file to contain transactions from 

Save a Copy date range and clear the 
x.

nsactions

s that occurred before the date range you 
ed with a √) or reconciled (marked with 

when you copy a file:

ared transactions in each non-investment 
e opening balance for that account in the 

nsactions from each non-investment 

ctions from investment accounts in the 
ion history for all your securities.
Appendix A, W

Make sure you rename the old file to indica
floppy disk, label the disk, and store it in a sa
to data from the previous year, you can also
disk.

Removing later transactions from the archiv

If you want the archive file to contain only t
(instead of all of the transactions that were i
and use Save a Copy to save only the transa
archive period. For example, if you want you
1999 only, enter 1/1/99 to 12/31/99 as the 
Include Prior Cleared Transactions checkbo

How Save a Copy treats prior uncleared tra

Prior uncleared transactions are transaction
specified but haven’t yet been cleared (mark
a �) in the Clr column.

If you include prior uncleared transactions 

• Quicken sums the amounts of all prior cle
account and uses this total amount as th
new file.

• Quicken includes all prior uncleared tra
account in the new file.

Note: Quicken always includes all transa
new file so you keep a complete transact
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 a cleared transaction that’s dated before 
n copies only the uncleared side of the 
l. In fact, it should come to your attention 
n, choose Find . Go To Transfer from the 

g transfer transaction in the other account, 
nt.”

ransactions in the new file? You should 
ons checkbox if you use Quicken for any 

les

d Transactions checkbox only if you want 
e date range specified, regardless of their 

ions in an account (a cash account, for 
the past transactions from that account in 
 transactions quickly using the Adjust 
 balance” on page 221, or “Updating the 
e 243.
Appendix A, W

• If an uncleared transaction is a transfer to
the starting date for the new file, Quicke
transfer to the new file. This is not harmfu
only if you select the uncleared transactio
Edit menu (x-[ ) to go to the correspondin
and see the message, “Transfer not prese

When should you include prior uncleared t
select the Include Prior Uncleared Transacti
of these tasks:

• reconciling bank or credit card accounts

• tracking assets

• tracking business payables and receivab

You should clear the Include Prior Uncleare
the new file to include only transactions in th
cleared status.

Tip: If you don’t typically reconcile transact
example) and you don’t want to include all 
your new file, you can reconcile all the past
Balance command. See “Updating your cash
value of an asset or liability account” on pag
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 transactions in a Quicken data file from 
ifferent kinds of password protection in 

 to your Quicken data by requiring a file 

en data file. After you set up a file 
n file unless you enter the password 

 your file from being copied, deleted, or 
pied to a different place, the password is 

sword that protects all transactions before 

 you cannot make changes to any transac-
 enter the password correctly. For 

ounting period so that no inadvertent 
t by setting up a transaction password to 
g period.

ion passwords by choosing Preferences 
ords icon.

ken Help Topics and select
Appendix A, W

Setting up passwords

You might want to protect some or all of the
unauthorized changes. You can set up two d
Quicken:

• You can discourage unauthorized access
password to open the file.

A file password protects an entire Quick
password, you cannot open your Quicke
correctly. A file password cannot protect
renamed but, if your file is renamed or co
still in effect.

• You can set up a separate transaction pas
a certain date from accidental changes.

After you set up a transaction password,
tions before the specified date unless you
example, you might want to close an acc
changes can be made to transactions in i
protect transactions from that accountin

You can set up and change file and transact
from the Edit menu and selecting the Passw

For step-by-step help, go to Data Files in Quic

How do I set up a password?
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 keep it in a safe place. If you forget your 
nd your Quicken data file to Intuit’s 

Technical Support Representative. at the 
ice fee for password removal.

A

ken Help Topics and select
Appendix A, W

Important! Write down your password and
password, the only way to remove it is to se
Password Removal Team (Talk to Quicken 
phone number on page 507). There is a serv

How do I change or remove a password

For step-by-step help, go to Data Files in Quic
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 in Quicken? Are you running low on 
ow to apply for online financial services?

Web-based services that deliver the infor-
isit our Technical Support web site for 
 for software, supplies, and Quicken 
s to sign up for two of Quicken’s biggest 
 Quicken Credit Card. To find out which 
ke a look at the listings on the following 
B Troubleshootin
contacting Intu
Saving a phone call ..........................................

Before you contact us.......................................

Who to contact..................................................

Placing orders ...................................................

Getting started with online financial service

Do you need to know how to do something
Quicken checks? Would you like to know h

Hours   Unless otherwise noted, 
all business hours for web-based 
services, automated phone 
support, and Fax on Demand are 
seven days a week, 24 hours a day, 
except to allow for system and 
server maintenance. Hours and 
phone numbers are subject to 
change.

Intuit supports convenient fax, phone, and 
mation and products you need—quickly. V
answers to your questions or shop the Web
checks. Use the Web or our toll-free number
timesavers: online financial services and the
service or support option is right for you, ta
pages.
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n works, the best way to get an immediate 
ces:

idance through a specific task while 
ctly to that information if the window for 
k up a specific topic by name in Topics, 

begins on page 518 for the topic you need. 
s, such as “missing check numbers,” and 
shooting.” 

ooting tips. Look through the following 

oblems

ving difficulty printing checks

without having to make a call
Appendix B, Troub

Saving a phone call

If you have a question about the way Quicke
answer is to look in one of the following pla

See “Getting step-by-step assis-
tance from Quicken Help” on 
page 47 for more information.

Quicken Help. Press x-? for step-by-step gu
you’re working in Quicken. You can go dire
the task is open and active. You can also loo
Index, or Look For view.

This onscreen manual. Check the index that 
The index has entries for common symptom
common problems are listed under “trouble

The tables in this chapter also list troublesh
pages. Here you’ll find:

• suggested solutions to some common pr

• troubleshooting suggestions if you’re ha

• additional tips to help resolve problems 
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d 10, and Monaco 9 and 12.

 not compress Quicken data files, the file 

uicken Help folder, and that the Quicken 
icken 2000 application file. Also, make 
he Extensions folder (in your System 
 System Files folder on your Quicken 

 the Quicken Essentials folder, and that 
e folder as the Quicken 2000 application 

re prices and number of shares using 
tment accounts.
Appendix B, Troub

Solutions to common problems

Problem area Solution

Problems with fonts displayed 
on the screen

Quicken requires Chicago 12, Geneva 9 an

Problems with compressed files For best results, we recommend that you do
Quicken Quotes, or the TAX.SCD file.

Quicken can’t open Quicken 
Help

Make sure the Quicken Help file is in the Q
Help folder is in the same folder as the Qu
sure that the Apple Guide extension is in t
Folder). If it isn’t, you can copy it from the
Deluxe 2000 CD-ROM.

Quicken can’t open the Supply 
Order Form

Make sure the Supply Order Form file is in
the Quicken Essentials folder is in the sam
file.

Prices or number of shares seem 
to be incorrect in the Portfolio 
window

Try pressing x-Option-U to update the sha
data from the transactions in all your inves
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s

 alignment problems such as the text 

th a page-oriented printer, see “Adjusting 
ers” on page 144.

ith a continuous-feed printer, see 
us-feed printers” on page 150.

is online.
the printer and the Macintosh is secure.
rect printer is selected.

st printed checks. You haven’t changed 
using other software, but when you try 

e day, and nothing works the next day, 
einstall the printer driver.
Appendix B, Troub

Check printing problems and solution

The majority of check printing problems are
printing too high or too low on the check.

• If you are having alignment problems wi
check alignment for page-oriented print

• If you are having alignment problems w
“Adjusting check alignment for continuo

Problem The printer doesn’t print.

Solution

Check the printer connections:
• Make sure your printer is turned on and 
• Make sure the cable connection between 
• Open the Chooser and make sure the cor

Problem

Your printer was working fine when you la
any settings and you can print documents 
to print checks in Quicken:
• the print is misaligned 
• gibberish appears on the checks
• the print dialog box doesn’t appear at all

Solution If you printed checks without problems on
your printer driver is probably damaged. R
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lf

he best way to solve it is to try these self-

ntains an index file to improve access to 
 combination, Quicken reconstructs its 

 use in the Quicken Info window.
 Quicken.
o select it, and then choose Get Info from 

 value for Preferred Size.
 restart Quicken by double-clicking the 
Appendix B, Troub

Other suggestions for helping yourse

If you still have a problem using Quicken, t
help approaches first.

Do this Here’s how

Have Quicken reconstruct its 
index file.

Press x-Option-B in Quicken. Quicken mai
your financial data. When you use this key
index file, which may solve your problem.

Increase the amount of memory 
Quicken can use.

You can increase the memory Quicken can
• Choose Quit from the File menu to leave
• Click the Quicken 2000 application icon t

the File menu.
• In the Quicken Info window, increase the
• Close the Quicken Info window, and then

icon for your Quicken data file.
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rack of most of your Quicken settings. If 
 by these settings, this step may solve it.

 Quicken.
and Intuit Online Prefs 2000 out of the 
lder and put them on the desktop next to 

on for your Quicken data file.
eed to reset all your preferences. You no 
files that you moved to the desktop, and 

it from Quicken and move the 
esktop back into the Preferences folder. 

 you want to replace newer versions of 
Appendix B, Troub

Remove your Quicken 2000 
Preferences file from the System 
Folder.

The Quicken 2000 preferences files keeps t
your problem is in one of the areas affected
• Choose Quit from the File menu to leave
• Move the files Quicken 2000 Preferences 

Preferences folder that’s in the System Fo
the Trash (so you can find them later).

• Restart Quicken by double-clicking the ic
If this step solves your problem, you will n
longer need the Quicken 2000 preferences 
you should drag them to the trash.
If this step does not solve your problem, ex
Quicken 2000 preferences files from your d
Click Replace when the system asks you if
the preferences files. Then restart Quicken.

Do this Here’s how
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t specialist leads you through steps to 
 some of this exploration yourself to 

chnical expertise. The key to trouble-
 first.
inning. Examine the windows and 
n. Make sure you are using the appro-

ng the correct options for what you want 
ude the information you want, check the 
stomize Report window.
u have a printing problem, test the 

f you can’t print checks, try printing a 
n, try printing from a word processor. If 
e printer and not Quicken. Check the 
ect printer is selected in the Chooser.
at’s changed since it last worked 
our software (added any applications or 
eral such as a modem)?
Appendix B, Troub

Explore the problem a bit before 
you call.

When you call  with a problem, the suppor
identify and solve the problem. You can do
eliminate possibilities that don’t require te
shooting is trying the most basic approach
Try the procedure again, starting at the beg
dialog boxes where you entered informatio
priate window or dialog box and are choosi
to do. For example, if a report does not incl
date range and the other settings in the Cu
Try a related procedure. For example, if yo
printer by trying to print something else. I
report. If you can’t print at all from Quicke
nothing prints, the problem is related to th
printer connections and make sure the corr
If something used to work, think about wh
correctly. For example, have you changed y
utilities) or your hardware (added a periph

Do this Here’s how
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t your computer with Quicken running, 

u saw one

m Quicken, choose About Quicken from 
umber).

 available (from the Finder, choose About 
 to get the numbers for Built-in Memory, 

k)

he Finder, choose About this Macintosh 
ion number)

Ts) and Control Panels (sometimes called 
er (look in the folders named Extensions 

er; everything in each of those folders is 

f relevant to your issue) 

er to help you identify information about 
 from the Apple (K) menu.
Appendix B, Troub

Before you contact us

If you need to call for product support, be a
and have the following information handy:

• Exact wording of the error message if yo

• Quicken version and release number (fro
the Apple (K) menu to see the version n

• Macintosh type and model

• Amount of memory (RAM) installed and
this Macintosh from the Apple (K) menu
Total Memory, and Largest Unused Bloc

• System software version number (from t
from the Apple (K) menu to see the vers

• Which extensions (sometimes called INI
CDEVs) are installed in your System Fold
and Control Panels in your System Fold
currently installed)

• Monitor type

• Printer manufacturer, type, and model (i

Tip: Apple includes the Apple System Profil
your system. Choose Apple System Profiler
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s or to give us feedback on Quicken, visit 
dge Base searches, updates, and answers 

n

er commonly asked questions about 
ents with answers to common questions, 

h answers to common questions about 
 a suggested procedure, the Automated 
re.
Appendix B, Troub

Who to contact

Quicken Technical Support Web Site

To find out about Technical Support option
our Web site. The Web site provides Knowle
to common questions.

http://www.intuit.com/support/quicke

Fax on Demand 

Use Fax on Demand to order faxes that answ
Quicken. To request a catalog of fax docum
call the number below. 

Fax on Demand
800-644-3198

Automated Technical Support

The Automated Expert can provide you wit
Quicken. And, if you need to hang up to try
Expert can even keep track of where you we

Automated Expert
800-644-3193

http://www.intuit.com/support/quicke
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n

esentative.

e

iced. Terms and conditions are subject to 

rvice Provider (ISP) connection, call them 
 in the Online Center. For setup issues, 
 Quicken Product Support.

transactions, call CheckFree. For all other 
l Support.

n time 
Appendix B, Troub

Product Support Options

• Purchase a support plan.

http://www.intuit.com/support/quicke

• Talk to  Quicken Technical Support Repr

520-618-7131
900-555-4932
Monday - Friday, 5 am - 5 pm Pacific tim

Quicken Technical Support is flexibly pr
change without notice.

Online financial services support

If the problem is caused by your Internet Se
directly. If not, click the Contact Info button
confirm your account information, then call

Customer Service for CheckFree

If a problem occurs after you transmit your 
issues, call Quicken for Macintosh Technica

CheckFree Customer Service
800-297-3180
Monday - Friday, 8 am - midnight Easter

http://www.intuit.com/support/quicken
http://www.intuit.com/support/quicken
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e

nline, call: 
Appendix B, Troub

CreditCheck Service by ConsumerInfo.Com

For help with your credit report, call: 

ConsumerInfo.Com Customer Service
888-888-8553
Monday - Friday, 6 am - 6 pm Pacific tim

http://www.consumerinfo.com/

America Online, Inc.

For help with installing or using America O

America Online Technical Support
888-265-8007
24 hours, 7 days a week

http://www.aol.com/

http://www.consumerinfo.com/
http://www.aol.com/
http://www.intuit.com/support/quicken
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d other supplies at: 

are with Quicken checks. Please refer to 
bout ordering checks and other financial 
lace your order:

e

Appendix B, Troub

Placing orders

Shop the Web

• Purchase Intuit software and services at:

http://www.intuit.com/quicken_store/

• Purchase Quicken checks, envelopes, an

http://www.intuitmarket.com/

Quicken Checks Customer Service

Save time and get the most out of your softw
the enclosed catalog for more information a
supplies. For additional information or to p

Call from the U.S.
800-433-8810
Monday - Friday, 5 am - 8 pm Pacific tim
Saturday, 7:30 am - 1 pm Pacific time

Call from Canada
877-445-3233

http://www.aol.com/
http://www.intuit.com/quicken_store/
http://www.intuitmarket.com/


leshooting and contacting Intuit          510

information, see the following:

e

 time

il:
 time

e

Appendix B, Troub

Intuit Direct Sales

To place a product order or to find product 

http://www.intuit.com/quicken_store/

TDD Users
800-843-8828
Monday - Friday, 8 am - 5 pm Pacific tim

Call from Canada
888-829-1722
Monday - Friday, 8 am - 5 pm Mountain

Extended hours September through Apr
Monday - Friday, 6 am - 11 pm Mountain
Saturday and Sunday 8 am - 8 pm

Call from Overseas
520-901-3220
520-901-3208 (Fax)
Monday - Friday, 7 am - 7 pm Pacific tim

http://www.intuit.com/quicken_store/


leshooting and contacting Intuit          511

dify your order, or contact Intuit, see our 

e

 time

e 
Appendix B, Troub

Intuit Customer Service

To check the status of your direct order, mo
web site: 

http://www.intuit.com/service/

TDD Users
800-843-8828
Monday - Friday, 8 am - 5 pm Pacific tim

Call from Canada
780-440-5952
Monday - Friday, 8 am - 5 pm Mountain

Overseas Service
520-901-3220
520-901-3208 (Fax)
Monday - Friday, 7 am - 7 pm Pacific tim

http://www.intuit.com/service/	
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nancial services 

 to use these services. 

ine account access and online payment), 
anking Setup and follow the onscreen 

ces, and to see a list of participating finan-

line payment, you can apply for online 
t service using your existing checking 
Appendix B, Troub

Getting started with online fi

Apply for online financial services

You need an Internet Service Provider (ISP)

• To apply for online banking service (onl
from the Banking menu choose Online B
directions.

• For information on online financial servi
cial institutions, see:

http://www.intuit.com/online

Apply for online payment with Intuit

If your financial institution doesn’t offer on
payment through the Intuit Online Paymen
account at a U.S. financial institution.

http://www.intuit.com/online
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 Intuit and Travelers Bank USA. You can 
icken. Current benefits include no annual 

tional TravelerMiles travel awards 
ravel. To apply, speak to a representative 

estions about your Quicken Credit Card 
activity, please call Travelers Bank USA. 

ur Quicken Credit Card transactions into 
ite:

e 

ard/
Apply for a Quicken Credit Card

The Quicken Credit Card is offered through
download your transactions directly into Qu
fee, a credit line of up to $50,000, and an op
program that earns free and discounted air t
or visit our Web site:

Travelers Bank USA
800-442-4939, ext. 123

http://www.quickencard.com/

Quicken Credit Card Support

If you are a current cardholder and have qu
account balance, available credit, or charge 

Travelers Bank USA
800-772-7889

If you experience difficulty downloading yo
Quicken, call this number or visit our Web s

Technical Support
520-618-7131
900-555-4932
Monday - Friday, 5 am - 5 pm Pacific tim

http://www.intuit.com/quickencreditc

http://www.quickencard.com/
http://www.intuit.com/quickencreditcard/
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rts   400
Index

A
account balance

adjusting
asset and liability accounts   244
bank accounts   175
credit card accounts   231
investment account   364
mutual fund accounts   364
opening balance   158, 162
portfolio accounts   301

can’t change Balance column   95
forecasting   445–455

account bar   67
accounting periods, closing

see transaction passwords; fiscal year
accounts   ??–68

accessing your accounts online   180
adding to a Quicken data file   64
Calendar, restricting in   92
Category field and   97
Category & Transfer list and   77
changing in a transaction   95
deleting   68, 69
displaying names or descriptions in repo



 519

cken   22–24

sh accounts; credit card accounts; liability 
tfolio accounts

ister   313
s

editing name, description, or type   68
enabling for online account access   187
enabling for online payment   201
forecast graph, restricting   448
graphs, selecting for   414
hiding in lists   68
hiding safer than deleting   69
income and expense, see categories
multiple windows open at once   67
opening   67
reports, selecting for   384
setting up   64
showing hidden   68
sorting graphs by   413
sorting reports by   381
tax lines, assigning to   462
transferring funds between   103–106
updating from previous versions of Qui
used the wrong account   95
see also asset accounts; bank accounts; ca

accounts; mutual fund accounts; por
accounts payable   238, 242
accounts receivable   237
accrued interest for bonds   326
accrued liabilities, tracking   238
Action field in portfolio or mutual fund reg
actions, investment, see investments, action
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r   196

122–124

alance transaction   160
activity areas   40
actuals in budget reports and graphs   438
adding

accounts to a Quicken data file   64
additional Quicken data files   481
buttons to the task bar   44
categories   78
Command-key shortcuts   45
downloaded transactions to your registe
indexes to the WatchList   353
memos to transactions   90
new transactions to QuickFill list   113
notes to checks   131
notes to the Calendar   92
online payees   201
page breaks to reports   373
register transactions to the Calendar   91
reminder notes to the Calendar   92, 94
scheduled transactions to the Calendar   

securities to a portfolio account   292
securities to the WatchList   353
shares to a mutual fund account   305
shares to a portfolio account   296
subcategories   79
transactions dated before the Opening B
transactions to the register   88–89
Windows button to toolbar   44
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5

4

address, on checks   131
adjustable-rate loans   258, 261
adjusting

account balance during reconcile   158, 17
asset account balance   244
cash account balance   221
cash balance of investment accounts   364
column width in Portfolio window   283
column width in reports   374
date range in reports   377
interest rates for loans   265
liability account balance   244
loan payment   260
mutual fund account balance   364
opening balance   95, 158
portfolio account balance   301
positioning of checks   144
share balance of investment accounts   36
value of asset   244

adjustments, see balance adjustments
aligning checks

continuous-feed printers   148
page-oriented printers   135, 144

American Express, see charge cards
amortization

negative   259
payment schedules   263
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nts   384

, 374

nd subcategories   459
setting up a loan for   249
see also loans

Amount Width setting   147
amounts, restricting reports by dollar amou
annual backup of data file   490
annuities, type of account for   273
archiving the previous year’s data   490
arrows, double-pointed mouse pointer   283
ASCII (text) export file format   402
asset accounts   235–244

adjusting balance of   244
defined   62
home inventory tracking   236
register   240
sample uses   236, 240
updating   243
when to use   235

assets, see asset accounts
Assets/Debt area   40
assigning

categories to transactions   97–99
classes to transactions   97
line items from tax forms to categories a
transfers to transactions   104

asterisk (*)
in investment accounts   290
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s   88

off   401

0, 95
ATM (automated teller machine) transaction
downloaded data   194

audit, sold assets or paid liabilities   243
Auto Recalculation command   401
automatic

backup, turning on and off   486
completion of transactions   113
recalculation of reports, turning on and 

Automatically Enter
setting for scheduled transactions   125

B
backdrop, turning on and off   43
backing up files   486–490
balance adjustments

asset and liability accounts   244
cash accounts   219, 221
changing opening balance   158, 175
credit card accounts   231
mutual fund accounts   364
portfolio accounts   301, 364
when account doesn’t balance   175
see also reconciling

Balance column, why you can’t change it   9
balances

account, adjusting   175
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bank statement   159, 162, 163
beginning balance for reconciling   162
ending balance for reconciling   163
forecasting   445
loans, tracking   248
online credit card   197
opening balance, determining   65

balancing
bank accounts   157–177
cash accounts   221
credit card account   229
investment accounts   363
online bank accounts   165
your checkbook   157–177

balancing your checkbook
see also reconciling

Balloon Help   54
balloon payments   258
bank

errors caught by reconciling   163, 175
Intuit checks are accepted by   128
service charges, entering in register   88
see also bank accounts; reconciling

bank accounts
reconciling   157–177
tracking cash in   216
tracking credit cards in   225
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75
writing checks in   128–132
bank data, handling disputes   209
Banking area   40
banking online, see online banking
banks, see financial institutions
beginning balance

on bank statement   159, 162
when reconciling   162

Billminder   127
bills   122–155

loan payments   260
paying credit card bills   232
paying online   201
scheduling regular payments   122

bonds
accrued interest for   326
Ginnie Mae   330
prices, entering   300
Series EE   333
shares, number of, entering   299
tax-free income and   335
type of account for   272
U.S. Savings Bonds   333
zero-coupon   335

brackets in Category field   77
brokerage accounts

suggestions for setting up in Quicken   2
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ta   431

nging   428

1

ify   82
type of account for   272
see also portfolio accounts

browser, see Web browser
budget amounts

copying between files   481
exporting   483
moving to another file   481

budgets   426–438
amounts for transfer accounts   434
automatically creating from historical da
deleting   436
displaying   426–432
editing amounts   435
entering amounts

automatically   431
manually   429

monitoring   437
monthly, quarterly, or yearly layout, cha
opening   426–432
renaming   436
reports   438
setting up   426–432
variance graphs   438

business
keeping separate from home finances   48
reports   170, 370

business transactions, using classes to ident
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counts   324

rs; QuickMath
buttons, customizing   43–45
Buy investment action   316, 324
buying securities

see also securities
buying securities, entering in investment ac

C
calculators, see financial planning calculato
Calendar   122–126

accounts, selecting   92
adding

register transactions   91, 124
reminder notes   92, 94
scheduled transactions   122

dragging and dropping transactions   126
editing transactions   126
illustration   92
moving around in   92
moving transactions   126
notes   92, 94
printing   94
reminder notes   92
scheduling future transactions   122–126

calls and puts   335
Canada

loans, semi-annual compounding   250
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29
29

78

220

21
ordering cheques   129
tax categories   75

canceling
online banking   209
online payments   206

capital
equipment   236, 241
return of   330

Capital Gain Long investment action   316, 3
Capital Gain Short investment action   316, 3
capital gains

distributions   328, 329
reports

IRS Schedule D and   472
short sales excluded from   336

carry forward budget amounts in reports   3
cash

advances from other Quicken accounts   

handling in checking account   216
no need to enter every transaction   219, 2
petty, tracking in cash account   215
recording deposit less cash   220
withdrawal expense category   216

cash accounts   218–221
account register   219
adjusting balance of   219, 221
setting up   218
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5

rts   400

transactions
cash balance in portfolio accounts   301, 312
adjusting   301, 364

cash flow, forecasting   445
cash management accounts (CMAs)   273, 27
categories   72–80, 97–99

assigned in online banking   194
assigning to transactions   97–99
business, illustrated   74
classes and   82
copying between files   481
copying, see categories, exporting
deleting   80
demoting to subcategory   80
displaying descriptions or names in repo
editing name, description, or type   80
entering in Category field   97, 98
entering on checks   131
exporting   483
finding uncategorized transactions   390
home, illustrated   74
including in budget reports   379
including in graphs   411
investment   77, 315, 316
modifying Quicken’s preset lists   76
more than one per transaction, see split 
moving to another file   481
not used for transfers   103
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 list; graphs; itemized category reports; 

igning to transactions

in   75
printing on voucher checks   134
recategorizing transactions   73
selecting for graphs   414
selecting for reports   385, 389
setting up   78
sorting graphs by   413
sorting reports by   381
subtotaling reports by   381
tax lines, assigning   460
tax related, marking as   458
typing in Category field   98
warn if not filled in   97
see also budgeting; Category & Transfer

reports; tax form assignments
categorizing transactions, see categories, ass
Category field

entering categories in   98
entering classes in   100
entering transfer accounts in   104
see also categories

Category & Transfer list
choosing from   99
moving categories in   80
opening   74
rearranging categories in   80
sorting   75
standard home and business categories 
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  73
using to create transfers   104
see also categories

CDs, see certificates of deposit
certificates of deposit (CDs)

prices, entering   300
shares, number of, entering   299
type of account for   273

changes, preventing unauthorized   496
changing

account for a transaction   95
categories that were entered incorrectly 

fields with Return key   118
file passwords   496
PIN   192
reconciled transactions   95
Return key action   118
Tab key action   118
tax status for investment accounts   68
transaction passwords   496
transactions with a bold checkmark   95
transactions with the wrong category   73
see also editing

charge cards
credit limit, changing   68
tracking   223–233

Charge column, credit card accounts   228
charts, see graphs
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150
check numbers
missing or duplicate   380
OK to have more than one set   26, 129
printed on Intuit checks   128
QuickFill transactions and   113
why preprinted   132

check registers   88–119
see also bank accounts; registers

CheckArt   155
checkbook, balancing, see reconciling
CheckFree   507

see also electronic payments; payees
checking accounts, seebank accounts   514
checking accounts, tracking   62
checking your credit rating   441
checkmarks, reconciling and   166
checks

adding art to   155
alignment in page-oriented printers   135
alignment on continuous-feed printers   

changing date to today   134
finding specific number or payee   117
logos pre-printed free   130
missing or duplicate check numbers   380
numbers
finding   117
OK to have more than one set   129
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indow

oals to track   295
why preprinted   132
ordering   129
partial first page of checks   141
positioning

continuous-feed printers   136
page-oriented printers   135

printing sample   148
printing, see printing, checks
reprinting   152
unprinted, reviewing   132
voiding   96
voucher, printing categories on   131, 134
writing   128–132
see also check numbers; Write Checks w

Checks on First Page icons   143
checks, ordering from Intuit   509
children’s investments, setting up types or g
Chooser, check printing and   133, 501
choosing, see item you want to choose
Class list   84, 102

entering classes from   102
moving classes in   85
rearranging classes in   85

classes   82–85, 100–102
assigning to transactions   97
categories and   82
Category field and   97
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transactions
copying between files   481
deleting   85
demoting to subclass   85
editing name or description   85
entering in Category field   100
exporting   483
forward slash (/) and   100
including in graphs   411
job tracking and   82
more than one per transaction, see split 
moving to another file   481
rental properties and   82
selecting for graphs   414
selecting for reports   389
setting up   84
sorting graphs by   413
sorting reports by   381
subtotaling reports by   381
tax line copies, assigning   467
transfers and   105
typing in Category field   100
when to use   83
see also Class list

Clear Split button   109
Clr column in register   89
cleared (√) transactions

defined   169
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asswords; fiscal year

325
on   207
marking during reconcile   166
when copying data to new file   494

clearing split information   109
clients, setting up classes to track   82
closing accounting period, see transaction p
closing assets or liabilities   243
closing balance, see ending balance
Collapse Header command   373
collectibles

prices, entering   300
shares, number of, entering   299
type of account for   273

college planning calculator   443
column headings for reports, changing   378
columns

choosing
in reports   378
in the Portfolio window   283

resizing
in reports   374
in the Portfolio window   283

Command-key shortcuts   45
see also the back cover of this manual

commissions and fees for investments   314, 

communicating with your financial instituti
completing entries automatically   113
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  125

   136

 482–485

d

compressed files, problems with   500
confirming entry of scheduled transactions 

consumer debt, reducing   441
continuous-feed printers, printing checks on
converting

categories into subcategories   80
classes into subclasses   85
foreign currency   337
old Quicken files in new version   22
reports for use with other programs   402
subcategories into categories   80
subclasses into classes   85
tax reports to other formats   473
to ASCII format   402
to QIF format   482

copying
accounts between files   481
all or part of a file   481
budget amounts between files   481
categories between files   481
classes between files   481
data to and from Quicken for Windows  

information between files   481
part of a file to a new file   481
securities between files   481
transactions between files   481
see also exporting; Save a Copy comman
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correcting
misspellings in the register   117
mistakes during reconciliation   167
mistakes in register   95

cost basis
gift or inherited shares and   331
home   236, 240

creating
additional data files   481
QIF files   482
Tax Exchange Format file (TXF)   473
see also setting up

credit card accounts   223–233
adjusting balance of   231
credit limit, changing   68
debit cards and   224
finance charges   230
online

assigning categories   195
checking your balance   197
getting data   197
paying your bill   198
transferring money   199

paying the bill   232
register   228
when to use   223

credit cards
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ort   31, 441
credit limit, changing   68
handling in checking account   225

credit limit, changing   68
credit rating, checking with Free Credit Rep
CreditCheck   508
currency, converting foreign   337
current balance

in Register window   89
on bank statement   163
postdated transactions not included   89

custodial fees, shares redeemed for   331
Customize command

graphs   409, 411, 413
reports   376, 382, 392

customizing
backdrop behind windows   43
button bar   43–45
graphs   411–419

content   413
layout   411

iconbar   43–45
interface   43–46
Quicken’s workspace   43–46
register   118
reports   372–397

content   372, 382
layout   372
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  370, 409
organization   372, 392
task bar   ??–45
toolbar   43–??

D
data

budgeting automatically from   431
Quicken, how organized   60
see also files

data entry
QuickFill   113
using QuickEntry   27, 114

data files   60–61, 481–497
creating additional   481
not affected by installation   15
protecting with passwords   496
restoring from backup   489
year-end copy   490

Date field, printing too high or low on check
dates

custom date ranges, creating for reports 

graphs   410
including in graphs   411
QuickFill transactions and   113
selecting for reports   371, 377
sorting reports by   381



 540

441

74
31, 440

126
debit cards   224
debts

reducing with Debt Reduction Planner   

tracking with liability accounts   238
Decrease column

asset account   240
liability account   242

deductions
from paycheck for retirement plan   112, 2
identifying with Tax Deduction Finder   

tracking for taxes   457–458
deleting

accounts   68, 69
budgets   436
Calendar notes   92
categories   80
classes   85
investment categories   80
loans   265
locked transactions   114
memorized graphs   416
memorized reports   397
memorized transactions   114
page breaks in reports   373
passwords   496
QuickFill transactions   114
scheduled transactions in the Calendar   
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s

ile window
securities   357
security prices   343
split transactions   109
transactions

from register   96
in Calendar   126

transactions with a bold checkmark   176
WatchList items   360

delivery date, online payments   204
Deluxe features, see Quicken Deluxe feature
demoting

categories to subcategories   80
classes to subclasses   85

deposits
adding in register   88
bank may summarize   174
paycheck   110
recording deposit less cash   220
reports, limiting to deposits   387

depreciation
tracking in asset account   235, 241
updating   244

design of reports   373–376
destination accounts for transfers   103
detail in graphs   417
Difference field in budgets   428
Difference this Statement amount in Reconc
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   171

ount   327
lance of brokerage account   328

74
equals zero   168
is not zero   171
is zero but there is a Previous Difference

disabling, see name of feature to disable
Discard command   109
disputes, online banking   209
Dividend investment action   317, 327
dividends

entering in portfolio or mutual fund acc
from money market fund that is cash ba
reinvestments   328
tax-free bond income   335

dollar amounts, see amounts
double-pointed arrow mouse pointer   283, 3
downloading transactions

how Quicken assigns categories   194
how Quicken matches transactions   193

due dates for scheduled transactions   124
duplicate check numbers

showing in reports   380
warn about   118

E
EasyAnswer

graphs   408
reports   368
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  73
editing
account for a transaction   95
account name, description, or type   68

transfers and   106
budget amounts   435
budget names   436
Calendar notes   92
categories that were entered incorrectly 

category name, description, or type   80
class name or description   85
downloaded transactions   195
file passwords   496
investment categories (not possible)   80
investment goals   295
loans   265
memorized reports   397
online payees   201
opening balance   95
PIN   192
QuickFill transactions   114
reconciled transactions   95
security

information   286
prices   343
types   295

transactions
downloaded   195
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   208
in Calendar   126
in register   95
passwords for   496
with a bold checkmark   95
with the wrong category   73

transfer transactions   106
EFT
float period   205
lead time   203
with online payment   203

electronic funds transfer, see EFT
electronic payments, Billminder and   127
e-mail

receiving from your financial institution
sending to your financial institution   207

Emergency Records Organizer   31, 440
encryption, used with online banking   183
ending balance

in Write Checks window   131
on bank statement   159, 163
when reconciling   163

ending bealance
in Register window   89

entering
account information   64
budget amounts   429
categories   98
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classes   84, 100
investment transactions   308
memos on checks   131
new categories   78
notes in Calendar   92
notes on checks   131
online transactions   191
prices in Portfolio account   300
scheduled payments   122
scheduled transactions   125
shares in Portfolio account   299
tax-related information   458
transaction groups   127
transactions in Calendar   122

envelopes for checks, ordering   129
equipment, tracking depreciation   241
erasing, see deleting
errors

correcting during reconciliation   167
correcting in register   95
see also troubleshooting

Excel export file format for reports   402
exchange rates, keeping track of   337
excluding transactions from reports   391
expense and income categories   72–80
exporting

ASCII files   402
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 482

counts   331
budget amounts   483
categories   483
classes   483
data

to a QIF file   482
to MacInTax (TXF format)   473
to Quicken for Windows   482

files for use with Quicken for Windows  

report data for other programs   402
reports to MacInTax   473
securities   483
tax information   473
text files   402
transactions   483
TXF file   473

F
fees

bank service charges   164
IRA custodial, entering in investment ac
online banking   186

fields, adjusting in a printed check   144
file passwords   496
files   60–61, 481–497

adding accounts to   64
archiving   490
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cken   22–24
ta file   481
compressed, problems with   500
not affected by installation   15
protecting with passwords   496
Quicken data file, defined   60
restoring from a backup   489
setting up additional   481
updating from previous versions of Qui
when to have more than one Quicken da

Fill Row command   430, 431, 435
filters in reports   382
finance charges, credit card accounts   230
Financial Calendar, see Calendar
Financial Fitness

Debt Reduction Planner   441
Emergency Records Organizer   440
Free Credit Report   441
Retirement Planner   441
Tax Deduction Finder   440

financial institutions
applying for online banking   186
receiving e-mail   208
sending e-mail   207
setting up online banking   181

financial planning calculators   443–444
printing   444
recalculating   444

Find command   117
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236

hout EFT   205
wildcard characters   392
finding

check number   117
Find command   117
missing check number   117
payee   117
symbols for securities   345
tax deductions   440
ticker symbols   345
transactions in the register   117
uncategorized transactions   390

Fine Tuning setting for checks   146
first-time setup   18
fiscal year

setting up a budget for   428
starting a new file (optional)   492

fixed annuities, type of account for   273
fixed-rate loans, see loans
flexible spending account

tracking contributions in asset account   

tracking deductions from paycheck   112
float period for online payment, with or wit
fonts, changing

budgets   436
graphs   419
printed checks   134
reports   400
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   462
   100

75

ers
forecast graph   445–455
accounts, selecting   448
illustration   446
printing   455
time span, selecting   446

forecasting   445–455
foreign currency   337
Form 1099-OID   335
formats, report   376–394
forms

tax, assigning to accounts and categories
forward slash (/) separator in Category field
401(k) and 403(b) retirement plans

suggestions for setting up in Quicken   2
tax lines, assigning   465
type of account for   273

Free Credit Report   31, 441
funds transfer online   199
funds, moving between accounts, see transf

G
gains, unrealized, see unrealized gains
Get Online Data command   191
Ginnie Maes   330
goals, see investments, goals
graphs   407–420



 550
fonts in   419
forecast   445
in Security Detail window   287
investigating detail for   417
memorizing   415
"Other" category in   97, 407
overview   407
preset dates for   410
QuickZoom in   417
recalling memorized   416
sorting   413
two- or three-dimensional   419

groups, see transaction groups
guarantee, Intuit checks   128

H
handwritten checks   129
Help

balloons   54
onscreen manual   55
Quicken Help   47–52
system   47–54
Tips & Shortcuts   53
with problems, see troubleshooting

hidden
accounts   64, 68
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dated before the Opening Balance 

es   236

ck   240

ry   30
securities   360
hiding

accounts   64, 68, 291
accounts in graphs   414
backdrop   43
categories in graphs   414
classes in graphs   414
report columns   373
report titles   373
securities   293

in graphs   414
in Portfolio window   360
in reports   382

historical Quicken data
archiving   490
using to create a budget   431

historical transactions, adding transactions 
transaction   160

holding account for prepaid medical expens
home

cost basis   236, 240
improvements, using asset account to tra
inventory

tracking with asset account   236
tracking with Quicken Home Invento

house payments   260
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box   495

r mutual fund accounts   328

ls to track   295
I
identifying tax deductions   440
ImageWriters, printing checks on   136
importing

data from Quicken for Windows   485
security prices   344–??, 344–352
to MacInTax with TXF   473

inches, adjusting check alignment   145
Include Prior Uncleared Transactions check
including transactions in reports   382
income and expense

categories to track   72–80
see also categories

graphs   407–420
reports   367–??

income distributions, entering in portfolio o
income taxes   457–478
incorrect bank data (online accounts)   209
Increase column

asset account   240
liability account   242

indexes
Quicken, rebuilding   502
stocks, tracking   353

industry groups, setting up investment goa
inkjet printers, see page-oriented printers
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t   253

ounts   327

 335

king   182
inserting, see adding
Insights   404

customizing   405
installing Quicken   15
insurance

homeowner’s, including in loan paymen
tracking home inventory for   30

IntelliCharge   196
interest

accrued   326
amortizing   248
bank

and reconcile   164
entering in register   88

entering in portfolio or mutual fund acc
rates for loans, adjusting   265
year-to-date loans   268

Interest Income investment action   317, 327,

Internet access
for use with online banking   181, 183
see also Quicken Financial Network

Internet connection, closing from online ban
Internet Service Provider

for use with online banking   183
Investing area   40
Investment Actions list   288
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43

lio accounts
investment & savings planning calculator   4
investments   271–364

accounts
adjusting cash or share balance   364
cash balance   301
entering transaction history   354
entering transactions   308, 311
reconciling   363
setting up   291, 304
statements   363
taxable status, changing   68
updating   339
ways to view   281–288
when to use   271–274
see also mutual fund accounts; portfo

action forms   308
actions   288, 316
categories   80, 315, 316
deleting a security   357
editing and deleting security prices   343
entering transaction history   354
goals

selecting for reports   387
setting up   293
subtotaling reports by   381

performance reports, short sales in   336
planning   443
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9

ares   331

pare   457

   45
reports   370
selecting which to include in reports   38
tax lines, assigning   462
transactions, entering

in action forms   308
in register   311

IRAs
custodial fees, entering redemption of sh
tax lines, assigning   463, 464
type of account for   273

IRS
forms and schedules, Quicken helps pre
Schedule D   472

ISP, see Internet Service Provider

J
jobs, setting up classes to track   82
justify, see reconciling

K
Keoghs

tax lines, assigning   465
type of account for   273

keyboard shortcuts
creating your own with Command keys
using   41
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of checks on   142

9

see also the back cover of this manual

L
laser printers, see page-oriented printers
LaserWriters, printing checks on   133–154
layout

graphs   411–413
reports   373–376

lead time for online payments   203
left-aligned printers, printing partial pages 
lending money   251, 257
liabilities   235

see also liability accounts
liability accounts   235–244

adjusting balance of   244
defined   63, 238
register   242
sample uses   238, 242
updating   243
when to use   238

limiting items in reports   382–392
line of credit accounts in online banking   18
lines of credit, tracking   223
Lines per Check setting   145
lists

accounts   67
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r of this manual
categories   75
classes   84, 102
investment actions   288
keyboard shortcuts for, see the back cove
loans   247
memorized graphs   416
memorized reports   396
online payees   201
QuickFill transactions   113
securities   286
security types   295

loads, mutual fund or other security   325
Loan Interview window   249
Loan list   247
loan planning calculator   443
loans   247–268

adjustable-rate   258
amortizing   248
balances, tracking   236, 238, 248
balloon payments   258
changing and deleting   265
estimating interest payments   443
estimating year-to-date interest   268
how Quicken tracks   247
lending money   251, 257
making payments   260
negative amortization   259
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  466

ce planning calculator

ter   155
payment schedules   263
payments   260
prepayments   263
refinancing   266, 443
renaming the principal account   265
setting up   249–257
tax lines, assigning to mortgage interest 

undoing a mistaken payment   261
variable-rate   258
zero-interest   259
see also loan planning calculator; refinan

locking QuickFill transactions   114
logos

preprinted on Intuit checks   130
printing on Intuit checks with your prin

looking for, see finding
lots, security   326

showing in Portfolio window   283

M
MacInTax

export file format   403
exporting Quicken data to   473
updating tax assignments   474

magnifying glass
in graphs   407
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in reports   399
margin interest expense   333
market values

in Portfolio window   340
mutual fund accounts   307
portfolio accounts   303
updating   339

match transactions, see Find command
Memo Position setting   145, 146
Memorize command

graphs   415
reports   395

memorized
graphs   415–416
QuickFill transactions   114
reports   395–397
transactions   113

memory
needed to run Quicken   14
printing graphs and   420
solving problems with   502

memos
adding to checks   131
adding to transactions   90
compared to notes on checks   131
selecting for reports   388
sorting reports by   381
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33
menus
alternatives to   41
creating Command-key shortcuts for   45

merchants, see payees 

Microsoft Excel, exporting to   402
Misc. Expense investment action   317, 326, 3
Misc. Income investment action   317
missing check numbers   380
missing transactions

credit card accounts   231
reconciling   167

mistakes
correcting during reconciliation   167
correcting in register   95

modifying, see editing
money market funds

cash balance invested in   302
prices, entering   300
shares, number of, entering   299
tracking   62
type of account for   273

mortgage-backed securities   330
mortgages   247–268

adjustable-rate   258
amortizing   248
balances, tracking   248
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 317, 330, 355
0

 484, 485
balloon payments   258
changing   265
estimating year-to-date interest   268
how Quicken tracks   247
making payments   260
negative amortization   259
payment schedule   263
payments   260
prepayments of loan principal   263
refinancing   266
renaming the principal account   265
setting up   249–257
undoing a mistaken payment   261
variable-rate   258
zero-interest   259
see also loans

Move Shares In investment action   296, 305,

Move Shares Out investment action   317, 33
moving

budget amounts to another file   481
categories

in the Category & Transfer list   80
to another file   481

classes
in the Class list   85
to another file   481

data to and from Quicken for Windows  
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data to new version of Quicken   22–23
money between accounts   103
securities between accounts   361
transactions to another account   95

multiple forecast scenarios   435
mutual fund accounts

adding shares to   305
adjusting the share balance of   364
asterisk (*) in register   290
capital gains distributions   329
commissions and fees   314, 325
described   271
dividends in   327
entering transactions   308–336

for dates in past   354
income distributions   328
interest income in   327
IRA custodial fees   331
loads   325
market values   307
reconciling   363
reinvestments   328
revising initial transactions   355
setting up   304–307
setup options   277
transfers in   322
ways to view   281–288
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 accounts

243
see also investments; securities
mutual funds

prices
entering   300
importing   344–??, 344–352

shares, number of, entering   299
tracking   271
see also mutual fund accounts; portfolio

N
names, see name of specific item
negative amortization   259
net worth

defined   235
EasyAnswer report   368
excluding sold assets or paid liabilities   

Net Worth Analysis   31
new

accounts   64
balance on bank statement   159, 163, 175
budgets   426
categories   78
classes   84
data files   481
features in Quicken 98   35
features, see Quicken 98 new features
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9

before the Opening Balance transaction   
investments goals   295
investments, deciding how to track   272
loans   249
portfolio accounts, setting up   291
Quicken users   18
securities, deciding how to track   272
securities, opening balance   296
transaction, adding   90, 123
year, creating new file for   490

"No category" in reports   390
notes

accounts   64
added Note field on check   131
Calendar   92, 94
compared to memos on checks   131

numbers
check
finding in register   117
OK to have two series of numbers   12
why preprinted   132

O
old transactions, adding transactions dated 

160
online account access   187–200

advantages of using   180
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6

ATM transactions   194
categories   194
compared to online payment   180
downloading transactions   191
editing downloaded transactions   195
features   180
line of credit accounts   189
matching transactions   193
new transactions   194
paying credit card bills   198
Quicken Credit Card   189
setting up

existing accounts   187
new accounts   189
overview   181

transferring money   199
updating your register   195, 196
with a credit or charge card   196
see also online banking

online banking   180–210
advantages of using   28, 180
applying for   512
applying to your financial institution   18
canceling service   209
disputes   209
e-mail to your financial institution   207
features   28
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line payment   180

yment

ion   209
features of online account access and on
fees   186
getting data   191
reconciling   165
security for   183
service features   28
setting up

online account access   187
online payment   201
overview   181

technical support   512
see also online account access; online pa

online investment tracking
applying for   512

online payment   201–206
advantages of using   180
canceling a payment   206
compared to online account access   181
creating a payment   202
features   181
lead time   203
payees, adding to list   201
payment query to your financial institut
sending   202
sending a payment   202
service information   201
setting up
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ur latest bank statement   158
overview   181
payees   201

stopping payment   206
technical support   512
tracing payments   208
transmission summary   200, 203
when received   203
with or without EFT   203
see also online banking

onscreen Help system   47–54
onscreen manual   55
opening

accounts   67
Calendar   91
Category & Transfer list   74
Help system   47
old Quicken files in new version   22
Quicken for the first time   18
registers   67, 90

opening balance
adjusting   158
amount is from the ending balance of yo
determining what to enter in register   65
editing   95
entering transactions prior to   20
of a new account   19
on bank statement   159, 162
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5
what to use for different account types   6
options (puts and calls)   335
order of transactions

in graphs   413
in registers   91
in reports   381

ordering checks and supplies   129
organization of your Quicken data   60
"Other" category

in graphs   97, 407
in reports   97

P
page breaks in reports   372
page-oriented printers

partial first page of checks   141
printing checks on   133–154

paper is too short error   153
Partial Page Orientation icons   142
passwords
file   496
transaction   496
year-end closing and   491

paycheck deposit example   110
payees

adding online payees   201
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   209
reporting on specific payees   388
sorting reports by   381
subtotaling reports by   381
typing on check   131

paying bills   122–155
credit card accounts   232
loan payments   260
online   201–206

creating a payment   202
sending a payment   202

online credit card accounts   198
Payment column, credit card accounts   228
payment query to your financial institution
payments

adjustable-rate loans   261
future, see Calendar
house   260
loan   260
mortgage   260
online

canceling   206
creating and sending   202
when received   201

reports, limiting to payments   387
variable-rate loans   261

payroll liability, tracking   235, 238
pension plans, type of account for   273
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 116

192

ecords   31, 440

ning calculators
percentages, using QuickMath to calculate  

periods (..) wildcard character   391
Personal Identification Number (PIN)   183, 

personal income taxes   457–478
personal information, organizing personal r
petty cash, tracking in cash account   215
phone numbers   507, 512

saving yourself a call   499
pie charts   407

see also graphs
PIN, see Personal Identification Number
plannerssee Financial Fitness; financial plan
planning

college   443
debt reduction   441
deciding which tools to use   425
for retirement   441
forecast graph   445–455
investments   443
loans   443
overview   423
refinancing loans   443
retirement   443
savings   443
with Quicken, summary   423–425

Planning area   40



 571

heck   150
pointer line, printing a sample continuous c
portfolio accounts

adding shares to   296
adjusting the cash balance of   301, 364
asterisk (*) in register   290
capital gains distributions   329
cash balance in   301
commissions and fees   314, 325
described   271
dividends in   327
entering transactions   308–336

for dates in past   354
income distributions   328
interest income in   327
IRA custodial fees   331
loads   325
margin interest expense   333
market values   303
reconciling   363
reinvestments   328
revising initial transactions   355
setting up   291–303, ??–307
setup options   277
transfers in   322
ways to view   281–288
see also investments; securities

Portfolio window
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 accounts
inted reports   375

  30
s

choosing columns to display   283
customizing the display   283–285
deleting prices   343
hiding securities   360
illustrated   282
updating prices   340
viewing price information   282
see also mutual fund accounts; portfolio

portrait versus landscape orientation for pr
positioning

checks in continuous-feed printers   136
checks in page-oriented printers   135

possessions
tracking with asset accounts   235
tracking with Quicken Home Inventory 

postdated checks, see postdated transaction
postdated transactions

Billminder and   127
included in ending balance   89, 131

precious metals
prices, entering   300
shares, number of, entering   299
type of account for   273

preferences
check printing

continuous-feed printers   136
page-oriented printers   133
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 for   236

2
76
reorder reminder   154
general   43, 118
graphs   419
Internet   184
passwords   496
Quicken Preferences file   503
QuickMath   116
register   118
reports   400
Web access   34

prepaid medical expenses, holding account
prepayments of loan principal   263
previewing

loan payment transactions   255
page breaks in a report   372
reports before you print   402

previous balance on bank statement   159, 16
previous discrepancies, when reconciling   1
price history graphs   287
principal

amortizing   248
loan   248
making prepayments of   263
return of   330

PRINT in Number field   152
Print Preview command   402
print to fit on one page   373
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rinters   144

nters   148
printers
continuous-feed, printing checks on   136
left-aligned, printing checks on   142
non-Apple   135, 144
page-oriented, printing checks on   135
right-aligned, printing checks on   142
setting up to print checks   133
see also printing   516

printing
Calendar   94
categories on voucher checks   134
checks

adding art to   155
alignment problems on non-Apple p
amount is cut off   147
changing the check date   134
continuous-feed printers   136
fonts   134
inches, adjusting   145
LaserWriters   133–154
page-oriented printers   133–154

partial first page   141
setting up printer   133

problems   501
reprinting   152
sample check on continuous-feed pri
stopping   139

financial planning calculators   444
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253
fitting reports on one page   373
forecast graph   455
loan payment schedule   263
mortgage payment schedule   263
planning calculators   444
Portfolio window   282
print preview   402
registers   119
reports   402
reports on one page   373
supplies ordering information   129

problems, see troubleshooting
product support   507
products, ordering from Intuit   510
projecting account balances   445–455
promoting

subclasses to classes   85
properties, setting up classes to track   82
property taxes, including in loan payment   

puts and calls   335

Q
QIF files   482
quarters, budgeting by   427
question mark (?) wildcard character   391
QuickBudget   432
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m   482–??

   503

 372

0

Quicken Credit Card   189, 196, 513
Quicken Deluxe features

Debt Reduction Planner   31, 441
Emergency Records Organizer   31, 440
Free Credit Report   31, 441
Net Worth Analysis   31
onscreen user’s manual   55
Quicken Home Inventory   30
QuickEntry   27
Retirement Planner   441
Tax Deduction Finder   31, 440

Quicken for Windows, converting to and fro
Quicken Help   47–52
Quicken Home Inventory   30
Quicken Preferences file, System Folder and
Quicken Quotes   344–351

retrieving stock price information   348
Quicken 98 new features   35

account bar   67
customizing reports right on the report  

Deluxe features
Emergency Records Organizer   31, 44
Free Credit Report   31, 441
QuickEntry   27
Tax Deduction Finder   31, 440

sample reports   370
Shortcuts button   95
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2

smarter reconcile   176
QuickEntry   27, 114
QuickFill

category names   98
class names   100
completing transactions with   113
defined   26
Transactions list   113
turning on and off   113

QuickMath
calculating amounts with   116
keys, assigning   116

QuickReport   369
QuickZoom

in graphs   417
in reports   398

quotes, historical
retrieving stock price information   349

R
RAM, see memory
real estate

investment trusts, type of account for   27
tracking properties with classes   82
type of account for   273

rearranging
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t   80

ening Balance transaction   160

ank statement   166
categories in the Category & Transfer lis
classes in the Class list   85

Recalculate Now command   401
recalling

memorized graphs   416
memorized reports   396
scheduled transactions   126
transactions   113–114

Receive column, cash account   219
Reconcile Startup window   161
reconciled (�) transactions   169
reconciliation reports   170
reconciling   157–177

adding transactions dated before the Op
adjusting the opening balance   158
cash accounts   221
checkmarks and   166
completing   168
correcting transaction errors   167
credit card account   229
first time   158
interest earned   164
marking transactions that appear on a b
missing transactions   167
more than one month at a time   159
mutual fund accounts   363
online accounts   165
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ctions; QuickFill transactions; memorized 
portfolio accounts   363
previous discrepancies, resolving   176
Prior Statements window   177
Reconcile window, illustrated   166
reconciled transactions, defined   169
reconciliation reports   170
re-reconciling old statements   176
Save a Copy and   494
service charges   164
sorting items in Reconcile window   166

recurring transactions, see scheduled transa
transactions; transaction groups

redeeming bonds   330, 333
reducing data entry time

using QuickEntry   114
using QuickFill   113

reducing debt   441
refinance planning calculator   443
refinancing loans   266, 443
registers   88–119

asset accounts   240
automatic sorting in   91
bank accounts   88
cash accounts   219
checking account, illustrated   88
Clr column in   89, 176
credit card account   228
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s   118

28

al fund accounts   328

ctions   125

6

customizing   118
finding a transaction   117
illustration   89
liability accounts   242
mutual fund accounts   281, 311
opening   67, 90
portfolio accounts   281, 311
preferences   118
printing   119
QuickEntry   114
searching for a transaction   117
setting Return key to move between field
Shortcuts button   95
updating with downloaded data   196

regular bills, paying   122–127
Reinvest Dividend investment action   318, 3
Reinvest Interest investment action   318, 328
Reinvest Long investment action   318, 328
Reinvest Short investment action   319, 328
reinvestments, entering in portfolio or mutu
REITs, type of account for   272
Remind Me About setting scheduled transa
reminder notes, adding to the Calendar   94
removing

command buttons from toolbar   45
Command-key shortcuts from menus   4
report columns   378
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   82

  73
see also deleting
renaming, see editing
rental properties, setting up classes to track
replacing

categories that were entered incorrectly 

misspellings in register   117
text in the register   117

Reporting area   40
reports   367–??

adding page breaks   373
adjusting column width   374
business   370
categories determine usefulness   72
choosing columns in   378
content   382–391
creating   368–371
creating TXF from   473
customizing   372–397
exporting

data to other programs   402
to MacInTax (TXF)   473

fitting to one page when printing   373
fonts in   374, 400
formatting   376–394
investigating detail in   398
investment   370
layout   373–376
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ion   95
memorizing   395
organization   392–394
"Other" category in   97
page breaks in   372
preferences, changing   400
preset dates for   371
printing   402
QuickZoom in   398
recalling memorized   396
restricting   382–392
reusing custom settings   395
selecting items to include   382, 389
sorting and subtotaling   381
standard   370
tax-related   469
wildcard characters and   391

reprinting checks   152
Require Category on Transactions option   9
resizing

columns in Portfolio window   283
columns in reports   374

Restore button, discards changes to transact
restoring data from a backup   489
restricting data

in graphs   413
in reports   382

Retirement Planner   443
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0, 335

s of checks on   142
5

d reports; memorized graphs
retirement planning   441, 443
retirement plans, type of account for   273
Return key, using to move between fields   1
return of capital   330
Return of Capital investment action   319, 33
reviewing unprinted checks   132
right-aligned printers, printing partial page
risk, setting up investment goals to track   29
row headings for reports, changing   380

S
salary, entering a paycheck deposit   110
sales tax, calculating with QuickMath   116
sample checks, printing continuous   148
sample reports   370
Save a Copy command   492

prior uncleared transactions and   494
saving

backup files   486
data files to other formats   485
files not necessary with Quicken   66
QuickFill transactions   114
report and graph formats, see memorize
report data to other formats   402
tax planner results   478
tax reports to other formats   473
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   461, 462
time entering data   113
transactions in the Calendar   93
transactions in the register   91

savings
accounts, tracking   62
planning   443

Schedule D (Capital Gains)   472
scheduled transactions   122–126

confirming entry when due   125
due dates   124
recording

before due date   126
on due date   124

Remind Me About setting   125
schedules

loan payment   263
tax schedule reports   470
tax, assigning to accounts and categories

scheduling transactions   122–126
searching, see  finding; replacing
securities

buying   324
buying on margin   333
deleting   357
dividends   331
exporting   483
finding symbols for   345
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nts; security prices; security types
gift or inherited shares, cost basis for   33
giving shares you own   330
indexes, tracking   353
lots for   326
moving between accounts   361
price history graphs   287
receiving shares as a gift   330
selecting for graphs   414
selecting for reports   389
selling   324
selling short   336
setting up   292–295
shares, number of, entering   299
splits   331
subtotaling reports by   381
symbols for   293, 345
tracking ones you don’t own   353
transferring between accounts   361
type of account for   272
types   293
see also investments; return on investme

Securities list   286
printing   286
showing hidden items   286, 360
sorting   286

Security Detail window
viewing price history graph   287
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1

rk
viewing price history list   287
Security field in portfolio account register   3
security lots   326
security prices

deleting   343
differences among exchanges   347
editing   343
entering   300, 339
importing from a text file   352
importing with Quicken Quotes   344–35
price history for one security   287
recalculating   342
updating   339
viewing for one security   287

security types   293
selecting for reports   389
subtotaling reports by   381

security (safety)
see also passwords; backing up your wo

security, online banking   183
selecting

a Quicken window   44
accounts in forecast graphs   448
accounts in graphs   414
accounts in reports   382
categories in graphs   414
categories in reports   382
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account   324
classes in graphs   414
classes in reports   382
columns in Portfolio window   282
columns in reports   373
securities in graphs   414
securities in reports   382
what to include in reports   382
see also item you want to select

Sell investment action   319, 324
selling

assets   243
lots   326
options (puts and calls)   336
securities

entering in portfolio or mutual fund 
short sales   336

T-bills   334
zero-coupon bonds   335

sending money to another account   103
SEP, see Keoghs
Series EE bonds   333
service charges from bank   164
setting up

additional data files   481
budget monitoring   437
categories   78
classes   84
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   45
first time   18
investment goals   293
loans   249–257
mutual fund accounts   304–307
online banking   181
passwords   496
portfolio accounts   291–303, ??–307
securities   292–295
security types   293

settings, see preferences
share balance, mutual fund accounts   312
Share Price field   300
shares

adding to a mutual fund account   305
adding to a portfolio account   296
entering number of   299
entering prices for   300
see also securities

Shares field   299
short sales   336
shortcuts

automatic budgeting   431
creating your own with Command keys
see also back cover of this manual

Shortcuts button   95, 367
showing

accounts in graphs   414
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accounts in reports   382
categories in graphs   414
categories in reports   382
classes in graphs   414
classes in reports   382
graph in security detail view   287
hidden accounts   68
price history graphs   287
securities in graphs   414
securities in reports   382
subcategories in graphs   413
subcategories in reports   382

single checks, printing   141
Single Check/Two Checks settings   145, 147
slash (/) in Category field   100
software, ordering from Intuit   510
sorting

automatic in the register   91
Category & Transfer list   75
graphs   413
reports   381
transactions   381, 413

source accounts for transfers   103
Spend column, cash account   219
Split button   107, 110
split transactions   107–112

entering   107–109
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2

printing categories on voucher checks   1
reports, excluding detail from   381
transfers   106

spreadsheets, exporting Quicken data to   40
starting a data file for new year   490
starting balance, see beginning balance
starting Quicken
first time   18
updating from earlier versions   22–24

statements
bank, reconciling   157–177
credit card   229
investment account   363

Stock Split investment action   320, 331
stocks

dividends   332
finding symbols for   345
indexes, tracking   353
prices

deleting   343
editing   343
entering   300, 339
importing   344–??, 344–352
recalculating   342
updating   339

shares, number of, entering   299
splits   331
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type of account for   272
see also investments; securities; shares

stopping payment   206
subcategories

example in report   33
moving from one category to another   80
rolling up into categories in graphs   413
showing in graphs   413
tax lines, assigning   460
see also categories

subclasses   84
moving from one class to another   85
promoting to classes   85
rolling up into classes in graphs   413
showing in graphs   413
see also classes

subtotaling reports   381
supplies

ordering checks   129
printing ordering information   129

supplies, ordering from Intuit   509
switching between open windows   44
SYLK export file format   402
symbols, stock
finding   345
using with Quicken Quotes   345
where to enter   293
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T
Tab key, using Return key instead   118
task bar

adding and removing buttons   44
customizing   ??–45

Tax Deduction Finder   31, 440
Tax Exchange Format file (TXF), creating   47
tax line assignments

categories   460
classes   467
keeping up to date   474
subcategories   460
transfers   462
see also taxes

Tax Links command   460, 467
tax planner   475–478

creating multiple scenarios   478
entering data   476
interpreting results   477
opening   476
tax rates, keeping up with changes   478
using your Quicken data in   476

tax schedules, see Schedule D; taxes
taxable status

accounts   68, 291
securities   293
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n software   473
taxes   457–478
assigning transactions to tax lines   466
capital gains reports   472
cost basis of your home   236, 240
estimating with tax planner   475–478
exporting Quicken data to tax preparatio
marking categories as tax related   458
payroll   238
property, including in loan payment   253
Tax Deduction Finder   31, 440
tax line assignments

categories   461
subcategories   460
transfers   462

tax planner   475–478
tax schedule reports   470
tax summary reports   469
see also tax line assignments

tax-free income, recording   335
tax-related categories

reports, limiting to   385
tax summary reports and   469

Tax-related checkbox, for categories   458
TAX.SCD file   460, 474

problems with   500
technical support   507

saving yourself a call   499
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telephone numbers, see phone numbers
templates

for frequently used transactions   114
for graphs   415–416
for reports   395–400

Text Amount Width setting   147
text formats (font, size, style)

graphs   419
reports   374, 400

text (ASCII) export file format   402
three-dimensional graphs   419
ticker symbols, finding   345
tilde (~) wildcard character   391
titles in

graphs   412, 415
reports   377, 395

toolbar
adding and removing buttons   44, 45
customizing   43–??

switching between windows with   44
using   41

tracing online payments   208
tracking

assets   235–244
bank accounts   62
cash   215–221
cash in bank accounts   216
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commended   127
charge cards   223–233
checking accounts   62
credit cards   223–233
debt (consumer)   441
depreciation   235
income and expenses   72–85, 367
investments   271–364
liabilities   235–244
loan payments   263
loans   247–268
money market funds   62
mutual funds   271–364
paycheck deposits   110
payroll liability   235
petty cash   215
savings accounts   62
securities   271–364
securities you don’t own   353
security prices   339
stock indexes   353
stocks   271–364
tax-related income and expenses   457–46
401(k) and 403(b) retirement plans   273

transaction groups   127
Billminder and   127
replacing with scheduled transactions re
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ction   160

93
transaction groups

transaction passwords   496
transactions

adding
to Calendar   91, 122
to register   88–89

assigning
categories to   97–99
classes to   100

automatic completion of   113
changing

the account   95
the category   73

copying to another file   481
correcting in register   95
dated before the Opening Balance transa
defined   88
deleting

from Calendar   96
from register   96
transfers   106

downloaded data matched   193
downloading

from the financial institution   191
how Quicken assigns categories   194
how Quicken matches transactions   1
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 20
editing
downloaded data   195
in Calendar   126
in register   95
transfers   106

excluding from reports or searches   391
exporting   483
finding in register   117
how sorted in register   91
inserting in register   88–89
investment, entering

in action forms   308
in register   311

moving   95
multiple categories per transaction   107
new downloaded data   194
Opening Balance transaction in register  

passwords for security   496
paycheck, entering   110
protecting with passwords   496
recurring

grouping   127
scheduling   122

scheduling   122
sorting

in graphs   413
in reports   381
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 484
splitting   107–112
see also split transactions

uncleared   169
unreconciled   169
voiding   96
what to do if you used the wrong accoun
where is transaction? Find command   11
year-to-date, reconciling   160

Transfer Money command   105
transfer not present message   495
transferring

between online accounts   199
data to and from Quicken for Windows  

money between Quicken accounts   103
securities between accounts   361

transfers   103–106
Category & Transfer list and   104
editing or deleting   106
explained   27
including in budget   434
mutual fund accounts   322
online   199
portfolio accounts   322
selecting for reports   394
tax lines, assigning   462

transmission summary   200, 203
Treasury bills
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 bank statements   171

   113
redeeming   334
type of account for   273

troubleshooting
check printing   501
general   502
paper is too short   153
reconciling Quicken bank accounts with

turning on and off
automatic backup   486
automatic memorization of transactions
automatic recalculation of reports   401
backdrop behind windows   43
Balloon Help   54
file passwords   496
passwords   496
QuickFill   113
transaction passwords   496

two-dimensional graphs   419
TXF file

creating   473
format   403

typefaces, changing
graphs   419
reports   374, 400

types, security, see security types



 600

  494

  22–24
U
uncategorized transactions, finding   390
uncleared transactions, copying to new file 

Undo command   95
unit trusts

return of capital   330
type of account for   272

unrealized gains, including in reports   379
unreconciling reconciled transactions   169
updating

account information   68
asset accounts   243
budget amounts   429
cash account balance   221
categories   76
classes   85
credit limit for credit card accounts   68
data from previous versions of Quicken 

depreciation   244
interest rates   265
liability accounts   243
loan information   265
loan payment   260
register with downloaded data   196
security prices and market values   339
stock quotes   339
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 the Web   34
13

4

dating

   185
your register
with downloaded transactions   195

upgrades, ordering from Intuit   510
upgrading

Quicken files to new version   22
what’s new in Quicken 98   35

Up–to–the–minute financial information on
Use QuickFill to fill in transactions option   1
Use Today’s Date When Printing option   13
U.S. Savings Bonds, redeeming   333

V
values, see market values;asset accounts, up
variable

annuities, type of account for   273
rate loans   261

voiding a transaction   96

W
wallet checks, printing single   141
WatchList

adding securities to   353
deleting securities from   360

Web browser, specifying for online banking
Web Connect   211
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ar   492
what’s new in Quicken 98   35
where is transaction?, Find command   117
wildcard characters (.. and ?)   391
window envelopes, for checks   131
windows

multiple accounts open at once   67
switching between   44
see also names of specific windows

Windows button, adding to toolbar   44
Write Checks window
finding a transaction in   117
illustration   130

writing checks   128–132

Y
Year 2000 Compliant Standard   4
year-end copy of data   490
years

budgeting by   427
starting a separate data file for a new ye

year-to-date
estimated interest payments   268
transactions, reconciling   160
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   100
Z
zero-coupon bonds   335
zero-interest loans   259
zoom, see QuickZoom

Symbols
↑  (arrow) in Portfolio window   342
↓  (arrow) in Portfolio window   342
* (asterisk)

investment accounts and   290
5 (bar) in Portfolio window   342
� (bold checkmark) in the Clr field   169
• (bold dot) in QuickFill Transactions list   1
❍ (circle) in Portfolio window   342
√ (cleared) transactions   169
♦ (diamond) in Portfolio window   342
/ (forward slash) separator in Category field
? (question mark) wildcard character   391
� (reconciled) transactions   169
√ (thin checkmark) in the Clr field   169
~ (tilde) wildcard character   391
.. (two periods) wildcard character   391
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Numbers
2-dimensional graphs   419
3-dimensional graphs   419
401(k) and 403(b) retirement plans

suggestions for setting up in Quicken   2
type of account for   273


	3head - Copyright
	3head - Trademarks
	3head - Software License Agreement
	3head - Year 2000 Compliant Standard
	2head - Credits
	1head - Table of Contents
	chaptitle - Installation and setup
	1head - System requirements
	1head - Installing Quicken
	1head - Getting started if you’re new to Quicken
	1head - Upgrading from a previous version of Quicken

	chaptitle - Here’s what Quicken can do for you
	1head - Managing your bank accounts
	1head - Online banking
	1head - Tracking your investments
	1head - Tracking your assets and debts
	1head - Planning ahead
	1head - Reports and graphs
	1head - Up–to–the–minute financial information on the Web
	1head - What’s new in Quicken�2000
	2head - Get the big picture
	2head - Download more quotes
	2head - Access more investment data
	2head - Research investment opportunities
	2head - Reduce your mortgage
	2head - Find answers fast
	2head - Save more time
	2head - Pay bills and bank online
	2head - Access more financial institutions
	2head - File taxes online


	chaptitle - Working with Quicken
	1head - Working with Quicken
	2head - Choosing Quicken commands
	3head - Choosing commands from the toolbar
	3head - Choosing commands from the menus
	3head - Choosing commands with the keyboard


	1head - Customizing your Quicken workspace
	2head - Hiding the backdrop
	2head - Customizing the toolbar
	3head - Adding a button to the toolbar
	3head - Switching between open windows
	3head - Rearranging and removing command buttons

	2head - Creating your own Command-key shortcuts
	3head - Removing a Command-key shortcut


	1head - Getting step-by-step assistance from Quicken Help
	2head - Quicken Help Topics
	2head - Quicken Help Index
	2head - Quicken Help Look For
	2head - Learning useful tips and shortcuts
	2head - Finding out ‘What’s that?’ with Balloon Help

	1head - Using this manual
	2head - Using the Table of Contents and Index
	2head - Searching the manual
	2head - Printing sections and chapters
	2head - Choosing a web browser for Adobe Reader
	2head - More information about Acrobat Reader


	chaptitle - Accounts track what you own and owe
	1head - About Quicken data files
	1head - About Quicken accounts
	2head - Tracking what you own
	2head - Tracking what you owe

	1head - Setting up a Quicken account
	1head - Opening an account register
	1head - Editing, hiding and deleting accounts

	chaptitle - Categories and classes track income and expenses
	1head - About categories
	1head - Setting up categories and subcategories
	2head - Modifying the preset category lists
	2head - Creating new categories
	2head - Creating subcategories

	1head - Editing, deleting, and moving categories and subcategories
	1head - About classes
	1head - Setting up classes and subclasses
	1head - Editing, deleting, and moving classes and subclasses

	chaptitle - Keeping your accounts up to date
	1head - Recording your day-to-day expenses
	2head - Entering a transaction in the register
	2head - Entering a transaction in the Calendar

	1head - Correcting mistakes
	1head - What do I put in the Category field?
	2head - Assigning a category to a transaction
	3head - Typing a category name in the register
	3head - Choosing a category from the Category & Transfer list

	2head - Assigning a class to a transaction
	3head - Typing a class name in the register
	3head - Choosing a class from the Class list


	1head - Transferring money between accounts
	2head - Changing a transaction that includes a transfer

	1head - Entering transactions with more than one category
	2head - Entering a split transaction
	2head - Sample split transaction: entering your paycheck

	1head - Speeding up data entry
	2head - Entering data with QuickFill
	2head - Reducing transaction entry time with QuickEntry
	2head - Calculating transaction amounts with QuickMath

	1head - Finding a specific transaction
	1head - Customizing the register
	1head - Printing the register

	chaptitle - Paying your bills
	1head - Scheduling bill payments
	2head - Scheduling a future transaction in the Calendar
	2head - Scheduling a future transaction from the register
	2head - What happens after I schedule a transaction?
	2head - Editing and deleting scheduled transactions
	2head - Grouping transactions that occur around the same time
	2head - Billminder reminds you to pay your bills

	1head - Writing checks with Quicken
	2head - Intuit checks
	3head - Ordering checks
	3head - How do I write checks away from home?
	3head - How can I get a logo printed on my checks?

	2head - Filling out a check

	1head - Printing Intuit checks
	2head - Setting up your printer
	2head - Positioning checks in page-oriented printers
	2head - Positioning checks in continuous-feed printers
	2head - Printing checks from your account
	2head - Stopping a print job
	2head - Examining printed checks
	2head - Printing a partial first page of checks with page-oriented printers
	2head - Adjusting check alignment for page-oriented printers
	2head - Printing a sample check with continuous-feed printers
	2head - Adjusting check alignment for continuous-feed printers
	2head - Reprinting checks
	2head - Using the trailer strip option
	2head - Letting Quicken remind you to order checks
	2head - Adding art to checks


	chaptitle - Reconciling Quicken accounts
	1head - Before you start
	2head - Reconciling for more than one month
	2head - Adding earlier transactions

	1head - Starting reconciliation
	2head - Starting to reconcile an online account

	1head - Marking cleared transactions
	1head - Completing reconciliation
	3head - What’s the difference between Ã and 3 in the Clr column?
	2head - Creating a reconciliation report

	1head - Solving reconciliation problems
	2head - Finding and correcting differences
	3head - Finding a problem with the number of items
	3head - Finding a problem with the dollar amount of items

	2head - Letting Quicken adjust for differences
	3head - Resolving a difference from your current statement
	3head - Resolving a previous difference



	chaptitle - Banking online
	1head - Banking online from Quicken
	2head - Working with online banking

	1head - Connecting to the Internet
	2head - Questions you may have about security
	2head - Specifying your Internet Service Provider
	2head - Choosing a Web browser
	2head - Applying to your financial institution
	3head - Finding out about available services and fees


	1head - Setting up a Quicken account for online banking
	2head - Enabling an existing Quicken account for online use
	2head - Creating and enabling a new Quicken account

	1head - Going online to access your accounts
	2head - Downloading transactions the first time
	3head - How Quicken matches transactions
	3head - How Quicken assigns categories

	2head - Updating your register
	2head - Using online account access with a credit or charge card account
	3head - Checking your credit or charge card balance
	3head - Paying your credit or charge card bill

	2head - Transferring money between online accounts

	1head - Making online payments
	2head - Setting up a payee
	2head - Creating and sending online payments
	2head - When will the payee receive your payment?
	2head - When is the money withdrawn from your account?
	2head - Canceling a payment

	1head - Communicating with your financial institution
	2head - Sending mail to your financial institution
	2head - Receiving mail from your financial institution
	2head - Tracing a payment
	3head - Requesting a payment investigation

	2head - Handling disputes and canceling online services

	1head - Sending several instructions in one connection
	1head - Using Web Connect
	2head - Importing account statement information using Web Connect
	2head - Setting up your browser for Web Connect
	3head - If you are using Mac OS 8.5, 8.6, or 9



	chaptitle - Tracking your cash
	1head - When to use Quicken cash accounts
	1head - Entering cash transactions in Quicken bank accounts
	1head - Setting up and using Quicken cash accounts
	2head - Entering cash expenses in a cash account
	2head - Transferring cash into a cash account
	2head - Updating your cash balance


	chaptitle - Tracking your credit cards
	1head - When to use Quicken credit card accounts
	1head - Entering credit card transactions in Quicken bank accounts
	1head - Setting up and using credit card accounts
	2head - Entering credit or charge card transactions
	2head - Reconciling a credit card account
	2head - Paying your credit or charge card bill


	chaptitle - Tracking assets and liabilities
	1head - When to use Quicken asset and liability accounts
	2head - When to use Quicken asset accounts
	2head - When to use Quicken liability accounts

	1head - Setting up and using asset and liability accounts
	2head - Entering transactions in an asset or liability account
	2head - Sample uses for asset accounts
	2head - Sample uses for liability accounts
	2head - Updating the value of an asset or liability account
	3head - Closing assets or liabilities
	3head - Updating the balance in an asset or liability account



	chaptitle - Tracking loans and mortgages
	1head - How Quicken tracks a loan
	1head - Setting up a loan
	2head - Entering loan information
	2head - Previewing the loan payment transaction

	1head - Handling different types of loans
	1head - Making a loan payment
	2head - How changes to a loan payment affect future payments and schedules
	2head - Viewing a loan’s payment schedule
	2head - Making prepayments of principal

	1head - Changing and deleting loans
	1head - Refinancing a loan
	1head - Estimating year�to�date loan interest

	chaptitle - Tracking investments
	1head - About investment accounts
	2head - When to use an investment account
	2head - Organizing securities in an investment account
	2head - Deciding how to set up your securities

	1head - Tracking your investment data in Quicken
	2head - The Register window
	2head - The Portfolio window
	3head - Customizing the column display
	3head - Customizing the row display

	2head - The Securities window
	2head - The Security Detail window
	2head - The Investment Actions window
	2head - How Quicken displays investment amounts

	1head - Setting up a Quicken portfolio account
	2head - Creating a portfolio account
	2head - Adding a security to a portfolio account
	3head - Assigning security types and investment goals to your securities

	2head - Setting up an opening balance for a security
	3head - Determining what to enter in the Shares field
	3head - Determining what to enter in the ‘At’ (Share Price) field

	2head - Setting up the cash balance in a portfolio account
	2head - Bringing the market value for the account up to date

	1head - Setting up a Quicken mutual fund account
	2head - Creating a mutual fund account
	2head - Setting up an opening share balance
	2head - Bringing the market value for the account up to date

	1head - Recording investment transactions
	2head - Using investment forms to enter transactions
	2head - Entering investment transactions in the register
	2head - Choosing an investment action
	3head - Transferring money to and from other accounts
	3head - Buying and selling securities
	3head - Entering dividends and interest
	3head - Entering reinvestments
	3head - Entering capital gains distributions from mutual funds
	3head - Entering a return of capital or principal
	3head - Giving and receiving securities
	3head - Redeeming shares for IRA custodial fees
	3head - Entering stock splits and stock dividends
	3head - Buying on margin
	3head - Buying and redeeming U.S. savings bonds
	3head - Redeeming T-bills
	3head - Recording zero-coupon bonds
	3head - Handling tax-free bond income
	3head - Entering options (puts and calls)
	3head - Selling short
	3head - Managing foreign currency


	1head - Updating security�prices
	2head - Viewing and entering prices in the Portfolio window
	3head - Recalculating security prices

	2head - Adding, changing, and deleting prices in Security Detail
	2head - Retrieving security prices online
	3head - Understanding stock symbols
	3head - Entering stock symbols for Canadian stock exchanges
	3head - Understanding stock price information
	3head - Retrieving security prices using Quicken Quotes
	3head - Retrieving historical security prices
	3head - Setting Quicken Quotes preferences
	3head - Importing a price file into Quicken


	1head - Tracking indexes and securities you don’t own
	1head - Entering a transaction history for investments
	2head - Revising an initial Move Shares In transaction
	2head - Entering transactions for dates in the past

	1head - Changing, deleting, and moving securities
	2head - Changing security information
	2head - Deleting and hiding securities
	3head - Deleting a security from your data file permanently
	3head - Hiding a security
	3head - Deleting a security from the WatchList

	2head - Moving a security from one account to another

	1head - Researching securities on the Web
	1head - Reconciling investment accounts
	2head - Reconciling an investment register
	2head - Adjusting the cash or share balance


	chaptitle - Creating reports
	1head - About reports
	1head - Getting easy answers
	1head - Creating a QuickReport
	1head - Creating basic Quicken reports
	1head - Customizing reports
	2head - Customizing right on the report
	3head - Changing the layout
	3head - Restricting the items that appear in the report

	2head - Customizing in the Customize Report window
	3head - Customizing report layout
	3head - Customizing report content
	3head - Customizing report organization


	1head - Reusing custom report settings
	2head - Memorizing a report
	2head - Recalling a memorized report
	2head - Changing and deleting memorized reports

	1head - Investigating items in reports with QuickZoom
	1head - Changing report preferences
	1head - Updating reports
	1head - Printing and exporting reports
	2head - Printing a report
	2head - Exporting a report for use with another program

	1head - Seeing the big picture with Insights
	2head - Customizing your Insights


	chaptitle - Creating graphs
	1head - About graphs
	1head - Getting easy answers
	1head - Creating standard Quicken graphs
	1head - Customizing graphs
	2head - Customizing graph layout
	2head - Customizing graph content
	2head - Reusing your custom graph settings
	3head - Memorizing a graph
	3head - Recalling a memorized graph
	3head - Changing and deleting memorized graphs


	1head - Investigating items in graphs with QuickZoom
	1head - Changing graph preferences
	1head - Printing graphs

	chaptitle - Planning your financial future
	1head - An overview of the Quicken planning tools
	2head - Deciding which tools to use

	1head - Budgeting
	2head - Creating your first budget
	2head - Changing the way your budget is organized
	2head - Entering amounts in your budget
	3head - Entering budget amounts manually
	3head - Entering budget amounts automatically
	3head - Moving around in your budget
	3head - Setting up budget amounts for transfers
	3head - Editing budget information

	2head - Creating and using additional budgets
	2head - Printing a budget
	2head - Monitoring budget status
	2head - Creating budget reports and graphs

	1head - Financial Fitness
	2head - Organize your essential records
	2head - Find potential tax deductions

	1head - Financial Fitness on the Web
	2head - Plan for retirement
	2head - Reduce your debt
	2head - Get a copy of your credit report

	1head - Using the financial planning calculators
	1head - Forecasting
	2head - Displaying the forecast graph
	2head - Selecting accounts for your forecast graph
	2head - Estimating your unscheduled income and expenses
	3head - Including additional average monthly amounts
	3head - Adding financial ‘special events’ to your graph
	3head - Editing financial ‘special events’

	2head - Printing the forecast graph


	chaptitle - Getting ready for tax time
	1head - Tracking tax�related income and expenses
	2head - Marking categories as tax related
	2head - Assigning tax form line items to categories
	3head - Assigning line items to categories
	3head - Assigning line items to investment categories
	3head - Assigning line items to transfers

	2head - Entering transactions with tax time in mind
	2head - Filing multiple copies of tax forms and schedules

	1head - Creating tax reports
	2head - Creating a tax summary report
	2head - Creating a tax schedule report
	2head - Creating a capital gains report for Schedule D

	1head - Transferring Quicken data to tax software
	2head - Updating tax form information

	1head - Estimating taxes with the Quicken tax planner
	2head - Assembling your tax information
	2head - Using the tax planner
	3head - Tax planner results
	3head - Trying out different tax scenarios


	1head - Using more than one Quicken data�file
	1head - Importing and exporting Quicken�data
	2head - Exporting Quicken�2000 for Macintosh data
	2head - Importing a QIF file into Quicken for Windows
	2head - Importing data into a Quicken�2000 for Macintosh data file

	1head - Backing up and archiving your data files
	2head - Backing up your data automatically
	2head - Backing up your data manually
	2head - Restoring your data
	2head - Archiving your data file at the end of the year
	3head - Creating a year-end backup

	2head - Creating a new file for a new fiscal or calendar year
	3head - Archiving the old file
	3head - Removing later transactions from the archive file
	3head - How Save a Copy treats prior uncleared transactions


	1head - Setting up passwords
	1head - Saving a phone call
	2head - Solutions to common problems
	2head - Check printing problems and solutions
	2head - Other suggestions for helping yourself

	1head - Before you contact us
	1head - Who to contact
	2head - Quicken Technical Support Web Site
	2head - Fax on Demand
	2head - Automated Technical Support
	2head - Product Support Options
	2head - Online financial services support
	3head - Customer Service for CheckFree
	3head - CreditCheck Service by ConsumerInfo.Com

	2head - America Online, Inc.

	1head - Placing orders
	2head - Shop the Web
	2head - Quicken Checks Customer Service
	2head - Intuit Direct Sales
	2head - Intuit Customer Service

	1head - Getting started with online financial services
	2head - Apply for online financial services
	2head - Apply for online payment with Intuit
	2head - Apply for a Quicken Credit Card
	3head - Quicken Credit Card Support


	1head - Index


